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1 Preface

1.1 About this Manual

This User Manual describes general software functions and settings common to all
applications and operating modes in the R&S VSE. Furthermore, it provides all the
information specific to I/Q measurements in the I/Q Analyzer application. All other
applications are described in the specific application manuals.

The main focus in this manual is on the measurement results and the tasks required to
obtain them. The following topics are included:

● Welcome to the R&S VSE
Introduction to and getting familiar with the software

● Software Installation and General Configuration
Installation and initial configuration of the software

● Measurements and Results
Descriptions of the measurement types available in the R&S VSE software

● Operating Basics
General operating methods and concepts in the R&S VSE software

● Controlling Instruments and Capturing I/Q Data
Methods of data acquisition and description of basic instrument control functions

● Data Management
Description of general functions to handle data files (configuration and result data)

● General Software Setup
Description of general software settings and functions that are independent of the
current measurement channel

● I/Q Analyzer Measurements
Description of the settings and functions provided to analyze results with the I/Q
Analyzer and the corresponding remote control commands

● How to Perform Measurements
Step-by-step description of performing basic measurements with the R&S VSE
software

● Network and Remote Operation
Information on setting up the PC with the R&S VSE software and the instrument in
use in a network and operating them remotely.

● Remote Commands
Remote commands required to configure and perform measurements in a remote
environment, sorted by tasks
Remote commands required to set up the environment and to perform common
tasks in the software, sorted by tasks
Programming examples demonstrate the use of many commands and can usually
be executed directly for test purposes

● Troubleshooting
Hints and tips on how to handle errors
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● Reference
Additional information on data formats and an overview of menu functions

● List of Commands
Alpahabetical list of all remote commands described in the manual

● Index

1.2 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele-
ments"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are distin-
guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.

 

Typographical Conventions
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2 Welcome to the R&S VSE
The R&S VSE is a new high-performance Rohde & Schwarz analysis software for vari-
ous analysis tasks and input from various instruments.

The R&S VSE features analysis of:
● the same data in various applications simultaneously
● I/Q data files
● multiple inputs from a single instrument
● a combination of input from different instruments, including:

– R&S®FSW
– R&S®FPS
– R&S®FSV
– R&S®FSQ
– R&S®FSL

This user manual contains a description of the basic functionality that the software pro-
vides, including remote control operation. The latest version is available for download
at the product homepage (http://www2.rohde-schwarz.com/product/VSE.html).

 

http://www2.rohde-schwarz.com/product/VSE.html
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3 Software Installation

3.1 Installing Required Components

The following software components must be installed to run the R&S VSE software
successfully:
● Microsoft .NET Framework 3.5 and 4.0 (both)
● VISA

Installing the Microsoft .NET Framework

When you install the R&S VSE via the provided installation file (see chapter 3.2,
"Installing and Starting the R&S VSE Software", on page 12), the installer automati-
cally checks whether the required Microsoft .NET Framework versions are available on
the PC. If not, version 3.5 is installed from the R&S VSE CD-ROM, and an internet
connection to the Microsoft website is established to download the Framework version
4.0 (due to the large file size). Thus, before attempting to install the R&S VSE soft-
ware, ensure a strong internet connection is available from the PC, as downloading
may take some time. Alternatively, download the Framework 4.0 version from the inter-
net manually before you start the R&S VSE installer.

Installing VISA

It is also necessary to install VISA (Virtual Instrument Software Architecture) to access
instruments connected to the PC via IEEE or LAN bus.

It is recommended that you use the National Instruments VISA driver. The National
Instrument VISA driver CD-ROM is supplied together with the R&S VSE CD-ROM. You
can also visit http://www.ni.com/visa to get the latest version for your operating system
if you are licensed to.

Once the R&S VSE software is installed, a status icon in the status bar indicates
whether the VISA installation is available, see table 6-1.

3.2 Installing and Starting the R&S VSE Software

After installing all required components, you can install the R&S VSE. It is recommen-
ded that you copy the file from the installation CD-ROM to your hard disk before you
execute it.

To install the R&S VSE software

1. Insert the R&S VSE CD-ROM in the PC.
If the start page does not open automatically, select the start.htm file in the
main directory.
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2. Switch to the "Installation" tab.

3. Select the link to the VSESetup_XXX.exe file.

4. Select a storage location on your hard disk.

5. From the hard disk, select the VSESetup_XXX.exe file.

6. Select the required options to be installed.
Unless you have ensured the required Microsoft .NET Framework versions are
installed manually before starting the R&S VSE installation, be sure to keep the
"R&S VSE .NET installation" option selected.

7. Select "Install".

The installer performs the following actions:
● Checks for the required Microsoft .NET Framework versions on the PC, and if nec-

essary, downloads the required version from the Internet, before installing both ver-
sions

● Installs the R&S VSE software including an uninstall tool
● Creates a shortcut on the desktop (optional)
● If necessary (the software will specifically ask you to), set the required environment

variables.
This step may require administrator rights on the PC.

When the installation is complete, the dialog box turns green and all selected options
are indicated as "OK".

To start the R&S VSE software

► Start the software via the Windows "Start Menu" entry or the shortcut on the desk-
top.

Demo mode
Without the use of the Smart Card Reader (see chapter 3.3, "Using the Smart Card
Reader", on page 13), the software starts in "Demo-Mode". In this case, all (installed)
options and remote commands are available. However, no instruments can be config-
ured, no I/Q files and no measurement settings can be loaded or saved.

3.3 Using the Smart Card Reader

The software is licensed by a smart card licensing system. This licensing system
requires a smart card to be connected to the PC when you are using the software.

The smart card and reader (R&S FSPC) are provided with the R&S VSE software CD.

You can connect the smart card in two ways.

● Connect the smart card in SIM format.

 

Using the Smart Card Reader
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If you want to connect the smart card in SIM format, use the USB smart card
reader that is included in the delivery of the software.

● Connect the smart card in its full format.
If you want to connect the smart card in full format, an interface compatible to the
card format is required.
The following devices are able to read the smart card in full format.
– smart card reader integrated in a keyboard
– smart card reader integrated in a notebook
– smart card reader integrated in a desktop PC (e.g. OMNIKEY)
– smart card reader connected to the computer via serial bus or USB (e.g. OMNI-

KEY)
– USB reader connected to a LAN-to-USB converter to distribute the license via

the network (e.g DIGI AnaywhereUSB/2)

Licensing support
If you have any difficulties with the licensing system, support is only assured when you
are using the USB smart card reader that is delivered with the smart card.

Using the USB smart card reader

1. Included in the delivery of the software is the smart card in full format and a smart
card reader.

2. Break out the smart card in SIM format.

3. Insert the smart card into the smart card reader.

Using the Smart Card Reader
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a) Turn the smart card reader in a way that the OMNIKEY label faces upward.
b) Insert the smart card with the chip face down and the angled corner facing

away from the reader.

4. Push the smart card into the reader as far as possible.

The smart card reader is ready for use on any USB interface.

Locking the computer

If you have difficulties unlocking the computer while the smart card is connected
because MS Windows tries to get log-in information from the card after you have
locked the computer.

You can solve this issue by editing the system registry.

Manual change

1. Open the Windows "Start Menu" and select the "Run" item.

2. Enter regedit into the dialog box to open the system registry.

3. Look for
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
policies\system.

4. Set the value of DisableCad to 0.

Administration rights
Security policies of your network environment might prevent you from editing the sys-
tem registry or installing drivers. Contact your IT administration in that case.

3.4 Deinstalling R&S VSE

Access: "Start" > "All Programs" > "Rohde-Schwarz" > "VSE" > [version_number] >
"Uninstall VSE"

or: "Start" > "Control Panel" > "Add or Remove Software"

You can uninstall the software itself via the uninstall tool available in the R&S VSE
folder, or via the standard Windows "Add or Remove Software" function.

 

Deinstalling R&S VSE
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4 Trying Out the R&S VSE
This chapter introduces the most important functions and settings of the R&S VSE step
by step. The complete and detailed description of the functionality can be found in the
subsequent chapters. Basic instrument operation is described in chapter 6, "Operating
Basics", on page 35.

Prerequisites

● The software is installed and started as described in chapter 3, "Software Installa-
tion", on page 12.

For these first measurements, you can use either a connected instrument in the net-
work or an input file.

● Capturing and Analyzing Data from a Connected Instrument.................................16
● Analyzing Stored Data from a File.......................................................................... 25

4.1 Capturing and Analyzing Data from a Connected
Instrument

The following example demonstrates how to perform a very simple measurement on
input from a connected instrument using the R&S VSE. Only the default I/Q Analyzer
application is required.

Try out the following:

● Configuring an Instrument.......................................................................................16
● Assigning the Instrument to a Channel................................................................... 18
● Adding Additional Result Displays.......................................................................... 19
● Rearranging Windows.............................................................................................21
● Undocking and Resizing the Help Window............................................................. 22
● Adding Further Measurement Channels................................................................. 22
● Recording Measurement Data................................................................................ 24

4.1.1 Configuring an Instrument

In the first step, we will search for instruments connected to the same network as the
PC running the R&S VSE software, and attempt to connect to one of them.

1. Select the "Instruments" tab at the upper left of the R&S VSE window.

2. Select "Search" to search for all instruments in the network.

3. To find instruments using the VXI-11 protocol, in the "Device Search" dialog box,
select the interface type "LAN VXI-11" and select "Search".
If there are very many results, try filtering them by the type of instrument, for exam-
ple, enter FSW in the "Filter" field.

 

 

 

Capturing and Analyzing Data from a Connected Instrument
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4. From the result list, select the instrument from which data is to be captured, then
select "OK".

5. In the "Instruments" window, select "Connect" to establish a connection to the
specified instrument.

The connection state should turn green and indicate "connected".

Capturing and Analyzing Data from a Connected Instrument
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4.1.2 Assigning the Instrument to a Channel

Now we must assign the configured and connected instrument as the input source for
the default measurement channel.

1. In the "Measurement Group Setup" tool window, for the default group 1, select the
"+" icon in front of the default measurement channel "IQ Analyzer".

2. Select "Instrument" as the input type.

3. From the "Instrument" selection list, select the instrument to be used for the mea-
surement.

4. From the "Input Source" selection list, select "RF".

5. Select the  "Capture" icon for the "IQ Analyzer" measurement channel.

Since the default measurement mode is continuous, a continuous measurement is
started immediately on the connected instrument. The results are displayed in the
"IQ Analyzer: Magnitude" result display.

 

Capturing and Analyzing Data from a Connected Instrument
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4.1.3 Adding Additional Result Displays

For the I/Q Analyzer, up to 6 windows can be displayed for a single channel. We will
add Spectrum and Statistics result displays.

1. Select the  "Add Window" icon from the toolbar.

2. Select the "Spectrum" result display.

A new window (2) for the "Spectrum" result display is opened.

 

Capturing and Analyzing Data from a Connected Instrument
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3. Select the  "Add Window" icon again and select the "Statistics" result display.

A new window (3) for the "Statistics" result display is opened.

Capturing and Analyzing Data from a Connected Instrument
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4.1.4 Rearranging Windows

The R&S VSE window has now become rather crowded. Let us move the "Statistics"
window (3) behind the Spectrum window (2), so both become tabs in the same area.

► Select the window title bar of the "Statistics" window (3) and drag it over the Spec-
trum window (2). Possible new positions for the "Statistics" window (3) are indica-
ted by an empty gray space in the R&S VSE window.

Fig. 4-1: Moving the Statistic window over the Spectrum window

As soon as the "Statistics" window (3) is placed over the Spectrum window (2),
both windows are shown as tabs.

When you drop the window, the moved window is added as a tab.

Fig. 4-2: Tabbed windows

To switch between the two windows, simply select the corresponding tab.

 

Capturing and Analyzing Data from a Connected Instrument
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4.1.5 Undocking and Resizing the Help Window

Displaying the help window is often useful when you need to know which values to
enter in a dialog, for example. However, if many result displays are required, the
R&S VSE window might get rather crowded. Thus, we will undock the help window and
move it outside the actual R&S VSE window.

1. Select the "Help" icon in the window title bar to display the "Help" window.

2. Select the "Dock" / "Undock" icon in the "Help" window title bar.

The window is detached and can be moved and resized independantly of the
R&S VSE window.

3. Move the "Help" window anywhere on the screen, for example next to the
R&S VSE window.

4. To resize the "Help" window, select the window frame and drag it to the required
size.

4.1.6 Adding Further Measurement Channels

In addition to the default I/Q Analyzer measurement channel, we will add a second
channel for I/Q Analysis.

1. In the "Measurement Group Setup" tool window, select the "+ Channel" button to
add a new measurement channel to the group.

2. Select the "I/Q Analyzer" measurement mode.

 

 

Capturing and Analyzing Data from a Connected Instrument
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The channel bar and the default result displays for the new IQ Analyzer measure-
ment channel are displayed. If necessary, the previously displayed windows are
cumulated in tabs to create room on the display.

Fig. 4-3: Second IQ Analyzer measurement channel ("IQ Analyzer 2")

3. Select the configured instrument as the input type for the new measurement chan-
nel.

Capturing and Analyzing Data from a Connected Instrument
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Notice how the "IQ Analyzer 2" channel is now active, while the "IQ Analyzer"
channel is deactivated. This is due to the fact that both channels are based on the
same instrument, but each instrument can only perform one measurement at a
time. Thus, the channel that was assigned to the instrument previously ("IQ Ana-
lyzer") is deactivated when the instrument is assigned to a new channel ("IQ Ana-
lyzer 2").

4. Select the "Capture mode" icon to toggle between single  and continuous 
measurements for each measurement channel.

5. Select the  "Capture" icon for a measurement channel to perform a measurement
on that channel. Only one channel can be started manually at a time. Before you
can start another channel, you must stop the previous measurement by selecting
the  "Stop" icon for that channel first.

4.1.7 Recording Measurement Data

Now we will record the measured I/Q Analyzer data so that we can play it back again
later. We want to store all available results, regardless of how many measurements we
perform.

1. From the "File" menu, select "Preferences > Recording".

2. Select the "Always Maximum Record Length" option.

3. Close the "Preferences" dialog box.

4. Select the  "Record" function for the "IQ Analyzer" channel in the "Measurement
Group Setup" tool window.

The captured I/Q data is recorded.

5. To stop recording measurement results, select the  "Pause" function for the "IQ
Analyzer" channel in the "Measurement Group Setup" tool window.

The temporary file is used as input for the "IQ Analyzer" channel, and the first
recorded record is displayed immediately in the channel's result displays.
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6. From the "File" menu, select "Save IQ Recording" to store the file permanently.

7. Select the storage location and file name for the stored data.

8. Select the "File Type": ".iq.tar".

9. Select "Save".

The captured data is stored to a file. You can now continue with the second part of
the Trying Out chapter: analyzing stored data from a file.

4.2 Analyzing Stored Data from a File

If no instrument is availabe in the network to provide input to the R&S VSE, you can
also try out the software using an input file. Several input files are provided with the
software for demonstration purposes. Check the
C:\ProgramData\Rohde-Schwarz\VSE\<version_number>\user\
predefined directory for an appropriate file.

Note that this directory is not displayed in the "Load I/Q File" dialog box, you must
enter the path and file name directly in the "File Name" field. (Tip: copy the path and
file name from the Windows Explorer window.)

4.2.1 How to Import I/Q Data for Analysis

1. In the "Measurement Group Setup" tool window, select the "+" icon in front of the
"IQ Analyzer" measurement channel.

2. Select "File" as the input type.

3. Select the "..." icon to open the "Load I/Q File" dialog box and select the storage
location and the file name.

4. Select the  "Capture" icon for the "IQ Analyzer" measurement channel.

The stored data is loaded from the file and evaluated in the "IQ Analyzer" result
displays.

4.2.2 Setting and Moving a Marker

Markers are useful to determine the position of particular effects in the trace. The most
common use is to determine a peak, which is the default setting when you activate a
marker. We will set a marker on the peak in the Magnitude display of the IQ Analyzer
measurement.

1. Tap the Magnitude display to set the focus on that window.

2. Select the  "New Marker" icon from the toolbar.
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Marker 1 is activated and automatically set to the maximum of trace 1. The marker
position and value is indicated in the diagram area as M1[1].

3. Now you can move the marker by tapping and dragging it to a different position.
The current position is indicated by a dotted blue line. Notice how the position and
value change in the marker area of the diagram.

Analyzing Stored Data from a File
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5 Measurements and Results
The R&S VSE provides several applications for different analysis tasks and different
types of signals. The I/Q Analyzer application is included in the basic R&S VSE soft-
ware. All other applications, such as Analog Demodulation or Vector Signal Analysis
(VSA) are optional additions and require special licenses. (See also chapter 5.2, "Avail-
able Applications", on page 32.)

● Measurement Concept............................................................................................27
● Available Applications............................................................................................. 32
● Starting an Application............................................................................................ 33

5.1 Measurement Concept

As a rule, each instrument can only perform a single measurement at any time. How-
ever, the R&S VSE allows you to perform multiple measurements on the same instru-
ment sequentially, or to perform multiple measurements on different instruments in par-
allel. Thus, comprehensive data analysis with a single tool becomes quick and simple.

Basic measurement process

In a basic I/Q measurement, data is imported from a file or captured from an instru-
ment and the measured results are displayed. Multiple applications can be used at the
same time in the R&S VSE. However, data acquisition on the same instrument is
restricted to a single application at a time.

Measurement channels

When you activate an application, a new measurement channel is created which deter-
mines the measurement settings for that application. The same application can be acti-
vated with different measurement settings by creating several channels for the same
application. Whenever you switch channels, the corresponding measurement settings
are restored.

The global information and results for each channel are displayed in separate windows
(or tabs) on the screen. The results from multiple applications can be displayed at the
same time, with display space being the only limiting factor. Each application may pro-
vide different result displays (see the applications' user manual for details). The mea-
surement windows can be rearranged and configured in the R&S VSE to meet your
requirements (see chapter 6.3, "Customizing the User Interface", on page 43).

The measurement channels are labeled with their default name. If that name already
exists, a sequential number is added. However, the name of the measurement channel
can be changed. For details and an overview of default names see INSTrument:
LIST? on page 291.

In the R&S VSE, measurement channels are controlled and initially configured in the
"Measurement Group Setup" tool window.
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Fig. 5-1: "Measurement Group Setup" tool window

For each channel, the input type (instrument or file) and the input source type must be
configured. Detailed configuration for the measurement can then be performed via the
specific configuration "Overview" which is available for each application. (For details
see the applications' user manual.)

You can define any number of measurement channels at the same time (restricted only
by memory resources). However, only one measurement channel can be started man-
ually at any time. Before you can start another channel, you must stop the previous
measurement channel first.

Measurement groups

As opposed to manual channel control, multiple measurements on different instru-
ments or files can be performed in parallel if controlled by the software. All measure-
ment channels that are to be started at the same time must be configured within a
group. When the group is started, all included (active) measurement channels are star-
ted and provide results independently as soon as their measurements are completed.

Measurement Concept
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Note, however, that the individual measurements are not synchronized in any way, and
the results are totally independent as the input data is different for each channel.

Configure triggers to synchronize the individual measurements.

Multiple groups of measurement channels can be configured, for example to define
individual test scenarios.

Measurement groups are a convenient way to start multiple measurements at the
same time.

Fig. 5-2: Example for a measurement group

Active vs inactive channels

As mentioned above, only measurements on different instruments or on files can be
performed in parallel. If the same instrument is assigned to multiple measurement
channels of the same group, those channels cannot be processed simultaneously.

Measurement Concept



Measurements and ResultsR&S®VSE

30User Manual 1176.8839.02 ─ 03

Thus, the channel to which the instrument was assigned previously is deactivated.
Only active measurements are included in a group measurement.

Active channels are indicated by a checkmark in front of the channel in the "Measure-
ment Group Setup" tool window.

Measurement groups and sequences

For multiple measurements on the same instrument, without switching between mea-
surement channels manually, the R&S VSE provides measurement sequences. A sin-
gle instrument can perform only one measurement at a time; however, a sequence of
measurements can be performed very quickly by the software.

Measurement sequences consist of a number of measurement groups, and each
group may contain multiple channels. However, only channels with distinct input types
can be active within a group during a measurement sequence. The groups themselves
can also be activated or deactivated individually. When you start a measurement
sequence, the individual groups are processed sequentially, in the order of their defini-
tion. The measurements for a single group are started simultaneously, and only when
all channels in the group have completed, the next group is processed.

Measurement Concept



Measurements and ResultsR&S®VSE

31User Manual 1176.8839.02 ─ 03

Fig. 5-3: Example for a measurement sequence

Active groups are indicated by a checkmark in front of the group in the "Measurement
Group Setup" tool window.

Measurement sequences are a convenient way to perform multiple measurements on
an input signal in a quick succession, and to obtain results from different applications in
a relatively short measurement time without having to switch between applications
manually. For stable input data, a measurement sequence can provide results in vari-
ous applications for almost identical input data.

Measurement mode

For each measurement you can define whether a defined number of measurements is
to be performed, or a continuous measurement. This is referred to as the measure-
ment mode. The measurement mode can be defined for an individual measurement
channel, a measurement group, or an entire measurement sequence. However, the
measurement mode for the channels within a group is always the same as for the
entire group, and the mode for the groups is the same as for the sequence. Thus, if
you change the mode for a sequence, the mode for the group and the individual chan-
nels is automatically adapted accordingly. Nevertheless, you can change the mode for
individual channels for manual measurement control.

Default measurement

The default measurement in the R&S VSE consists of a single measurement channel
(with the I/Q Analyzer application) in a default group and a default measurement

Measurement Concept
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sequence in continuous measurement mode. The measured magnitude values are dis-
played.

5.2 Available Applications

The I/Q Analyzer application is included in the basic R&S VSE software. All other appli-
cations, such as Analog Demodulation or Vector Signal Analysis (VSA) are optional
additions and require special licenses.

I/Q Analyzer.................................................................................................................. 32
Analog Demodulation....................................................................................................32
Vector Signal Analysis (VSA)........................................................................................32
Pulse Measurements.................................................................................................... 32
3G FDD......................................................................................................................... 33
GSM.............................................................................................................................. 33
WLAN............................................................................................................................33
LTE................................................................................................................................33

I/Q Analyzer
The I/Q Analyzer is the default application and provides measurement and display
functions for I/Q data.

Remote command: 
INST:SEL IQ, see INSTrument[:SELect] on page 292

Analog Demodulation
The Analog Demodulation application requires an additional license. This application
provides measurement functions for demodulating AM, FM, or PM signals.

For details see the R&S VSE-K7 User Manual.

Remote command: 
INST:SEL ADEM, see INSTrument[:SELect] on page 292

Vector Signal Analysis (VSA)
The VSA application requires the Vector Signal Analysis option, R&S VSE-K70, to be
installed, and an additional license. This application provides measurements and eval-
uations for Vector Signal Analysis.

For details see the R&S VSE-K70 User Manual.

Remote command: 
INST:SEL DDEM, see INSTrument[:SELect] on page 292

Pulse Measurements
The Pulse application requires the Pulse Measurements option, R&S VSE-K6, to be
installed, and an additional license. This application provides measurement functions
for pulsed signals.

For details see the R&S VSE-K6 User Manual.

Remote command: 
INST:SEL PULSE, see INSTrument[:SELect] on page 292
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3G FDD
The 3G FDD BTS and 3G FDD UE applications require the 3GPP FDD Measurements
option, R&S VSE-K72, to be installed, and an additional license. This applications pro-
vide test measurements for W-CDMA uplink and downlink signals (base station sig-
nals) according to the test specification.

For details see the R&S VSE-K72 User Manual.

Remote command: 
INST:SEL BWCD, see INSTrument[:SELect] on page 292

GSM
The GSM application requires the GSM Measurements option R&S VSE-K10, to be
installed, and an additional license. This application provides GSM measurements.

For details see the R&S VSE-K10 User Manual.

Remote command: 
INST:SEL GSM, see INSTrument[:SELect] on page 292

WLAN
The WLAN application requires one of the WLAN options, R&S VSE-K91, to be instal-
led, and an additional license. This application provides measurements and evalua-
tions according to the WLAN IEEE 802.11 standards.

For details see the R&S VSE-K91 User Manual.

Remote command: 
INST:SEL WLAN, see INSTrument[:SELect] on page 292

LTE
The LTE application requires the LTE Measurements option R&S VSE-K100x, to be
installed, and an additional license. This application provides LTE measurements.

For details see the R&S VSE-K10x (LTE Downlink) User Manual.

Remote command: 
INST:SEL LTE, see INSTrument[:SELect] on page 292

5.3 Starting an Application

The default application in the R&S VSE is the I/Q Analyzer.

1. To start a new application, in the "Measurement Group Setup" tool window, select
the "New Channel" button.
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2. Select the required application.

For more information on working with applications see chapter 7, "Controlling Instru-
ments and Capturing I/Q Data", on page 52.

Starting an Application
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6 Operating Basics
This chapter provides an overview on how to work with the R&S VSE. It describes
what kind of information is displayed in the diagram area, how to operate the R&S VSE
via the graphical user interface, and how to use the Online Help. The information
described here refers to the basic R&S VSE functionality, and is generally available in
all supported applications. For specifics on the individual applications, see the corre-
sponding user manuals.

● Graphical User Interface Elements......................................................................... 35
● Understanding the I/Q Analyzer Display Information.............................................. 41
● Customizing the User Interface...............................................................................43
● Getting Help............................................................................................................ 49

6.1 Graphical User Interface Elements

All tasks necessary to operate the instrument in use can be performed using the
R&S VSE graphical user interface.

In addition to the measurement results, the display provides status and setting informa-
tion, allows you to switch between various measurement tasks, and provides access to
all measurement functions.

Fig. 6-1: Graphical user interface elements
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1 = Menu bar with general and measurement specific menus
2 = Toolbar with general and measurement specific tools
3 = Tool window for measurement group tool
4 = Tool window for instrument configuration
5 = Tabs for individual measurement channels
6 = Channel bar for active channel settings
7 = Result display for first measurement channel (yellow line)
8 = Result display for second measurement channel (purple line)
9 = Four result displays for third measurement channel (green line)
10 = Status bar with error messages, progress bar and instrument status for active channel

6.1.1 Menus

Most functions in the R&S VSE are available from the menus at the top of the window.

The following menus provide basic functions for all applications:
● "File"
● "Window"
● "Help"

These functions are described in this manual. An overview is provided in chapter A.1,
"Menu Reference", on page 449.

Other menus are application-specific and provide different functions depending on
the selected measurement channel, for example:
● Input
● Measurement Setup
● Trace
● Marker
● Limits

These menu functions are described in the individual application's User Manual and in
chapter 10, "I/Q Analyzer Measurements", on page 112.

6.1.2 Toolbars

Standard functions can be performed via the icons in the toolbars.

The toolbars can be docked anywhere alongside the outer edge of the R&S VSE win-
dow, that is, beneath the menu bar, above the status bar, or on the left or right edges
of the window. For details see chapter 6.3, "Customizing the User Interface",
on page 43.
For information on how to hide or display individual toolbars see chapter 6.3.4, "Clos-
ing and Deactivating Windows and Bars", on page 48.

Note that some icons are only available for specific applications. Those functions are
described in the individual application's User Manual.
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An overview of all available toolbar functions is provided in chapter A.2, "Reference of
Toolbar Functions", on page 454.

6.1.3 Status Bar

The software status, instrument status, errors and warnings and any irregularities in
the instrument in use are indicated in the status bar at the bottom of the R&S VSE win-
dow.

Hiding the status bar
You can hide the status bar display, e.g. in order to enlarge the display area for the
measurement results ("File > Preferences > Displayed Items").
See chapter 9.2.1, "Displayed Items", on page 102.

Software status

The status bar indicates the state of the VISA installation on the PC running the
R&S VSE software. The VISA installation is required in order to connect the R&S VSE
to other instruments.

The following VISA status icons may be displayed:

Table 6-1: VISA status icons

VISA installation is available; network connections to other instruments are possible

VISA installation is available, but a firewall may be prohibiting a connection to other instru-
ments in the network.
Try one of the following to resolve the problem:
● Check the IP addresses of the instruments configured in the "Instruments" window and

make sure you are allowed to connect to those instruments.
● Try using HiSLIP protocol instead of VSI-11
● Ask your local administrator to loosen the firewall restrictions on your PC.
● Restart the instrument you want to connect to.

VISA installation is not complete or available; network connections to other instruments are not
possible.

See "Installing VISA" on page 12 or contact the Rohde & Schwarz Support Center (see chap-
ter 14.3, "Obtaining Technical Support", on page 447).

If you place the mouse over the icon, a descriptive message is displayed informing you
what to do.

Instrument status

The displayed instrument status information depends on the type of instrument that is
connected to the R&S VSE. For the supported Rohde & Schwarz Signal and Spectrum
Analyzers, the following types of information may be displayed, if applicable.
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The instrument is configured for operation with an external reference.

The input from the connected instrument is being resampled by the R&S VSE soft-
ware to obtain the required sample rate.

Progress

The progress of the current software operation is displayed in the status bar.

Error messages

If errors or irregularities are detected, a keyword and an error message, if available,
are displayed in the status bar. For details see the individual applications' user manual.

6.1.4 Windows

The R&S VSE distinguishes between three types of windows, depending on their use:
● Tool windows: provide functionality for specific global tasks, such as configuring

instruments or measurement groups; see chapter 7, "Controlling Instruments and
Capturing I/Q Data", on page 52

● Channel bar: provides information on measurement channel settings (one window
per active channel)

● Result displays: provide the measurement results

The layout of the individual windows is customizable and highly flexible, see chap-
ter 6.3, "Customizing the User Interface", on page 43.

● Channel bar.............................................................................................................38
● Result Displays / Measurement Windows...............................................................39

6.1.4.1 Channel bar

For each channel, a separate window with measurement information is displayed.
When you select a result display window for a different channel, the channel bar for
that channel is also activated. Each channel bar is provided with a colored line in the
window title bar which is the same color as the corresponding channel result displays.

Fig. 6-2: Example for channel bar (I/Q Analyzer)
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In the default configuration, the channel bars for multiple channels are displayed in
separate tabs in the same window. Depending on which result display is currently
active, the corresponding channel information tab is displayed. However, you can sep-
arate the tabs into individual windows. See chapter 6.3, "Customizing the User Inter-
face", on page 43.

Channel-specific settings

The channel bar provides information on channel-specific settings for the measure-
ment. A bullet next to the setting indicates that user-defined settings are used, not
automatic settings. A green bullet indicates this setting is valid and the measurement is
correct. A red bullet indicates an invalid setting that does not provide useful results.
Channel information varies depending on the active application. For details see the
individual user manuals.

Instrument settings

In addition to the channel-specific settings, the channel bar also displays information
on general instrument settings that affect the measurement results even though this is
not immediately apparent from the display of the measured values. This information is
displayed in gray font and only when applicable for the current measurement, as
opposed to the channel-specific settings that are always displayed.

The instrument settings depend on the type of instrument that is connected to the
R&S VSE. For the supported Rohde & Schwarz Signal and Spectrum Analyzers, the
following types of information may be displayed, if applicable.

Table 6-2: Instrument settings displayed in the channel bar

PA The preamplifier is activated

75 Ω The input impedance of the instrument is set to 75 Ω

DC/AC An external DC or AC calibration signal is in use.

6.1.4.2 Result Displays / Measurement Windows

Measurement results can be evaluated in many different ways, for example graphi-
cally, as summary tables, statistical evaluations etc. Optional applications add their
own specific measurements and result displays. Thus, the result display is highly con-
figurable to suit your specific requirements and optimize analysis.

For each measurement, a separate measurement channel is activated. Each measure-
ment channel can provide multiple result displays. All windows that belong to the same
measurement (including the channel bar) are indicated by a colored line at the top of
the window title bar.
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Fig. 6-3: Color-coded windows

Window title bar

The contents of the individual result displays are described in detail in the applications'
user manuals.

The following common functions are available in all window title bars:

Table 6-3: Common functions and icons in the window title bar

Change result type Displays a list of possible result types for the active channels to replace
the current display.

Invalid data Indicates that invalid or inconsistent data is displayed, that is: the trace no
longer matches the displayed measurement settings. This may be the
case, for example, when you change the measurement bandwidth, but the
displayed trace is still based on the old bandwidth. As soon as a new mea-
surement is performed or the display is updated, the icon disappears.

(This icon is sometimes also referred to as a "dirty flag".)

Graphical User Interface Elements
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/

Dock / Undock win-
dow

Docks the window to the main R&S VSE window or separates it from the
main window.

See "Docked and undocked windows" on page 43

Delete window Closes the selected window

6.2 Understanding the I/Q Analyzer Display Information

The following figure shows a measurement diagram during I/Q Analyzer operation. All
different information areas are labeled. They are explained in more detail in the follow-
ing sections.

Fig. 6-4: Screen elements in the I/Q Analyzer application

1 = Color coding for windows of same channel
2 = Channel bar with measurement settings
3 = Window title bar with diagram-specific (trace) information
4 = Diagram area with marker information
5 = Diagram footer with diagram-specific information, depending on result display

Channel bar

The channel bar shows the most important settings for the corresponding application.
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Select a setting in the channel bar to open the corresponding configuration dialog box
and change the setting quickly and easily.
Right-click a setting to display a context menu for it.

For the I/Q Analyzer application, the channel bar shows the following settings:

Table 6-4: Information displayed in the channel bar for the I/Q Analyzer application

Ref Level Reference level

(m.+el.)Att (Mechanical and electronic) RF attenuation

Ref Offset Reference level offset

Freq Center frequency

Meas Time Measurement time

Rec Length Defined record length (number of samples to capture)

SRate Defined sample rate for data acquisition

RBW (Spectrum evaluation only) Resolution bandwidth calculated from the
sample rate and record length

Window title bar information

For each diagram, the header provides the following information:

Fig. 6-5: Window title bar information in the I/Q Analyzer application

0 = Color coding for windows of same channel
1 = Edit result display function
2 = Invalid data flag
3 = Channel name
4 = Window number
5 = Window type
6 = Trace color, trace number, detector type, trade mode
7 = Dock/undock window function
8 = Close window function

Diagram footer information

The diagram footer (beneath the diagram) displays scaling information and depends on
the evaluation:

Magnitude and Spectrum diagrams:
● Center frequency
● Number of measurement points
● Range per division (x-axis)
● Span (Spectrum)

Understanding the I/Q Analyzer Display Information
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I/Q Vector diagram:
● Maximum value on y-axis

6.3 Customizing the User Interface

The layout of the individual windows in the R&S VSE software is customizable and
highly flexible. Apart from a few fixed interface elements (menu bar, status bar), the
windows can be positioned almost anywhere on the screen.

● Windows Concept................................................................................................... 43
● Displaying New Windows........................................................................................46
● Rearranging Windows.............................................................................................47
● Closing and Deactivating Windows and Bars......................................................... 48

6.3.1 Windows Concept

Docked and undocked windows

In the default layout, all windows are positioned within the main R&S VSE window.
When you change the size of the R&S VSE window, or add new subwindows, the sub-
windows are adapted or rearranged as necessary. The subwindows are docked to the
main window.

Fig. 6-6: Example for docked windows in the R&S VSE window

Optionally, each subwindow can be undocked, that is, detached from the main
R&S VSE window. Undocked windows can be placed anywhere on the screen, even
outside of the main R&S VSE window. This is useful, for example, if a second monitor
is available and you want to take advantage of the additional display area. However,
undocked windows "float" on the screen, covering any other displays behind them, and
are not adapted or rearranged when you change the size of the R&S VSE window or
add new subwindows.

 

 

Customizing the User Interface



Operating BasicsR&S®VSE

44User Manual 1176.8839.02 ─ 03

Fig. 6-7: Example for undocked window in the R&S VSE window

Docking areas for interface elements

The windows and other interface elements can be docked within predefined areas in
the R&S VSE window. (For details on the window types see chapter 6.1.4, "Windows",
on page 38.)
● The menu bar and status bar are fixed elements and are always located at the

top and bottom edge of the window, respectively. No windows can be docked
above the menu bar or below the status bar.

● Toolbars can only be placed along the outer edges of the R&S VSE window,
below the menu bar and above the status bar.

● Tool windows can only be placed along the outer edges of the R&S VSE window,
below the menu bar and above the status bar, and not outside of any toolbars.

● Channel bars can be placed above or below the result displays, at the top or bot-
tom edges of the R&S VSE window, but not outside of any tool windows or tool-
bars.

● Result displays are surrounded by all other window types and bars. They must be
placed within a grid structure of columns and rows. The number of result displays
in each column or row is restricted only by the available display space and the min-
imum window size of the individual windows.

Table 6-5: Docking areas in the R&S VSE window

Customizing the User Interface
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Docking positions

Possible docking positions for the currently selected element are indicated by an empty
gray space in the R&S VSE window.

Window tabs

As mentioned above, each window type requires a minimum amount of space for dis-
play. If not enough display space for all active windows is available, windows of the
same type are automatically arranged in tabs within one window. To switch between
displayed windows, simply select the corresponding tab.

For example, when a new channel is started or a new display is added, the existing
windows may be combined into one window using tabs, while the new windows are
displayed in maximum size.

In order to save space on the screen and when not all windows are relevant at the
same time, you can also arrange windows in tabs manually. Tabs are created when
you dock a window on top of an existing window of the same type. The docking posi-
tion is indicated by showing the existing window with a tab, instead of providing an
empty gray space for a new window.

Table 6-6: Docking windows as tabs

Possible docking position: tab in existing window Result: new tab in existing window

Customizing the User Interface
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Window size

Each window type requires a minimum amount of display space. The maximum size is
restricted only by the available display space within the R&S VSE window (for docked
windows) or on the entire screen (for undocked windows).

Note that since result displays are placed within a grid structure (see "Docking areas
for interface elements" on page 44), the minimum width of a window may also be
restricted by other result displays in the same column and the minimum height may be
restricted by other result displays in the same row.

Active windows, selected window

When a measurement is performed in a channel, results are determined for all config-
ured result displays. Thus, in order to analyze result data and possibly store it to a file,
you must activate windows for the corresponding result displays. A list of all active win-
dows for all configured measurement channels is available from the "Window" menu.

As soon as you select a window, for example by clicking the mouse in it, any window-
specific operations you perform subsequently are applied to that window. For example,
you can set a marker or zoom in into the display of the window. Furthermore, when you
select a window, you also select the channel the selected window belongs to. The
channel bar (see chapter 6.1.4.1, "Channel bar", on page 38) for the selected channel
is activated, and any channel-specific operations are applied to the selected channel.

Closing vs deactivating windows

If a large number of channels or result displays are active, the display may become
very crowded and confusing. Thus, if you do not require the online visualization of the
results, you can temporarily deactivate windows in the display. Deactivating a window
simply hides the display, without losing its settings or contents. A deactivated window
can easily be restored to the display without having to reconfigure it.

Closing a window permanently deletes the result display and its contents. A new win-
dow with the same evaluation method and default settings can be added again, but the
previous settings and contents are lost.

6.3.2 Displaying New Windows

For the I/Q Analyzer, up to 6 windows can be displayed for a single channel.

To add a new window

1. Select the global information window or any other measurement window of the
measurement channel you want to add a window for.

2.

Select the "Add Window" icon or
From the "Window" menu, select "New Window".

3. Select the result display you want to add a window for.
The available result display types depend on the selected application.
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For other applications, see the application-specific documentation.

A new window for the result display is opened.
If not enough display space for all active windows is available, the existing win-
dows are combined into one window using tabs, while the new window is displayed
in maximum size.

To replace the contents of a measurement window

1. In the window whose contents you want to replace, in the window title bar, select
the  "Replace" icon.

2. Select the result display.

The window displays the newly selected result display for the selected measure-
ment channel.

Remote commands:

LAYout:GLOBal:ADD[:WINDow]? on page 299

LAYout:GLOBal:REPLace[:WINDow] on page 305

6.3.3 Rearranging Windows

To dock or undock a window

► Select the "Dock" / "Undock" icon in the window title bar.

If the window was docked, it is detached and can be moved and resized independ-
antly of the R&S VSE window.
If the window was undocked, it is docked to its default position in the R&S VSE
window.

(For details see "Docked and undocked windows" on page 43.)

To change the position of a window or bar

► Select the bar or window title bar and drag it to a new position on the screen. Pos-
sible docking positions for the currently selected element are indicated by an empty
gray space in the R&S VSE window or by showing the underlying window with a
tab.

When you drop the window or bar, it is docked to the selected position.
If you drop the window on top of an existing window of the same type, the moved
window is added as a tab.
To switch between displayed windows, simply select the corresponding tab.
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To resize a window

► To resize a window, select the window frame and drag it to the required size. Note
the restrictions concerning the minimum window size described in "Window size"
on page 46.

To restore the default configuration for the measurement channel, use the Preset >
Selected Channel function in the "File" menu.

6.3.4 Closing and Deactivating Windows and Bars

Closing a window permanently deletes the result display and its contents, while deacti-
vating a window simply hides the display, without losing its settings or contents. Tool
windows and channel bars can not be closed permanently.

(For details see "Closing vs deactivating windows" on page 46).

To hide or display a toolbar

1. Right-click any toolbar or the menu bar.

A context menu with a list of all available toolbars is displayed.

2. Select the toolbar you want to hide or display.

A checkmark indicates that the toolbar is currently displayed.

The toolbar is toggled on or off.

To deactivate or reactivate a tool window or channel bar

► From the "Window" menu, select the tool window or channel bar.

The window is toggled on or off.

To deactivate or reactivate a result display

1. From the "Window" menu, select "Active Windows".
Alternatively, right-click the window title bar of a result display that belongs to the
same channel.

2. Select the result display you want to deactivate or reactivate.

A checkmark indicates that the window is currently active.

The window is toggled on or off.

To close a result display

►

Select the "Delete" icon in the window title bar.

The result display is permanently removed.
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Remote command:

LAYout:GLOBal:REMove[:WINDow] on page 305

6.4 Getting Help

If any questions or problems concerning the R&S VSE arise, an extensive online help
system is provided in the software and can be consulted at any time. The help system
is context-sensitive and provides information specifically for the current operation or
setting to be performed. In addition, general topics provide an overview on complete
tasks or function groups as well as background information.

6.4.1 Calling Up Help

The online help can be opened at any time by selecting one of the "Help" icons on the
toolbar or by selecting the F1 key.

Calling context-sensitive help

► To display the "Help" dialog box for the currently focused screen element, e.g. a
softkey or a setting in an opened dialog box, select the "Help" icon on the toolbar.

The "Help" dialog box "View" tab is displayed. A topic containing information about
the focused screen element is displayed.
If no context-specific help topic is available, a more general topic or the "Contents"
tab is displayed.

For standard Windows dialog boxes (e.g. Print dialog, Device Search, VISA Resource
String Builder etc.), no context-sensitive help is available.

► To display a help topic for a screen element not currently focused:

a) Select the "Help pointer" icon on the toolbar.

The pointer changes its shape to a "?" and an arrow.
b) Select the screen element to change the focus.

A topic containing information about the selected (now focused) screen element is
displayed.
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6.4.2 Using the Help Window

The Help window contains several tabs:
● "View" - shows the selected help topic
● "Contents" - contains a table of help contents
● "Index" - contains index entries to search for help topics
● "Search" - provides text search

The Help toolbar provides some buttons:
● To browse the topics in the order of the table of contents: Up arrow = previous

topic, Down arrow = next topic
● To browse the topics visited before: Left arrow = back, Right arrow = forward
● To increase or decrease the font

To search for a topic in the index

The index is sorted alphabetically. You can browse the list, or search for entries in the
list.

1. Switch to the "Index" tab.

2. Select the "Keyboard" icon besides the entry field.

3. Enter the first characters of the keyword you are interested in.

The entries containing these characters are displayed.

4. Double-click the suitable index entry.

The "View" tab with the corresponding help topic is displayed.

To search topics for a text string

1. Switch to the "Search" tab.

2. Select the "Keyboard" icon besides the entry field.

3. Enter the string you want to find.
If you enter several strings with blanks between, topics containing all words are
found (same as AND operator).

For advanced search, consider the following:

● To find a defined string of several words, enclose it in quotation marks. For
example, a search for "trigger qualification" finds all topics with exactly "trigger
qualification". A search for trigger qualification finds all topics that contain the
words trigger and qualification.

● Use "Match whole word" and "Match case" to refine the search.
● Use operators AND, OR, and NOT.
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To close the Help window

► Select the "Close" icon in the upper right corner of the help window.
Or:
Press the ESC key on the front panel.
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7 Controlling Instruments and Capturing I/Q
Data
A key feature of the R&S VSE is the ability to capture data from various instruments or
retrieve data from stored measurement files, and to analyze this data in various appli-
cations.

● Input Sources..........................................................................................................52
● Configuring Instruments..........................................................................................53
● Controlling Measurement Channels, Groups, and Sequences...............................67

7.1 Input Sources

The input source selects the source of the data to be analyzed. You can either analyze
a live signal or a signal that has been recorded previously and whose characteristics
have been saved to a file.

7.1.1 Connected Instrument

Any instruments that are to provide signals to the R&S VSE must be configured in the
software. The R&S VSE then manages all connections to the other instruments. If the
instrument configured for a particular measurement channel is changed, the R&S VSE
software adapts the measurement settings, if necessary and possible. Thus, the mea-
surement and analysis tasks performed using the R&S VSE software are mostly inde-
pendent of the underlying instrument.

Currently, the following instruments can be connected to the R&S VSE software to pro-
vide signal input:
● R&S®FSW Signal and Spectrum Analyzers
● R&S®FSV Signal and Spectrum Analyzers
● R&S®FPS Signal and Spectrum Analyzers
● R&S®FSL Signal and Spectrum Analyzers

The instrument connected to and controlled by the R&S VSE software is referred to as
the instrument in use throughout this documentation.

Input sources

Depending on the type of instrument and the connectors it provides, the following
source of input is supported by the R&S VSE software:
● RF

Captures and analyzes the data from the RF input of the spectrum analyzer in use.

 

 

 

Input Sources



Controlling Instruments and Capturing I/Q DataR&S®VSE

53User Manual 1176.8839.02 ─ 03

7.1.2 File Input

Alternatively to "live" data input from a connected instrument, measurement data to be
analyzed by the R&S VSE software can also be provided "offline" by a stored data file.
This allows you to perform a measurement on any instrument, store the results to a
file, and analyze the stored data partially or as a whole at any time using the R&S VSE
software.

Currently, the following file formats are supported by the R&S VSE software to provide
signal input:
● iq.tar (compressed data format)
● csv files
● mat (matlab) files
● iqw

For more information see also chapter 8.3.4, "Recalling Measurement Data from Files",
on page 92.

7.2 Configuring Instruments

Access: "Window" > "Instruments"

The R&S VSE can capture and analyze data from various instruments. These instru-
ments must be configured before measurements can be performed on them via the
R&S VSE. Instruments are configured in the R&S VSE's "Instruments" tool window.

● Remote Control Interfaces and Protocols............................................................... 53
● Defining the Connection Information Manually....................................................... 56
● Determining the Address with Software Support.................................................... 58
● Searching for Connected Instruments Automatically.............................................. 61
● Deleting all Instrument Configurations.................................................................... 62
● Initializing a Self-Alignment on the instrument in use..............................................63
● Configuring the Behavior During Remote Control...................................................63
● Configuring a Frequency Reference for the Connected Instrument....................... 64
● Obtaining Information on Versions and Options on the instrument in use..............66

7.2.1 Remote Control Interfaces and Protocols

The software supports different interfaces and protocols for remote control. The follow-
ing table gives an overview.
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Table 7-1: Remote control interfaces and protocols

Interface Protocols, VISA*) address string Remarks

Local Area
Network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol (IVI-6.1)
TCPIP::host address::hislip0[::INSTR]

● VXI-11
TCPIP::host address::inst0[::INSTR]
Library: VISA

The interface is based on TCP/IP and
supports various protocols.

For a description of the protocols refer
to:

VXI-11 Protocol

HiSLIP Protocol

*) VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA
installation on the controller is a prerequisite for remote control using the indicated interfaces.

(See also "VISA library" on page 54).

7.2.1.1 LAN Interface

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected
using a commercial RJ45 cable (shielded or unshielded twisted pair category 5). The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and the VISA program library must be
installed on the controller.

VISA library

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. The I/O channel is selected at initialization time by
means of the channel-specific address string ("VISA resource string") indicated in
table 7-1, or by an appropriately defined VISA alias (short name).

A VISA installation is a prerequisite for remote control using the LAN interface.

IP address

Only the IP address or a valid DNS host name is required to set up the connection.
The host address is part of the "VISA resource string" used by the programs to identify
and control the instrument.

The VISA resource string has the form:

TCPIP::host address[::LAN device name][::INSTR]
where:

● TCPIP designates the network protocol used
● host address is the IP address or host name of the device
● LAN device name defines the protocol and the instance number of a sub-instru-

ment;
– inst0 selects the VXI-11 protocol (default)

– hislip0 selects the newer HiSLIP protocol
● INSTR indicates the instrument resource class (optional)
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Example: 
● Instrument has the IP address 192.1.2.3; the valid resource string using VXI-11

protocol is:
TCPIP::192.1.2.3::INSTR

● The DNS host name is VSE-123456; the valid resource string using HiSLIP is:
TCPIP::VSE-123456::hislip0

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.

For details on configuring the LAN connection, see chapter 12.3, "How to Set Up a
Network and Remote Control", on page 253.

● VXI-11 Protocol.......................................................................................................55
● HiSLIP Protocol.......................................................................................................55

VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol uses
two TCP sockets for a single connection - one for fast data transfer, the other for non-
sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

● High performance as with raw socket network connections
● Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,

Serial Poll, Remote/Local, Trigger, and Service Request
● Uses a single IANA registered port (4880), which simplifies the configuration of fire-

walls
● Supports simultaneous access of multiple users by providing versatile locking

mechanisms
● Usable for IPv6 or IPv4 networks

Configuring Instruments
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Note that HiSLIP data is sent to the device using the "fire and forget" method with
immediate return, as opposed to VXI-11, where each operation is blocked until a
VXI-11 device handshake returns. Thus, a successful return of a VISA operation such
as viWrite() does not guarantee that the instrument has finished or started the
requested command, but is delivered to the TCP/IP buffers.

For more information see also the application note: 1MA208: Fast Remote Instrument
Control with HiSLIP.

7.2.2 Defining the Connection Information Manually

Access: "Window" > "Instruments" > Setup

If you already know the network connection information of the instrument to be control-
led by the R&S VSE software, you can enter it directly in the "Instruments" tool win-
dow.

New Instrument............................................................................................................. 57
Search...........................................................................................................................57
Close Instrument........................................................................................................... 57
Interface Type............................................................................................................... 57
IP address..................................................................................................................... 57
Resource String............................................................................................................ 58
Advanced Settings........................................................................................................ 58
Calibration State / Self Alignment................................................................................. 58
Connection State...........................................................................................................58
Infos & Settings............................................................................................................. 58
Connect / Disconnect.................................................................................................... 58
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New Instrument
Displays the configuration dialog for a new instrument. You can also configure instru-
ments that are not connected to the PC running the R&S VSE software.

To configure a new instrument quickly while the "Instruments" tool window is closed,
select the "File > Instruments > New window" menu item. The "Instruments" tool win-
dow is displayed with an entry for a new instrument.

Remote command: 
DEVice:CREate  on page 265

Search
Starts a search for all instruments connected to the same network as the PC running
the R&S VSE software.

(See chapter 7.2.4, "Searching for Connected Instruments Automatically",
on page 61).

Close Instrument
You can delete a instrument that is no longer available or required by the R&S VSE
software. Select the  "Close" icon next to the instrument name in the "Instruments"
tool window.

Remote command: 
DEVice:DELete on page 265

Interface Type
Specifies the interface protocol used to connect the instrument to the network.

For details on interfaces see chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 53

"VXI-11" Standard TCP/IP-based protocol

"HiSlip" High performance protocol

Remote command: 
DEVice:TARGet:TYPE on page 268

IP address
Unique IP address of the connected instrument. The five most recently selected IP
addresses are available from the dropdown list.

(To delete this list, select "File > Preset > Reset VSE Layout", see "Restoring User-
Specific Settings ( Reset VSE Layout )" on page 77.)

The IP address consists of four number groups separated by dots. Each group con-
tains 3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a group (as an example see the pre-installed address).

For information on how to determine the IP address see the instrument's documenta-
tion.

Remote command: 
DEVice:TARGet on page 267
DEVice:TARGet? on page 267
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Resource String
VISA resource string used by the R&S VSE to identify and control the connected
instrument. The five most recently selected resource strings are available from the
dropdown list.

(To delete this list, select "File > Preset > Reset VSE layout", see "Restoring User-Spe-
cific Settings ( Reset VSE Layout )" on page 77.)

For details see chapter 7.2.1.1, "LAN Interface", on page 54.

Advanced Settings
Opens the "VISA Resource String Builder" which supports you in determining the
required resource string, see chapter 7.2.3, "Determining the Address with Software
Support", on page 58.

Calibration State / Self Alignment
Indicates whether the connected instrument is calibrated. If necessary, a self-alignment
can be initiated on the connected instrument (see chapter 7.2.6, "Initializing a Self-
Alignment on the instrument in use", on page 63).

Connection State
Indicates the current state of the connection to the specified instrument in the network.

Remote command: 
DEVice:STATe? on page 266

Infos & Settings
Displays additional information on the connected instrument, if available. See chap-
ter 7.2.9, "Obtaining Information on Versions and Options on the instrument in use",
on page 66.

Remote command: 
DEVice:INFO:HWINfo? on page 268
DEVice:INFO:OPT? on page 269
DEVice:INFO:IDN? on page 269

Connect / Disconnect
Establishes a connection to the specified instrument in the network, or disconnects an
existing connection.

Remote command: 
DEVice:CREate  on page 265

7.2.3 Determining the Address with Software Support

Access: "Window" > "Instruments" > Advanced > "VISA Resource String Builder"

If you do not know the network address of the connected instrument, the R&S VSE
software can help you determine the correct connection information using the "VISA
Resource String Builder".
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Alias.............................................................................................................................. 59
Timeout......................................................................................................................... 59
Interface Type............................................................................................................... 59
Address (format)........................................................................................................... 60
IP address..................................................................................................................... 60
Host name.....................................................................................................................60
Board Number...............................................................................................................60
LAN device name..........................................................................................................60
VISA Resource String................................................................................................... 60
Status............................................................................................................................ 61
Check............................................................................................................................ 61

Alias
A logical name used to identify the instrument more easily in the network and connec-
tion settings in the R&S VSE software.

Timeout
Time in which the network connection to the instrument must be established before the
the attempt is aborted.

Interface Type
Specifies the interface protocol used to connect the instrument to the network.
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For details on interfaces see chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 53

"VXI-11" Standard TCP/IP-based protocol

"HiSlip" High performance protocol

Remote command: 
DEVice:TARGet:TYPE on page 268

Address (format)
Defines the format used to specify the instrument's network address

"IPv6" Internet protocol version 6

"IPv4" Internet protocol version 4

"Host name" Computer name of the instrument instead of IP address

IP address
Unique IP address of the connected instrument. The five most recently selected IP
addresses are available from the dropdown list.

(To delete this list, select "File > Preset > Reset VSE Layout", see "Restoring User-
Specific Settings ( Reset VSE Layout )" on page 77.)

The IP address consists of four number groups separated by dots. Each group con-
tains 3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a group (as an example see the pre-installed address).

For information on how to determine the IP address see the instrument's documenta-
tion.

Remote command: 
DEVice:TARGet on page 267
DEVice:TARGet? on page 267

Host name
Unique host computer name of the connected instrument (if Address (format) is "Host
name".

Board Number
Unique board number of the connected instrument.

LAN device name
Defines the protocol and the instance number of a sub-instrument;

"inst0" VXI-11 protocol

"hislip0" HiSLIP protocol

VISA Resource String
The VISA resource string determined from the defined information, to be used by the
R&S VSE to identify and control the connected instrument.

For details see chapter 7.2.1.1, "LAN Interface", on page 54.
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Status
Indicates the current state of the connection to the specified instrument in the network
after a Check was performed.

Check
Checks the connection state to the instrument specified by the VISA resource string.
The result is indicated under Status.

7.2.4 Searching for Connected Instruments Automatically

Access: "Window" > "Instruments" > "Search"

Alternatively to defining the connection information manually, the R&S VSE can search
for all instruments connected to the same network as the PC running the R&S VSE
software. You can then select the instrument to be controlled by the R&S VSE software
from the detected instruments.

Search...........................................................................................................................61
Stop...............................................................................................................................62
Interface Type............................................................................................................... 62
Results.......................................................................................................................... 62
Filter.............................................................................................................................. 62
Connect LXI.................................................................................................................. 62

Search
Starts a network search for connected instruments using the specified Interface Type.
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Note that this search may take a while. Results are only displayed when the search is
completed.

Stop
Stops a search for connected instruments.

Interface Type
Specifies the interface protocol used to connect the instrument to the network.

For details on interfaces see chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 53

"VXI-11" Standard TCP/IP-based protocol

"HiSlip" High performance protocol

Remote command: 
DEVice:TARGet:TYPE on page 268

Results
For each instrument detected in the network, the following information is provided:
● Interface Type
● Instrument model name
● VISA Resource String

(The full information is displayed when you select the arrow button for a result
entry.)

Filter
Applies a filter to the instrument search. Only instruments whose resource string con-
tains the specified characters are displayed.

Connect LXI
Opens the LXI configuration home page for the instrument in use. This allows you to
configure or operate the instrument directly from a Web browser. For details see the
instrument's user documentation.

7.2.5 Deleting all Instrument Configurations

Access: "File" > "Instruments" > "Delete All"

You can delete the connection settings of all defined instruments in one step. Note that
after deleting a connection, the instrument is no longer known to the R&S VSE soft-
ware.

Instrument configurations are also deleted when you use the preset function "File" >
"Preset" > "All & Delete Instruments", see "Restoring All Default Settings and Deleting
Instrument Configurations ( Preset All & Delete Instruments )" on page 76.

Remote command:

DEVice:DELete:ALL on page 266
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7.2.6 Initializing a Self-Alignment on the instrument in use

Access: "Window" > "Instruments" > "Self Alignment"

Once configured, you can perform a self-alignment on any instrument connected to the
R&S VSE software.

When you put the instrument into operation for the first time or when strong tempera-
ture changes occur, it may be necessary to align the data to a reference source.

During instrument start, the installed hardware is checked against the current firmware
version to ensure the hardware is supported. If not, self-alignment fails until the firm-
ware version is updated.

The correction data and characteristics required for the alignment are determined by
comparison of the results at different settings with the known characteristics of the
instrument's high-precision calibration signal source.

7.2.7 Configuring the Behavior During Remote Control

Access: "Window" > "Instruments" > "Infos &Settings" > "General" tab

When the R&S VSE software is used to capture and analyze input from a connected
instrument, the instrument is operated in remote mode. Some general settings are
available to define how the instrument behaves during remote control and whether
access by multiple users to the same instrument is allowed.

Local Lockout................................................................................................................ 63
Display Update..............................................................................................................64
VISA lock state..............................................................................................................64

Local Lockout
If enabled, the instrument is set to be controlled remotely (that is, by the R&S VSE soft-
ware) and the keys or graphical user interface are disabled.
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See also chapter 12.1.7, "Locking Instruments for Exclusive Remote Control",
on page 250.

Remote command: 
DEVice:GENeral:LLO on page 270

Display Update
Defines whether the display of the instrument in use is updated while it is being control-
led by the R&S VSE software.

Turning off the display update function improves performance.

Tip: you can also turn off the display update function for the R&S VSE software, see
"Remote Display Update" on page 251.

Remote command: 
DEVice:GENeral:DISPlay on page 270

VISA lock state
Locks or unlocks the VISA connection to the selected instrument. If the connection is
locked, no other devices can operate the same instrument remotely. If no connection to
the instrument has been established yet, any subsequent connection to it is locked
immediately (see also chapter 12.1.7, "Locking Instruments for Exclusive Remote Con-
trol", on page 250).

Tip: you can change the default value for the VISA lock for subsequent connections in
the user preferences, see "Lock new VISA connections" on page 252.

Remote command: 
DEVice:LOCKing on page 271
DEVice:LOCKing:ALL on page 272

7.2.8 Configuring a Frequency Reference for the Connected Instrument

Access: "Window" > "Instruments" > "Infos & Settings" > "Reference" tab

An instrument in use can use the internal reference source or an external reference
source as the frequency standard for all internal oscillators. A crystal oscillator is used
as the internal reference source. If an external reference is used, all internal oscillators
of the instrument in use are synchronized to the external reference frequency.

External references must be connected to the instrument in use correctly. For details
see the instrument's "Getting Started" manual.
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The default setting is the internal reference. When an external reference is used, "EXT
REF" is displayed in the status bar.

Reference Frequency Input Source.............................................................................. 65
Tuning Range................................................................................................................65
Frequency..................................................................................................................... 65
Loop Bandwidth............................................................................................................ 66
Reference Frequency Output........................................................................................66
Resetting the Default Values.........................................................................................66

Reference Frequency Input Source
Various sources are available to provide a reference frequency to the instrument in
use, depending on the type of instrument. The available reference parameters also
depend on the instrument type. For details see the instrument's User Manual.

Remote command: 
DEVice:EXTRef:SOURce on page 274

Tuning Range
The tuning range is only available for the variable external reference frequency. It
determines how far the frequency may deviate from the defined level in parts per mil-
lion (10-6).

For more information see the instrument's User Manual.

Remote command: 
DEVice:EXTRef:TRANge on page 275

Frequency
Defines the external reference frequency to be used (for variable connectors only).

For more information see the instrument's User Manual.

Remote command: 
DEVice:EXTRef:FREQuency on page 272
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Loop Bandwidth
Defines the speed of internal synchronization with the reference frequency. The setting
requires a compromise between performance and increasing phase noise.

For more information see the instrument's User Manual.

Remote command: 
DEVice:EXTRef:LBWidth on page 273

Reference Frequency Output
The instrument in use can provide a reference frequency to other instruments that are
connected to this instrument. If one of the options is activated, the reference signal is
output to the corresponding connector.

For more information see the instrument's User Manual.

Remote command: 
DEVice:EXTRef:O100 on page 273
DEVice:EXTRef:O640 on page 274
DEVice:EXTRef:OSYNc on page 274

Resetting the Default Values
The values for the "Tuning Range", "Frequency" and "Loop Bandwidth" are stored for
each source of "Reference Frequency Input". Thus, when you switch the input source,
the previously defined settings are restored. You can restore the default values for all
input sources using the "Preset Channel" function.

7.2.9 Obtaining Information on Versions and Options on the instrument
in use

Access: "Window" > "Instruments" > "Infos &Settings" > "Info" tab

Information on the firmware version and options installed on the instrument in use is
provided.
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Identification String........................................................................................................67
Options..........................................................................................................................67

Identification String
Indicates the instrument identification for the selected instrument.

The syntax is:
"Rohde&Schwarz,<instrument type>,<part number>/serial
number>,<firmware version>"
Remote command: 
DEVice:INFO:IDN? on page 269

Options
Provides a list of all hardware and software options installed on the instruement.

For details on options refer to the instrument's documentation.

Remote command: 
DEVice:INFO:HWINfo? on page 268
DEVice:INFO:OPT? on page 269

7.3 Controlling Measurement Channels, Groups, and
Sequences

Access: "Window" > "Measurement Group Setup"

Measurement channels, groups, and sequences are configured and controlled in the
"Measurement Group Setup" tool window.

● Sequence Functions............................................................................................... 68
● Group Functions......................................................................................................69
● Channel Functions.................................................................................................. 71
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7.3.1 Sequence Functions

Measurement sequences can perform multiple measurements on the same instrument,
without switching between measurement channels manually.

Measurement sequences consist of a number of measurement groups, and each
group may contain multiple channels.

For details see "Measurement groups and sequences" on page 30.

Play............................................................................................................................... 68
Stop...............................................................................................................................68
Measurement mode ( Single / Continuous )..................................................................69
Record...........................................................................................................................69

Play
"Play" starts a new measurement sequence according to the "Measurement mode
( Single / Continuous )" on page 69.

Remote command: 
INITiate:SEQuencer:IMMediate on page 298

Stop
Stops a running measurement sequence.

Remote command: 
INITiate:SEQuencer:ABORt on page 297
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Measurement mode ( Single / Continuous )
Defines the measurement mode for the entire measurement sequence and all mea-
surement groups and channels it contains.

For details see "Measurement mode" on page 31.

"Single" Each measurement group is started one after the other in the order of
definition. All measurement channels in a group are started simulta-
neously and performed once. After all measurements are completed,
the next group is started. After the last group, the measurement
sequence is finished.

"Continuous" Each measurement group is started one after the other in the order of
definition. All measurement channels in a group are started simulta-
neously and performed once. After all measurements are completed,
the next group is started. After the last group, the measurement
sequence restarts with the first one and continues until it is stopped
explicitely (see "Play" on page 68).

Remote command: 
INITiate:SEQuencer:MODE on page 298

Record
Currently not available.

7.3.2 Group Functions

All measurement channels that are to be started at the same time must be configured
within a group.

Multiple groups of measurement channels can be configured, for example to group
measurements for a specific test scenario.

For details see "Measurement groups" on page 28.
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Activate/Deactivate Group............................................................................................ 70
New Group.................................................................................................................... 70
Capture......................................................................................................................... 71
Pause / Cont................................................................................................................. 71
Measurement mode ( Single / Continuous )..................................................................71
Record...........................................................................................................................71
Close............................................................................................................................. 71

Activate/Deactivate Group
If activated, the group is included in a measurement sequence.

Remote command: 
INSTrument:BLOCk:USE on page 297

New Group
Inserts a new group in the "Measurement Group Setup" tool window.

Remote command: 
INSTrument:BLOCk:CREate[:NEW] on page 295
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Capture
Starts a new measurement (and restarts averaging) for all active measurement chan-
nels in the group. Only channels with distinct input types can be active at the same
time. The results for each channel are displayed whenever the measurement is com-
pleted, independently of the other channels.

Remote command: 
INITiate:BLOCk:IMMediate on page 294

Pause / Cont
"Pause" stops a running measurement on the group.

"Cont" continues a measurement group (including any averaging procedures) that was
temporarily interrupted.

To restart averaging with the next measurement, use the  ("Capture") function after
stopping the last channel.

Remote command: 
INITiate:BLOCk:ABORt on page 293
INITiate:BLOCk:CONMeas on page 293

Measurement mode ( Single / Continuous )
Defines the measurement mode for the group itself and all measurement channels it
contains.

For details see "Measurement mode" on page 31.

"Single" All measurement channels in the group are started simultaneously
and performed once.

"Continuous" All measurement channels in the group are started simultaneously.
After all measurements are completed, the group restarts all mea-
surements again.

Remote command: 
INITiate:BLOCk:CONTinuous on page 293

Record
Currently not available.

Close
Removes the group and closes all measurement channels and windows it included.

Remote command: 
INSTrument:BLOCk:DELete on page 296

7.3.3 Channel Functions

A measurement channel determines the measurement settings for a specific applica-
tion.

For details see "Measurement channels" on page 27.
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Activate/Deactivate Channel......................................................................................... 72
Assigning the Channel Input Source.............................................................................72

└ Input Type.......................................................................................................72
└ Instrument.......................................................................................................73

└ Input Source......................................................................................... 73
└ File.................................................................................................................. 73
 New Channel.................................................................................................... 73
└ Duplicate Current Channel..............................................................................73

Replace Current Channel..............................................................................................73
Capture......................................................................................................................... 74
Pause / Cont................................................................................................................. 74
Measurement mode ( Single / Continuous )..................................................................74
Record...........................................................................................................................74
New Measurement Window.......................................................................................... 74
Close............................................................................................................................. 75
Select Channel..............................................................................................................75

Activate/Deactivate Channel
If activated, the measurement is included in a group measurement.

Note that channels are deactivated automatically if the same instrument is assigned to
multiple measurement channels of the same group. The channel to which the instru-
ment was previously assigned is deactivated (the checkmark is removed).

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:USE on page 295

Assigning the Channel Input Source
For each measurement channel, the input source must be configured. The following
settings are displayed when you expand the channel settings in the "Measurement
Group Setup" tool window (toggle the +/- icon).

Input Type ← Assigning the Channel Input Source
Selects an instrument or a file as the type of input provided to the channel.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce on page 285
INPut:SELect on page 314
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Instrument ← Assigning the Channel Input Source
Specifies a configured instrument to be used for input.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:DEVice<d> on page 284

Input Source ← Instrument ← Assigning the Channel Input Source
Configures the source of input (and channel) on the selected instrument to be used.

"RF" Radio Frequency ("RF INPUT" connector)

"Channel 1 | Channel 2 | Channel 3 | Channel 4 "
Oscilloscope input channel 1, 2, 3, or 4.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce:TYPE on page 285

File ← Assigning the Channel Input Source
Specifies the I/Q data file to be used for input.

Select a file from the list of recently loaded files, or select "..." to open the "Load I/Q
File" dialog box (see chapter 8.3.4.1, "Loading the I/Q Data File and Essential Mea-
surement Information", on page 92).

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar] on page 283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV on page 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW on page 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT on page 279

 New Channel
A selection list of available applications is displayed. A new channel for the selected
application is created.

For a list of available applications see chapter 5.2, "Available Applications", on page 32

Remote command: 
INSTrument:CREate[:NEW] on page 289
INSTrument[:SELect] on page 292

Duplicate Current Channel ← New Channel
Alternatively to selecting a new application from the selection list of available applica-
tions, you can duplicate the currently active channel. In this case, a new measurement
channel of the same type and with the identical measurement settings is started. The
name of the new channel is the same as the copied channel, extended by a consecu-
tive number (e.g. "Spectrum" -> "Spectrum 2").

Remote command: 
INSTrument:CREate:DUPLicate on page 289

Replace Current Channel
A selection list of available applications is displayed. The currently selected channel is
replaced by the selected application.
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For a list of available applications see chapter 5.2, "Available Applications", on page 32

Remote command: 
INSTrument:CREate:REPLace on page 290

Capture
Starts a new measurement (and restarts averaging) for the measurement channel.

Remote command: 
INITiate<n>[:IMMediate] on page 288

Pause / Cont
"Pause" stops a running measurement.

"Cont" continues a measurement (including any averaging procedures) that was tem-
porarily interrupted.

To restart averaging with the next measurement, use the  ("Capture") function after
stopping the last measurement.

Remote command: 
ABORt on page 286
INITiate<n>:CONMeas on page 287

Measurement mode ( Single / Continuous )
Defines how data is captured during the measurement.

For details see "Measurement mode" on page 31.

"Single" A single measurement is performed, that is: data is captured for the
specified measurement time.
For the "Input Source": "File", a single record is replayed. To replay
subsequent records, continue the measurement using the  ("Pause/
Continue") function.

"Continu-
ous"

A continuous measurement is performed, that is: data is captured
continuously until the measurement is stopped manually using the the

 ("Pause/Continue") function.
For the "Input Source": "File", the data from the I/Q file is replayed
continuously until stopped.

Remote command: 
INITiate<n>:CONTinuous on page 287

Record
Starts a measurement and stores the measurement data to a temporary file. You can
then use the data in the stored file as input for analysis at a later time or using a differ-
ent application.

For details see chapter 8.3.1, "Recording Measurement Data", on page 86.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:RECord on page 289

New Measurement Window
Adds a new window with the selected result display for the measurement channel.
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Close
Removes the measurement channel from the group and closes all windows.

Select Channel

Selects a channel from the list of configured channels in the "Control" toolbar.

In the "Measurement Group Setup" window, the selected channel is highlighted. The
corresponding channel bar info is displayed and the focus is set on the default window
for that channel. The menus are adapted to the selected application.

Remote command: 
INSTrument[:SELect] on page 292
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8 Data Management
The captured data and measurement results from the R&S VSE can be stored to files.
Furthermore, measurement and software settings can be stored.

● Restoring the Default Software Configuration (Preset)...........................................76
● Storing and Recalling Measurement Settings.........................................................77
● Recording and Recalling Captured I/Q Data for Evaluation....................................85
● Printing Current Measurement Results...................................................................97

8.1 Restoring the Default Software Configuration (Preset)

Access: "File" > "Preset"

When delivered, the R&S VSE has a default configuration. You can restore this defined
initial state at any time as a known starting point for measurements. This is often rec-
ommendable as a first step in troubleshooting when unusual measurement results
arise.

Settings can be restored in different levels:

Restoring All Default Settings ( Preset All )...................................................................76
Restoring All Default Settings and Deleting Instrument Configurations ( Preset All &
Delete Instruments )......................................................................................................76
Restoring Channel Settings ( Preset Selected Channel )............................................. 77
Restoring User-Specific Settings ( Reset VSE Layout )................................................77

Restoring All Default Settings ( Preset All )
Restores the initial software state, that is: all measurement sequences, groups and
channels are stopped and all windows are closed; the default group and I/Q Analyzer
measurement channel are restored.

Settings concerning the layout of the R&S VSE window, for example the display and
position of toolbars and special tool windows, remain unchanged.

Note:
The initial software state is also restored if you delete the shutdown file (see "Deleting
the Shutdown File" on page 102).

Remote command: 
*RST on page 263 or SYSTem:PRESet on page 388

Restoring All Default Settings and Deleting Instrument Configurations ( Preset
All & Delete Instruments )
Restores the initial software state, that is: all measurement sequences, groups and
channels are stopped and all windows are closed; the default group and I/Q Analyzer
measurement channel are restored.

In addition, all instrument configurations are deleted (see ).
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Settings concerning the layout of the R&S VSE window, for example the display and
position of toolbars and special tool windows, remain unchanged.

Remote command: 
*RST on page 263 or SYSTem:PRESet on page 388
+
DEVice:DELete:ALL on page 266

Restoring Channel Settings ( Preset Selected Channel )
Resets the currently selected measurement channel only to its default settings.

This function has the same effect as the "Preset Channel" on page 128 function in the
Configuration "Overview".

Remote command: 
SYSTem:PRESet:CHANnel[:EXECute] on page 388

Restoring User-Specific Settings ( Reset VSE Layout )
Restores user-defined settings, for example the display and position of toolbars and
special tool windows or lists of most recently defined input values (e.g. IP addresses of
connected instruments).

Measurement channels remain unchanged.

User-defined settings are stored in the file
C:\ProgramData\Rohde-Schwarz\VSE\<version_number>\user\
settings_pcsw_user.xml.

8.2 Storing and Recalling Measurement Settings

Possibly you would like to restore or repeat a measurement you performed under spe-
cific conditions using the R&S VSE. In this case, you can store and recall software and
measurement settings, and possibly other related measurement data.

Two different methods are available for managing measurement settings:

● Quick Save/Quick Recall - a defined set of measurement or channel settings are
stored or recalled quickly in just one step

● Configurable Save/Recall - a user-defined set of measurement or channel settings
are stored to a definable storage location
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Restrictions when recalling measurement settings
When recalling a saved configuration file, the following restrictions apply:
● The frequency range defined in the configuration file must be supported by the

instrument in use for the channel to which the file is to be recalled.
● Configuration files created using an instrument with certain options in use will not

work using an instrument without these options
● Files created with newer software versions may not work with a previous version
● Depending on the general software setting, instrument configurations are restored,

but the connections may have to be established manually (see "Reconnect saved
connections after recall" on page 102).

● Quick Save/Quick Recall.........................................................................................78
● Configurable Storage and Recall............................................................................ 80

8.2.1 Quick Save/Quick Recall

The Quick Save and Quick Recall functions allow you to store channel settings very
easily and quickly in one step. Up to 10 different sets of settings can be stored to or
recalled from "save sets". Each save set is identified by its storage date and contents
(all channels or specific channel) in the display. The save sets are stored in the C:/
ProgramData/Rohde-Schwarz/VSE/<version>/user/QuickSave directory, in
files named QuickSave1.dfl to QuickSave10.dfl. The storage file names and
locations cannot be changed.

During recall, save sets of type "All channels" replace the settings of the entire soft-
ware. All other save sets start a new measurement channel with the stored settings.

If a measurement channel with the same name as the channel to be restored is
already active, the channel name for the new channel is extended by a consecutive
number:

8.2.1.1 Quick Save / Quick Recall Settings

Access: "File" > "Save"/"Recall" > "Quick Save"/ "Quick Recall"

The "Quick Save" and "Quick Recall" dialog boxes are very similar and closely related.
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QuickSave 1 / ... / QuickSave 10.................................................................................. 79
Storage Type (Save only)............................................................................................. 79
Recall............................................................................................................................ 79

QuickSave 1 / ... / QuickSave 10
Selects one of the save sets to store the current settings in or to be recalled. At the
time of storage, the "QuickSave 1 / ... / QuickSave 10" placeholder is replaced by a
label indicating the storage date and time and the storage type.

During recall, save sets of type "All channels" replace the measurement settings of the
entire software. All other save sets start a new measurement channel with the stored
settings.

Storage Type (Save only)
Defines which type of settings is to be stored in the save set.

"All channels" The measurement settings for all currently active channels are
stored.

"Current Chan-
nel"

Only the measurement settings for the currently selected measure-
ment channel are stored.

Recall
Restores the channel settings as saved in the selected settings file. If the settings file
contains settings for a specific channel only a new channel with the stored settings is
activated, otherwise the entire measurement settings are loaded.

Note: If a measurement channel with the same name as the channel to be restored (in
a new channel) is already active, the channel name for the new channel is extended by
a consecutive number:
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In remote commands, you must append this number to the channel name, as well.

Remote command: 
MMEMory:LOAD:STATe on page 398

8.2.2 Configurable Storage and Recall

The more sophisticated storage and recall functions allow you to define which settings
are stored, and where the settings file is stored to. Any settings file can be selected for
recall.

● Stored Data Types.................................................................................................. 80
● Storage Location and File Name.............................................................................80
● Save and Recall Dialog Boxes................................................................................81
● Startup Recall Settings............................................................................................83

8.2.2.1 Stored Data Types

The following types of data can be stored to and loaded from files via the "Save" dialog
box on the R&S VSE:

Table 8-1: Items that can be stored to files

Item Description

Current Settings Current software and measurement settings

All Traces All active traces;

All Limit Lines All limit lines (Note: information on which limit lines are active is stored with
the "Current Settings")

Not available for I/Q Analyzer

Spectrogram Spectrogram display

Only available for I/Q Analyzer and Analog Demod applications

8.2.2.2 Storage Location and File Name

The storage location and file name are selected in a file selection dialog box which is
displayed when you perform a storage function.

By default, the name of a settings file consists of a base name followed by an under-
score and three numbers, e.g. limit_lines_005. In the example, the base name is
limit_lines. The base name can contain characters, numbers and underscores.
The file extension dfl is added automatically. The default folder for settings files is
C:/ProgramData/Rohde-Schwarz/VSE/<version>/user.
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Hidden folder
Note that the ProgramData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the file name, you can access the files
stored there.
Alternatively, enable the "Files and Folders: Hidden files and folders: Show hidden
files, folders, and drives" option in the Windows Explorer. (Press the ALT key to display
the menu bar. Select "Tools > Folder Options" > "View" tab.)
For more information refer to the Microsoft Windows documentation.

8.2.2.3 Save and Recall Dialog Boxes

Access: "File" > "Save"/"Recall" > "Save"/"Recall"

The "Save" and "Recall" dialog boxes are very similar and closely related.

Selecting the Storage Location - Drive/ Path/ Files.......................................................81
File Name......................................................................................................................82
Comment.......................................................................................................................82
File Type....................................................................................................................... 82
Items............................................................................................................................. 82
Save File....................................................................................................................... 83
Recall in New Channel / Recall in Current Channel......................................................83

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the settings file on the software or an external drive.
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The "Drive" indicates the internal (C:) or any connected external drives (e.g. a USB
storage device).

The "Path" contains the drive and the complete file path to the currently selected
folder.

The "Files" list contains all subfolders and files of the currently selected path.

The default storage location for the settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version>\user.

Note that the ProgramData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the file name, you can access the files
stored there. See also "Hidden folder" on page 81.

Remote command: 
MMEMory:CATalog? on page 389

File Name
Contains the name of the data file without the path or extension.

By default, the name of a settings file consists of a base name followed by an under-
score. Multiple files with the same base name are extended by three numbers, e.g.
limit_lines_005.

For details on the file name and location see chapter 8.2.2.2, "Storage Location and
File Name", on page 80.

Comment
An optional description for the data file. A maximum of 60 characters can be displayed.

Remote command: 
MMEMory:COMMent on page 390

File Type
Determines whether the global software settings with all channels will be stored or
recalled, or the current channel settings only.

Items
Defines which data and settings are stored or will be recalled. Depending on the "File
Type", only channel settings or global settings are available. Which items are available
also depends on the installed options (see also chapter 8.2.2.1, "Stored Data Types",
on page 80).

Remote command: 
MMEMory:SELect[:ITEM]:ALL on page 395
MMEMory:SELect[:ITEM]:DEFault on page 395
MMEMory:SELect[:ITEM]:HWSettings on page 396
MMEMory:SELect[:ITEM]:LINes:ALL on page 396
MMEMory:SELect[:ITEM]:NONE on page 396
MMEMory:SELect[:ITEM]:TRACe[:ACTive] on page 397
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Save File
Saves the settings file with the defined file name.

Remote command: 
MMEMory:STORe<n>:STATe on page 400
MMEMory:STORe<n>:STATe:NEXT on page 400

Recall in New Channel / Recall in Current Channel
Restores the measurement settings as saved in the selected settings file. If the set-
tings file contains settings for a specific channel only, select "Recall in New Channel"
to activate a new channel with the stored settings, or "Recall in Current Channel" to
replace the current channel settings.

Note: If a measurement channel with the same name as the channel to be restored (in
a new channel) is already active, the channel name for the new channel is extended by
a consecutive number:

In remote commands, you must append this number to the channel name, as well.

Remote command: 
MMEMory:LOAD:STATe on page 398

8.2.2.4 Startup Recall Settings

Access: "File" > "Recall"> "Startup Recall"

By default, the settings from the shutdown file (see "Create Shutdown File"
on page 101) or the default settings are restored when the R&S VSE software is star-
ted. However, you can select a different settings file to be restored.
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Startup Recall................................................................................................................84
Selecting the Storage Location - Drive/ Path/ Files.......................................................84
File Name......................................................................................................................85
Comment.......................................................................................................................85

Startup Recall
Activates or deactivates the startup recall function. If activated, the settings stored in
the selected file are loaded each time the software is started or preset. If deactivated,
the default settings are loaded.

Note that only All Channels settings files can be selected for the startup recall function,
not single channel settings files.

Remote command: 
MMEMory:LOAD:AUTO on page 398

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the settings file on the software or an external drive.

The "Drive" indicates the internal (C:) or any connected external drives (e.g. a USB
storage device).

The "Path" contains the drive and the complete file path to the currently selected
folder.

The "Files" list contains all subfolders and files of the currently selected path.

The default storage location for the settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version>\user.
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Note that the ProgramData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the file name, you can access the files
stored there. See also "Hidden folder" on page 81.

Remote command: 
MMEMory:CATalog? on page 389

File Name
Contains the name of the data file without the path or extension.

By default, the name of a settings file consists of a base name followed by an under-
score. Multiple files with the same base name are extended by three numbers, e.g.
limit_lines_005.

For details on the file name and location see chapter 8.2.2.2, "Storage Location and
File Name", on page 80.

Comment
An optional description for the data file. A maximum of 60 characters can be displayed.

Remote command: 
MMEMory:COMMent on page 390

8.3 Recording and Recalling Captured I/Q Data for Evalu-
ation

By default, when data is captured during a measurement, it is stored on the instrument
in use. The R&S VSE software accesses this data to analyze and display the results
for the channel.

If the captured I/Q data is required for further analysis at a later time or in a different
application, possibly using different settings, you can record the captured data. In this
case, the I/Q data is stored to a temporary file on the PC running the R&S VSE soft-
ware. These files can then be exported, that is: stored to a file permanently, at a user-
defined storage location. Exported I/Q data can then be recalled and used as input for
further measurements and analysis by the R&S VSE software.

Difference between Save and Export functions
The "Save" function described in chapter 8.2, "Storing and Recalling Measurement
Settings", on page 77 stores the finished measurement results (and settings), so that
the same results can be restored later in the same application.
However, if you would like to store the raw I/Q data as it is captured, without further
evaluation functions applied, in order to evaluate it using other functions or in a differ-
ent application, you must use the "Save I/Q Recording" functions described here. Note
that in order to export the raw (resampled) data, you must start recording directly at the
time of capture. Once the data has been captured without being recorded, it can no
longer be exported as raw (resampled) data.
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● Recording Measurement Data................................................................................ 86
● General Recording Settings....................................................................................87
● Exporting Recorded I/Q Data..................................................................................88
● Recalling Measurement Data from Files.................................................................92

8.3.1 Recording Measurement Data

If the captured I/Q data is required for further analysis at a later time or in a different
application, you can record the measurement results for a specific channel. In this
case, the (resampled) I/Q data is stored to a temporary file on the PC running the
R&S VSE software. The record length is defined as:

[<Measurement time> * <Number of records>] + <Additional settling samples>

where <Measurement time> is defined in the channel capture settings, and <Number
of records> and <Additional settling samples> are general recording settings (see
chapter 8.3.2, "General Recording Settings", on page 87).

Alternatively, the measurement time can be set to the maximum provided by the instru-
ment in use automatically.

When the recording is finished, the temporary file is automatically set to be the input
source for the selected channel. The measurement results stored in the first record are
immediately displayed. The temporary file can then be exported, that is: stored to a file
permanently. Recorded I/Q data files are available for export until one of the following
actions occur:

● A new measurement is performed. The temporary file is overwritten with each mea-
surement.

● The measurement channel is closed.
● The R&S VSE software is closed.
● The data acquisition settings are changed. In this case, the stored data no longer

matches the current settings and the data becomes "invalid". It can no longer be
exported.

Note that if a recording is aborted before it has completed, the temporary file is deleted
and the captured data is not available for evaluation or display.

To start recording measurement data for a channel

► To record measurement results select the  "Record" function for the channel in
the "Measurement Group Setup" tool window (see also "Record" on page 74).
Alternatively, select the "Record" icon in the toolbar to record the results for the
currently active measurement channel.

The captured I/Q data is recorded until the defined number of records have been
captured or recording is stopped manually.
The first recorded record is displayed immediately in the channel's result displays.
After recording has finished, the I/Q data can be exported to a file permanently,
see chapter 8.3.3, "Exporting Recorded I/Q Data", on page 88.
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To stop data recording

► To stop recording measurement results, select the  "Pause" function for the chan-
nel in the "Measurement Group Setup" tool window.

Note that if a recording is aborted before it has completed, the temporary file is
deleted and the captured data is not available for evaluation or display.

8.3.2 General Recording Settings

Access: "File" > "Preferences" > "Recording"

Some general settings concerning recording in the R&S VSE are available in the gen-
eral software settings.

Number of Records....................................................................................................... 87
Default Comment.......................................................................................................... 87
Always Maximum Record Length..................................................................................88
Additional Settling Samples.......................................................................................... 88

Number of Records
Defines the number of records to be stored. One record contains the data captured
during the defined measurement time for a single channel. If more measurements are
available than the specified number (x) of records, only the most recent (x) measure-
ment results are stored.As a rule, the recording is limited by the maximum record
length provided by the instrument.

Alternatively, all available records for a channel can be stored (see "Always Maximum
Record Length" on page 88). In this case, the "Number of Records" are disabled.

Remote command: 
RECord:COUNt on page 406

Default Comment
Defines a default text for the comment to the stored data file. This default comment is
displayed in the "Save I/Q Recording" dialog box (see Comment).

Remote command: 
RECord:COMMent[:DEFault] on page 406
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Always Maximum Record Length
If enabled, all available records for a channel are stored. The "Number of Records" is
ignored (and disabled).

If disabled, only the most recent "Number of Records" on page 87 are stored.

Remote command: 
RECord:MAXimum:RLEN on page 407

Additional Settling Samples
Stores additional samples (in addition to the specified capture time) for the channel to
compensate for settling effects.

This setting is required for connected instruments that require resampling. The addi-
tional samples compensate for settling effects in the filters used by the resampler.

You can recognize the use of a resampler by the "Resampler active" message in the
status bar of the R&S VSE.

Remote command: 
RECord:SETTling:TIME on page 407

8.3.3 Exporting Recorded I/Q Data

Access: "File" > "Save I/Q Recording"

Recorded data from a instrument in use can be stored to a file permanently. You can
then use the data in the export file as input for analysis at a later time or using a differ-
ent application.

Results can only be stored for the currently selected measurement channel and only
after measurement data has explicitely been recorded (see chapter 8.3.1, "Recording
Measurement Data", on page 86).
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Selecting the Storage Location - Drive/ Path/ Files.......................................................89
File Name......................................................................................................................89
File Type....................................................................................................................... 89
Comment.......................................................................................................................89
Meta Data Settings........................................................................................................90
Save.............................................................................................................................. 91

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the I/Q data file on the PC or an external drive.

The "Drive" indicates the internal (C:) or any connected external drives (e.g. a USB
storage device).

The "Path" contains the drive and the complete file path to the currently selected
folder.

The "Files" list contains all subfolders and files of the currently selected path.

Remote command: 
MMEMory:CATalog? on page 389

File Name
Contains the name of the data file without the path or extension.

For details on the file name and location see chapter 8.2.2.2, "Storage Location and
File Name", on page 80.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar] on page 283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV on page 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW on page 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT on page 279

File Type
Various file types are supported for I/Q data import and export.

Note: For best performance and to ensure comprehensive meta data is available, use
the iq.tar format. This is a widely used file format for Rohde & Schwarz products.
For details on the supported file formats see chapter A.5, "Reference: Supported File
Formats", on page 460.

"iq.tar" Compressed file format for an individual measurement channel or
several channels with identical capture settings (sample rate, band-
width)

"csv" Comma-separated ASCII file format

"iqw" Binary file format; contains only I/Q data from a single channel, with-
out any meta data

"mat" Matlab file format v.4 or v.7 (v.7 requires Matlab Runtime installation)

Remote command: 
Exporting I/Q recording files:
EXPort:IQ:FORMat on page 402

Comment
Inserts a descriptive comment to the data file.
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Tip: if a default comment is defined in the general recording settings (see "Default
Comment" on page 87), it is provided as a default here.

Remote command: 
MMEMory:STORe<n>:IQ:COMMent on page 405

Meta Data Settings
Defines which meta data is included in the data file. Meta data is required to restore
the measurement settings when the data file is recalled as input for the R&S VSE soft-
ware later.

Note that only the settings used during recording are stored; subsequent changes to
the settings are ignored.

For iqw file format, no meta data is available.

"Min" The minimum set of measurement settings required to restore the
channel later are stored. In particular, this includes:
● Reference level
● Center frequency
● Input path
● Analysis bandwidth
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"Max" All available meta data from the entire signal processing chain (input
path to the output) is stored.

In particular, this may include (depending on the type of measure-
ment channel and instrument in use):
● Amplitude parameters:

– Reference level
– Electronic attenuation
– Mechanical attenuation
– Preamplifier
– Input impedance
– Input coupling
– Range

● Frequency parameters:
– Center frequency

● Input parameters:
– Recording device (instrument providing the data)
– Calibration state
– External reference
– Input path
– Highpass filter state
– YIG preselector

● I/Q parameters:
– Analysis bandwidth
– Filter settings

● Trigger parameters:
– Trigger source
– Trigger position
– Trigger level
– Trigger slope
– Trigger holdoff
– Trigger hysteresis

"Custom" A user-definable set of meta data (subset of "Full") is stored.

Remote command: 
EXPort:IQ:META:DATA on page 402
EXPort:IQ:META:DATA:SET on page 403

Save
Stores the captured data to the specified file.

Remote command: 
EXPort:IQ:FILE on page 402
MMEMory:STORe<n>:IQ:STATe on page 405
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8.3.4 Recalling Measurement Data from Files

When measurement (I/Q) data is recorded to a file, not only the result data is stored,
but also the essential instrument and measurement settings required to obtain those
results. Thus, when you recall a measurement file, the stored settings are restored in
the R&S VSE software, as well. This enables you to repeat the stored measurement
under the same conditions - assuming the file was recorded on a compatible instru-
ment and contains the required measurement information.

Recalling measurement data from a file results in a measurement channel being acti-
vated with the input source "File". You can then "replay" the measurement and the
stored results, or even just an extract of the entire measurement.

When measurement results are recorded, the recorded data is immediately used as
input for further analysis in the R&S VSE software. Therefore, the input source is
switched to "File", rather than "Instrument". However, the instrument settings are main-
tained so that you can switch back to the instrument as an input source quickly.

In order to recall measurement results, the I/Q data file and essential measurement
information must first be selected. Then the results of the entire measurement, or only
a specific extract of it, can be restored.

● Loading the I/Q Data File and Essential Measurement Information....................... 92
● Restoring the Measurement Results - R&S VSE Player.........................................94

8.3.4.1 Loading the I/Q Data File and Essential Measurement Information

Access: I/Q files are recalled using the "Recall I/Q Recording" dialog box which is dis-
played when you do one of the following:
● Select the "Recall I/Q Recording" icon from the main toolbar.
● Select the "File > Recall IQ Recording" menu item.
● Select the "Input & Output > Input Source" menu item and switch to the "I/Q File"

tab. Select the "Select file" button.
● Select the "Input source": "File" for a measurement channel, then select the "..."

button to select the I/Q data file to be loaded.
● In the R&S VSE Player ("Window > Player"), select the "..." button to select the I/Q

data file to be loaded.
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Selecting the Storage Location - Drive/ Path/ Files.......................................................93
File Name......................................................................................................................93
Essential Information.....................................................................................................94

└ Sample Rate................................................................................................... 94
└ Acquisition Bandwidth.....................................................................................94
└ I/Q Format.......................................................................................................94

Meta Information........................................................................................................... 94

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the I/Q data file on the PC or an external drive.

The "Drive" indicates the internal (C:) or any connected external drives (e.g. a USB
storage device).

The "Path" contains the drive and the complete file path to the currently selected
folder.

The "Files" list contains all subfolders and files of the currently selected path.

Remote command: 
MMEMory:CATalog? on page 389

File Name
Contains the name of the data file without the path or extension.

For details on the file name and location see chapter 8.2.2.2, "Storage Location and
File Name", on page 80.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar] on page 283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV on page 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW on page 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT on page 279
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Essential Information
Defines the channel-specific information required to re-configure the recorded mea-
surement. If the I/Q data file contains measurement information, it is displayed read-
only. For iqw files or files stored by applications other than R&S VSE that do not con-
tain this information, the essential information must be provided manually.

Sample Rate ← Essential Information
If a stored sample rate is available, it is indicated for reference only and cannot be
changed. If not available, the sample rate used to obtain the stored data must be
specified manually.

Acquisition Bandwidth ← Essential Information
The bandwidth of the data that was stored to the file.

If the bandwidth of the stored data is available, it is indicated and cannot be changed.

If the bandwidth was not stored, a default value of 0.8 * Sample Rate is used. This
value can be changed manually.

I/Q Format ← Essential Information
Determines how the stored I/Q data is to be interpreted. The available formats depend
on the file type.

"IIQQ |
IQBLock"

First all I-values are listed, then the Q-values
(I,I,I,I,I,I,...Q,Q,Q,Q,Q,Q)
.iqw format only

"IQIQ | IQPair" One pair of I/Q values after the other is listed
(I,Q,I,Q,I,Q...).
.iqw format only

"Complex" .iq.tar format only (cannot be edited)

"Polar" .iq.tar format only (cannot be edited)

Meta Information
Provides additional general information on the data file, if available. This information is
provided for reference only and cannot be edited.

8.3.4.2 Restoring the Measurement Results - R&S VSE Player

In order to replay the stored measurements in individual channels, the R&S VSE soft-
ware provides a special tool: the R&S VSE Player. Using the R&S VSE Player you can
play back the entire measurement, or only a specific time span, and you can define
how to process multiple records.

The R&S VSE Player is available via the "Window > Player" menu item.
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If available, the loaded I/Q file for the selected measurement channel is displayed. You
can also load a different I/Q file directly in the R&S VSE Player.

Alternatively to the R&S VSE Player you can use the  ("Play") function in the "Mea-
surement Group Setup" tool window to replay a channel for which the "Input Source":
"File" is selected and a file is loaded.
For details see "Play" on page 68.

Changing data acquisition settings for a stored measurement
When replaying stored measurement data from a file, you can change the Data Acqui-
sition and Bandwidth Settings, for example:
● Sample rate / Analysis bandwidth: The R&S VSE provides an internal resampler,

which allows you to change the sample rate, or bandwidth, or both, of the replayed
I/Q data

● Center frequency: You can shift the center frequency of the current measurement
compared to the stored measurement data. The maximum shift depends on the
channel's current analysis bandwidth.
For details see "Center frequency" on page 144.

● I and Q paths: Swap the I and Q values for the measurement, for example to com-
pare the data to another measurement in which the instrument ports were swap-
ped.

Capture......................................................................................................................... 95
Pause / Cont................................................................................................................. 96
Measurement mode ( Single / Continuous )..................................................................96
File................................................................................................................................ 96
Playback Settings..........................................................................................................96
Overlap Settings............................................................................................................97

Capture
Starts replaying the data from the I/Q file from the beginning for the measurement
channel. Any averaging procedures are restarted.

In "Single" measurement mode, the first record in the I/Q data file is replayed.
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In "Continuous" measurement mode, the entire measurement in the I/Q data file is
replayed continuously, starting at the beginning.

Remote command: 
INITiate<n>[:IMMediate] on page 288

Pause / Cont
"Pause" stops replaying data.

"Cont" continues replaying data (including any averaging procedures) at the current
position.

In "Single" measurement mode, the next record in the I/Q data file is replayed.

To restart averaging, use the  ("Capture") function after stopping the last measure-
ment.

Remote command: 
ABORt on page 286
INITiate<n>:CONMeas on page 287

Measurement mode ( Single / Continuous )
Defines how data is replayed during the measurement.

"Single" A single record is replayed. To replay subsequent records, continue
the measurement using the  ("Pause/Continue") function.

"Continu-
ous"

The data from the I/Q file is replayed continuously until stopped.

Remote command: 
INITiate<n>:CONTinuous on page 287

File
Specifies the I/Q data file to be used for input.

Select a file from the list of recently loaded files, or select "..." to open the "Load I/Q
File" dialog box (see chapter 8.3.4.1, "Loading the I/Q Data File and Essential Mea-
surement Information", on page 92).

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar] on page 283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV on page 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW on page 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT on page 279

Playback Settings
The data to be replayed can be restricted to a specified capture time within the stored
measurement data.

Use the sliders or enter time values to define:
● Start time: the measurement time at which replay starts
● Current Position: the time in the measurement span that is currently being dis-

played
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● Stop time: the measurement time at which replay stops

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:TIME on page 282
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:SAMPle
on page 281
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:TIME
on page 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:SAMPle
on page 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:TIME on page 283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:SAMPle
on page 282

Overlap Settings
The overlap settings determine how successive records within one data file are
replayed.

After the first record has been replayed, the specified percentage (x) of the next record
is displayed together with the remaining data (meas time - x) from the previous record.

The larger the overlap, the slower the display is updated.

The behaviour can be defined depending on the used trace mode. Note that the
behaviour is applied to all windows of the same channel.

"Averaging
On:"

Applies if any trace in the channel uses average, max hold or aver-
age trace mode.

"Averaging
Off:"

Applies if no averaging trace modes are used in the channel.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:ON
on page 281
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:OFF
on page 280

8.4 Printing Current Measurement Results

Access: "File" > "Print"

In order to document the graphical results and the most important settings for the cur-
rently performed measurement, you can create a hardcopy or screenshot of the current
display.

Remote commands for these settings are described in chapter 13.7.6, "Storing or Print-
ing Screenshots", on page 407.
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To print a screenshot of the current display with the current settings immediately, with-
out switching to the "Print" dialog, use the  "Print" icon in the toolbar.

 Print..........................................................................................................................99
Print to...........................................................................................................................99
Copies........................................................................................................................... 99
Print Logo......................................................................................................................99
Print Date and Time...................................................................................................... 99
Comment.......................................................................................................................99
Windows........................................................................................................................99
Orientation.....................................................................................................................99
Scaling.......................................................................................................................... 99
Windows / Page.......................................................................................................... 100
Colors..........................................................................................................................100
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 Print
Starts printing out all measurement results displayed on the screen: diagrams, traces,
markers, marker lists, limit lines, etc.. Optionally, comments and the date and time are
included at the bottom margin of the printout. All displayed items belonging to the soft-
ware user interface (e.g. toolbars or dialog boxes) are not printed out.

Remote command: 
HCOPy:ITEM:ALL on page 411
HCOPy[:IMMediate<device>] on page 411
HCOPy[:IMMediate<device>]:NEXT on page 411

Print to
Specifies a printer configured for the PC the R&S VSE software is installed on.

Copies
Defines the number of copies to be printed.

Print Logo
Activates/deactivates the printout of the Rohde & Schwarz company logo in the upper
left corner.

Remote command: 
DISPlay:LOGO on page 408

Print Date and Time
Activates/deactivates the printout of the current date and time at the bottom of the
screenshot.

Remote command: 
HCOPy:TDSTamp:STATe<device> on page 412

Comment
Defines an optional comment to be printed with the screenshot of the display. Maxi-
mum 120 characters are allowed. 60 characters fit in one line. In the first line, at any
point a manual line-feed can be forced by entering "@".

The comment is printed below the diagram area, but not displayed on the screen.

Remote command: 
HCOPy:ITEM:WINDow:TEXT on page 411

Windows
Selects the result display windows to be included in the screenshot. By default, all
active windows are included.

Orientation
Selects the page orientation of the printout: portrait or landscape

Remote command: 
HCOPy:PAGE:ORIentation<device> on page 412

Scaling
Selects the scaling of the printout on the paper. A preview using the selected setting is
displayed in the dialog box.
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"Maintain
aspect ratio"

The diagram is scaled only as required to fit the available paper size,
while maintaining the original aspect ratio.

"Size to fit" (Default) Scales the printout to fit the paper size optimally.

Windows / Page
Defines the number of diagrams to be printed on a single page.

Colors
Opens the "Print Color" dialog box to configure the colors for printing screenshots. For
details see "Print colors" on page 105.
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9 General Software Preferences
Some basic software settings can be configured independently of the selected operat-
ing mode or application. Usually, you will configure most of these settings initially when
you set up the software according to your personal preferences or requirements and
then only adapt individual settings to special circumstances when necessary. Some
special functions are provided for service and basic system configuration.

Recording, Network and Remote Settings
Recording settings are described in chapter 8, "Data Management", on page 76.
Settings for network and remote operation are described in chapter 12.2, "Network and
Remote Control Settings", on page 250.

● General Software Behavior...................................................................................101
● Display Settings.................................................................................................... 102
● How to Configure the Colors for Display and Printing...........................................107
● Software Information and Support........................................................................ 108

9.1 General Software Behavior

Access: "File" > "Preferences" > "General"

You can determine the behavior of the software when it is being shut down and restar-
ted.

Create Shutdown File..................................................................................................101
Reconnect saved connections after recall.................................................................. 102
Deleting the Shutdown File......................................................................................... 102
Defining a Startup Settings File...................................................................................102

Create Shutdown File
If activated, a shutdown file is created when the R&S VSE software is closed. The
shutdown file contains information on the defined connections, as well as measure-
ment sequence and channel configuration, such as which input sources are used for
which measurement channels and which result displays are active.
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When the R&S VSE software is started again, the previously stored configuration is
restored. If you delete the shutdown file (see "Deleting the Shutdown File"
on page 102), the R&S VSE software starts in the default configuration the next time.

The shutdown file is stored located at
C:\ProgramData\Rohde-Schwarz\VSE\<version_number>\results\
Shutdown.dfl.

Reconnect saved connections after recall
If activated, when stored measurement settings are recalled, a connection is automati-
cally established to all configured instruments (see chapter 8.2, "Storing and Recalling
Measurement Settings", on page 77).

If deactivated, the instrument configurations are restored in the "Instruments" window;
however, the connections must be established manually (see "Connect / Disconnect"
on page 58).

Deleting the Shutdown File
Access: "Start" > "All Programs" > "Rohde-Schwarz" > "VSE" > <version_number> >
"Delete Shutdown File"

In the Windows "Start" menu, an additional function is provided to delete the file that
stores the current software configuration during shutdown, if available (see "Create
Shutdown File" on page 101). If you delete the shutdown file, the R&S VSE software
starts in the default configuration the next time the R&S VSE software is started again.

Deleting the shutdown file does not affect settings concerning the layout of the basic
R&S VSE window. The display and position of toolbars and special tool windows are
retained.

Deleting the shutdown file has the same effect as Restoring All Default Settings ( Pre-
set All ) directly after startup.

Defining a Startup Settings File
You can define a settings file other than the shutdown file to be restored during soft-
ware startup, see chapter 8.2.2.4, "Startup Recall Settings", on page 83.

9.2 Display Settings

Some general display settings are available regardless of the current application or
operating mode.

Access: "File" > "Preferences"

● Displayed Items.....................................................................................................102
● Display Theme and Colors....................................................................................103

9.2.1 Displayed Items

Access: "File" > "Preferences" > "Displayed Items"
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Several elements on the screen display can be hidden or shown as required, for exam-
ple to enlarge the display area for the measurement results.

Status Bar................................................................................................................... 103
Diagram Footer (Annotation).......................................................................................103

Status Bar
The status bar beneath the diagram indicates the global software settings, the software
status and any irregularities during measurement or display.

Some of the information displayed in the status bar can be queried from the status reg-
istry via remote commands, see chapter 13.10.1, "Using the Status Register",
on page 424.

Remote command: 
DISPlay:SBAR[:STATe] on page 418

Diagram Footer (Annotation)
The diagram footer beneath the diagram contains information on the x-axis of the dia-
gram display, such as the current center frequency and span settings, the displayed
span per division and the number of measurement points.

Remote command: 
DISPlay:ANNotation:FREQuency on page 417

9.2.2 Display Theme and Colors

Access: "File" > "Preferences" > "Theme + Color".

You can configure the used colors and styles of display elements on the screen.

For step-by-step instructions see chapter 9.3, "How to Configure the Colors for Display
and Printing", on page 107.

 

Display Settings



General Software PreferencesR&S®VSE

104User Manual 1176.8839.02 ─ 03

Theme......................................................................................................................... 104
Screen colors.............................................................................................................. 105
Print colors.................................................................................................................. 105
Showing Print Colors on Display.................................................................................105
Modifying User-Defined Color Assignments............................................................... 105

└ Selecting the Object......................................................................................106
└ Predefined Colors......................................................................................... 106
└ Preview......................................................................................................... 106

Defining User-specific Colors......................................................................................106
Restoring the User Settings to Default Colors............................................................ 107

Theme
The theme defines the colors and style used to display softkeys and other screen
objects.

The default theme is "PCSW".

Remote command: 
DISPlay:THEMe:SELect on page 420

Display Settings
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Screen colors
Two different color sets are provided by the software, a third user-defined set can be
configured.

The default color schemes provide optimum visibility of all screen objects when regard-
ing the screen from above or below. Default setting is "Default Colors 1".

If "User Defined Colors" is selected, a user-defined color set can be defined (see
"Defining User-specific Colors" on page 106).

Remote command: 
DISPlay:CMAP<item>:DEFault<colors> on page 418

Print colors
Defines the color settings used for printout. In addition to the predefined settings, a
user-defined color set can be configured (see "Defining User-specific Colors"
on page 106).

If "Show Print Colors on Display" is activated, the currently selected print colors are
displayed as a preview for your selection.

Optimized Colors Selects an optimized color setting for the printout to improve the visi-
bility of the colors (default setting). Trace 1 is blue, trace 2 black,
trace 3 green, and the markers are turquoise. The background is
always printed in white and the grid in black.

Screen Colors (Print) Selects the current screen colors for the printout. The background is
always printed in white and the grid in black.

Screen Colors (Hardcopy) Selects the current screen colors without any changes for a hard-
copy.

User Defined Colors Selects the user-defined color setting.

Remote command: 
HCOPy:CMAP<item>:DEFault<colors> on page 408

Showing Print Colors on Display
Temporarily shows the currently selected print colors on the screen display. This func-
tion can be used as a preview for printing.

Modifying User-Defined Color Assignments
You can configure the colors used to display and print individual screen objects
according to your specific requirements.

The colors are configured in the (identical) "Screen Color Setup"/"Printer Color Setup"
dialog boxes.

Display Settings
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Selecting the Object ← Modifying User-Defined Color Assignments
Selects the object for which the color is to be defined. Colors can be defined for the
following objects:
● Background
● Grid
● Individual traces
● Display lines
● Limit lines and check results
● Markers and marker information

Remote command: 
Each object is assigned to a specific suffix of the CMAP commands, see chap-
ter 13.8.4, "CMAP Suffix Assignment", on page 420.

Predefined Colors ← Modifying User-Defined Color Assignments
Displays the available colors from the predefined color set that can be used for the
selected object.

Remote command: 
HCOPy:CMAP<item>:PDEFined on page 409

Preview ← Modifying User-Defined Color Assignments
Indicates the currently selected color that will be used for the selected object.

Defining User-specific Colors
In addition to the colors in the predefined color set you can configure a user-specific
color to be used for the selected object.

When you select "Userdefined Colors", the set of predefined colors is replaced by a
color palette and color configuration settings.
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The color palette allows you to select the color directly. The color settings allow you to
define values for tint, saturation and brightness.

Remote command: 
HCOPy:CMAP<item>:HSL on page 409

Restoring the User Settings to Default Colors
In addition to the predefined color settings, a user-defined setting can be configured.
By default, the same settings as defined in "Default Colors 1" are used. They can then
be modified according to user-specific requirements (see "Modifying User-Defined
Color Assignments" on page 105).

The "Set to Default" function restores the original default settings for the user-defined
color set. You can select which of the three default settings are restored.

Remote command: 
DISPlay:CMAP<item>:PDEFined on page 419

9.3 How to Configure the Colors for Display and Printing

You can configure the style and colors with which various screen objects are displayed
or printed.

To select a color set

1. Select "File" > "Preferences" > "Theme + Color".

2. In the "Screen Colors" area, select a predefined set of colors to be used for screen
display, or select "User Defined Colors" to configure the color set yourself.
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3. In the "Print Colors" area, select a predefined set of colors to be used for printing
screenshots, or select "User Defined Colors" to configure the color set yourself.
Activate the "Show Print Colors on Display" option to see a preview of the print col-
ors.

To configure a user-defined color set

1. In the "Theme + Color" tab of the "Preferences" dialog box select "User Defined
Colors" either for the screen or the print colors.

2. Select "Modify User Defined Colors".

The "Screen Color Setup" dialog box is opened.

3. From the "Selected Object" list, select the object to which you want to assign a
color.

4. Select a color from the "Predefined Colors" or select the "Userdefined Colors..."
button to define a different color.

The "Preview" area indicates the currently selected color.

5. To assign a user-specific color to the selected object, do one of the following:

● Select the color from the palette.
● Enter values for the "Tint", "Saturation", and "Brightness".

Note: In the continuous color spectrum ("Tint") red is represented by 0% and
blue by 100%.

● Enter an "ARGB" value in hexadecimal format.

6. Select the next object to which you want to assign a color from the "Selected
Object" list and assign a color as described.
Repeat these steps until all objects you want to configure have been assigned a
color.

7. Select "OK" to close the dialog box and apply the colors to the assigned objects.

9.4 Software Information and Support

Some general software functions are available concerning optional functionality, licen-
ses, service functions, or system messages. These settings are available from the
"Help" menu.

● Licensing, Versions and Options...........................................................................108
● R&S Support Information...................................................................................... 110

9.4.1 Licensing, Versions and Options

Access: "Help" > "License"
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Information on the R&S VSE software version and additional licensed options is provi-
ded in the "Versions + Options" dialog box. The unique Rohde & Schwarz device ID is
also indicated here, as it is required for license and option administration. Furthermore,
you can also install new firmware options in this dialog box.

To simply find out the version of the R&S VSE software, select "Help > About".

Expired option licenses
If an option is about to expire, a message box is displayed to inform you. You can then
use the "Install Option" function to enter a new license key.
If an option has already expired, a message box appears for you to confirm. In this
case, all software functions are unavailable (including remote control) until the
R&S VSE is rebooted. You must then use the "Install Option" function to enter the new
license key.

Remote commands:

DIAGnostic:SERVice:VERSinfo? on page 417

Install Option............................................................................................................... 109
Install Option by XML.................................................................................................. 110

Install Option
Opens an edit dialog box to enter the license key for the option that you want to install.

Only user accounts with administrator rights are able to install options.

Software Information and Support
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Install Option by XML
Opens a file selection dialog box to install an additional option to the R&S VSE using
an XML file. Enter or browse for the name of an XML file that contains the option key
and press "Select".

Only user accounts with administrator rights are able to install options.

9.4.2 R&S Support Information

Access: "Help" > "Support" > "R&S Support"

In case of errors you can store useful information for troubleshooting and send it to
your Rohde & Schwarz support center.

Creating R&S Support Information..............................................................................110
Save Device Footprint.................................................................................................111

Creating R&S Support Information
Creates a *.zip file with important support information. The *.zip file contains the sys-
tem configuration information ("device footprint"), the current eeprom data and a
screenshot of the screen display.

This data is stored to the following directory on the PC the R&S VSE software is instal-
led on:

C:\ProgramData\Rohde-Schwarz\VSE\<version_no>\user.

The file name consists of the unique device ID and the current date and time of the file
creation.
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Example: VSE_1310.0002K02-900014-if_20140807_091003.zip.

If you contact the Rohde&Schwarz support to get help for a certain problem, send
these files to the support in order to identify and solve the problem faster.

Remote command: 
DIAGnostic:SERVice:SINFo? on page 416

Save Device Footprint
Creates an *.xml file with licensing information on installed software versions.

This data is stored to the following directory on the PC the R&S VSE software is instal-
led on:

C:\ProgramData\Rohde-Schwarz\VSE\<version_no>\devicedata\xml\.

It is also included in the service.zip file.

The file name consists of the unique device ID and the current date and time of the file
creation, e.g.
DeviceFootprint_1310.0002K02-900014-if_2014-08-07T06-58-29.xml.

Software Information and Support
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10 I/Q Analyzer Measurements

10.1 Result Displays for the I/Q Analyzer

The I/Q Analyzer analyzes the I/Q data that was captured by the instrument in use or
imported to the R&S VSE in various different result displays.

Spectrograms
Spectrograms are not configured as separate result displays, but as a subwindow of an
existing I/Q Analyzer Spectrum or Magnitude window. They are activated and deactiva-
ted in the "Spectrogram" tab of the "Traces" settings (see "Spectrogram Settings"
on page 178).

Magnitude................................................................................................................... 112
Spectrum.....................................................................................................................113
I/Q-Vector....................................................................................................................114
Real/Imag (I/Q)............................................................................................................114
Statistic........................................................................................................................115
Phase vs. Time........................................................................................................... 116
Marker Table............................................................................................................... 117

Magnitude
Shows the level values in time domain.

 

 

Result Displays for the I/Q Analyzer



I/Q Analyzer MeasurementsR&S®VSE

113User Manual 1176.8839.02 ─ 03

Remote command: 
LAY:ADD:WIND? '1',RIGH,MAGN, see LAYout:ADD[:WINDow]? on page 306
Results:
TRACe<n>[:DATA]? on page 384

Spectrum
Displays the frequency spectrum of the captured I/Q samples.

Result Displays for the I/Q Analyzer
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Tip: You can analyze the levels per frequency over time using a Spectrogram, see
"Working with Spectrograms" on page 169.

Remote command: 
LAY:ADD:WIND? '1',RIGH,FREQ, see LAYout:ADD[:WINDow]? on page 306
Results:
TRACe<n>[:DATA]? on page 384

I/Q-Vector
Displays the captured samples in an I/Q-plot. The samples are connected by a line.

Note: For the I/Q vector result display the number of I/Q samples to record ("Record
Length") is automatically set to the number of measurement points. The number of
measurement points cannot be changed for this result display.

Remote command: 
LAY:ADD:WIND? '1',RIGH,VECT, see LAYout:ADD[:WINDow]? on page 306
Results:
TRACe<n>[:DATA]? on page 384

Real/Imag (I/Q)
Displays the I and Q values in separate diagrams.

Result Displays for the I/Q Analyzer
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Remote command: 
LAY:ADD:WIND? '1',RIGH,RIM, see LAYout:ADD[:WINDow]? on page 306
Results:
TRACe<n>[:DATA]? on page 384

Statistic
Shows a histogram of measured I/Q magnitudes. The number of bins used for the his-
togram, that is, the number of different measurement values the statistical occurrence
is determined for, can be defined.

Result Displays for the I/Q Analyzer
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Remote command: 
LAY:ADD? '1',RIGH,STAT, see LAYout:ADD[:WINDow]? on page 306

Phase vs. Time
Shows the phase values in the time domain.

Result Displays for the I/Q Analyzer
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Remote command: 
LAY:ADD? '1',RIGH, POLar, see LAYout:ADD[:WINDow]? on page 306

Marker Table
Displays a table with the current marker values for the active markers.

This table may be displayed automatically if configured accordingly (see "Marker Table
Display" on page 198).

Remote command: 
LAY:ADD? '1',RIGH, MTAB, see LAYout:ADD[:WINDow]? on page 306
Results:
CALCulate<n>:MARKer<m>:X on page 358
CALCulate<n>:MARKer<m>:Y? on page 386

10.2 Basics on I/Q Data Acquisition and Processing

Some background knowledge on basic terms and principles used when describing I/Q
data processing in the R&S VSE software in general, and in the I/Q Analyzer applica-
tion in particular, is provided here for a better understanding of the required configura-
tion settings.
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Principally, the R&S VSE (and all its applications) analyze data that was captured on a
connected instrument, or directly from a file with stored I/Q data. The software itself
does not capture data.

Complex baseband data

In the telephone systems of the past, baseband data was transmitted unchanged as an
analog signal. In modern phone systems and in radio communication, however, the
baseband data is modulated on a carrier frequency, which is then transmitted and must
be demodulated by the receiver. When using modern modulation methods (e.g. QPSK,
QAM etc.), the baseband signal becomes complex. Complex data (or: I/Q data) con-
sists of an imaginary (I) and a real (Q) component.

The R&S VSE software is capable of analyzing the individual I and Q components of
the complex signal.

I/Q Analyzer - analyzing complex data

The I/Q Analyzer is a standard application used to analyze I/Q data with the R&S VSE.
By default, it assumes the I/Q data is modulated on a carrier frequency.

● How Much Data is Measured: Capture Count and Measurement Points............. 118
● Sample Rate, Record Length and Analysis Bandwidth........................................ 119
● Basics on FFT.......................................................................................................119
● Receiving Data Input and Providing Data Output................................................. 125

10.2.1 How Much Data is Measured: Capture Count and Measurement
Points

The number of measurements to be performed in single measurement mode is defined
by the "Capture Count". Values from 0 to 200000 are allowed. If the values 0 or 1 are
set, one measurement is performed. The capture count is applied to all the traces in a
diagram.

If the trace configurations "Average", "Max Hold" or "Min Hold" are set, the "Capture
Count" also determines the number of averaging or maximum search procedures (see
"Analyzing Several Traces - Trace Mode" on page 166).

The number of points configured in the capture settings is not actually the number of
points to be captured (that is defined as the Record Length), but rather the number of
points to be evaluated in each trace (also referred to as measurement points). Thus,
the number of measurement points is window-specific. (However, all time-based dis-
plays (except for I/Q Vector) use the same number of measurement points.)

For I/Q Vector displays, the number of measurement points is always coupled to the
Record Length, which has a maximum of 524288 points.

For Spectrum displays and all time-based displays (except for the I/Q Vector), the
number of measurement points can either be defined manually or automatically.

In Auto mode, the number is coupled to the number of frequency points ("FFT Length"
on page 158).
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In Manual mode, all values from 51 to 524288 can be set. The default value is 1001
points.

For details on how the number of points and the capture count affect the trace results
on the screen, see "Mapping Samples to measurement Points with the Trace Detector"
on page 164.

10.2.2 Sample Rate, Record Length and Analysis Bandwidth

Definitions

● Input sample rate (ISR): the sample rate of the useful data provided by the device
connected to the input of the instrument in use

● (User, Output) Sample rate (SR): the sample rate that is defined by the user (e.g.
in the "Data Aquisition" dialog box in the "I/Q Analyzer" application) and which is
used as the basis for analysis or output

● Usable I/Q (Analysis) bandwidth: the bandwidth range in which the signal
remains undistorted in regard to amplitude characteristic and group delay; this
range can be used for accurate analysis by the R&S VSE

● Record length: Number of I/Q samples the instrument in use captures during the
specified measurement time; calculated as the measurement time multiplied by the
sample rate. By default, the record length is set to the number of measurement
points, and the measurement time and sample rate are adapted accordingly. The
maximum record length is 524288, but may not exceed the number of samples
provided by the instrument in use.

For the I/Q data acquisition, digital decimation filters are used internally in the instru-
ment in use. The passband of these digital filters determines the maximum usable I/Q
bandwidth. In consequence, signals within the usable I/Q bandwidth (passband)
remain unchanged, while signals outside the usable I/Q bandwidth (passband) are
suppressed. Usually, the suppressed signals are noise, artifacts, and the second IF
side band. If frequencies of interest to you are also suppressed, you should try to
increase the output sample rate, since this increases the maximum usable I/Q band-
width.

As a rule, the usable I/Q bandwidth is proportional to the output sample rate. However,
the bandwidth used by the R&S VSE software is restricted by the bandwidth provided
by the instrument in use.

10.2.3 Basics on FFT

The I/Q Analyzer measures the power of the signal over time. In order to convert the
time domain signal to a frequency spectrum, an FFT (Fast Fourier Transformation) is
performed which converts a vector of input values into a discrete spectrum of frequen-
cies.
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t[s]

FFT

f[Hz]

10.2.3.1 Frequency Resolution of FFT Results - RBW

The resolution bandwidth defines the minimum frequency separation at which the
individual components of a spectrum can be distinguished. Small values result in a
high precision, as the distance between two distinguishable frequencies is small.
Higher values decrease the precision, but increase measurement speed.

The RBW is determined by the following equation:

LengthWindow
RateSampleBandwidthNormalizedRBW 

Definition of RBW (10 - 1)

(Note: The normalized bandwidth is a fixed value that takes the noise bandwidth of the
window function into consideration.)

The maximum RBW is restricted by the Analysis Bandwidth, or by the following equa-
tion, whichever is higher:

3
RateSample*BandwidthNormalizedRBWmax 

If a higher spectral resolution is required, the number of samples must be increased by
using a higher sample rate or longer record length.

The minimum achievable RBW depends on the sample rate and record length, accord-
ing to the following equation:

524288min
RateSampleBandwidth*NormalizedRBW 

RBW and FFT mode

Depending on the selected RBW mode, the resolution bandwidth is either determined
automatically or can be defined manually.
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Auto mode:

This is the default mode in the I/Q Analyzer. The RBW is determined automatically
depending on the Sample Rate and the Record Length.

A single window is used, thus the Window Length corresponds to the Record Length.

A Flatop window function is used.

(Note: if you enter an RBW value in Auto mode, the mode is automatically switched to
Manual.

Manual mode:

The RBW can be defined by the user. The required Sample Rate, Record Length and
the "Meas Time" on page 156 are adapted accordingly.

A single window is used, thus the Window Length corresponds to the Record Length.

A Flatop window function is used.

Advanced FFT mode

The RBW is determined by the advanced FFT parameters. Using advanced FFT
mode, multiple overlapping FFT windows can be used with an averaging transforma-
tion algorithm (see "Combining Results - Trace Detector" on page 123).

10.2.3.2 FFT Calculation Methods

FFT calculation can be performed using different methods.

Single

In single mode, one FFT is calculated for the entire record length, that means the win-
dow length is identical to the FFT length, and both are identical to the record length.

Fig. 10-1: FFT parameters for single FFT calculation

Averaging

In averaging mode, several overlapping FFTs are calculated for each record; the
results are combined to determine the final FFT result for the record.

The number of FFTs to be combined is determined by the Window Overlap and the
Window Length.
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Fig. 10-2: FFT parameters for averaged FFT calculation

Window Functions

In advanced FFT mode, the Fourier transformation is not performed on the entire cap-
tured data in one step. In this case, an averaging transformation algorithm is used,
which uses only a limited number of samples to calculate an individual result. This
process is called windowing.

After sampling in the time domain, each window is multiplied with a specific window
function. Windowing helps minimize the discontinuities at the end of the measured sig-
nal interval and thus reduces the effect of spectral leakage, increasing the frequency
resolution.

Various different window functions are provided in the R&S VSE to suit different input
signals. Each of the window functions has specific characteristics, including some
advantages and some trade-offs. These characteristics need to be considered carefully
to find the optimum solution for the measurement task.

Ignoring the window function - rectangular window
The regtangular window function is in effect not a function at all, it maintains the origi-
nal sampled data. This may be useful to minimize the required bandwidth; however, be
aware that if the window does not contain exactly one period of your signal, heavy
sidelobes may occur, which do not exist in the original signal.

Table 10-1: Characteristics of typical FFT window functions

Window type Frequency
resolution

Magnitude
resolution

Sidelobe sup-
pression

Measurement recommendation

Rectangular Best Worst Worst No function applied.

Separation of two tones with almost
equal amplitudes and a small fre-
quency distance

Blackman-Harris
(default)

Good Good Good Harmonic detection and spurious
emission detection

Gauss (Alpha =
0.4)

Good Good Good Weak signals and short duration

Flattop Worst Best Good Accurate single tone measurements

5-Term Good Good Best Measurements with very high
dynamic range
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Overlapping

The averaging transformation algorithm in advanced FFT mode calculates multiple
FFTs per measurement by dividing one captured record into several windows. Consec-
utive windows may overlap. Overlapping "reuses" samples that were already used to
calculate the preceding FFT result.

In advanced FFT mode with averaging, the overlapping factor can be set freely. The
higher the overlap factor, the more windows are used. This leads to more individual
results and improves detection of transient signal effects. However, it also extends the
duration of the calculation. The size of the window can be defined manually according
to the record length, the overlap factor, and and the FFT length.

With an overlap of the FFTs of 67%, for example, the second data block the R&S VSE
performs the FFT on covers the last 67% of the data of the first FFT with only 33% new
data. The third data block still covers 33% of the first data block and 67% of the second
data block and so on.

Fig. 10-3: Overlapping FFTs

Combining Results - Trace Detector

Multiple overlapping windows are combined to create the final spectrum using the
selected trace detector. If necessary, the trace detector is also used to reduce the
number of calculated frequency points (defined by the FFT length) to the defined num-
ber of measurement points. By default, the Autopeak trace detector is used.
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Due to the fact that the frequency points are reduced to the number of measurement
points, using a detector other than Auto Peak may lead to wrong level results if the
measurement points are fewer than the number of calculated frequency points (defined
by the FFT length) .

Dependencies Between FFT Parameters in Averaging Mode

Advanced FFT analysis in the R&S VSE is highly configurable. Several parameters,
including the record length, FFT length, and Window length, can be defined according
to the user's requirements. Note, however, that these parameters are correlated and
can not be configured independently of the others.

Record Length

Defines the number of I/Q samples to capture from the instrument in use. By default,
the number of measurement points is used. The record length is calculated as the
measurement time multiplied by the sample rate.

The maximum record length is 524288, but may not exceed the instrument in use or
the number of samples provided by the input file.

FFT Length

Defines the number of frequency points determined by each FFT calculation. The more
points are used, the higher the resolution in the spectrum becomes, but the longer the
calculation takes.

If you use the arrow keys or the mouse wheel to change the FFT length, the value is
incremented or decremented by powers of 2. If you enter the value manually, any inte-
ger value from 3 to 524288 is available.

If the FFT length is longer than the Window Length the sample data is filled up with
zeros up to the FFT length. The FFT is then performed using interpolated frequency
points.
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For an FFT length that is not a power of 2, a DFT (discrete Fourier transform) is per-
formed, which requires more time for calculation, but avoids the effects of interpolation.

In order to display all calculated frequency points (defined by the FFT length), the num-
ber of measurement points is set to the FFT length automatically in advanced FFT
mode.

Window Length

Defines the number of samples to be included in a single window in averaging mode.

Values from 3 to 524288 are available. However, the window length may not be longer
than the FFT Length.

If the window length is shorter than the FFT Length, the sample data is filled up with
zeros up to the FFT length.

If the window length is longer than the Record Length (that is, not enough samples are
available), a window length the size of the Record Length is used for calculation.

The window length and the Window Overlap determine how many FFT calculations
must be performed for each record in averaging mode (see "Transformation Algorithm"
on page 158).

10.2.4 Receiving Data Input and Providing Data Output

The R&S VSE can analyze signals from different input sources and provide various
types of output (such as noise or trigger signals).

10.2.4.1 Input from Noise Sources

The instrument in use may provide a connector (NOISE SOURCE CONTROL) with a
voltage supply for an external noise source. By switching the supply voltage for an
external noise source on or off via the software, you can activate or deactive the con-
nected device as required.

External noise sources are useful when you are measuring power levels that fall below
the noise floor of the instrument in use itself, for example when measuring the noise
level of an amplifier.

In this case, you can first connect an external noise source (whose noise power level is
known in advance) to the instrument in use and measure the total noise power. From
this value you can determine the noise power of the instrument in use. Then when you
measure the power level of the actual DUT, you can deduct the known noise level from
the total power to obtain the power level of the DUT.

The noise source is controlled in the "Output" settings, see "Noise Source"
on page 133
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10.2.4.2 Receiving and Providing Trigger Signals

Using one of the TRIGGER INPUT / OUTPUT connectors of the instrument in use, the
R&S VSE can use a signal from an external device as a trigger to capture data. Alter-
natively, the internal trigger signal used by the instrument in use can be output for use
by other connected devices. Using the same trigger on several devices is useful to
synchronize the transmitted and received signals within a measurement.

For details on the connectors see the R&S VSE "Getting Started" manual.

External trigger as input

If the trigger signal for the R&S VSE is provided by an external device, the trigger sig-
nal source must be connected to the instrument in use and the trigger source must be
defined as "External" for the R&S VSE.

Trigger output

The instrument in use can provide output to another device either to pass on the inter-
nal trigger signal, or to indicate that the instrument in use itself is ready to trigger.

The trigger signal can be output by the instrument in use automatically, or manually by
the user. If it is provided automatically, a high signal is output when the instrument in
use has triggered due to a measurement start ("Device Triggered"), or when the instru-
ment in use is ready to receive a trigger signal after a measurement start ("Trigger
Armed").

Manual triggering

If the trigger output signal is initiated manually, the length and level (high/low) of the
trigger pulse is also user-definable. Note, however, that the trigger pulse level is
always opposite to the constant signal level defined by the output "Level" setting, e.g.
for "Level = High", a constant high signal is output to the connector until the "Send
Trigger" button is selected. Then, a low pulse is provided.

Providing trigger signals as output is described in detail in the R&S VSE User Manual.

10.3 Configuration

Access: "Meas Setup" > "Overview"

The easiest way to configure a measurement channel is via the "Overview" dialog box.

Alternatively, you can access the individual dialog boxes from the corresponding menu
items, or via tools in the toolbars, if available.

In this documentation, only the most convenient method of accessing the dialog boxes
is indicated - usually via the "Overview". For an overview of all available menu items
and toolbar icons see chapter A.1, "Menu Reference", on page 449 and chapter A.2,
"Reference of Toolbar Functions", on page 454.
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The remote commands required to perform these tasks are described in chapter 13.6,
"Remote Commands for the I/Q Analyzer", on page 311.

● Configuration Overview.........................................................................................127
● Data Input and Output Settings.............................................................................129
● Amplitude.............................................................................................................. 135
● Frequency Settings............................................................................................... 143
● Triggers.................................................................................................................145
● Data Acquisition and Bandwidth Settings............................................................. 154
● Adjusting Settings Automatically...........................................................................161

10.3.1 Configuration Overview

Access: "Meas Setup" > "Overview"

The easiest way to configure an I/Q Analysis channel is via the "Overview" dialog box.

Fig. 10-4: Configuration Overview for I/Q Analyzer

The "Overview" indicates the most important currently defined settings for the mea-
surement channel and provides quick access to the main settings dialog boxes. The
individual configuration steps are displayed in the order of the data flow. Thus, you can
easily configure an entire measurement channel from input over processing to output
and analysis by stepping through the dialog boxes as indicated in the "Overview".
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The Overview varies depending on the application; for detailed descriptions see the
corresponding application's User Manual.

The "Overview" for the I/Q Analyzer provides quick access to the following configura-
tion dialog boxes (listed in the recommended order of processing):

1. Input settings
See chapter 10.3.2, "Data Input and Output Settings", on page 129

2. Amplitude settings
See chapter 10.3.3, "Amplitude", on page 135

3. Frequency settings
See chapter 10.3.4, "Frequency Settings", on page 143

4. Optionally, Trigger/Gate settings
See chapter 10.3.5, "Triggers", on page 145

5. Bandwidth (data acquisition and capture) settings
See chapter 10.3.6, "Data Acquisition and Bandwidth Settings", on page 154

6. Optionally, output settings
See chapter 10.3.2, "Data Input and Output Settings", on page 129

7. Analysis settings and functions
See chapter 10.4, "Analysis", on page 164

To configure settings

► Select any button in the "Overview" or select a setting in the channel's global info
bar to open the corresponding dialog box.

For step-by-step instructions on configuring I/Q Analyzer measurements, see chap-
ter 11, "How To Perform Measurements with the R&S VSE", on page 213.

Preset Channel
Select the "Preset Channel" button in the lower lefthand corner of the "Overview" to
restore all measurement settings in the current channel to their default values.

This function has the same effect as the "Preset > Selected Channel" menu item.

Remote command: 
SYSTem:PRESet:CHANnel[:EXECute] on page 388

Specifics for
The measurement channel may contain several windows for different results. Thus, the
settings indicated in the "Overview" and configured in the dialog boxes vary depending
on the selected window.

Select an active window from the "Specifics for" selection list that is displayed in the
"Overview" and in all window-specific configuration dialog boxes.

The "Overview" and dialog boxes are updated to indicate the settings for the selected
window.
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10.3.2 Data Input and Output Settings

Access: "Input & Output"

The R&S VSE can control the input sources and output connectors of the connected
instruments.

● Radio Frequency Input..........................................................................................129
● I/Q File Input..........................................................................................................132
● Output Settings..................................................................................................... 133

10.3.2.1 Radio Frequency Input

Access: "Overview" > "Input" > "Input Source" > "Radio Frequency"

or: "Input & Output" > "Input Source" > "IQ File"

The default input source for the instrument in use is "Radio Frequency". Depending on
the instrument in use, different input parameters are available.

Fig. 10-5: RF input source settings for an R&S FSW

Input Type................................................................................................................... 129
Instrument................................................................................................................... 130
Input Coupling............................................................................................................. 130
Impedance.................................................................................................................. 130
High-Pass Filter 1...3 GHz.......................................................................................... 130
YIG-Preselector...........................................................................................................130
Preselector State.........................................................................................................131
Preselector Mode........................................................................................................ 131
10 dB Minimum Attenuation........................................................................................ 131
Input Selection............................................................................................................ 132

Input Type
Selects an instrument or a file as the type of input provided to the channel.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce on page 285
INPut:SELect on page 314
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Instrument
Specifies a configured instrument to be used for input.

Input Coupling
The RF input of the instrument in use can be coupled by alternating current (AC) or
direct current (DC).

AC coupling blocks any DC voltage from the input signal. This is the default setting to
prevent damage to the instrument. Very low frequencies in the input signal may be dis-
torted.

However, some specifications require DC coupling. In this case, you must protect the
instrument from damaging DC input voltages manually. For details, refer to the data
sheet.

Remote command: 
INPut:COUPling on page 312

Impedance
For some measurements, the reference impedance for the measured levels of the
instrument in use can be set to 50 Ω or 75 Ω.

75 Ω should be selected if the 50 Ω input impedance is transformed to a higher impe-
dance using a 75 Ω adapter of the RAZ type (= 25 Ω in series to the input impedance
of the instrument). The correction value in this case is 1.76 dB = 10 log (75Ω/50Ω).

Remote command: 
INPut:IMPedance on page 313

High-Pass Filter 1...3 GHz
Activates an additional internal high-pass filter for RF input signals from 1  GHz to
3 GHz. This filter is used to remove the harmonics of the analyzer in order to measure
the harmonics for a DUT, for example.

This function may require an additional hardware option on the instrument in use.

Remote command: 
INPut:FILTer:HPASs[:STATe] on page 312

YIG-Preselector
Activates or deactivates the YIG-preselector, if available on the instrument in use.

An internal YIG-preselector at the input of the instrument in use ensures that image fre-
quencies are rejected. However, this is only possible for a restricted bandwidth. In
order to use the maximum bandwidth for signal analysis you can deactivate the YIG-
preselector at the input of the instrument in use, which may lead to image-frequency
display.

Note:
For the following measurements, the YIG-Preselector is off by default (if available).
● I/Q Analyzer
● GSM
● VSA

Remote command: 
INPut:FILTer:YIG[:STATe] on page 313
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Preselector State
Turns the preselector on and off.

When you turn the preselector on, you can configure the characteristics of the prese-
lector and add the preamplifier into the signal path.

When you turn the preselector off, the signal bypasses the preselector and the pream-
plifier, and is fed into the input mixer directly.

Remote command: 
INPut:PRESelection[:STATe] on page 313

Preselector Mode
Selects the preselection filters to be applied to the measurement.

"Auto" Performs a measurement by automatically applying all available
bandpass filters.
Available with the optional preamplifier.

"Auto Wide" Performs a measurement by automatically applying the wideband fil-
ters consecutively:
● Lowpass 40 MHz
● Bandpass 30 MHz to 2250 MHz
● Bandpass 2 GHz to 8 GHz
● Bandpass 8 GHz to 26.5 GHz
Available with the optional preselector.

"Auto Narrow" Performs a measurement by automatically applying the most suitable
narrowband preselection filters, depending on the bandwidth you
have selected.
For measurement frequencies up to 30 MHz, the instrument in use
uses combinations of lowpass and highpass filters. For higher fre-
quencies, the instrument in use uses bandpass filters.
Available with the optional preselector.

"Manual" Performs a measurement with the filter settings you have defined
manually.

Remote command: 
INPut:PRESelection:SET on page 313

10 dB Minimum Attenuation
Turns the availabilty of attenuation levels of less than 10 dB on and off.

When you turn the feature on, the attenuation level is always at least 10 dB to protect
the input mixer and avoid accidental setting of 0 dB, especially if you measure DUTs
with high RFI voltage.

When you turn it off, you can also select attenuation levels of less than 10 dB.

The setting applies to a manual selection of the attenuation as well as the automatic
selection of the attenuation.

Remote command: 
INPut:ATTenuation:PROTection[:STATe] on page 312
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Input Selection
Selects the RF input you would like to use for a measurement.

Note that you can not use both RF inputs simultaneously.

Remote command: 
Global: INPut:TYPE on page 314

10.3.2.2 I/Q File Input

Access: "Overview" > "Input" > "Input Source" > "IQ File"

or: "Input & Output" > "Input Source" > "IQ File"

Alternatively to "live" data input from a connected instrument, measurement data to be
analyzed by the R&S VSE software can also be provided "offline" by a stored data file.
This allows you to perform a measurement on any instrument, store the results to a
file, and analyze the stored data partially or as a whole at any time using the R&S VSE
software.

The "Input Source" settings defined in the "Input" dialog box are identical to those con-
figured for a specific channel in the "Measurement Group Setup" window.
(See "Assigning the Channel Input Source" on page 72).

Input Type................................................................................................................... 132
Input File..................................................................................................................... 132

Input Type
Selects an instrument or a file as the type of input provided to the channel.

Remote command: 
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce on page 285
INPut:SELect on page 314

Input File
Specifies the I/Q data file to be used for input.
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Select "Select File" to open the "Load I/Q File" dialog box.

(See chapter 8.3.4.1, "Loading the I/Q Data File and Essential Measurement Informa-
tion", on page 92).

10.3.2.3 Output Settings

Access: "Overview" > "Output"

or: "Input & Output" > "Output"

The R&S VSE can control the output provided by the instrument in use to special con-
nectors for other devices.

Which output settings and connectors are available depends on the instrument in use.

For details on the output connectors refer to the instrument's Getting Started manual.

IF/VIDEO/DEMOD Output...........................................................................................133
IF Out Frequency........................................................................................................ 133
Noise Source...............................................................................................................133
Trigger 2/3...................................................................................................................134

└ Output Type.................................................................................................. 134
└ Level................................................................................................... 134
└ Pulse Length.......................................................................................134
└ Send Trigger.......................................................................................135

IF/VIDEO/DEMOD Output
This function is currently not available.

IF Out Frequency
This function is currently not available.

Noise Source
Switches the supply voltage for an external noise source on the instrument in use on or
off, if available.

External noise sources are useful when you are measuring power levels that fall below
the noise floor of the instrument in use itself, for example when measuring the noise
level of a DUT.
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For details see chapter 10.2.4.1, "Input from Noise Sources", on page 125

Remote command: 
DIAGnostic:SERVice:NSOurce on page 315

Trigger 2/3
Defines the usage of variable trigger input/output connectors on the instrument in use.
Which output settings are available depends on the type of instrument in use. For
details see the instrument's documentation.

"Input" The signal at the connector is used as an external trigger source by
the instrument in use. Trigger input parameters are available in the
"Trigger" dialog box.

"Output" The instrument in use sends a trigger signal to the output connector
to be used by connected devices.
Further trigger parameters are available for the connector.

Remote command: 
OUTPut:TRIGger<port>:LEVel on page 332
OUTPut:TRIGger<port>:DIRection on page 332

Output Type ← Trigger 2/3
Type of signal to be sent to the output

"Device Trig-
gered"

(Default) Sends a trigger when the instrument in use triggers.

"Trigger
Armed"

Sends a (high level) trigger when the instrument in use is in "Ready
for trigger" state.
This state is indicated by a status bit in the STATus:OPERation reg-
ister (bit 5), as well as by a low level signal at the AUX port (pin 9) of
the instrument in use, if available.
For details see "STATus:OPERation Register" on page 242 and the
instrument's documentation.

"User Defined" Sends a trigger when user selects "Send Trigger" button.
In this case, further parameters are available for the output signal.

Remote command: 
OUTPut:TRIGger<port>:OTYPe on page 332

Level ← Output Type ← Trigger 2/3
Defines whether a constant high (1) or low (0) signal is sent to the output connector.

Remote command: 
OUTPut:TRIGger<port>:LEVel on page 332

Pulse Length ← Output Type ← Trigger 2/3
Defines the length of the pulse sent as a trigger to the output connector.

Remote command: 
OUTPut:TRIGger<port>:PULSe:LENGth on page 333
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Send Trigger ← Output Type ← Trigger 2/3
Sends a user-defined trigger to the output connector immediately. Note that the trigger
pulse level is always opposite to the constant signal level defined by the output "Level"
setting, e.g. for "Level = High", a constant high signal is output to the connector until
the "Send Trigger" button is selected. Then, a low pulse is sent.

Which pulse level will be sent is indicated by a graphic on the button.

Remote command: 
OUTPut:TRIGger<port>:PULSe:IMMediate on page 333

10.3.3 Amplitude

Access: "Overview" > "Amplitude"

or: "Input & Output" > "Amplitude"

Amplitude settings affect the y-axis display in power diagrams.

● Impact of the Vertical Axis Settings.......................................................................135
● Amplitude Settings................................................................................................ 137
● Scaling the Y-Axis.................................................................................................141
● Scaling Statistics Displays.................................................................................... 142

10.3.3.1 Impact of the Vertical Axis Settings

Some background knowledge on the impact of the described settings is provided here
for a better understanding of the required configuration.

● Reference Level....................................................................................................135
● RF Attenuation...................................................................................................... 136
● Scaling.................................................................................................................. 137

Reference Level

The reference level value is the maximum value the AD converter can handle without
distortion of the measured value. Signal levels above this value will not be measured
correctly, which is indicated by the "IF OVLD" status display.

Internally, the reference level is also used to determine the optimum hardware settings
for the R&S VSE. The defined reference level should correspond with the maximum
expected RF input level.

When determining the expected input level, consider that the power from all input sig-
nals contribute to the total power. The reference level must be higher than the total
power from all signals.

The optimum reference level for the current measurement settings can be set automat-
ically by the R&S VSE (see "Reference Level" on page 138).

In general, the instrument in use measures the signal voltage at the RF input. The level
display is calibrated in RMS values of an unmodulated sine wave signal. In the default
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state, the level is displayed at a power of 1 mW (= dBm). Via the known input impe-
dance (50 Ω or 75 Ω, see "Impedance" on page 130), conversion to other units is pos-
sible.

Reference level offset

If the signal is attenuated or amplified before it is fed into the R&S VSE, you can define
an (arithmetic) offset to the reference level so the application shows correct power
results. All displayed power level results are shifted by this value, and the scaling of the
y-axis is changed accordingly.

To determine the required offset, consider the external attenuation or gain applied to
the input signal. For attenuation, define a positive offset so the R&S VSE increases the
displayed power values.

If an external gain is applied, define a negative offset so the R&S VSE decreases the
displayed power values.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal optimally) ignores any "Reference Level Offset". Thus, it is impor-
tant to keep in mind the actual power level the R&S VSE must handle, and not to rely
on the displayed reference level.

internal reference level = displayed reference level - offset

Example

1. The initial reference level is 2 dBm with no offset.

Both the displayed reference level and the internal reference level are 2 dBm.

2. An offset of 3 dB is defined.

The displayed reference level is adjusted to 5 dBm.
The internal reference level remains at 2 dBm.
(5 dBm (displayed ref level) - 3 dB (offset) = 2 dBm)

3. Now the user decreases the reference level to 1 dBm.

The displayed reference level is adjusted to 1 dBm.
The internal reference level is adjusted to:
1 dBm (displayed ref level) - 3 dB (offset) = -2 dBm.

RF Attenuation

The attenuation is meant to protect the input mixer from high RF input levels. The level
at the input mixer is determined by the set RF attenuation according to the formula:

"levelmixer = levelinput – RF attenuation"

The maximum mixer level allowed is 0 dBm. Mixer levels above this value may lead to
incorrect measurement results, which is indicated by the "RF OVLD" status display.
Furthermore, higher input levels may damage the instrument. Therefore, the required
RF attenuation is determined automatically according to the reference level by default.

High attenuation levels also avoid intermodulation. On the other hand, attenuation
must be compensated for by re-amplifying the signal levels after the mixer. Thus, high
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attenuation values cause the inherent noise (i.e the noise floor) to rise and the sensitiv-
ity of the analyzer decreases.

For ideal sinusoidal signals, the displayed signal level is independent of the RF attenu-
ation.

Depending on the type of measurement evaluation that is required, a compromise
must be found between a low noise floor and high intermodulation levels, and protect-
ing the instrument from high input levels. This is best done by letting the instrument in
use determine the optimum level automatically (see "Attenuation Mode / Value"
on page 140).

Scaling

In a linear display, the measurement values are distributed linearly throughout the grid.
That means the entire range of measured values is divided by the number of rows in
the grid (10) and each row corresponds to 1/10 of the total range. Linear scaling is use-
ful to determine precise levels for a small range of values. However, if large and small
values appear in the same display, it is difficult to determine individual values precisely
or to distinguish values that are close together.

In a logarithmic display, smaller values are distributed among a much larger area of the
display, while large values are condensed to a smaller area. Now it is much easier to
distinguish several lower values, as they are spread over a wider area. Logarithmic
scaling is useful when large ranges of values must be combined in one display. Loga-
rithmic scaling is best applied to measurement values in logarithmic units (dB, dBm
etc.).

In addition to linear or logarithmic scaling, the vertical axis can be set to display either
absolute or relative values. Absolute values show the measured levels, while relative
values show the difference between the measured level and the defined reference
level. Relative values are indicated in percent for linear scaling, and in dB for logarith-
mic scaling.

10.3.3.2 Amplitude Settings

Access: "Overview" > "Input/Frontend" > "Amplitude"

or: "Input & Output" > "Amplitude"

Amplitude settings determine how the instrument in use must process or display the
expected input power levels.

Which amplitude settings are available depends on the instrument in use.

The remote commands required to define these settings are described in "Amplitude
Settings" on page 315.
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Reference Level.......................................................................................................... 138
└ Shifting the Display (Offset).......................................................................... 138
└ Unit................................................................................................................139
└ Setting the Reference Level Automatically (Auto Level)...............................139

RF Attenuation............................................................................................................ 139
└ Attenuation Mode / Value..............................................................................140

Using Electronic Attenuation....................................................................................... 140
Input Settings.............................................................................................................. 140

└ Preamplifier...................................................................................................141

Reference Level
Defines the expected maximum reference level. Signal levels above this value may not
be measured correctly, which is indicated by the "IF OVLD" status display ("OVLD" for
analog baseband or digitial baseband input).

The reference level is also used to scale power diagrams; the reference level is then
used as the maximum on the y-axis.

Since the hardware of the instrument in use is adapted according to this value, it is rec-
ommended that you set the reference level close above the expected maximum signal
level to ensure an optimum measurement (no compression, good signal-to-noise ratio).

For details see "Reference Level" on page 135.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel on page 316

Shifting the Display (Offset) ← Reference Level
Defines an arithmetic level offset. This offset is added to the measured level. In some
result displays, the scaling of the y-axis is changed accordingly.
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Define an offset if the signal is attenuated or amplified before it is fed into the R&S VSE
so the application shows correct power results. All displayed power level results will be
shifted by this value.

The setting range is ±200 dB in 0.01 dB steps.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal optimally) ignores any "Reference Level Offset". Thus, it is impor-
tant to keep in mind the actual power level the R&S VSE must handle, and not to rely
on the displayed reference level (internal reference level = displayed reference level -
offset).

For details see "Reference level offset" on page 136.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel:OFFSet on page 316

Unit ← Reference Level
The instrument in use measures the signal voltage at the RF input.

In the default state, the level is displayed at a power of 1 mW (= dBm). Via the known
input impedance (50 Ω or 75 Ω, see "Impedance" on page 130), conversion to other
units is possible.

The following units are available and directly convertible:
● dBm
● dBmV
● dBμV
● dBμA
● dBpW
● Volt
● Ampere
● Watt

Remote command: 
INPut:IMPedance on page 313
CALCulate<n>:UNIT:POWer on page 316

Setting the Reference Level Automatically (Auto Level) ← Reference Level
The instrument in use automatically determines the optimal reference level for the cur-
rent input data. At the same time, the internal attenuators and the preamplifier are
adjusted so the signal-to-noise ratio is optimized, while signal compression, clipping
and overload conditions are minimized. This function is not available on all supported
instruments.

You can change the measurement time for the level measurement if necessary (see
"Automatic Measurement Time Mode and Value" on page 163).

Remote command: 
[SENSe:]ADJust:LEVel on page 317

RF Attenuation
Defines the attenuation applied to the RF input of the R&S VSE.
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Attenuation Mode / Value ← RF Attenuation
The RF attenuation can be set automatically as a function of the selected reference
level (Auto mode). This ensures that no overload occurs at the RF INPUT connector
for the current reference level. It is the default setting.

In "Manual" mode, you can set the RF attenuation in 1 dB steps (down to 0 dB). Other
entries are rounded to the next integer value. The range is specified in the data sheet.
If the defined reference level cannot be set for the defined RF attenuation, the refer-
ence level is adjusted accordingly and the warning "Limit reached" is displayed.

NOTICE! Risk of hardware damage due to high power levels. When decreasing the
attenuation manually, ensure that the power level does not exceed the maximum level
allowed at the RF input, as an overload may lead to hardware damage.
For details see "RF Attenuation" on page 136.

Remote command: 
INPut:ATTenuation on page 317
INPut:ATTenuation:AUTO on page 317

Using Electronic Attenuation
If the (optional) Electronic Attenuation hardware is installed on the instrument in use,
you can also activate an electronic attenuator.

In "Auto" mode, the settings are defined automatically; in "Manual" mode, you can
define the mechanical and electronic attenuation separately.

Note: Note that restrictions may apply concerning which frequencies electronic attenu-
ation is available for, depending on which instrument is connected to the R&S VSE
software. Check your instrument documentation for details.
In "Auto" mode, RF attenuation is provided by the electronic attenuator as much as
possible to reduce the amount of mechanical switching required. Mechanical attenua-
tion may provide a better signal-to-noise ratio, however.
When you switch off electronic attenuation, the RF attenuation is automatically set to
the same mode (auto/manual) as the electronic attenuation was set to. Thus, the RF
attenuation may be set to automatic mode, and the full attenuation is provided by the
mechanical attenuator, if possible.
If the defined reference level cannot be set for the given attenuation, the reference
level is adjusted accordingly and the warning "Limit reached" is displayed in the status
bar.

Remote command: 
INPut:EATT:STATe on page 318
INPut:EATT:AUTO on page 318
INPut:EATT on page 318

Input Settings
Some input settings affect the measured amplitude of the signal, as well.

The parameters "Input Coupling" and "Impedance" are identical to those in the "Input"
settings.

See chapter 10.3.2.1, "Radio Frequency Input", on page 129.
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Preamplifier ← Input Settings
If the (optional) Preamplifier hardware is installed on the instrument in use, a preampli-
fier can be activated for the RF input signal.

You can use a preamplifier to analyze signals from DUTs with low input power.

Depending on the connected instrument, different settings are available. See the
instrument's documentation for details.

Remote command: 
INPut:GAIN:STATe on page 319
INPut:GAIN[:VALue] on page 319

10.3.3.3 Scaling the Y-Axis

The individual scaling settings that affect the vertical axis are described here.

Access: "Overview" > "Amplitude" > "Scale" tab

or: "Input & Output" > "Scale"

The remote commands required to define these settings are described in chap-
ter 13.6.1.2, "Configuring the Vertical Axis (Amplitude, Scaling)", on page 315.

Range..........................................................................................................................141
Ref Level Position....................................................................................................... 142
Ref Value.................................................................................................................... 142
Scaling........................................................................................................................ 142
Y-Axis Max.................................................................................................................. 142

Range
Defines the displayed y-axis range in dB.

The default value is 100 dB.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] on page 320
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Ref Level Position
Defines the reference level position, i.e. the position of the maximum AD converter
value on the level axis in %, where 0  % corresponds to the lower and 100  % to the
upper limit of the diagram.

For spectrograms, this value defines the position of the reference level value within the
span covered by the color map. In this case, the value is given in %, where 0  % corre-
sponds to the maximum (right end) and 100  % to the minimum (left end) of the color
map.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RPOSition on page 321

Ref Value
The reference level value (configured in Amplitude Settings), indicated for reference
only.

Scaling
Defines the scaling method for the y-axis.

For more information see "Scaling" on page 137.

"Logarithmic" Logarithmic scaling (only available for logarithmic units - dB..., and A,
V, Watt)

"Linear Unit" Linear scaling in the unit of the measured signal

"Linear Per-
cent"

Linear scaling in percentages from 0 to 100

"Absolute" The labeling of the level lines refers to the absolute value of the refer-
ence level (not available for "Linear Percent")

"Relative" The scaling is in dB, relative to the reference level (only available for
logarithmic units - dB...). The upper line of the grid (reference level) is
always at 0 dB.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing on page 321
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:MODE on page 320

Y-Axis Max
Defines the maximum value of the y-axis in the currently selected diagram in either
direction (in Volts). Thus, the y-axis scale starts at -<Y-Axis Max> and ends at +<Y-
Axis Max>.

This command is only available if the evaluation mode for the I/Q Analyzer is set to "IQ
Vector" or "Real/Imag".

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] on page 320

10.3.3.4 Scaling Statistics Displays

Access: "Overview" > "Amplitude" > "Scale" tab

or: "Input & Output" > "Scale"
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For statistics displays, scale settings are available for both the y-axis and the x-axis.

X-Axis Reference Value.............................................................................................. 143
Range..........................................................................................................................143
Offset...........................................................................................................................143
Quantize Bins..............................................................................................................143
Y-Max / Y-Min............................................................................................................. 143

X-Axis Reference Value
The reference value on the x-axis in the current unit. The reference value is the highest
value displayed on the x-axis.

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:X:RVALue on page 323

Range
Range of x-axis in dB

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:X:RANGe on page 322

Offset
Defines an arithmetic level offset. This offset is added to the measured level irrespec-
tive of the selected unit. The scaling of the x-axis is changed accordingly.

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:X:RLEVel:OFFSet on page 322

Quantize Bins
For Statistics displays, this value defines the number of quantize bins used to create
the histogram, that is, the number of different measurement values the statistical
occurrence is determined for.

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:X:QUANtize on page 322

Y-Max / Y-Min
Defines the displayed range using minimum and maximum values.

Values in the range 1e-9 < value < 0.1 are allowed. The distance between max and min
value must be at least one decade.

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:Y:UPPer on page 323
CALCulate<n>:IQ:STATistics:SCALe:Y:LOWer on page 323

10.3.4 Frequency Settings

Access: "Overview" > "Frequency"

or: "Input & Output" > "Frequency"
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Center frequency.........................................................................................................144
Center Frequency Stepsize.........................................................................................144
Frequency Offset.........................................................................................................144

Center frequency
Defines the center frequency of the signal in Hertz.

0 Hz ≤ fcenter ≤ fmax

fmax and spanmin depend on the instrument and are specified in the data sheet.

Note: For file input you can shift the center frequency of the current measurement
compared to the stored measurement data. The maximum shift depends on the chan-
nel's current analysis bandwidth.

2max
channelfile

file
ABWABW

CFCFshift




If the file does not provide the center frequency, it is assumed to be 0 Hz.

Remote command: 
[SENSe:]FREQuency:CENTer on page 324

Center Frequency Stepsize
Defines the step size by which the center frequency is increased or decreased using
the arrow keys.

When you use the mouse wheel, the center frequency changes in steps of only 1/10 of
the "Center Frequency Stepsize".

The step size can be coupled to another value or it can be manually set to a fixed
value.

"= Center" Sets the step size to the value of the center frequency. The used
value is indicated in the "Value" field.

"Manual" Defines a fixed step size for the center frequency. Enter the step size
in the "Value" field.

Remote command: 
[SENSe:]FREQuency:CENTer:STEP on page 324

Frequency Offset
Shifts the displayed frequency range along the x-axis by the defined offset.
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This parameter has no effect on the instrument's hardware, or on the captured data or
on data processing. It is simply a manipulation of the final results in which absolute fre-
quency values are displayed. Thus, the x-axis of a spectrum display is shifted by a
constant offset if it shows absolute frequencies, but not if it shows frequencies relative
to the signal's center frequency.

A frequency offset can be used to correct the display of a signal that is slightly distorted
by the measurement setup, for example.

The allowed values range from -100 GHz to 100 GHz. The default setting is 0 Hz.

Remote command: 
[SENSe:]FREQuency:OFFSet on page 325

10.3.5 Triggers

Access: "Overview" > "Trigger/Gate"

or: "Input & Output" > "Trigger"

Trigger settings determine when the input signal is measured.

Which settings are available depends on the instrument in use.

External triggers from one of the TRIGGER INPUT/OUTPUT connectors on the instru-
ment in use are configured in a separate tab of the dialog box.

● Triggered Measurements......................................................................................146
● Trigger Settings.....................................................................................................148
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10.3.5.1 Triggered Measurements

In a basic measurement with default settings, the measurement is started immediately
when you select the "Capture" icon. However, sometimes you want the measurement
to start only when a specific condition is fulfilled on the instrument in use, for example a
signal level is exceeded, or in certain time intervals. For these cases you can define a
trigger for the measurement.

An "Offset" can be defined to delay the measurement after the trigger event, or to
include data before the actual trigger event in time domain measurements (pre-trigger
offset).

For complex tasks, advanced trigger settings are available:
● Hysteresis to avoid unwanted trigger events caused by noise
● Holdoff to define exactly which trigger event will cause the trigger in a jittering sig-

nal

● Trigger Source...................................................................................................... 146
● Trigger Offset........................................................................................................ 146
● Trigger Hysteresis.................................................................................................146
● Trigger Drop-Out Time..........................................................................................147
● Trigger Holdoff...................................................................................................... 148

Trigger Source

The trigger source defines which source must fulfill the condition that triggers the mea-
surement. Basically, this can be:

● Time: the measurement is repeated in a regular interval
● Power: an input signal is checked for a defined power level

The trigger signal can be any of the following:
– The input signal at one of various stages in the signal analysis process - before

or after the input mixer, after the video filter etc.
– A signal from an external device via one of the TRIGGER INPUT / OUTPUT

connectors on the instrument
– A signal from one of the input channels from a connected oscilloscope

For details on the available trigger sources see "Trigger Source" on page 150.

Trigger Offset

An offset can be defined to delay the measurement after the trigger event, or to include
data before the actual trigger event in time domain measurements (pre-trigger offset).
Pre-trigger offsets are possible because the R&S VSE captures data continuously in
the time domain, even before the trigger occurs.

See "Trigger Offset" on page 152.

Trigger Hysteresis

Setting a hysteresis for the trigger helps avoid unwanted trigger events caused by
noise, for example. The hysteresis is a threshold to the trigger level that the signal
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must fall below on a rising slope or rise above on a falling slope before another trigger
event occurs.

Example: 
In the following example, the second possible trigger event is ignored as the signal
does not exceed the hysteresis (threshold) before it reaches the trigger level again on
the rising edge. On the falling edge, however, two trigger events occur as the signal
exceeds the hysteresis before it falls to the trigger level the second time.

Trigger level

TT
T

Trigger 
hysteresis

T

Fig. 10-6: Effects of the trigger hysteresis

See "Hysteresis" on page 152

Trigger Drop-Out Time

If a modulated signal is instable and produces occassional "drop-outs" during a burst,
you can define a minimum duration that the input signal must stay below the trigger
level before triggering again. This is called the "drop-out" time. Defining a dropout time
helps you stabilize triggering when the analyzer is triggering on undesired events.

T

Drop-Out

T T

Fig. 10-7: Effect of the trigger drop-out time

See "Drop-Out Time" on page 152.
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Drop-out times for falling edge triggers
If a trigger is set to a falling edge ("Slope" = "Falling", see "Slope" on page 153) the
measurement is to start when the power level falls below a certain level. This is useful,
for example, to trigger at the end of a burst, similar to triggering on the rising edge for
the beginning of a burst.
If a drop-out time is defined, the power level must remain below the trigger level at
least for the duration of the drop-out time (as defined above). However, if a drop-out
time is defined that is longer than the pulse width, this condition cannot be met before
the final pulse, so a trigger event will not occur until the pulsed signal is over!

Drop-Out

T T T

Fig. 10-8: Trigger drop-out time for falling edge trigger

Trigger Holdoff

The trigger holdoff defines a waiting period before the next trigger after the current one
will be recognized.

T T

Holdoff

Frame 1 Frame 2
TT

Fig. 10-9: Effect of the trigger holdoff

See "Trigger Holdoff" on page 152.

10.3.5.2 Trigger Settings

Access: "Overview" > "Trigger/Gate"
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or: "Input & Output" > "Trigger"

Trigger settings determine when the input signal is measured. Which settings are avail-
able depends on the instrument in use.

Gate settings are currently not available.

External triggers from one of the TRIGGER INPUT/OUTPUT connectors on the instru-
ment in use are configured in a separate tab of the dialog box.

Trigger Source............................................................................................................ 150
└ Free Run.......................................................................................................150
└ External Trigger<X>......................................................................................150
└ IF Power........................................................................................................150
└ I/Q Power......................................................................................................150
└ RF Power......................................................................................................151
└ Time..............................................................................................................151
└ Magnitude (offline)........................................................................................ 151

Trigger Level............................................................................................................... 151
Repetition Interval....................................................................................................... 151
Drop-Out Time............................................................................................................ 152
Trigger Offset.............................................................................................................. 152
Hysteresis................................................................................................................... 152
Trigger Holdoff............................................................................................................ 152
Slope........................................................................................................................... 153
Trigger 2/3...................................................................................................................153
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└ Output Type.................................................................................................. 153
└ Level................................................................................................... 153
└ Pulse Length.......................................................................................154
└ Send Trigger.......................................................................................154

Trigger Source
Selects the trigger source. If a trigger source other than "Free Run" is set, "TRG" is dis-
played in the channel bar and the trigger source is indicated.

For more information see "Trigger Source" on page 146.

Note that the availability of trigger sources depends on the instrument in use.

Remote command: 
TRIGger[:SEQuence]:SOURce on page 330

Free Run ← Trigger Source
No trigger source is considered. Data acquisition is started manually or automatically
and continues until stopped explicitely.

Remote command: 
TRIG:SOUR IMM, see TRIGger[:SEQuence]:SOURce on page 330

External Trigger<X> ← Trigger Source
Data acquisition starts when the signal fed into the specified input connector or input
channel of the instrument in use meets or exceeds the specified trigger level.

(See "Trigger Level" on page 151).

Note: Which input and output connectors are available depends on the connected
instrument. For details see the "Instrument Tour" chapter in the instrument's Getting
Started manual.

Remote command: 
TRIG:SOUR EXT, TRIG:SOUR EXT2, TRIG:SOUR EXT3, TRIG:SOUR EXT4
See TRIGger[:SEQuence]:SOURce on page 330

IF Power ← Trigger Source
The R&S VSE starts capturing data as soon as the trigger level is exceeded around
the third intermediate frequency.

(The third IF represents the center frequency.)

This trigger source is only available for RF input.

The available trigger levels depend on the RF attenuation and preamplification. A refer-
ence level offset, if defined, is also considered.

For details on available trigger levels and trigger bandwidths see the data sheet.

Remote command: 
TRIG:SOUR IFP, see TRIGger[:SEQuence]:SOURce on page 330

I/Q Power ← Trigger Source
This trigger source is only available in the I/Q Analyzer application and in applications
that process I/Q data.

Triggers the measurement when the magnitude of the sampled I/Q data exceeds the
trigger threshold.
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The trigger bandwidth corresponds to the bandwidth setting for I/Q data acquisition.

(See "Analysis Bandwidth" on page 155.)

Remote command: 
TRIG:SOUR IQP, see TRIGger[:SEQuence]:SOURce on page 330

RF Power ← Trigger Source
Defines triggering of the measurement via signals which are outside the displayed
measurement range.

For this purpose the software uses a level detector at the first intermediate frequency.

The resulting trigger level at the RF input depends on the RF attenuation and preampli-
fication. For details on available trigger levels see the instrument's data sheet.

Note: If the input signal contains frequencies outside of this range (e.g. for fullspan
measurements), the measurement may be aborted and a message indicating the
allowed input frequencies is displayed in the status bar.
A "Trigger Offset", "Trigger Polarity" and "Trigger Holdoff" (to improve the trigger stabil-
ity) can be defined for the RF trigger, but no "Hysteresis".

Remote command: 
TRIG:SOUR RFP, see TRIGger[:SEQuence]:SOURce on page 330

Time ← Trigger Source
Triggers in a specified repetition interval.

Remote command: 
TRIG:SOUR TIME, see TRIGger[:SEQuence]:SOURce on page 330

Magnitude (offline) ← Trigger Source
For (offline) input from a file, rather than an instrument. Triggers on a specified signal
level.

Remote command: 
TRIG:SOUR MAGN, see TRIGger[:SEQuence]:SOURce on page 330

Trigger Level
Defines the trigger level for the specified trigger source.

For gated measurements, this setting also defines the gate level.

For details on supported trigger levels, see the data sheet.

Remote command: 
TRIGger[:SEQuence]:LEVel:IFPower on page 328
TRIGger[:SEQuence]:LEVel:IQPower on page 328
TRIGger[:SEQuence]:LEVel[:EXTernal<port>] on page 327
TRIGger[:SEQuence]:LEVel:RFPower on page 329
TRIGger[:SEQuence]:LEVel:MAPower on page 328

Repetition Interval
Defines the repetition interval for a time trigger. The shortest interval is 2 ms.
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The repetition interval should be set to the exact pulse period, burst length, frame
length or other repetitive signal characteristic.

Remote command: 
TRIGger[:SEQuence]:TIME:RINTerval on page 331

Drop-Out Time
Defines the time the input signal must stay below the trigger level before triggering
again.

For more information on the drop-out time see "Trigger Drop-Out Time" on page 147.

Remote command: 
TRIGger[:SEQuence]:DTIMe on page 326

Trigger Offset
Defines the time offset between the trigger event and the start of the measurement.

For more information see "Trigger Offset" on page 146.

offset > 0: Start of the measurement is delayed

offset < 0: Measurement starts earlier (pre-trigger)

Only possible for zero span (e.g. I/Q Analyzer application) and gated trigger switched off

Maximum allowed range limited by the measurement time:

pretriggermax = measurement timemax

Tip: To determine the trigger point in the sample (for "External" or "IF Power" trigger
source), use the TRACe:IQ:TPISample? command.

(If supported by the instrument in use.)

Remote command: 
TRIGger[:SEQuence]:HOLDoff[:TIME] on page 326

Hysteresis
Defines the distance in dB to the trigger level that the trigger source must exceed
before a trigger event occurs. Settting a hysteresis avoids unwanted trigger events
caused by noise oscillation around the trigger level.

This setting is only available for "IF Power" or "Magnitude (offline)" trigger sources. The
range of the value depends on the instrument in use.

For more information see "Trigger Hysteresis" on page 146.

Remote command: 
TRIGger[:SEQuence]:IFPower:HYSTeresis on page 327
TRIGger[:SEQuence]:MAPower:HYSTeresis on page 329

Trigger Holdoff
Defines the minimum time (in seconds) that must pass between two trigger events.
Trigger events that occur during the holdoff time are ignored.
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For more information see "Trigger Holdoff" on page 148.

Remote command: 
TRIGger[:SEQuence]:IFPower:HOLDoff on page 327
TRIGger[:SEQuence]:MAPower:HOLDoff on page 329

Slope
For all trigger sources except time you can define whether triggering occurs when the
signal rises to the trigger level or falls down to it.

Remote command: 
TRIGger[:SEQuence]:SLOPe on page 330

Trigger 2/3
Defines the usage of variable trigger input/output connectors on the instrument in use.
Which output settings are available depends on the type of instrument in use. For
details see the instrument's documentation.

"Input" The signal at the connector is used as an external trigger source by
the instrument in use. Trigger input parameters are available in the
"Trigger" dialog box.

"Output" The instrument in use sends a trigger signal to the output connector
to be used by connected devices.
Further trigger parameters are available for the connector.

Remote command: 
OUTPut:TRIGger<port>:LEVel on page 332
OUTPut:TRIGger<port>:DIRection on page 332

Output Type ← Trigger 2/3
Type of signal to be sent to the output

"Device Trig-
gered"

(Default) Sends a trigger when the instrument in use triggers.

"Trigger
Armed"

Sends a (high level) trigger when the instrument in use is in "Ready
for trigger" state.
This state is indicated by a status bit in the STATus:OPERation reg-
ister (bit 5), as well as by a low level signal at the AUX port (pin 9) of
the instrument in use, if available.
For details see "STATus:OPERation Register" on page 242 and the
instrument's documentation.

"User Defined" Sends a trigger when user selects "Send Trigger" button.
In this case, further parameters are available for the output signal.

Remote command: 
OUTPut:TRIGger<port>:OTYPe on page 332

Level ← Output Type ← Trigger 2/3
Defines whether a constant high (1) or low (0) signal is sent to the output connector.

Remote command: 
OUTPut:TRIGger<port>:LEVel on page 332
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Pulse Length ← Output Type ← Trigger 2/3
Defines the length of the pulse sent as a trigger to the output connector.

Remote command: 
OUTPut:TRIGger<port>:PULSe:LENGth on page 333

Send Trigger ← Output Type ← Trigger 2/3
Sends a user-defined trigger to the output connector immediately. Note that the trigger
pulse level is always opposite to the constant signal level defined by the output "Level"
setting, e.g. for "Level = High", a constant high signal is output to the connector until
the "Send Trigger" button is selected. Then, a low pulse is sent.

Which pulse level will be sent is indicated by a graphic on the button.

Remote command: 
OUTPut:TRIGger<port>:PULSe:IMMediate on page 333

10.3.6 Data Acquisition and Bandwidth Settings

Access: "Overview" > "Bandwidth"

or: "Meas Setup" > "Data Acquisition"

The signal bandwidth to be captured and analyzed is configurable.

● Data Acquisition.................................................................................................... 154
● Capture Settings................................................................................................... 159

10.3.6.1 Data Acquisition

Access: "Overview" > "Bandwidth" > "Data Acquisition"

or: "Meas Setup" > "Data Acquisition"

The data acquisition settings define which parts of the input signal are captured for fur-
ther evaluation in the applications.
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Fig. 10-10: Data acquisition settings with advanced FFT parameters

The remote commands required to perform these tasks are described in chap-
ter 13.6.1.6, "Configuring Data Acquisition", on page 333.

Sample Rate............................................................................................................... 155
Analysis Bandwidth..................................................................................................... 155
Maximum Bandwidth...................................................................................................156
Meas Time.................................................................................................................. 156
Record Length.............................................................................................................156
Swap I/Q..................................................................................................................... 156
RBW............................................................................................................................157
Advanced FFT mode / Basic settings......................................................................... 157

└ Transformation Algorithm..............................................................................158
└ FFT Length................................................................................................... 158
└ Window Function.......................................................................................... 158
└ Window Overlap............................................................................................158
└ Window Length............................................................................................. 158

Sample Rate
Defines the I/Q data sample rate of the R&S VSE. This value is dependent on the
defined Analysis Bandwidth and the defined signal source.

sample rate = analysis bandwidth / 0.8

For details on the dependencies see chapter 10.2.2, "Sample Rate, Record Length and
Analysis Bandwidth", on page 119.

Remote command: 
TRACe:IQ:SRATe on page 340

Analysis Bandwidth
Defines the flat, usable bandwidth of the final I/Q data. This value is dependent on the
defined Sample Rate and the defined signal source.
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analysis bandwidth = 0.8 * sample rate

However, the analysis bandwidth used by the R&S VSE software may be restricted by
the bandwidth provided by the instrument in use.

Remote command: 
TRACe:IQ:BWIDth on page 338

Maximum Bandwidth
Depending on the instrument in use, the maximum bandwidth to be used by the
R&S VSE for I/Q data acquisition can be restricted. This setting is only available if a
bandwidth extension option is installed on the instrument in use. Otherwise the maxi-
mum bandwidth is determined automatically.

The available values depend on the instrument and the installed bandwidth extension
options. For details see the instrument's documentation.

Remote command: 
TRACe:IQ:WBANd[:STATe] on page 341
TRACe:IQ:WBANd:MBWIDTH on page 341

Meas Time
Defines the I/Q acquisition time. By default, the measurement time is calculated as the
number of I/Q samples ("Record Length") divided by the sample rate. If you change the
measurement time, the Record Length is automatically changed, as well.

For details on the maximum number of samples see also chapter 10.2.2, "Sample
Rate, Record Length and Analysis Bandwidth", on page 119. Note that the measure-
ment time used by the R&S VSE software may be restricted by the measurement time
available on the instrument in use.

Remote command: 
[SENSe:]SWEep:TIME on page 338

Record Length
Defines the number of I/Q samples to record. By default, the number of measurement
points is used. The record length is calculated as the measurement time multiplied by
the sample rate. If you change the record length, the Meas Time is automatically
changed, as well.

Note: For the I/Q vector result display, the number of I/Q samples to record ("Record
Length") must be identical to the number of trace points to be displayed ("Measure-
ment Points"). Thus, the measurement points are not editable for this result display. If
the "Record Length" is edited, the measurement points are adapted automatically.
For record lengths outside the valid range of measurement points (see "Points"
on page 159) the diagram does not show valid results.

Remote command: 
TRACe:IQ:RLENgth on page 338
TRACe:IQ:SET on page 339

Swap I/Q
Activates or deactivates the inverted I/Q modulation. If the I and Q parts of the signal
from the DUT are interchanged, the R&S VSE can do the same to compensate for it.
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On I and Q signals are interchanged

Inverted sideband, Q+j*I

Off I and Q signals are not interchanged

Normal sideband, I+j*Q

Remote command: 
[SENSe:]SWAPiq on page 337

RBW
Defines the resolution bandwidth for Spectrum results. The available RBW values
depend on the sample rate and record length.

Depending on the selected RBW mode, the value is either determined automatically or
can be defined manually. As soon as you enter a value in the input field, the RBW
mode is changed to "Manual".

This setting is only available if a Spectrum window is active.

If the "Advanced Fourier Transformation Params" option is enabled, advanced FFT
mode is selected and the RBW cannot be defined directly.

Note that the RBW is correlated with the Sample Rate and Record Length (and possi-
bly the Window Function and Window Length). Changing any one of these parameters
may cause a change to one or more of the other parameters. For more information see
chapter 10.2.3.1, "Frequency Resolution of FFT Results - RBW", on page 120.

"Auto mode" (Default) The RBW is determined automatically depending on the
Sample Rate and Record Length. A single window function is used
(window length = record length). The number of measurement points
is automatically adapted to the FFT length.

"Manual mode" The RBW can be defined by the user.
The user-defined RBW is used and the Window Length (and possibly
Sample Rate) are adapted accordingly. A single window function is
used (window length = record length)

"Advanced
FFT mode"

This mode is used if the "Advanced Fourier Transformation Params"
option is enabled.
The RBW is determined by the advanced FFT parameters.
An averaging window function can be used (window length ≤ record
length).

Remote command: 
[SENSe:]IQ:BANDwidth|BWIDth:MODE on page 334
[SENSe:]IQ:BANDwidth|BWIDth:RESolution on page 334

Advanced FFT mode / Basic settings
Shows or hides the "Advanced Fourier Transformation" parameters in the "Data Acqui-
sition" dialog box.

These parameters are required for Spectrum results and are thus only available if a
Spectrum window is active.

Note that if the advanced FFT mode is used, the RBW settings are not available.

For more information see chapter 10.2.3.2, "FFT Calculation Methods", on page 121.
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Transformation Algorithm ← Advanced FFT mode / Basic settings
Defines the FFT calculation method.

"Single" One FFT is calculated for the entire record length; if the FFT Length
is larger than the record length, zeros are appended to the captured
data.

"Averaging" Several overlapping FFTs are calculated for each record; the results
are combined to determine the final FFT result for the record. The
number of FFTs to be averaged is determined by the Window Over-
lap and the Window Length.

Remote command: 
[SENSe:]IQ:FFT:ALGorithm on page 335

FFT Length ← Advanced FFT mode / Basic settings
Defines the number of frequency points determined by each FFT calculation. The more
points are used, the higher the resolution in the spectrum becomes, but the longer the
calculation takes.

For Spectrum displays, the number of measurement points is set to the FFT length
automatically.

Note: If you use the arrow keys or the mouse wheel to change the FFT length, the
value is incremented or decremented by powers of 2.
If you enter the value manually, any integer value from 3 to 524288 is available.

Remote command: 
[SENSe:]IQ:FFT:LENGth on page 335

Window Function ← Advanced FFT mode / Basic settings
In the I/Q analyzer you can select one of several FFT window types.

The following window types are available:
● Blackman-Harris
● Flattop
● Gauss
● Rectangular
● 5-Term

Remote command: 
[SENSe:]IQ:FFT:WINDow:TYPE on page 336

Window Overlap ← Advanced FFT mode / Basic settings
Defines the part of a single FFT window that is re-calculated by the next FFT calcula-
tion when using multiple FFT windows.

Remote command: 
[SENSe:]IQ:FFT:WINDow:OVERlap on page 336

Window Length ← Advanced FFT mode / Basic settings
Defines the number of samples to be included in a single FFT window in averaging
mode. (In single mode, the window length corresponds to the "Record Length"
on page 156.)

In manual or advanced FFT mode, values from 3 to 524288 are available. (In Auto
mode, averaging is not used.)
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However, the window length may not be longer than the FFT Length.

Remote command: 
[SENSe:]IQ:FFT:WINDow:LENGth on page 336

10.3.6.2 Capture Settings

Access: "Overview" > "Bandwidth" > "Capture"

or: "Meas Setup" > "Capture"

Spectrogram settings are only available if a spectrogram is active for the selected win-
dow (see "State" on page 179).

Fig. 10-11: Capture settings with active spectrogram

Points.......................................................................................................................... 159
Quantize Bins..............................................................................................................160
Capture Count.............................................................................................................160
Selecting a frame to display........................................................................................ 160
Continue Frame.......................................................................................................... 161
Frame Count............................................................................................................... 161
Clear Spectrogram...................................................................................................... 161

Points
This value defines the number of measurement points that are evaluated and dis-
played in the result diagrams.

In "Auto" mode, the number of capture points is coupled with the FFT Length.

In "Manual" mode or Advanced FFT mode, the number is user-definable.

Note: The capture settings are window-specific. For some result displays, the points
may not be editable as they are determined automatically, or restrictions may apply.
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For the I/Q vector result display, the number of I/Q samples to record ("Record
Length") must be identical to the number of trace points to be displayed ("Points").
Thus, the points are not editable for this result display. If the "Record Length" is edited,
the points are adapted automatically. For record lengths outside the valid range of
points, i.e. fewer than 51 points or more than 524288 points, the diagram does not
show valid results.
Using fewer points than the FFT Length with a detector other than Auto Peak may lead
to wrong level results. For details see "Combining Results - Trace Detector"
on page 123.

Remote command: 
[SENSe:]SWEep:POINts on page 338

Quantize Bins
For Statistics displays, this value defines the number of quantize bins used to create
the histogram, that is, the number of different measurement values the statistical
occurrence is determined for.

Remote command: 
CALCulate<n>:IQ:STATistics:SCALe:X:QUANtize on page 322

Capture Count
Defines the number of times data is captured in single measurement mode. Values
from 0 to 200000 are allowed. If the values 0 or 1 are set, one measurement is per-
formed.

The capture count is applied to all the traces in all diagrams.

If the trace modes "Average", "Max Hold" or "Min Hold" are set, this value also deter-
mines the number of averaging or maximum search procedures.

In continuous measurement mode, if capture count = 0 (default), averaging is per-
formed over 10 measurement. For capture count =1, no averaging, maxhold or minhold
operations are performed.

For more information see chapter 10.2.1, "How Much Data is Measured: Capture
Count and Measurement Points", on page 118.

For spectrogram displays, the capture count determines how many captures are com-
bined in one frame in the spectrogram, i.e. how many captures the R&S VSE performs
to plot one trace in the spectrogram result display. For more details see "Time Frames"
on page 171.

Remote command: 
[SENSe:]AVERage<n>:COUNt on page 348

Selecting a frame to display
Selects a specific frame, loads the corresponding trace from the memory, and displays
it in the Spectrum window.

Note that activating a marker or changing the position of the active marker automati-
cally selects the frame that belongs to that marker.

This function is only available in single sweep mode or if the sweep is stopped, and
only if a spectrogram is selected.

The most recent frame is number 0, all previous frames have a negative number.
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For more details see "Time Frames" on page 171.

Remote command: 
CALCulate<n>:SPECtrogram:FRAMe:SELect on page 351

Continue Frame
Determines whether the results of the previous sweeps are included in the analysis of
the next sweeps for trace modes "Max Hold", "Min Hold", and "Average".

This function is available in single sweep mode only.
● On

When the average or peak values are determined for the new sweep, the results of
the previous sweeps in the spectrogram are also taken into account.

● Off
The average or peak values are determined from the results of the newly swept
frames only.

Remote command: 
CALCulate<n>:SPECtrogram:CONT on page 350

Frame Count
Determines how many frames are plotted during a single sweep measurement (as
opposed to a continuous sweep). The maximum number of possible frames depends
on the history depth (see "History Depth" on page 180).

For more details see "Time Frames" on page 171.

Remote command: 
CALCulate<n>:SPECtrogram:FRAMe:COUNt on page 350

Clear Spectrogram
Resets the spectrogram result display and clears the history buffer.

This function is only available if a spectrogram is selected.

Remote command: 
CALCulate<n>:SPECtrogram:CLEar[:IMMediate] on page 350

10.3.7 Adjusting Settings Automatically

Access: "Auto Set" toolbar

Depending on the instrument in use, some settings can be adjusted by the instrument
automatically according to the current measurement settings. In order to do so, a mea-
surement is performed. The duration of this measurement can be defined automatically
or manually.

To activate the automatic adjustment of a setting from the R&S VSE, select the corre-
sponding function in the "Auto Set" toolbar or in the configuration dialog box for the set-
ting, where available.
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Adjusting settings automatically during triggered measurements
When you select an auto adjust function a measurement is performed to determine the
optimal settings. If you select an auto adjust function for a triggered measurement, you
are asked how the instrument in use should behave:
● (default:) The measurement for adjustment waits for the next trigger
● The measurement for adjustment is performed without waiting for a trigger.

The trigger source is temporarily set to "Free Run". After the measurement is com-
pleted, the original trigger source is restored. The trigger level is adjusted as fol-
lows for IF Power and RF Power triggers:
Trigger Level = Reference Level - 15 dB

Remote command:
[SENSe:]ADJust:CONFigure:TRIG on page 343

Adjusting all Determinable Settings Automatically (Auto All)...................................... 162
Adjusting the Center Frequency Automatically (Auto Freq)........................................ 162
Setting the Reference Level Automatically (Auto Level)............................................. 162
Auto Settings Configuration........................................................................................ 163

└ Automatic Measurement Time Mode and Value...........................................163
└ Upper Level Hysteresis.................................................................................163
└ Lower Level Hysteresis.................................................................................163

Adjusting all Determinable Settings Automatically (Auto All)
Activates all automatic adjustment functions for the current measurement settings.

This includes:
● Auto Frequency
● "Setting the Reference Level Automatically (Auto Level)" on page 139

Remote command: 
[SENSe:]ADJust:ALL on page 342

Adjusting the Center Frequency Automatically (Auto Freq)
The instrument in use adjusts the center frequency automatically.

The optimum center frequency is the frequency with the highest S/N ratio in the fre-
quency span. As this function uses the signal counter, it is intended for use with sinus-
oidal signals.

Remote command: 
[SENSe:]ADJust:FREQuency on page 344

Setting the Reference Level Automatically (Auto Level)
The instrument in use automatically determines the optimal reference level for the cur-
rent input data. At the same time, the internal attenuators and the preamplifier are
adjusted so the signal-to-noise ratio is optimized, while signal compression, clipping
and overload conditions are minimized. This function is not available on all supported
instruments.
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You can change the measurement time for the level measurement if necessary (see
"Automatic Measurement Time Mode and Value" on page 163).

Remote command: 
[SENSe:]ADJust:LEVel on page 317

Auto Settings Configuration
For some automatic settings, additional parameters can be configured. The "Auto Set
Config" dialog box is available when you select the icon from the "Auto Set" toolbar.

Automatic Measurement Time Mode and Value ← Auto Settings Configuration
To determine the optimal reference level automatically, a level measurement is per-
formed on the instrument in use. You can define whether the duration of this measure-
ment is determined automatically or manually.

To define the duration manually, enter a value in seconds.

Remote command: 
[SENSe:]ADJust:CONFigure:DURation:MODE on page 343
[SENSe:]ADJust:CONFigure:DURation on page 342

Upper Level Hysteresis ← Auto Settings Configuration
When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preamplifier (if available) of the instrument in use are also
adjusted. In order to avoid frequent adaptation due to small changes in the input signal,
you can define a hysteresis. This setting defines a lower threshold the signal must fall
below (compared to the last measurement) before the reference level is adapted auto-
matically.

Remote command: 
[SENSe:]ADJust:CONFigure:HYSTeresis:UPPer on page 343

Lower Level Hysteresis ← Auto Settings Configuration
When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preamplifier (if available) of the instrument in use are also
adjusted. In order to avoid frequent adaptation due to small changes in the input signal,
you can define a hysteresis. This setting defines a lower threshold the signal must fall
below (compared to the last measurement) before the reference level is adapted auto-
matically.

Remote command: 
[SENSe:]ADJust:CONFigure:HYSTeresis:LOWer on page 343
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10.4 Analysis

General result analysis settings concerning the trace, markers, lines etc..

● Trace Configuration...............................................................................................164
● Marker Usage........................................................................................................187
● Zoomed Displays.................................................................................................. 207

10.4.1 Trace Configuration

A trace is a collection of measured data points. The trace settings determine how the
measured data is analyzed and displayed on the screen.

● Basics on Setting up Traces................................................................................. 164
● Trace Configuration...............................................................................................174
● How to Configure Traces...................................................................................... 182

10.4.1.1 Basics on Setting up Traces

Some background knowledge on traces is provided here for a better understanding of
the required configuration settings.

● Mapping Samples to measurement Points with the Trace Detector..................... 164
● Analyzing Several Traces - Trace Mode...............................................................166
● How Many Traces are Averaged - Capture Count + Measurement Mode............167
● How Trace Data is Averaged - the Averaging Mode.............................................168
● Working with Spectrograms.................................................................................. 169

Mapping Samples to measurement Points with the Trace Detector

A trace displays the values measured at the measurement points. The number of sam-
ples taken during a measurement may be much larger than the number of measure-
ment points that are displayed in the measurement trace.

Obviously, a data reduction must be performed to determine which of the samples are
displayed for each measurement point. This is the trace detector's task.

The trace detector can analyze the measured data using various methods:

The detector activated for the specific trace is indicated in the corresponding trace
information by an abbreviation.

Table 10-2: Detector types

Detector Abbrev. Description

Positive Peak Pk Determines the largest of all positive peak values of the levels measured at the
individual frequencies which are displayed in one sample point

Negative Peak Mi Determines the smallest of all negative peak values of the levels measured at
the individual frequencies which are displayed in one sample point
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Detector Abbrev. Description

Auto Peak Ap Combines the peak detectors; determines the maximum and the minimum
value of the levels measured at the individual frequencies which are displayed
in one sample point

RMS Rm Calculates the root mean square of all samples contained in a measurement
point.

To this effect, R&S VSE uses the linear voltage after envelope detection. The
sampled linear values are squared, summed and the sum is divided by the
number of samples (= root mean square). For logarithmic display the logarithm
is formed from the square sum. For linear display the root mean square value
is displayed. Each measurement point thus corresponds to the power of the
measured values summed up in the measurement point.

The RMS detector supplies the power of the signal irrespective of the wave-
form (CW carrier, modulated carrier, white noise or impulsive signal). Correc-
tion factors as needed for other detectors to measure the power of the different
signal classes are not required.

Average Av Calculates the linear average of all samples contained in a measurement
point.

To this effect, R&S VSE uses the linear voltage after envelope detection. The
sampled linear values are summed up and the sum is divided by the number of
samples (= linear average value). For logarithmic display the logarithm is
formed from the average value. For linear display the average value is dis-
played. Each measurement point thus corresponds to the average of the mea-
sured values summed up in the measurement point.

The average detector supplies the average value of the signal irrespective of
the waveform (CW carrier, modulated carrier, white noise or impulsive signal).

Sample Sa Selects the last measured value of the levels measured at the individual fre-
quencies which are displayed in one sample point; all other measured values
for the frequency range are ignored

The result obtained from the selected detector for a measurement point is displayed as
the value at this frequency point in the trace.

video
signal

s1  s2  s3  s4  s5  s6         s8        s1      

video
signal

s1  s2  s3  s4  s5  s6         s8        s1      

Measurement point n

Video
Signal

Meas. point n+1

MAX PEAK
AUTO PEAK
MIN PEAK

SAMPLE

RMS
AVG

The trace detector for the individual traces can be selected manually by the user or set
automatically by the R&S VSE.
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The detectors of the R&S VSE are implemented as pure digital devices. All detectors
work in parallel in the background, which means that the measurement speed is inde-
pendent of the detector combination used for different traces.

Auto detector

If the R&S VSE is set to define the appropriate detector automatically, the detector is
set depending on the selected trace mode:

Trace mode Detector

Clear Write Auto Peak

Max Hold Positive Peak

Min Hold Negative Peak

Average Sample Peak

View –

Blank –

Analyzing Several Traces - Trace Mode

If several measurement are performed one after the other, or continuous measurement
are performed, the trace mode determines how the data for subsequent traces is pro-
cessed. After each measurement, the trace mode determines whether:

● the data is frozen (View)
● the data is hidden (Blank)
● the data is replaced by new values (Clear Write)
● the data is replaced selectively (Max Hold, Min Hold, Average)

Each time the trace mode is changed, the selected trace memory is cleared.
The trace mode also determines the detector type if the detector is set automatically,
see "Mapping Samples to measurement Points with the Trace Detector" on page 164.

The R&S VSE supports the following trace modes:

Table 10-3: Overview of available trace modes

Trace Mode Description

Blank Hides the selected trace.

Clear Write Overwrite mode: the trace is overwritten by each measurement. This is the default set-
ting.

All available detectors can be selected.
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Trace Mode Description

Max Hold The maximum value is determined over several measurements and displayed. The
R&S VSE saves the measurement result in the trace memory only if the new value is
greater than the previous one.

This mode is especially useful with modulated or pulsed signals. The signal spectrum
is filled up upon each measurement until all signal components are detected in a kind
of envelope.

This mode is not available for statistics measurements.

Min Hold The minimum value is determined from several measurements and displayed. The
R&S VSE saves the measurement result in the trace memory only if the new value is
lower than the previous one.

This mode is useful for example for making an unmodulated carrier in a composite
signal visible. Noise, interference signals or modulated signals are suppressed,
whereas a CW signal is recognized by its constant level.

This mode is not available for statistics measurements.

Average The average is formed over several measurements and displayed.

The Capture Count determines the number of averaging procedures.

This mode is not available for statistics measurements.

View The current contents of the trace memory are frozen and displayed.

If a trace is frozen ("View" mode), the measurement settings, apart from scaling set-
tings, can be changed without impact on the displayed trace. The fact that the dis-
played trace no longer matches the current measurement settings is indicated by a yel-
low asterisk  on the tab label.

If you change any parameters that have an effect on the scaling of the diagram axes,
the R&S VSE automatically adapts the trace data to the changed display range. This
allows you to zoom into the diagram after the measurement in order to show details of
the trace.

How Many Traces are Averaged - Capture Count + Measurement Mode

In "Average" trace mode, the capture count and measurement mode determine how
many traces are averaged. The more traces are averaged, the smoother the trace is
likely to become.

The algorithm for averaging traces depends on the measurement mode and capture
count.

● capture count = 0 (default)
– In "Continuous" measurement mode, a continuous average is calculated for

10 measurements, according to the following formula:

10
*9 MeasValueTraceTrace old 

Fig. 10-12: Equation 1

Due to the weighting between the current trace and the average trace, past val-
ues have practically no influence on the displayed trace after about ten mea-
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surements. With this setting, signal noise is effectively reduced without need for
restarting the averaging process after a change of the signal.

– In "Single" measurement mode, the current trace is averaged with the previ-
ously stored averaged trace. No averaging is carried out for the first measure-
ment but the measured value is stored in the trace memory. The next time a
measurement is performed, the trace average is calculated according to the fol-
lowing formula:

2
MeasValueTraceTrace old 

The averaged trace is then stored in the trace memory.
● capture count = 1

The currently measured trace is displayed and stored in the trace memory. No
averaging is performed.

● capture count > 1
For both "Single" measurement mode and "Continuous" measurement mode,
averaging takes place over the selected number of measurements. In this case the
displayed trace is determined during averaging according to the following formula:









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
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Trace

Fig. 10-13: Equation 2

where n is the number of the current measurement (n = 2 ... Capture Count).
No averaging is carried out for the first measurement but the measured value is
stored in the trace memory. With increasing n, the displayed trace is increasingly
smoothed since there are more individual measurements for averaging.
After the selected number of measurements the average trace is saved in the trace
memory. Until this number of measurements is reached, a preliminary average is
displayed. When the averaging length defined by the "Capture Count" is attained,
averaging is continued in continuous measurement mode or for "Continue Single
Measurement" according to the following formula:

N
MeasValueTraceNTrace old 


*)1(

where N is the capture count

How Trace Data is Averaged - the Averaging Mode

When the trace is averaged over several sweeps (Trace mode: "Average"), different
methods are available to determine the trace average.

With logarithmic averaging, the dB values of the display voltage are averaged or sub-
stracted from each other with trace mathematical functions.

With linear averaging, the level values in dB are converted into linear voltages or pow-
ers prior to averaging. Voltage or power values are averaged or offset against each
other and reconverted into level values.

For stationary signals the two methods yield the same result.
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Logarithmic averaging is recommended if sinewave signals are to be clearly visible
against noise since with this type of averaging noise suppression is improved while the
sinewave signals remain unchanged.

For noise or pseudo-noise signals the positive peak amplitudes are decreased in loga-
rithmic averaging due to the characteristic involved and the negative peak values are
increased relative to the average value. If the distorted amplitude distribution is aver-
aged, a value is obtained that is smaller than the actual average value. The difference
is -2.5 dB.

This low average value is usually corrected in noise power measurements by a 2.5 dB
factor. Therefore the R&S VSE offers the selection of linear averaging. The trace data
is linearized prior to averaging, then averaged and logarithmized again for display on
the screen. The average value is always displayed correctly irrespective of the signal
characteristic.

Working with Spectrograms

In addition to the standard "level versus frequency" or "level versus time" traces, the
I/Q Analyzer also provides a spectrogram display of the measured data. A special fea-
ture of the R&S VSE software is that it provides spectrograms for applications based
on I/Q data, such as the I/Q Analyzer and the Analog Demodulation application.

A spectrogram shows how the spectral density of a signal varies over time. The x-axis
shows the frequency, the y-axis shows the time. A third dimension, the power level, is
indicated by different colors. Thus you can see how the strength of the signal varies
over time for different frequencies.

Analysis



I/Q Analyzer MeasurementsR&S®VSE

170User Manual 1176.8839.02 ─ 03

Example: 

In this example you see the spectrogram for the calibration signal of an R&S FSW,
compared to the standard spectrum display. Since the signal does not change over
time, the color of the frequency levels does not change over time, i.e. vertically. The
legend above the spectrogram display describes the power levels the colors represent.

Spectrogram based on specific trace
The R&S VSE software allows you to define which trace of a particular result display
the Spectrogram is calculated from, if multiple traces are available. For example, if a
Spectrum is displayed with a Maxhold, a Minhold and an Average trace, you can acti-
vate a Spectrogram that displays the maximum, minimum, or average power levels
over time and frequency.

Result display

The spectrogram result can consist of the following elements:

Analysis



I/Q Analyzer MeasurementsR&S®VSE

171User Manual 1176.8839.02 ─ 03

1

2

8

5

4

7
6 6

3

7

Fig. 10-14: Display elements for a result display with a spectrogram subwindow

1 = Main result display (in this case: Spectrum)
2 = Marker info with frame number
3 = Spectrogram subwindow title with trace information
4 = Color map
5 = Spectrogram subwindow
6 = Current frame indicators
7 = Deltamarker in Spectrogram and Spectrum displays
8 = Current frame number

For more information about spectrogram configuration see "Spectrogram Settings"
on page 178.

Remote commands:

Activating and configuring spectrograms:

chapter 13.6.2.2, "Configuring Spectrograms", on page 349

Storing results:

MMEMory:STORe<n>:SPECtrogram on page 406

● Time Frames.........................................................................................................171
● Color Maps............................................................................................................172

Time Frames

The time information in the spectrogram is displayed vertically, along the y-axis. Each
line (or trace) of the y-axis represents one or more captured measurement and is
called a time frame or simply "frame". As with standard spectrum traces, several mea-
sured values are combined in one measurement point using the selected detector.

(See "Mapping Samples to measurement Points with the Trace Detector"
on page 164).
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Frames are sorted in chronological order, beginning with the most recently recorded
frame at the top of the diagram (frame number 0). With the next measurement, the pre-
vious frame is moved further down in the diagram, until the maximum number of cap-
tured frames is reached. The display is updated continuously during the measurement,
and the measured trace data is stored. Spectrogram displays are continued even after
single measurements unless they are cleared manually.

The maximum number of frames that you can capture depends on the number of mea-
surement points that are analyzed during the measurement.

The scaling of the time axis (y-axis) is not configurable. However, you can enlarge the
spectrogram display to the full window size using the State: "Full".

Displaying individual frames

The spectrogram diagram contains all stored frames since it was last cleared. Arrows
on the left and right border of the spectrogram indicate the currently selected frame.
The spectrum diagram always displays the spectrum for the currently selected frame.

The current frame number is indicated in the diagram footer. The current frame, dis-
played at the top of the diagram, is frame number 0. Older frames further down in the
diagram are indicated by a negative index, e.g."-10". You can display the spectrum dia-
gram of a previous frame by changing the current frame number.

Color Maps

Spectrograms assign power levels to different colors in order to visualize them. The
legend above the spectrogram display describes the power levels the colors represent.

The color display is highly configurable to adapt the spectrograms to your needs. You
can define:

● Which colors to use (Color scheme)
● Which value range to apply the color scheme to
● How the colors are distributed within the value range, i.e where the focus of the vis-

ualization lies (shape of the color curve)

The individual colors are assigned to the power levels automatically by the R&S VSE.

The Color Scheme

You can select which colors are assigned to the measured values. Four different color
ranges or "schemes" are available:

● Hot

Uses a color range from blue to red. Blue colors indicate low levels, red colors indi-
cate high ones.

● Cold
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Uses a color range from red to blue. Red colors indicate low levels, blue colors
indicate high ones.
The "Cold" color scheme is the inverse "Hot" color scheme.

● Radar

Uses a color range from black over green to light turquoise with shades of green in
between. Dark colors indicate low levels, light colors indicate high ones.

● Grayscale

Shows the results in shades of gray. Dark gray indicates low levels, light gray indi-
cates high ones.

The Value Range of the Color Map

If the measured values only cover a small area in the spectrogram, you can optimize
the displayed value range so it becomes easier to distinguish between values that are
close together, and only parts of interest are displayed at all.

The Shape and Focus of the Color Curve

The color mapping function assigns a specified color to a specified power level in the
spectrogram display. By default, colors on the color map are distributed evenly. How-
ever, if a certain area of the value range is to be visualized in greater detail than the
rest, you can set the focus of the color mapping to that area. Changing the focus is
performed by changing the shape of the color curve.

The color curve is a tool to shift the focus of the color distribution on the color map. By
default, the color curve is linear. If you shift the curve to the left or right, the distribution
becomes non-linear. The slope of the color curve increases or decreases. One end of
the color palette then covers a large amount of results, while the other end distributes
several colors over a relatively small result range.

You can use this feature to put the focus on a particular region in the diagram and to
be able to detect small variations of the signal.
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Example: 

Fig. 10-15: Linear color curve shape = 0; colors are distributed evenly over the complete result range

In the color map based on the linear color curve, the range from -105.5 dBm to -60
dBm is covered by blue and a few shades of green only. The range from -60 dBm to
-20 dBm is covered by red, yellow and a few shades of green.

Fig. 10-16: Spectrogram with default color curve

The sample spectrogram is dominated by blue and green colors. After shifting the color
curve to the left (negative value), more colors cover the range from -105.5 dBm to -60
dBm (blue, green and yellow), which occurs more often in the example. The range
from -60 dBm to -20 dBm, on the other hand, is dominated by various shades of red
only.

Fig. 10-17: Non-linear color curve shape = -0.5

Fig. 10-18: Spectrogram with shifted color curve

10.4.1.2 Trace Configuration

or: "Trace"

Trace configuration includes the following settings and functions:

● Trace Settings.......................................................................................................174
● Spectrogram Settings............................................................................................178

Trace Settings

Access: "Overview" > "Analysis" > "Traces"
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or: "Trace" > "Trace"

You can configure the settings for up to 6 individual traces.

For I/Q Vector evaluation mode, only 1 trace is available and the detector is not edita-
ble.

Trace 1/Trace 2/Trace 3/Trace 4/Trace 5/Trace 6...................................................... 175
Trace Mode................................................................................................................. 175
Detector.......................................................................................................................176
Hold.............................................................................................................................176
Average Mode.............................................................................................................177
Average Count............................................................................................................ 177
Predefined Trace Settings - Quick Config...................................................................177
Copy Trace..................................................................................................................178

Trace 1/Trace 2/Trace 3/Trace 4/Trace 5/Trace 6
Selects the corresponding trace for configuration. The currently selected trace is high-
lighted.

"How to Configure a Standard Trace" on page 182

Remote command: 
Selected via numeric suffix of:TRACe<1...6> commands
DISPlay[:WINDow<n>]:TRACe<t>[:STATe] on page 346

Trace Mode
Defines the update mode for subsequent traces.

For details see "Analyzing Several Traces - Trace Mode" on page 166.
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"Clear Write" Overwrite mode: the trace is overwritten by each measurement. This
is the default setting.
The "Detector" is automatically set to "Auto Peak".

"Max Hold" The maximum value is determined over several measurements and
displayed. The R&S VSE saves each trace point in the trace memory
only if the new value is greater than the previous one.
The "Detector" is automatically set to "Positive Peak".
This mode is not available for statistics measurements.

"Min Hold" The minimum value is determined from several measurements and
displayed. The R&S VSE saves each trace point in the trace memory
only if the new value is lower than the previous one.
The "Detector" is automatically set to "Negative Peak".
This mode is not available for statistics measurements.

"Average" The average is formed over several measurements.
The Capture Count determines the number of averaging procedures.
The "Detector" is automatically set to "Sample".
This mode is not available for statistics measurements.

"View" The current contents of the trace memory are frozen and displayed.

"Blank" Removes the selected trace from the display.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:MODE on page 345

Detector
Defines the trace detector to be used for trace analysis.

For details see "Mapping Samples to measurement Points with the Trace Detector"
on page 164.

The trace detector is used to combine multiple FFT window results to create the final
spectrum. (Note: in previous versions of the R&S VSE, the I/Q Analyzer always used
the linear average detector.) If necessary, the trace detector is also used to reduce the
number of calculated frequency points (defined by the FFT length) to the defined num-
ber of measurement points. By default, the Autopeak trace detector is used.

"Auto" Selects the optimum detector for the selected trace and filter mode.
This is the default setting.

"Type" Defines the selected detector type.

Remote command: 
[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion] on page 347
[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion]:AUTO on page 347

Hold
If activated, traces in "Min Hold", "Max Hold" and "Average" mode are not reset after
specific parameter changes have been made.

Normally, the measurement is started again after parameter changes, before the mea-
surement results are analyzed (e.g. using a marker). In all cases that require a new
measurement after parameter changes, the trace is reset automatically to avoid false
results (e.g. with span changes). For applications that require no reset after parameter
changes, the automatic reset can be switched off.
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The default setting is off.

Remote command: 
DISPlay[:WINDow<n>]:TRACe<t>:MODE:HCONtinuous on page 346

Average Mode
Defines the mode with which the trace is averaged over several measurements. A dif-
ferent averaging mode can be defined for each trace.

This setting is only applicable if trace mode "Average" is selected.

The Capture Count determines the number of averaging procedures.

For details see "How Trace Data is Averaged - the Averaging Mode" on page 168.

"Linear" The power level values are converted into linear units prior to averag-
ing. After the averaging, the data is converted back into its original
unit.

"Logarithmic" For logarithmic scaling, the values are averaged in dBm. For linear
scaling, the behavior is the same as with linear averaging.

"Power" Activates linear power averaging.
The power level values are converted into unit Watt prior to averag-
ing. After the averaging, the data is converted back into its original
unit.
Use this mode to average power values in Volts or Amperes cor-
rectly.

Remote command: 
[SENSe:]AVERage<n>:TYPE on page 347

Average Count
Determines the number of averaging or maximum search procedures If the trace
modes "Average", "Max Hold" or "Min Hold" are set.

In continuous measurement mode, if capture count = 0 (default), averaging is per-
formed over 10 measurements. For capture count =1, no averaging, maxhold or min-
hold operations are performed.

This value is identical to the Capture Count setting in the "Capture" settings.

Remote command: 
[SENSe:]AVERage<n>:COUNt on page 348
TRACe:IQ:AVERage:COUNt on page 348

Predefined Trace Settings - Quick Config
Commonly required trace settings have been predefined and can be applied very
quickly by selecting the appropriate button.

Function Trace Settings

Preset All Traces Trace 1: Clear Write

Auto Detector (Auto Peak)

Traces 2-6: Blank

Auto Detector
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Function Trace Settings

Set Trace Mode

Max | Avg | Min

Trace 1: Max Hold

Auto Detector (Positive Peak)

Trace 2: Average

Auto Detector (Sample)

Trace 3: Min Hold

Auto Detector (Negative Peak)

Traces 4-6: Blank

Auto Detector

Set Trace Mode

Max | ClrWrite | Min

Trace 1: Max Hold

Auto Detector (Positive Peak)

Trace 2: Clear Write

Auto Detector (Auto Peak)

Trace 3: Min Hold

Auto Detector (Negative Peak)

Traces 4-6: Blank

Auto Detector

Copy Trace
Access: "Overview" > "Analysis" > "Traces" > "Copy Trace"

or: "Trace" > "Copy Trace"

Copies trace data to another trace.

The first group of buttons (labelled "Trace 1" to "Trace 6") select the source trace. The
second group of buttons (labelled "Copy to Trace 1" to "Copy to Trace 6") select the
destination.

Remote command: 
TRACe<n>:COPY on page 348

Spectrogram Settings

Access: "Overview" > "Analysis" > "Traces" > "Spectrogram"

or: "Trace" > Spectrogram

The individual settings available for spectrogram display are described here. For set-
tings on color mapping, see "Color Map Settings" on page 180.

Settings concerning the frames and how they are handled during a measurement are
provided as additional capture settings for spectrogram display, see chapter 10.3.6.2,
"Capture Settings", on page 159.

For background information see also "Working with Spectrograms" on page 169.

● General Spectrogram Settings..............................................................................179
● Color Map Settings................................................................................................180
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General Spectrogram Settings

Access: "Overview" > "Analysis" > "Traces" > "Spectrogram"

or: "Trace" > "Spectrogram"

This section describes general settings for spectrogram display.

State............................................................................................................................179
Selecting a frame to display........................................................................................ 179
History Depth.............................................................................................................. 180
Color Mapping.............................................................................................................180
Clear Spectrogram...................................................................................................... 180

State
Activates and deactivates a Spectrogram subwindow.

"Split" Displays the Spectrogram as a subwindow in the original result dis-
play.

"Full" Displays the Spectrogram in a subwindow in the full size of the origi-
nal result display.

"Off" Closes the Spectrogram subwindow.

Remote command: 
CALCulate<n>:SPECtrogram[:STATe] on page 351

Selecting a frame to display
Selects a specific frame, loads the corresponding trace from the memory, and displays
it in the Spectrum window.

Note that activating a marker or changing the position of the active marker automati-
cally selects the frame that belongs to that marker.

This function is only available in single sweep mode or if the sweep is stopped, and
only if a spectrogram is selected.

The most recent frame is number 0, all previous frames have a negative number.
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For more details see "Time Frames" on page 171.

Remote command: 
CALCulate<n>:SPECtrogram:FRAMe:SELect on page 351

History Depth
Sets the number of frames that the R&S VSE stores in its memory.

If the memory is full, the R&S VSE deletes the oldest frames stored in the memory and
replaces them with the new data.

Remote command: 
CALCulate<n>:SPECtrogram:HDEPth on page 351

Color Mapping
Opens the "Color Map" dialog.

For details see "Color Maps" on page 172.

Clear Spectrogram
Resets the spectrogram result display and clears the history buffer.

This function is only available if a spectrogram is selected.

Remote command: 
CALCulate<n>:SPECtrogram:CLEar[:IMMediate] on page 350

Color Map Settings

Access: "Overview" > "Analysis" > "Traces" > "Color Mapping"

or: "Trace" > "Spectrogram" > "Color Mapping"

For more information on color maps see "Color Maps" on page 172.

In addition to the available color settings, the dialog box displays the current color map
and provides a preview of the display with the current settings.
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Fig. 10-19: Color Mapping dialog box

1 = Color map: shows the current color distribution
2 = Preview pane: shows a preview of the spectrogram with any changes that you make to the color

scheme
3 = Color curve pane: graphical representation of all settings available to customize the color scheme
4/5 = Color range start and stop sliders: define the range of the color map or amplitudes for the spectrogram
6 = Color curve slider: adjusts the focus of the color curve
7 = Histogram: shows the distribution of measured values
8 = Scale of the horizontal axis (value range)

Start / Stop
Defines the lower and upper boundaries of the value range of the spectrogram.

Remote command: 
DISPlay[:WINDow<n>]:SPECtrogram:COLor:LOWer on page 352
DISPlay[:WINDow<n>]:SPECtrogram:COLor:UPPer on page 353

Shape
Defines the shape and focus of the color curve for the spectrogram result display.

"-1 to <0" More colors are distributed among the lower values

"0" Colors are distributed linearly among the values

">0 to 1" More colors are distributed among the higher values

Remote command: 
DISPlay[:WINDow<n>]:SPECtrogram:COLor:SHAPe on page 353
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Hot/Cold/Radar/Grayscale
Sets the color scheme for the spectrogram.

Remote command: 
DISPlay[:WINDow<n>]:SPECtrogram:COLor[:STYLe] on page 353

Auto
Defines the color range automatically according to the existing measured values for
optimized display.

Set to Default
Sets the color mapping to the default settings.

Remote command: 
DISPlay[:WINDow<n>]:SPECtrogram:COLor:DEFault on page 352

10.4.1.3 How to Configure Traces

The following step-by-step procedures describe the following tasks:

● How to Configure a Standard Trace......................................................................182
● How to Display and Configure a Spectrogram......................................................183
● How to Copy Traces..............................................................................................187

How to Configure a Standard Trace

Step-by-step instructions on configuring the trace settings are provided here. For
details on individual functions and settings see "Trace Settings" on page 174.

Trace settings are configured in the "Traces" dialog box.

To display the "Traces" dialog box, do one of the following:
● Select "Analysis" from the "Overview", then select the "Traces" tab.
● Select the "Trace > Trace" menu item.

1. For each trace, select the "Trace Mode" and "Trace Detector". Traces with the
trace mode "Blank" are not displayed.

2. To configure several traces to predefined display modes in one step, press the but-
ton for the required function:

● "Preset All Traces"
● "Set Trace Mode Avg | Max | Min"
● "Set Trace Mode Max | ClrWrite | Min"

For details see "Trace Settings" on page 174.

3. For "Average" trace mode, define the number of measurements to be averaged in
the "Count" field.

4. If linear scaling is used, select the "Average Mode: Linear".
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5. To improve the trace stability, increase the number of "Measurement Points" or the
"Measurement Time" (in the "Capture" settings).

All configured traces (not set to "Blank") are displayed after the next measurement.

How to Copy Traces

1. A trace copy function is provided in a separate tab of the "Traces" dialog box. To
display this tab do one of the following:

● Select "Analysis" from the "Overview", then select the "Trace Copy" tab.
● Select the "Trace > Copy Trace" menu item.

2. Select the "Source" trace to be copied.

3. Select the "Copy to trace..." button for the trace to which the settings are to be
applied.

The settings from the source trace are applied to the destination trace. The newly
configured trace (if not set to "Blank") is displayed after the next measurement.

How to Display and Configure a Spectrogram

Step-by-step instructions on how to display and configure a spectrogram are provided
here. For details on individual functions and settings see "Spectrogram Settings"
on page 178.

The remote commands required to perform these tasks are described in chap-
ter 13.6.2.2, "Configuring Spectrograms", on page 349.

The following tasks are described here:

● "To display a spectrogram" on page 183
● "To remove the spectrogram display" on page 184
● "To set a marker in the spectrogram" on page 184
● "To configure a spectrogram" on page 184
● "To select a color scheme" on page 185
● "To set the value range graphically using the color range sliders" on page 185
● "To set the value range numerically" on page 186
● "To set the color curve shape graphically using the slider" on page 187
● "To set the color curve shape numerically" on page 187

To display a spectrogram

1. Select a Magnitude or Spectrum result display.

2. From the "Trace" menu, select "Spectrogram".

The Spectrogram is automatically displayed as a subwindow of the selected result
display, where each subwindow is the same size.

3. To enlarge the Spectrogram to the full window size, select "State: Full".

4. To clear an existing spectrogram display, select "Clear Spectrogram".
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5. Close the dialog box.

The spectrogram is updated continuously with each new capture.

To display the Spectrum or Magnitude diagram for a specific time frame:

1. Stop the continuous measurement or wait until the single capture is completed.

2. Select the frame number in the diagram footer of the Spectrogram.

3. Enter the required frame number in the edit dialog box.
Note that the most recent sweep is frame number 0, all previous frames have neg-
ative numbers.

To remove the spectrogram display

1. Select the result display that contains the Spectrogram subwindow.

2. From the "Trace" menu, select "Spectrogram".

3. Select "State: Off"

The Spectrogram subwindow is closed, and the original result display is restored in
full window size.

To set a marker in the spectrogram

1. While a spectrogram is displayed, select the  "Place Next Marker" icon in the
"Marker" toolbar.

2. Select a "Marker" softkey.

3. Enter the frequency or time (x-value) of the marker or delta marker.

4. Enter the frame number for which the marker is to be set, for example 0 for the cur-
rent frame, or -2 for the second to last frame. Note that the frame number is always
0 or a negative value!
The marker is only visible in the spectrum diagram if it is defined for the currently
selected frame. In the spectrogram result display all markers are visible that are
positioned on a visible frame.

To configure a spectrogram

1. Configure the spectrogram frames:

a) From the Meas Setup menu, select "Capture".
b) In the "Capture Count" field, define how many captures are to be analyzed to

create a single frame.
c) In the "Frame Count" field, define how many frames are to be plotted during a

single measurement.
d) To include frames from previous measurements in the analysis of the new

frame (for "Max Hold", "Min Hold" and "Average" trace modes only), select
"Continue Frame" = "ON".

2. Define how many frames are to be stored in total:
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a) From the "Trace" menu, select "Spectrogram".
b) In the "History Depth" field, enter the maximum number of frames to store.

3. If necessary, adapt the color mapping for the spectrogram to a different value
range or color scheme as described in "How to Configure the Color Mapping"
on page 185.

How to Configure the Color Mapping

The color display is highly configurable to adapt the spectrograms to your needs.

The settings for color mapping are defined in the "Color Mapping" dialog box. To dis-
play this dialog box, do one of the following:

● Select the color map in the spectrogram display.
● From the "Trace" menu, select "Spectrogram", then select "Color Mapping", or

switch to the "Color Mapping" tab directly.

To select a color scheme

You can select which colors are assigned to the measured values.

► In the "Color Mapping" dialog box, select the option for the color scheme to be
used.

Editing the value range of the color map

The distribution of the measured values is displayed as a histogram in the "Color Map-
ping" dialog box. To cover the entire measurement value range, make sure the first
and last bar of the histogram are included.

To ignore noise in a spectrogram, for example, exclude the lower power levels from the
histogram.

The value range of the color map must cover at least 10% of the value range on the
horizontal axis of the diagram, that means, the difference between the start and stop
values must be at least 10%.

The value range can be set numerically or graphically.

To set the value range graphically using the color range sliders

1. Select and drag the bottom color curve slider (indicated by a gray box at the left of
the color curve pane) to the lowest value you want to include in the color mapping.
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2. Select and drag the top color curve slider (indicated by a gray box at the right of
the color curve pane) to the highest value you want to include in the color mapping.

To set the value range numerically

1. In the "Start" field, enter the percentage from the left border of the histogram that
marks the beginning of the value range.

2. In the "Stop" field, enter the percentage from the right border of the histogram that
marks the end of the value range.

Example: 
The color map starts at -100 dBm and ends at 0 dBm (i.e. a range of 100 dB). In order
to suppress the noise, you only want the color map to start at -90 dBm. Thus, you enter
10% in the "Start" field. The R&S VSE shifts the start point 10% to the right, to
-90 dBm.

Adjusting the reference level and level range
Note that changing the reference level and level range of the measurement also affects
the color mapping in the spectrogram.

Editing the shape of the color curve

The color curve is a tool to shift the focus of the color distribution on the color map. By
default, the color curve is linear, i.e. the colors on the color map are distributed evenly.
If you shift the curve to the left or right, the distribution becomes non-linear. The slope
of the color curve increases or decreases. One end of the color palette then covers a
large amount of results, while the other end distributes several colors over a relatively
small result range.

The color curve shape can be set numerically or graphically.
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To set the color curve shape graphically using the slider

► Select and drag the color curve shape slider (indicated by a gray box in the middle
of the color curve) to the left or right. The area beneath the slider is focussed, i.e.
more colors are distributed there.

To set the color curve shape numerically

► In the "Shape" field, enter a value to change the shape of the curve:

● A negative value (-1 to <0) focusses the lower values
● 0 defines a linear distribution
● A positive value (>0 to 1) focusses the higher values

How to Copy Traces

You can copy the trace settings from one trace to another in the "Copy Trace" tab of
the "Traces" dialog box.

► Select the "Source" trace and then the button for the "Copy to" trace.

Remote command:

TRACe<n>:COPY on page 348

10.4.2 Marker Usage

The following marker settings and functions are available in the I/Q Analyzer applica-
tion.

Marker settings are window-specific.
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For "I/Q Vector" displays markers are not available.

In the I/Q Analyzer application, the resolution with which the frequency can be mea-
sured with a marker depends on the filter bandwidth, which is derived from the defined
sample rate, as well as the number of measurement points and the used detector (see
chapter 10.2.3.1, "Frequency Resolution of FFT Results - RBW", on page 120).

● Basics on Markers and Marker Functions.............................................................188
● Marker Settings.....................................................................................................193
● Marker Search Settings and Positioning Functions.............................................. 198
● Band Power Marker.............................................................................................. 206
● Deactivating All Marker Functions.........................................................................207

10.4.2.1 Basics on Markers and Marker Functions

Some background knowledge on marker settings and functions is provided here for a
better understanding of the required configuration settings.

Markers are used to mark points on traces, to read out measurement results and to
select a display section quickly. R&S VSE provides 16 markers per display window.

● The easiest way to work with markers is using a mouse. Simply drag the marker
and drop it at the required position. When you select the marker label in the dis-
play, a vertical line is displayed which indicates the marker's current x-value.

● You can also set an active marker to a new position by defining its x-position
numerically. When you select a marker from the list in the "Marker" toolbar or from
the "Marker" menu, an edit dialog box is displayed.

● To select or set individual markers very quickly, use the functions in the "Marker"
menu or in the "Marker" toolbar.
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● To set up several markers at once, use the "Marker" dialog box (select  or
"Marker > Marker").

● To determine more sophisticated marker results, use the special functions in the
"Marker Function" dialog box (select "Marker > Marker Function").

● Marker Types........................................................................................................ 189
● Activating Markers.................................................................................................189
● Marker Results......................................................................................................189
● Searching for Signal Peaks...................................................................................190
● Measuring the Power in a Channel (Band)........................................................... 192
● Markers in the Spectrogram..................................................................................193

Marker Types

All markers can be used either as normal markers or delta markers. A normal marker
indicates the absolute signal value at the defined position in the diagram. A delta
marker indicates the value of the marker relative to the specified reference marker (by
default marker 1).

In addition, special functions can be assigned to the individual markers. The availability
of special marker functions depends on whether the measurement is performed in the
frequency or time domain, and on the type of measurement.

Temporary markers are used in addition to the markers and delta markers to analyze
the measurement results for special marker functions. They disappear when the asso-
ciated function is deactivated.

Activating Markers

Only active markers are displayed in the diagram and in the marker table.

Active markers are indicated by a checkmark in the marker selection lists.

By default, marker 1 is active and positioned on the maximum value (peak) of trace 1
as a normal marker. If several traces are displayed, the marker is set to the maximum
value of the trace which has the lowest number and is not frozen (View mode). The
next marker to be activated is set to the frequency of the next lower level (next peak)
as a delta marker; its value is indicated as an offset to marker 1.

A marker can only be activated when at least one trace in the corresponding window is
visible. If a trace is switched off, the corresponding markers and marker functions are
also deactivated. If the trace is switched on again, the markers along with coupled
functions are restored to their original positions, provided the markers have not been
used on another trace.

Marker Results

The results can be displayed directly within the diagram area or in a separate table. By
default, the first two active markers are displayed in the diagram area. If more markers
are activated, the results are displayed in a marker table.
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Marker information in diagram area

By default, the results of the last two markers or delta markers that were activated are
displayed in the diagram area.

The following information is displayed there:

● The marker type (M for normal, D for delta, or special function name)
● The marker number (1 to 16)
● The assigned trace number in square brackets [ ]
● The marker value on the y-axis, or the result of the marker function
● The marker position on the x-axis

Marker information in marker table

In addition to the marker information displayed within the diagram area, a separate
marker table may be displayed beneath the diagram. This table provides the following
information for all active markers:

Table 10-4: Contents of the marker table in the I/Q Analyzer application

Wnd Window within the application

Type Marker type: N (normal), D (delta), T (temporary, internal) and number

Ref Reference marker for delta markers

Trc Trace to which the marker is assigned

Frame Spectrogram frame the marker is positioned in. Displayed only when the Spectro-
gram is displayed.

X-value X-value of the marker

Y-value Y-value of the marker

Function Activated marker or measurement function

Function Result Result of the active marker or measurement function

Searching for Signal Peaks

A common measurement task is to determine peak values, i.e. maximum or minimum
signal levels. The R&S VSE provides various peak search functions and applications:

● Setting a marker to a peak value once (Peak Search)
● Searching for a peak value within a restricted search area (Search Limits)
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Peak search limits

The peak search can be restricted to a search area. The search area is defined by limit
lines which are also indicated in the diagram. In addition, a minimum value (threshold)
can be defined as a further search condition.

When is a peak a peak? - Peak excursion

During a peak search, for example when a marker peak table is displayed, noise val-
ues may be detected as a peak if the signal is very flat or does not contain many
peaks. Therefore, you can define a relative threshold ("Peak excursion"). The signal
level must increase by the threshold value before falling again before a peak is detec-
ted. To avoid identifying noise peaks as maxima or minima, enter a peak excursion
value that is higher than the difference between the highest and the lowest value mea-
sured for the displayed inherent noise.

Effect of peak excursion settings (example)

The following figure shows a trace to be analyzed.

Fig. 10-20: Trace example

The following table lists the peaks as indicated by the marker numbers in the diagram
above, as well as the minimum decrease in amplitude to either side of the peak:

Marker # Min. amplitude decrease to either side of the signal

1 30 dB

2 29.85 dB

3 20 dB

4 10 dB

5 18 dB
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In order to eliminate the smaller peaks M3,M4 and M5 in the example above, a peak
excursion of at least 20 dB is required. In this case, the amplitude must rise at least 20
dB before falling again before a peak is detected.

Measuring the Power in a Channel (Band)

To determine the noise power in a transmission channel, you could use a noise marker
and multiply the result with the channel bandwidth. However, the results would only be
accurate for flat noise.

Band power markers allow you to measure the integrated power for a defined span
(band) around a marker (similar to ACP measurements). By default, 5 % of the current
span is used. The span is indicated by limit lines in the diagram. The results can be
displayed either as a power (dBm) or density (dBm/Hz) value and are indicated in the
marker table for each band power marker.

Band power markers are only available for result displays in the frequency domain.
The entire band must lie within the display. If it is moved out of the display, the result
cannot be calculated (indicated by "- - -" as the "Function Result"). However, the width
of the band is maintained so that the band power can be calculated again when it
returns to the display.

All markers can be defined as band power markers, each with a different span. When a
band power marker is activated, if no marker is active yet, marker 1 is activated. Other-
wise, the currently active marker is used as a band power marker (all other marker
functions for this marker are deactivated).

If the detector mode for the marker trace is set to "Auto", the RMS detector is used.
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Remote commands:

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer[:STATe] on page 376

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:RESult? on page 376

Markers in the Spectrogram

Markers and delta markers are shaped like diamonds in the spectrogram. They are
only displayed in the spectrogram if the marker position is inside the visible area of the
spectrogram. If more than two markers are active, the marker values are displayed in a
separate marker table.

In the spectrum result display, the markers and their frequency and level values (1) are
displayed as usual. Additionally, the frame number is displayed to indicate the position
of the marker in time (2).

In the spectrogram result display, you can activate up to 16 markers or delta markers
at the same time. Each marker can be assigned to a different frame. Therefore, in
addition to the frequency you also define the frame number when activating a new
marker. If no frame number is specified, the marker is positioned on the currently
selected frame. All markers are visible that are positioned on a visible frame. Special
search functions are provided for spectrogram markers.

In the spectrum result display, only the markers positioned on the currently selected
frame are visible. In "Continuous Sweep" mode this means that only markers posi-
tioned on frame 0 are visible. To view markers that are positioned on a frame other
than frame 0 in the spectrum result display, you must stop the measurement and select
the corresponding frame.

10.4.2.2 Marker Settings

or: "Marker" > "Marker"

The remote commands required to define these settings are described in "Setting Up
Individual Markers" on page 354.

● Individual Marker Setup........................................................................................ 193
● General Marker Settings....................................................................................... 197

Individual Marker Setup

Up to 17 markers or delta markers can be activated for each window simultaneously.
Initial marker setup is performed using the "Marker" dialog box.
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The markers are distributed among 3 tabs for a better overview. By default, the first
marker is defined as a normal marker, whereas all others are defined as delta markers
with reference to the first marker. All markers are assigned to trace 1, but only the first
marker is active.

 Place New Marker..................................................................................................194
 Marker 1/ Delta 1/ Delta 2/.../Delta 16.................................................................195

Selected Marker.......................................................................................................... 195
Marker State................................................................................................................195
Marker Position (X-value)............................................................................................195
Frame (Spectrogram only).......................................................................................... 196
Marker Type................................................................................................................ 196
Reference Marker....................................................................................................... 196
Linking to Another Marker........................................................................................... 196
Assigning the Marker to a Trace................................................................................. 196
Select Marker.............................................................................................................. 197
All Markers Off............................................................................................................ 197

 Place New Marker
Activates the next currently unused marker and sets it to the peak value of the current
trace in the current window.

If a spectrogram is active, an edit field is displayed for the frame number (≤ 0) in which
the marker is to be placed.

Analysis



I/Q Analyzer MeasurementsR&S®VSE

195User Manual 1176.8839.02 ─ 03

 Marker 1/ Delta 1/ Delta 2/.../Delta 16
When you select the arrow on the marker selection list in the toolbar, or select a
marker from the "Marker > Select Marker" menu, the marker is activated and an edit
dialog box is displayed to enter the marker position ("X-value").

If a spectrogram is active, the frame number (≤ 0) in which the marker is to be placed
can also be defined.

To deactivate a marker, select the marker name in the marker selection list in the tool-
bar (not the arrow) to display the "Select Marker" dialog box. Change the "State" to
"Off".

Marker 1 is always the default reference marker for relative measurements. If activa-
ted, markers 2 to 16 are delta markers that refer to marker 1. These markers can be
converted into markers with absolute value display using the "Marker Type" function.

Several markers can be configured very easily using the "Marker" dialog box, see
chapter 10.4.2.2, "Marker Settings", on page 193.

Remote command: 
CALCulate<n>:MARKer<m>[:STATe] on page 357
CALCulate<n>:MARKer<m>:X on page 358
CALCulate<n>:MARKer<m>:Y? on page 386
CALCulate<n>:DELTamarker<m>[:STATe] on page 356
CALCulate<n>:DELTamarker<m>:X on page 356
CALCulate<n>:DELTamarker<m>:X:RELative? on page 385
CALCulate<n>:DELTamarker<m>:Y? on page 386
For spectrogram display:
CALCulate<n>:DELTamarker<m>:SPECtrogram:FRAMe on page 364
CALCulate<n>:MARKer<m>:SPECtrogram:FRAMe on page 360

Selected Marker
Marker name. The marker which is currently selected for editing is highlighted orange.

Remote command: 
Marker selected via suffix <m> in remote commands.

Marker State
Activates or deactivates the marker in the diagram.

Remote command: 
CALCulate<n>:MARKer<m>[:STATe] on page 357
CALCulate<n>:DELTamarker<m>[:STATe] on page 356

Marker Position (X-value)
Defines the position (x-value) of the marker in the diagram.

Remote command: 
CALCulate<n>:MARKer<m>:X on page 358
CALCulate<n>:DELTamarker<m>:X on page 356
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Frame (Spectrogram only)
Spectrogram frame the marker is assigned to.

Remote command: 
CALCulate<n>:MARKer<m>:SPECtrogram:FRAMe on page 360
CALCulate<n>:DELTamarker<m>:SPECtrogram:FRAMe on page 364

Marker Type

Toggles the marker type.

The type for marker 1 is always "Normal", the type for delta marker 1 is always "Delta".
These types cannot be changed.

Note: If normal marker 1 is the active marker, switching the "Mkr Type" activates an
additional delta marker 1. For any other marker, switching the marker type does not
activate an additional marker, it only switches the type of the selected marker.

"Normal" A normal marker indicates the absolute value at the defined position
in the diagram.

"Delta" A delta marker defines the value of the marker relative to the speci-
fied reference marker (marker 1 by default).

Remote command: 
CALCulate<n>:MARKer<m>[:STATe] on page 357
CALCulate<n>:DELTamarker<m>[:STATe] on page 356

Reference Marker
Defines a marker as the reference marker which is used to determine relative analysis
results (delta marker values).

Remote command: 
CALCulate<n>:DELTamarker<m>:MREF on page 356

Linking to Another Marker
Links the current marker to the marker selected from the list of active markers. If the x-
axis value of the inital marker is changed, the linked marker follows on the same x-
position. Linking is off by default.

Using this function you can set two markers on different traces to measure the differ-
ence (e.g. between a max hold trace and a min hold trace or between a measurement
and a reference trace).

Remote command: 
CALCulate<n>:MARKer<m>:LINK:TO:MARKer<m> on page 357
CALCulate<n>:DELTamarker<m>:LINK:TO:MARKer<m> on page 355
CALCulate<n>:DELTamarker<m>:LINK on page 355

Assigning the Marker to a Trace
The "Trace" setting assigns the selected marker to an active trace. The trace deter-
mines which value the marker shows at the marker position. If the marker was previ-
ously assigned to a different trace, the marker remains on the previous frequency or
time, but indicates the value of the new trace.
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The marker can also be assigned to the currently active trace using the "Marker >
Marker to Trace" menu item.

If a trace is turned off, the assigned markers and marker functions are also deactiva-
ted.

Remote command: 
CALCulate<n>:MARKer<m>:TRACe on page 358

Select Marker

The "Select Marker" function opens a dialog box to select and activate or deactivate
one or more markers quickly.

Remote command: 
Marker selected via suffix <m> in remote commands.

All Markers Off

Deactivates all markers in one step.

Remote command: 
CALCulate<n>:MARKer<m>:AOFF on page 357

General Marker Settings

Some general marker settings allow you to influence the marker behavior for all mark-
ers.
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Marker Table Display.................................................................................................. 198
Marker Stepsize.......................................................................................................... 198

Marker Table Display
Defines how the marker information is displayed.

"On" Displays the marker information in a table in a separate area beneath
the diagram.

"Off" Displays the marker information within the diagram area.

"Auto" (Default) Up to two markers are displayed in the diagram area. If
more markers are active, the marker table is displayed automatically.

Remote command: 
DISPlay:MTABle on page 359

Marker Stepsize
Defines the size of the steps that the marker position is moved using the mouse wheel.

"Standard" The marker position is moved in (Span/1000) steps, which corre-
sponds approximately to the number of pixels for the default display
of 1001 measurement points. This setting is most suitable to move
the marker over a larger distance.

"Points" The marker position is moved from one measurement point to the
next. This setting is required for a very precise positioning if more
measurement points are collected than the number of pixels that can
be displayed on the screen. It is the default mode.

Remote command: 
CALCulate<n>:MARKer<m>:X:SSIZe on page 359

10.4.2.3 Marker Search Settings and Positioning Functions

Access: "Overview" > "Analysis" > "Marker" > "Search"

or: "Marker" > "Search"

Several functions are available to set the marker to a specific position very quickly and
easily, or to use the current marker position to define another characteristic value. In
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order to determine the required marker position, searches may be performed. The
search results can be influenced by special settings.

In I/Q Analyzer mode, the search settings for "Real/Imag (I/Q)" evaluation include an
additional parameter, see "Branch for Peak Search" on page 201.

● Marker Search Settings.........................................................................................199
● Marker Search Settings for Spectrograms............................................................201
● Positioning Functions............................................................................................204

Marker Search Settings

Access: "Overview" > "Analysis" > "Markers" > "Search Settings"

or: "Marker" > "Search"

Markers are commonly used to determine peak values, i.e. maximum or minimum val-
ues, in the measured signal. Configuration settings allow you to influence the peak
search results.

Search Mode for Next Peak........................................................................................ 199
Exclude LO..................................................................................................................200
Peak Excursion........................................................................................................... 200
Auto Max / Min Peak Search.......................................................................................200
Search Limits.............................................................................................................. 200

└ Search Limits (Left / Right)........................................................................... 200
└ Search Threshold..........................................................................................201
└ Using Zoom Limits........................................................................................ 201
└ Deactivating All Search Limits...................................................................... 201

Branch for Peak Search.............................................................................................. 201

Search Mode for Next Peak
Selects the search mode for the next peak search.

"Left" Determines the next maximum/minimum to the left of the current
peak.
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"Absolute" Determines the next maximum/minimum to either side of the current
peak.

"Right" Determines the next maximum/minimum to the right of the current
peak.

Remote command: 
"Positioning the Marker" on page 370

Exclude LO
If activated, restricts the frequency range for the marker search functions.

"ON" The minimum frequency included in the peak search range is ≥ 5 ×
resolution bandwidth (RBW).
Due to the interference by the first local oscillator to the first inter-
mediate frequency at the input mixer, the LO is represented as a sig-
nal at 0 Hz. To avoid the peak marker jumping to the LO signal at 0
Hz, this frequency is excluded from the peak search.

"OFF" No restriction to the search range. The frequency 0 Hz is included in
the marker search functions.

Remote command: 
CALCulate<n>:MARKer<m>:LOEXclude on page 367

Peak Excursion
Defines the minimum level value by which a signal must rise or fall so that it will be
identified as a maximum or a minimum by the search functions.

Entries from 0 dB to 80 dB are allowed; the resolution is 0.1 dB. The default setting for
the peak excursion is 6 dB.

Remote command: 
CALCulate<n>:MARKer<m>:PEXCursion on page 367

Auto Max / Min Peak Search
If activated, a maximum or minimum peak search is performed automatically for
marker 1 after each measurement.

Remote command: 
CALCulate<n>:MARKer<m>:MAXimum:AUTO on page 371
CALCulate<n>:MARKer<m>:MINimum:AUTO on page 372

Search Limits
The search results can be restricted by limiting the search area or adding search con-
ditions.

Search Limits (Left / Right) ← Search Limits
If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 368
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 369
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHT on page 369
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Search Threshold ← Search Limits
Defines an absolute threshold as an additional condition for the peak search. Only
peaks that exceed the threshold are detected.

Remote command: 
CALCulate<n>:THReshold on page 370

Using Zoom Limits ← Search Limits
If activated, the peak search is restricted to the active zoom area defined for a single
zoom (see "Single Zoom" on page 209).

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits:ZOOM[:STATe] on page 369

Deactivating All Search Limits ← Search Limits
Deactivates the search range limits.

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 368
CALCulate<n>:THReshold:STATe on page 370

Branch for Peak Search
Defines which data is used for marker search functions in I/Q data.

This function is only available for the display configuration "Real/Imag (I/Q)" (see "Real/
Imag (I/Q)" on page 114).

Note: The search settings apply to all markers, not only the currently selected one.

"Real"
Marker search functions are performed on the real trace of the I/Q
measurement.

"Imag"
Marker search functions are performed on the imaginary trace of the
I/Q measurement.

"Magnitude"
Marker search functions are performed on the magnitude of the I and
Q data.

Remote command: 
CALCulate<n>:MARKer<m>:SEARch on page 368

Marker Search Settings for Spectrograms

Access: "Overview" > "Analysis" > "Markers" > "Search"

or: "Marker" > "Search"

Spectrograms show not only the current sweep results, but also the sweep history.
Thus, when searching for peaks, you must define the search settings within a single
time frame (x-direction) and within several time frames (y-direction).

These settings are only available for spectrogram displays.
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Marker Search Type....................................................................................................202
Marker Search Area.................................................................................................... 202
Exclude LO..................................................................................................................202
Peak Excursion........................................................................................................... 203
Auto Max / Min Peak Search.......................................................................................203
Search Limits.............................................................................................................. 203

└ Search Limits (Left / Right)........................................................................... 203
└ Search Threshold..........................................................................................203
└ Using Zoom Limits........................................................................................ 204
└ Deactivating All Search Limits...................................................................... 204

Marker Search Type
Defines the type of search to be performed in the spectrogram.

"X-Search" Searches only within the currently selected frame.

"Y-Search" Searches within all frames but only at the current frequency position.

"XY-Search" Searches in all frames at all positions.

Remote command: 
Defined by the search function, see "Marker Search (Spectrograms)" on page 359

Marker Search Area
Defines which frames the search is performed in.

"Visible" Only the visible frames are searched.

"Memory" All frames stored in the memory are searched.

Remote command: 
CALCulate<n>:MARKer<m>:SPECtrogram:SARea on page 361
CALCulate<n>:DELTamarker<m>:SPECtrogram:SARea on page 364

Exclude LO
If activated, restricts the frequency range for the marker search functions.
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"ON" The minimum frequency included in the peak search range is ≥ 5 ×
resolution bandwidth (RBW).
Due to the interference by the first local oscillator to the first inter-
mediate frequency at the input mixer, the LO is represented as a sig-
nal at 0 Hz. To avoid the peak marker jumping to the LO signal at 0
Hz, this frequency is excluded from the peak search.

"OFF" No restriction to the search range. The frequency 0 Hz is included in
the marker search functions.

Remote command: 
CALCulate<n>:MARKer<m>:LOEXclude on page 367

Peak Excursion
Defines the minimum level value by which a signal must rise or fall so that it will be
identified as a maximum or a minimum by the search functions.

Entries from 0 dB to 80 dB are allowed; the resolution is 0.1 dB. The default setting for
the peak excursion is 6 dB.

Remote command: 
CALCulate<n>:MARKer<m>:PEXCursion on page 367

Auto Max / Min Peak Search
If activated, a maximum or minimum peak search is performed automatically for
marker 1 after each measurement.

Remote command: 
CALCulate<n>:MARKer<m>:MAXimum:AUTO on page 371
CALCulate<n>:MARKer<m>:MINimum:AUTO on page 372

Search Limits
The search results can be restricted by limiting the search area or adding search con-
ditions.

Search Limits (Left / Right) ← Search Limits
If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 368
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 369
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHT on page 369

Search Threshold ← Search Limits
Defines an absolute threshold as an additional condition for the peak search. Only
peaks that exceed the threshold are detected.

Remote command: 
CALCulate<n>:THReshold on page 370
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Using Zoom Limits ← Search Limits
If activated, the peak search is restricted to the active zoom area defined for a single
zoom (see "Single Zoom" on page 209).

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits:ZOOM[:STATe] on page 369

Deactivating All Search Limits ← Search Limits
Deactivates the search range limits.

Remote command: 
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 368
CALCulate<n>:THReshold:STATe on page 370

Positioning Functions

Access: "Marker" toolbar

The following functions set the currently selected marker to the result of a peak search
or set other characteristic values to the current marker value.

Peak Search................................................................................................................204
Search Next Peak....................................................................................................... 204
Search Minimum......................................................................................................... 205
Search Next Minimum.................................................................................................205
Center Frequency = Marker Frequency...................................................................... 205
Reference Level = Marker Level................................................................................. 205

Peak Search

Sets the selected marker/delta marker to the maximum of the trace. If no marker is
active, marker 1 is activated.

For spectrogram displays, define which frame the peak is to be searched in.

Remote command: 
CALCulate<n>:MARKer<m>:MAXimum[:PEAK] on page 371
CALCulate<n>:DELTamarker<m>:MAXimum[:PEAK] on page 374

Search Next Peak
Sets the selected marker/delta marker to the next (lower) maximum of the assigned
trace. If no marker is active, marker 1 is activated.

, 

For spectrogram displays, define which frame the next peak is to be searched in.
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For the Next Peak Up/Down functions, the search is automatically performed in all
frames above or below the currently selected frame, respectively.

Remote command: 
CALCulate<n>:MARKer<m>:MAXimum:NEXT on page 371
CALCulate<n>:MARKer<m>:MAXimum:RIGHt on page 372
CALCulate<n>:MARKer<m>:MAXimum:LEFT on page 371
CALCulate<n>:DELTamarker<m>:MAXimum:NEXT on page 374
CALCulate<n>:DELTamarker<m>:MAXimum:RIGHt on page 374
CALCulate<n>:DELTamarker<m>:MAXimum:LEFT on page 373

Search Minimum

Sets the selected marker/delta marker to the minimum of the trace. If no marker is
active, marker 1 is activated.

For spectrogram displays, define which frame the minimum is to be searched in.

Remote command: 
CALCulate<n>:MARKer<m>:MINimum[:PEAK] on page 373
CALCulate<n>:DELTamarker<m>:MINimum[:PEAK] on page 375

Search Next Minimum
Sets the selected marker/delta marker to the next (higher) minimum of the selected
trace. If no marker is active, marker 1 is activated.

, 

For spectrogram displays, define which frame the next minimum is to be searched in.

For the Next Min Up/Down functions, the search is automatically performed in all
frames above or below the currently selected frame, respectively.

Remote command: 
CALCulate<n>:MARKer<m>:MINimum:NEXT on page 372
CALCulate<n>:MARKer<m>:MINimum:LEFT on page 372
CALCulate<n>:MARKer<m>:MINimum:RIGHt on page 373
CALCulate<n>:DELTamarker<m>:MINimum:NEXT on page 374
CALCulate<n>:DELTamarker<m>:MINimum:LEFT on page 374
CALCulate<n>:DELTamarker<m>:MINimum:RIGHt on page 375

Center Frequency = Marker Frequency

Sets the center frequency to the selected marker or delta marker frequency. A peak
can thus be set as center frequency, for example to analyze it in detail with a smaller
span.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:CENTer on page 324

Reference Level = Marker Level
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Sets the reference level to the selected marker level.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:REFerence on page 315

10.4.2.4 Band Power Marker

Access: "Overview" > "Analysis" > "Marker Functions" > "Band Power" > "Band Power
Config"

or: "Marker" > "Marker Function" > "Band Power"

For each of the 16 markers band power measurement can be activated.

The individual marker settings correspond to those defined in the "Marker" dialog box
(see "Individual Marker Setup" on page 193). Any settings to the marker state or type
changed in the "Marker Function" dialog box are also changed in the "Marker" dialog
box and vice versa.

For more information see "Measuring the Power in a Channel (Band)" on page 192.

Band Power Measurement State................................................................................ 206
Span............................................................................................................................207
Power Mode................................................................................................................ 207
Switching All Band Power Measurements Off.............................................................207

Band Power Measurement State
Activates or deactivates band power measurement for the marker in the diagram.

Band power markers are only available for standard frequency measurements (not
zero span) in the Spectrum application.
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If activated, the markers display the power or density measured in the band around the
current marker position.

For details see "Measuring the Power in a Channel (Band)" on page 192.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer[:STATe] on page 376
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer[:STATe] on page 378

Span
Defines the span (band) around the marker for which the power is measured. The span
is indicated by lines in the diagram.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:SPAN on page 376
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:SPAN on page 377

Power Mode
Defines the mode of the power measurement result.

"Power" The result is an absolute power level. The power unit depends on the
Unit setting.

"Density" The result is a power level in relation to the bandwidth, displayed in
dBm/Hz.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:MODE on page 375
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:MODE on page 377

Switching All Band Power Measurements Off
Deactivates band power measurement for all markers.

Remote command: 
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer[:STATe] on page 376
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer[:STATe] on page 378

10.4.2.5 Deactivating All Marker Functions

Access: "Overview" > "Analysis" > "Marker Functions" > "All Functions Off"

or: "Marker" > "All Markers Off"

All special marker functions can be deactivated in one step.

10.4.3 Zoomed Displays

You can zoom into the diagram to visualize the measurement results in greater detail.
Using a mouse pointer you can easily define the area to be enlarged.
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Zoom and the number of trace points
Note that zooming is merely a visual tool, it does not change any measurement set-
tings, such as the number of trace points!
You should increase the number of trace points before zooming, as otherwise the func-
tion has no real effect (see chapter 10.2.1, "How Much Data is Measured: Capture
Count and Measurement Points", on page 118).

● Single Zoom Versus Multiple Zoom...................................................................... 208
● Zoom Functions.................................................................................................... 209
● How to Zoom Into a Diagram................................................................................ 210

10.4.3.1 Single Zoom Versus Multiple Zoom

Two different (graphical) zoom modes are available: single zoom and multiple zoom. A
single zoom replaces the current diagram by a new diagram which displays an
enlarged extract of the trace. This function can be used repetitively until the required
details are visible. In multiple zoom mode, you can enlarge up to four different areas of
the trace simultaneously. An overview window indicates the zoom areas in the original
trace, while the zoomed trace areas are displayed in individual windows. The zoom
areas can be moved and resized any time. The zoom area that corresponds to the indi-
vidual zoom display is indicated in the lower right corner, between the scrollbars.

Fig. 10-21: Single zoom
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Fig. 10-22: Multiple zoom

Using the zoom area to restrict a peak search
The selected zoom area can be used to restrict the search range for a peak search,
but only in single zoom mode (see "Using Zoom Limits" on page 201).

10.4.3.2 Zoom Functions

Access: "Zoom" icons in toolbar

Single Zoom................................................................................................................ 209
Multiple Zoom..............................................................................................................209
Restore Original Display............................................................................................. 210

 Deactivating Zoom (Selection mode)...................................................................... 210

Single Zoom

A single zoom replaces the current diagram by a new diagram which displays an
enlarged extract of the trace. This function can be used repetitively until the required
details are visible.

Remote command: 
DISPlay[:WINDow<n>]:ZOOM:STATe on page 378
DISPlay[:WINDow<n>]:ZOOM:AREA on page 378

Multiple Zoom
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In multiple zoom mode, you can enlarge several different areas of the trace simultane-
ously. An overview window indicates the zoom areas in the original trace, while the
zoomed trace areas are displayed in individual windows. The zoom area that corre-
sponds to the individual zoom display is indicated in the lower right corner, between
the scrollbars.

Remote command: 
DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:STATe on page 379
DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:AREA on page 379

Restore Original Display

Restores the original display, that is, the originally calculated displays for the entire
capture buffer, and closes all zoom windows.

Remote command: 
single zoom:
DISPlay[:WINDow<n>]:ZOOM:STATe on page 378
multiple zoom:
DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:STATe on page 379 (for each
multiple zoom window)

 Deactivating Zoom (Selection mode)
Deactivates any zoom mode.

Selecting a point in the display no longer invokes a zoom, but selects an object.

Remote command: 
single zoom:
DISPlay[:WINDow<n>]:ZOOM:STATe on page 378
multiple zoom:
DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:STATe on page 379 (for each
multiple zoom window)

10.4.3.3 How to Zoom Into a Diagram

The remote commands required to zoom into a display are described in chap-
ter 13.6.2.4, "Zooming into the Display", on page 378.

The following tasks are described here:

● "To zoom into the diagram at one position" on page 210
● "To return to selection mode in the diagram" on page 211
● "To return to original display" on page 211
● "To zoom into multiple positions in the diagram" on page 211

To zoom into the diagram at one position

1.

Click on the "Single Zoom" icon in the toolbar.
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Zoom mode is activated.

2. Select the area in the diagram to be enlarged using the mouse pointer. The
selected area is indicated by a dotted rectangle.

When you drop the mouse pointer, the diagram is replaced by the zoomed trace
area.

3. Repeat these steps, if necessary, to enlarge the diagram further.

Scrolling in the zoomed display
You can scroll the diagram area to display the entire diagram using the scrollbars at
the right and at the bottom of the diagram.

To return to selection mode in the diagram

While you are in zoom mode, selecting points in the display changes the zoom area. In
order to select or move a trace or marker, you must switch back to selection mode:

►

Select the "Selection mode" icon in the toolbar.

To return to original display

►

Click on the "Zoom Off" icon in the toolbar.

The original trace display is restored. Zoom mode remains active, however.
To switch off zoom mode and return to selection mode, select the "Selection mode"
icon in the toolbar.

To zoom into multiple positions in the diagram

1.

Analysis
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Click on the "Multiple Zoom" icon in the toolbar.

Multiple zoom mode is activated.

2. Select the first area in the diagram to be enlarged as described in "To zoom into
the diagram at one position" on page 210. The selected area is indicated by a dot-
ted rectangle.

When you have completed your selection, the original trace is shown in an over-
view diagram with the selected area indicated by a dotted rectangle. The zoomed
trace area is displayed in a separate window (see figure 10-22.

3. In the overview diagram, select the next area to be enlarged.

The second zoom area is indicated in the overview diagram, and a second zoom
window is displayed.

4. Repeat these steps, if necessary, to zoom into further trace areas (up to four).

To move or change zoom areas

In multiple zoom mode, you can change the size or position of the individual zoom
areas easily at any time.

1. If necessary, switch off zoom mode and return to selection mode by selecting the
"Selection mode" icon in the toolbar.

2. To resize a zoom area, set the mouse pointer directly on the corresponding frame
in the overview window and drag the line to change the size of the frame.
To move a zoom area, set the mouse pointer inside the corresponding frame in
the overview window and drag the frame to the new position.

The contents of the zoom windows are adapted accordingly.

Analysis
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11 How To Perform Measurements with the
R&S VSE
The following step-by-step instructions demonstrate how to load and store I/Q data and
perform basic measurements with the R&S VSE in general, and how to configure data
acquisition and analyze data in the I/Q Analyzer application.

● How to Perform a Basic Measurement with Instrument Input...............................213
● How to Import I/Q Data for Analysis......................................................................215
● How to Perform Measurements on Multiple Files and Instruments.......................216
● How to Perform a Sequence of Measurements on a Single File or Instrument.... 217
● How to Save and Load Measurement Settings.....................................................218
● How to Export I/Q Data......................................................................................... 219
● How to Capture Baseband (I/Q) Data in the I/Q Analyzer.....................................220
● How to Analyze Data in the I/Q Analyzer..............................................................221

11.1 How to Perform a Basic Measurement with Instrument
Input

The following step-by-step instructions demonstrate how to perform a very simple mea-
surement on input from a connected instrument using the R&S VSE.

1. Configure a instrument from which data is to be captured:

a) In the "Instruments" tool window, select "New Instrument".
b) Select "Search" to search for all instruments in the network and select the

instrument from which data is to be captured.
Alternatively, enter the connection information for the new instrument manually.

c) Select "Connect" to establish a connection to the specified instrument.
d) If necessary, select "Self Alignment" to calibrate the instrument.
e) Optionally, select "Infos & Settings" to do one of the following:

● Configure the use of an external reference on the instrument
● Control the display of the remote controlled instrument
● Obtain information on the options installed on the connected instrument

2. Assign the configured instrument to the default measurement channel:

a) In the "Measurement Group Setup" tool window, for the default group 1, select
the "+" icon in front of the default measurement channel "IQ Analyzer".

b) Select "Instrument" as the input type.
c) If several instruments are configured, select the instrument to be used for the

measurement from the "Instrument" selection list.
d) If optional interfaces for data input to the instrument are available, select the

input source to be used for the measurement from the "Input Source" selection
list.
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3. Configure further input source settings as required for the selected signal source
(see chapter 11.7, "How to Capture Baseband (I/Q) Data in the I/Q Analyzer",
on page 220.

4. Select the "Capture mode" icon for the "IQ Analyzer" measurement channel to tog-
gle between single  and continuous  measurements. For single capture mode,
a fixed number of measurements is performed (defined by the measurement set-
tings), whereas in continuous capture mode, measurements are performed contin-
uously until they are stopped manually.

5. Select the  "Capture" icon for the "IQ Analyzer" measurement channel.

One or more measurements are performed on the input data from the connected
instrument and the results are displayed in the"IQ Analyzer: Magnitude" result dis-
play.

Analyze the captured data as described in chapter 11.8, "How to Analyze Data in
the I/Q Analyzer", on page 221, or add further measurement channels to analyze
the input data in other applications as described in chapter 11.3, "How to Perform
Measurements on Multiple Files and Instruments", on page 216.

To add further measurement channels

1. In the "Measurement Group Setup" tool window, select the "+ Channel" button to
add a new measurement channel to the group.

2. Select the measurement mode or a copy of the currently selected measurement
channel ("Duplicate Current Channel").

The channel bar and the default result displays for the new measurement channel
are displayed. If necessary, the previously displayed windows are cumulated in
tabs to create room on the display.

3. Select the input type for the new measurement channel and assign a configured
instrument or import a file (see chapter 11.1, "How to Perform a Basic Measure-
ment with Instrument Input", on page 213 or chapter 11.2, "How to Import I/Q Data
for Analysis", on page 215).

4. Configure further input source or measurement settings as required for the individ-
ual channels (see the applications' user manual for details).

5. Repeat these steps to add further measurement channels to the group.

6. Select the "Capture mode" icon to toggle between single  and continuous 
measurements for each measurement channel.

7. Select the  "Capture" icon for a measurement channel to perform a measurement
on that channel. Only one channel can be started manually at a time. Before you
can start another channel, you must stop the previous measurement by selecting
the  "Stop" icon for that channel first.

How to Perform a Basic Measurement with Instrument Input
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To start multiple measurements (on diffferent input types) at the same time, perform a
measurement on the entire group; see chapter 11.3, "How to Perform Measurements
on Multiple Files and Instruments", on page 216.
To perform several measurements on the same instrument sequentially, configure a
measurement sequence; see chapter 11.4, "How to Perform a Sequence of Measure-
ments on a Single File or Instrument", on page 217.

11.2 How to Import I/Q Data for Analysis

To import data via the "Measurement Group Setup" window

1. In the "Measurement Group Setup" tool window, select the "+" icon in front of the
measurement channel.

2. Select "File" as the input type.

3. Select the "..." icon to open a file selection dialog box and select the storage loca-
tion and the file name.
Alternatively, select a file from the selection list of recently imported files.

4. Select the  "Capture" icon for the measurement channel.

The stored data is loaded from the file and evaluated in the selected application.

To import data via the "Input" dialog box

Alternatively to the procedure described above, starting in the "Measurement Group
Setup" tool window, you can also import data via the "Input" dialog box.

1. From the "Input & Output" menu, select "Input Source".

2. Select "I/Q File" as the input source.

3. Select "Select File" to open a file selection dialog box and select the storage loca-
tion and the file name.

4. Set the state of the I/Q file input source to "On".

5. Close the "Input" dialog box.

6. Select the  "Capture" icon for the measurement channel.

The stored data is loaded from the file and evaluated in the selected application.
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11.3 How to Perform Measurements on Multiple Files and
Instruments

Multiple measurements on different instruments or files can be performed quasi in par-
allel. All measurements are started at the same time, and provide results independ-
ently as they are completed in each measurement channel.

1. In the "Instruments" tool window, configure all instruments on which measurements
are to be performed (see also chapter 11.1, "How to Perform a Basic Measurement
with Instrument Input", on page 213).

2. In the "Measurement Group Setup" tool window, select the "+ Channel" button to
add a new measurement channel to the group.

3. Select the measurement mode or a copy of the currently selected measurement
channel ("Duplicate Current Channel").

The channel bar and the default result displays for the new measurement channel
are displayed. If necessary, the previously displayed windows are cumulated in
tabs to create room on the display.

4. Select the input type for the new measurement channel and assign a configured
instrument or import a file (see chapter 11.1, "How to Perform a Basic Measure-
ment with Instrument Input", on page 213 or chapter 11.2, "How to Import I/Q Data
for Analysis", on page 215).

If the same instrument is assigned to multiple measurement channels of the same
group, the channel to which the instrument was assigned last is deactivated (the
checkmark for the channel in the "Measurement Group Setup" tool window is
removed).

5. Configure further input source or measurement settings as required for the individ-
ual channels (see the applications' user manual for details).

6. Repeat these steps to add further measurement channels to the group.

7. Select the "Capture mode" icon (  / ) for the group to toggle between single
and continuous measurements. For single capture mode, each measurement
channel is processed a single time, whereas in continuous capture mode, the mea-
surements are performed continuously until the group measurement is stopped
manually.

Note that the capture mode of the group automatically defines the capture mode of
the individual channels as the same mode.

8. Select the "Capture" icon for the group to start all active measurement channels.

One or more measurements are performed on the input data for each active mea-
surement channel at the same time, and the results are displayed in the channels'
result displays when available.

Note: You can perform a measurement for a single channel by selecting the
"Capture" icon for that measurement channel. However, only one channel can be
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started manually at a time. Before you can start another channel, you must stop
the previous measurement by selecting the "Pause" icon for that channel first.

Analyze the captured data as described in chapter 11.8, "How to Analyze Data in
the I/Q Analyzer", on page 221.

11.4 How to Perform a Sequence of Measurements on a
Single File or Instrument

A single instrument can perform only one measurement at a time; however, a
sequence of measurements can be performed in just one step.

1. In the "Instruments" tool window, configure the instrument on which the measure-
ments are to be performed (see also chapter 11.1, "How to Perform a Basic Mea-
surement with Instrument Input", on page 213).

2. In the "Measurement Group Setup" tool window, select the "+ New Group" button
to add a measurement group, that is: a measurement channel for the same instru-
ment or file.

3. Select the input type for the new measurement channel and assign the same con-
figured instrument or import the same file as for the other groups (see chap-
ter 11.1, "How to Perform a Basic Measurement with Instrument Input",
on page 213 or chapter 11.2, "How to Import I/Q Data for Analysis", on page 215).

4. Optionally, you can add further measurement channels on different instruments/
files to a group (see chapter 11.3, "How to Perform Measurements on Multiple
Files and Instruments", on page 216).

5. Repeat these steps to add further groups.

6. Toggle the "CONT" / "SGL" button at the bottom of the "Measurement Group
Setup" tool window to toggle between single and continuous measurements for the
entire measurement sequence. For single capture mode, each group is processed
a single time in the defined sequence, whereas in continuous capture mode, the
groups are performed in the defined sequence continuously until measurement is
stopped manually.

Note that the capture mode of the entire measurement sequence automatically
defines the capture mode of the individual groups and channels as the same
mode.

7. Select the "Capture" button at the bottom of the "Measurement Group Setup" tool
window to start the active groups in the defined order.
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The measurements for a single group are performed and the results are displayed
in the channels' result displays. When that group has completed its measurements,
the next group in the sequence is started.

Analyze the captured data as described in chapter 11.8, "How to Analyze Data in
the I/Q Analyzer", on page 221.

11.5 How to Save and Load Measurement Settings

Measurement settings can be saved to a file and loaded again later, so that you can
repeat the measurement with the same settings.

To save configurable measurement settings

1. Select the  "Save" icon from the toolbar.

2. In the "Save" dialog box, switch to the "Save" tab.

3. In the file selection dialog box, select a file name and storage location for the set-
tings file.

4. Optionally, define a comment to describe the stored settings.

5. Select whether the measurement settings for all channels are to be stored, or only
those for the current channel.

6. Select the items to be saved with the settings. Either the settings for the currently
selected channel only or for all channels can be stored, and various other items
such as lines or traces etc. can be stored as well (see chapter 8.2.2.1, "Stored
Data Types", on page 80).

7. Select "Save".

A file with the defined name and path and the extension .dfl is created.

To recall configurable measurement settings

1. Select the  "Open" icon from the toolbar.

2. In the "Recall" dialog box, switch to the "Recall" tab.

3. In the file selection dialog box, select the file name and storage location of the set-
tings file.

Note: The "File Type" indicates whether the file contains instrument settings for all
channels, or only those for the current channel.

4. If several items were saved, select which items are to be restored.

5. If channel settings were saved, select whether the settings will replace the settings
in the current channel, or whether a new channel with the saved settings will be
opened.
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6. Select "Recall".

The settings and selected items from the saved measurement are restored and
you can repeat the measurement with the same settings.

11.6 How to Export I/Q Data

Note that in order to export the raw data, you must start recording directly at the time of
capture. Once the data has been captured without being recorded, it can no longer be
exported as raw data.

To save results of data that has been captured, but not recorded, use the "Save set-
tings" functions (see chapter 11.5, "How to Save and Load Measurement Settings",
on page 218).

To record I/Q data

► Configure the measurement as required (see also chapter 11.7, "How to Capture
Baseband (I/Q) Data in the I/Q Analyzer", on page 220), but use the  "Record"
function to start the measurement (instead of the  "Capture" function).

To export the I/Q data recording

1. Select "File > Save I/Q Recording".

2. Select the storage location for the I/Q data file.

3. Select the file type (format).

4. Select which set of meta data is to be stored with the I/Q data.

5. Select "Save".

To import the stored data file to the R&S VSE again as input, see chapter 11.2,
"How to Import I/Q Data for Analysis", on page 215.

Previewing the I/Q data from an iq-tar file in a web browser

The iq-tar file format allows you to preview the exported I/Q data in a web browser.

1. Use an archive tool (e.g. WinZip® or PowerArchiver®) to unpack the iq-tar file
into a folder.

2. Locate the folder using Windows Explorer.

3. Open your web browser.
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4. Drag the I/Q parameter XML file, e.g. example.xml, into your web browser.

11.7 How to Capture Baseband (I/Q) Data in the I/Q Ana-
lyzer

By default, the I/Q Analyzer assumes the captured data is modulated on a carrier fre-
quency and consists of two components (I/Q).
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Make sure the I/Q Analyzer measurement channel is currently active before you
attempt to change its configuration, for example by selecting one of its windows or the
application in the toolbar selection list.

1. From the "Meas Setup" menu, select "Overview" to display the configuration "Over-
view" that guides you through the configuration steps.

2. Select "Input" to configure the "RF Input" signal source.

3. Select "Amplitude" to define the attenuation, reference level or other settings that
affect the input signal's amplitude and scaling.

4. Select "Frequency" to define the input signal's center frequency.

5. Optionally, select "Trigger" to define a trigger for data acquisition, for example an
I/Q Power trigger to start capturing data only when a specific power is exceeded.

6. Select "Bandwidth" and define the bandwidth parameters for data acquisition:

● "Sample rate" or "Analysis Bandwidth:" the span of the input signal to be cap-
tured for analysis, or the rate at which samples are captured (both values are
correlated)

● Optionally, if a bandwidth extension for 160 MHz or 320 MHz is installed on the
instrument, the "Maximum Bandwidth", depending on whether you require a
larger bandwidth or not.

● "Measurement Time:" how long the data is to be captured
● "Record Length": the number of samples to be captured (also defined by sam-

ple rate and measurement time)

7. Switch to the "Capture" tab of the "Data Acquisition" dialog box and define the
number of measurements to be performed ("Capture Count"). The setting "Capture
Count = 0" is only useful for continuous capture mode.

8. From the "Window" menu, select "New Window" and then the result displays that
are of interest to you.
Arrange the windows on the display to suit your preferences by moving them
around or changing their size (see also chapter 6.3, "Customizing the User Inter-
face", on page 43).

9. Perform a measurement with the defined settings as described in chapter 11.1,
"How to Perform a Basic Measurement with Instrument Input", on page 213.

11.8 How to Analyze Data in the I/Q Analyzer

1. Select the "I/Q Analyzer" measurement channel.

2. Select the "Meas Setup > Overview" menu item to display the configuration "Over-
view".
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3. Select the "Analysis" button to make use of the advanced analysis functions in the
displays.

For example:

● Configure a trace to display the average over a series of measurements (on the
"Trace" tab; if necessary, increase the "Average Count").

● Configure markers and delta markers to determine deviations and offsets within
the signal (on the "Marker" tab).

How to Analyze Data in the I/Q Analyzer
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12 Network and Remote Operation
The R&S VSE software can capture and analyze data from a connected instrument in
a network. In this case, the R&S VSE software controls the connected instrument
remotely. The R&S VSE software, in turn, can be controlled remotely from another PC
in the network. Various methods for remote control are supported:

● Connecting the host PC with the R&S VSE software installed and the instrument in
use to a network to capture data directly from the instrument.
This is the basic operating scenario for the R&S VSE software and is described in
detail in chapter 7, "Controlling Instruments and Capturing I/Q Data", on page 52

● Using the Windows Remote Desktop application in a LAN network to work with the
R&S VSE software interactively

● Connecting a controller PC to the network to operate both the R&S VSE software
and the instrument in use remotely from the same PC.

How to configure the remote control interfaces is described in chapter 12.3, "How to
Set Up a Network and Remote Control", on page 253.

● Remote Control Basics......................................................................................... 223
● Network and Remote Control Settings..................................................................250
● How to Set Up a Network and Remote Control.....................................................253

12.1 Remote Control Basics

Basic information on operating an instrument via remote control is provided here. This
information applies to all applications and operating modes on the R&S VSE.

See also chapter 7.2.1, "Remote Control Interfaces and Protocols", on page 53.

12.1.1 SCPI (Standard Commands for Programmable Instruments)

SCPI commands - messages - are used for remote control. Commands that are not
taken from the SCPI standard follow the SCPI syntax rules. The R&S VSE supports
the SCPI version 1999. The SCPI standard is based on standard IEEE 488.2 and aims
at the standardization of device-specific commands, error handling and the status reg-
isters. The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE
488.2" from John M. Pieper (R&S order number 0002.3536.00) offers detailed informa-
tion on concepts and definitions of SCPI.

Tables provide a fast overview of the bit assignment in the status registers. The tables
are supplemented by a comprehensive description of the status registers.

12.1.2 Messages

The messages transferred on the data lines are divided into the following categories:
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● Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.

● Instrument messages
Instrument messages are employed in the same way for all interfaces, if not indica-
ted otherwise in the description. Structure and syntax of the instrument messages
are described in chapter 12.1.3, "SCPI Command Structure", on page 225. A
detailed description of all messages available for the instrument is provided in the
chapter "Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:
– Commands
– Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are
subdivided according to two criteria:
● According to the effect they have on the instrument:

– Setting commands cause instrument settings such as a reset of the instru-
ment or setting the frequency.

– Queries cause data to be provided for remote control, e.g. for identification of
the instrument or polling a parameter value. Queries are formed by directly
appending a question mark to the command header.

● According to their definition in standards:
– Common commands: their function and syntax are precisely defined in stand-

ard IEEE 488.2. They are employed identically on all instruments (if implemen-
ted). They refer to functions such as management of the standardized status
registers, reset and self-test.

– Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI confirmed" in the command reference chapters. Commands without this
SCPI label are device-specific; however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement
results, instrument settings and information on the instrument status.
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12.1.3 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics
(keywords). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.

12.1.3.1 Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an aster-
isk (*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.
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12.1.3.2 Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.
For demonstration purposes only, assume the existence of the following commands for
this section:
● DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
● FORMat:READings:DATA <type>[,<length>]
● HCOPy:DEVice:COLor <Boolean>
● HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
● HCOPy[:IMMediate]
● HCOPy:ITEM:ALL
● HCOPy:ITEM:LABel <string>
● HCOPy:PAGE:DIMensions:QUADrant[<N>]
● HCOPy:PAGE:ORIentation LANDscape | PORTrait
● HCOPy:PAGE:SCALe <numeric value>
● MMEMory:COPY <file_source>,<file_destination>
● SENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
● SENSe:FREQuency:STOP <numeric value>
● SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by
upper case letters, the long form corresponds to the complete word. Either the short
form or the long form can be entered; other abbreviations are not permitted.

Example: 
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels
or sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

 

Remote Control Basics



Network and Remote OperationR&S®VSE

227User Manual 1176.8839.02 ─ 03

Example: 
Definition: HCOPy:PAGE:DIMensions:QUADrant[<N>]
Command: HCOP:PAGE:DIM:QUAD2
This command refers to the quadrant 2.

Different numbering in remote control
For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.
Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The
instrument must recognize the long command to comply with the SCPI standard. Some
commands are considerably shortened by these optional mnemonics.

Example: 
Definition: HCOPy[:IMMediate]
Command: HCOP:IMM is equivalent to HCOP

Optional mnemonics with numeric suffixes
Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.
Example:
Definition:DISPlay[:WINDow<1...4>]:MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow
parameter with the suffix for the required window.
DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space". If several parame-
ters are specified in a command, they are separated by a comma (,). For a description
of the parameter types, refer to chapter 12.1.3.3, "SCPI Parameters", on page 228.

Example: 
Definition:HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
Command:HCOP:DEV:CMAP:COL:RGB 3,32,44
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The
effect of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy:PAGE:ORIentation LANDscape | PORTrait
Command HCOP:PAGE:ORI LAND specifies landscape orientation

Command HCOP:PAGE:ORI PORT specifies portrait orientation

Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics
needs to be included in the header of the command. The effect of the command is independent of
which of the mnemonics is used.

Example:

DefinitionSENSE:BANDwidth|BWIDth[:RESolution] <numeric_value>
The two following commands with identical meaning can be created:

SENS:BAND:RES 1
SENS:BWID:RES 1

[ ] Mnemonics in square brackets are optional and may be inserted into the header or omitted.

Example: HCOPy[:IMMediate]
HCOP:IMM is equivalent to HCOP

{ } Parameters in curly brackets are optional and can be inserted once or several times, or omitted.

Example: SENSe:LIST:FREQuency <numeric_value>{,<numeric_value>}
The following are valid commands:

SENS:LIST:FREQ 10
SENS:LIST:FREQ 10,20
SENS:LIST:FREQ 10,20,30,40

12.1.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The
parameters must be separated from the header by a "white space" (ASCII code 0 to 9,
11 to 32 decimal, e.g. blank). Allowed parameters are:

● Numeric values
● Special numeric values
● Boolean parameters
● Text
● Character strings
● Block data

The parameters required for each command and the allowed range of values are
specified in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The man-
tissa may comprise up to 255 characters, the exponent must lie inside the value range
-32000 to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent
alone is not allowed. In the case of physical quantities, the unit can be entered.
Allowed unit prefixes are G (giga), MA (mega), MOHM and MHZ are also allowed), K
(kilo), M (milli), U (micro) and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

● G (giga)
● MA (mega), MOHM, MHZ
● K (kilo)
● M (milli)
● U (micro)
● N (nano)

If the unit is missing, the basic unit is used.

Example: 
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example: 
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a
query, the numeric value is provided.

● MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

● DEF
DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

● UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width
can be specified via an allocated step command for each parameter which can be
set via UP, DOWN.

● INF/NINF
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INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

● NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instru-
ment response. This value is not defined. Possible causes are the division of zero
by zero, the subtraction of infinite from infinite and the representation of missing
values.

Example: 
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values
The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered follow-
ing the quotation mark.
Example: SENSe:LIST:FREQ? MAXimum
Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represen-
ted by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a
query.

Example: 
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the
header by a white space. In the case of a query, the short form of the text is provided.

Example: 
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").
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Example: 
HCOP:ITEM:LABel "Test1" or HCOP:ITEM:LABel 'Test1'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example: 
FORMat:READings:DATA #45168xxxxxxxx
The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 follow-
ing digits indicate the length to be 5168 bytes. The data bytes follow. During the trans-
mission of these data bytes all end or other control signs are ignored until all bytes are
transmitted.
#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL^END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

12.1.3.4 Overview of Syntax Elements

The following table provides an overview of the syntax elements:

: The colon separates the mnemonics of a command. In a command line the separating semico-
lon marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

, The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

' '

"

Quotation marks introduce a string and terminate it (both single and double quotation marks are
possible).

# The hash symbol introduces binary, octal, hexadecimal and block data.
● Binary: #B10110
● Octal: #O7612
● Hexa: #HF3A7
● Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

12.1.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of
the following:
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● a <New Line>
● a <New Line> with EOI
● an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the
next command belongs to a different command system, the semicolon is followed by a
colon.

Example: 
MMEM:COPY "Test1","MeasurementXY";:HCOP:ITEM ALL
This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels
in common, the command line can be abbreviated. To this end, the second command
after the semicolon starts with the level that lies below the common levels. The colon
following the semicolon must be omitted in this case.

Example: 
HCOP:ITEM ALL;:HCOP:IMM
This command line contains two commands. Both commands are part of the HCOP
command system, i.e. they have one level in common.
When abbreviating the command line, the second command begins with the level
below HCOP. The colon after the semicolon is omitted. The abbreviated form of the
command line reads as follows:
HCOP:ITEM ALL;IMM

A new command line always begins with the complete path.

Example: 
HCOP:ITEM ALL
HCOP:IMM

12.1.3.6 Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard
IEEE 488.2.

● The requested parameter is transmitted without a header.
Example: HCOP:PAGE:ORI?, Response: LAND

● Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe:FREQuency:STOP? MAX, Response: 3.5E9
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● Numeric values are output without a unit. Physical quantities are referred to the
basic units or to the units set using the Unit command. The response 3.5E9 in
the previous example stands for 3.5 GHz.

● Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy:DEV:COL ON
Query: HCOPy:DEV:COL?
Response: 1

● Text (character data) is returned in a short form.
Example:
Setting command: HCOPy:PAGE:ORIentation LANDscape
Query: HCOP:PAGE:ORI?
Response: LAND

12.1.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

● A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented
as sequential commands.

● An overlapping command is one which does not automatically finish executing
before the next command starts executing. Usually, overlapping commands take
longer to process and allow the program to do other tasks while being executed. If
overlapping commands do have to be executed in a defined order, e.g. in order to
avoid wrong measurement results, they must be serviced sequentially. This is
called synchronization between the controller and the instrument.

Setting commands within one command line, even though they may be implemented
as sequential commands, are not necessarily serviced in the order in which they have
been received. In order to make sure that commands are actually carried out in a cer-
tain order, each command must be sent in a separate command line.

Example: Commands and queries in one message
The response to a query combined in a program message with commands that affect
the queried value is not predictable.
The following commands always return the specified result:
:FREQ:STAR 1GHZ;SPAN 100;:FREQ:STAR?
Result:
1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:
:FREQ:STAR 1GHz;STAR?;SPAN 1000000
The result could be the value of STARt before the command was sent since the instru-
ment might defer executing the individual commands until a program message termi-
nator is received. The result could also be 1 GHz if the instrument executes commands
as they are received.
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As a general rule, send commands and queries in different program messages.

Example: Overlapping command with *OPC
The instrument implements INITiate[:IMMediate] as an overlapped command.
Assuming that INITiate[:IMMediate] takes longer to execute than *OPC, sending
the following command sequence results in initiating a sweep and, after some time,
setting the OPC bit in the ESR:
INIT; *OPC.
Sending the following commands still initiates a sweep:
INIT; *OPC; *CLS
However, since the operation is still pending when the instrument executes *CLS, forc-
ing it into the "Operation Complete Command Idle" State (OCIS), *OPC is effectively
skipped. The OPC bit is not set until the instrument executes another *OPC command.

12.1.4.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC,
*OPC? or *WAI can be used. All three commands cause a certain action only to be
carried out after the hardware has been set. By suitable programming, the controller
can be forced to wait for the corresponding action to occur.

Table 12-1: Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action Programming the controller

*OPC Sets the Operation Complete bit in the ESR
after all previous commands have been exe-
cuted.

● Setting bit 0 in the ESE
● Setting bit 5 in the SRE
● Waiting for service request (SRQ)

*OPC? Stops command processing until 1 is
returned. This is only the case after the Oper-
ation Complete bit has been set in the ESR.
This bit indicates that the previous setting has
been completed.

Sending *OPC? directly after the command
whose processing should be terminated
before other commands can be executed.

*WAI Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated
before other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped com-
mand is a good choice if the overlapped command takes only little time to process. The
two synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use
one of the following methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1
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2. Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.

3. Send the overlapped command with *OPC

4. Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

*OPC? with short timeout

1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. A return value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the "-410, Query interrup-
ted" entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for control-
ling the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with
other instruments.
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12.1.5 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. Both can be queried via GPIB bus or LAN interface
(STATus... commands, see chapter 13.10.1, "Using the Status Register",
on page 424).

● Hierarchy of Status Registers............................................................................... 236
● Structure of a SCPI Status Register......................................................................238
● Contents of the Status Registers.......................................................................... 239
● Application of the Status Reporting System..........................................................246
● Reset Values of the Status Reporting System......................................................248

12.1.5.1 Hierarchy of Status Registers

As shown in the following figure, the status information is of hierarchical structure.
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Fig. 12-1: Graphical overview of the R&S VSE status registers hierarchy

● STB, SRE
The STatus Byte (STB) register and its associated mask register Service Request
Enable (SRE) form the highest level of the status reporting system. The STB pro-
vides a rough overview of the instrument status, collecting the information of the
lower-level registers.

● ESR, SCPI registers
The STB receives its information from the following registers:
– The Event Status Register (ESR) with the associated mask register standard

Event Status Enable (ESE).

– The STATus:OPERation and STATus:QUEStionable registers which are
defined by SCPI and contain detailed information on the instrument.
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● IST, PPE
The IST flag ("Individual STatus"), like the SRQ, combines the entire instrument
status in a single bit. The PPE fulfills the same function for the IST flag as the SRE
for the service request.

● Output buffer
The output buffer contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

12.1.5.2 Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus the contents of the register parts
can be processed by the controller as positive integers.

Fig. 12-2: The status-register model

Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

● CONDition
The CONDition part is written into directly by the hardware or the sum bit of the
next lower register. Its contents reflect the current instrument status. This register
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part can only be read, but not written into or cleared. Its contents are not affected
by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.

– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.

– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

12.1.5.3 Contents of the Status Registers

In the following sections, the contents of the status registers are described in more
detail.
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● Status Byte (STB) and Service Request Enable Register (SRE)..........................240
● IST Flag and Parallel Poll Enable Register (PPE)................................................ 241
● Event Status Register (ESR) and Event Status Enable Register (ESE)...............241
● STATus:OPERation Register................................................................................242
● STATus:QUEStionable Register...........................................................................242
● STATus:QUEStionable:EXTended Register.........................................................242
● STATus:QUEStionable:EXTended:INFO Register............................................... 243
● STATus:QUEStionable:FREQuency Register...................................................... 243
● STATus:QUEStionable:LIMit Register.................................................................. 244
● STATus:QUEStionable:LMARgin Register........................................................... 245
● STATus:QUEStionable:POWer Register.............................................................. 245
● STATus:QUEStionable:TIMe Register..................................................................246

Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB can thus be compared with the CONDition part of an SCPI register and
assumes the highest level within the SCPI hierarchy.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *SRE and read
using the command *SRE?.

Table 12-2: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus:QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

Remote Control Basics



Network and Remote OperationR&S®VSE

241User Manual 1176.8839.02 ─ 03

Bit No. Meaning

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus:OPERation status register.

IST Flag and Parallel Poll Enable Register (PPE)

As with the SRQ, the IST flag combines the entire status information in a single bit. It
can be read by means of a parallel poll (see "Parallel Poll" on page 247) or using the
command *IST?.

The parallel poll enable register (PPE) determines which bits of the STB contribute to
the IST flag. The bits of the STB are "ANDed" with the corresponding bits of the PPE,
with bit 6 being used as well in contrast to the SRE. The IST flag results from the
"ORing" of all results. The PPE can be set using commands *PRE and read using com-
mand *PRE?.

Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table 12-3: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.
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Bit No. Meaning

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

STATus:OPERation Register

The STATus:OPERation register contains information on current activities of the
instrument in use. It also contains information on activities that have been executed
since the last read out.

You can read out the register with STATus:OPERation:CONDition? or STATus:
OPERation[:EVENt]?.

STATus:QUEStionable Register

The STATus:QUEStionable register contains information on instrument states that do
not meet the specifications.

The STAT:QUES:SYNC register is used by the applications and is thus described in the
individual applications' User Manuals.

You can read out the register with STAT:QUES:COND or STAT:QUES:EVEN.

The STATus:QUEStionable register "sums up" the information from all subregisters
(e.g. bit 2 sums up the information for all STATus:QUEStionable:TIMe registers).
For some subregisters, there may be separate registers for each active channel. Thus,
if a status bit in the STATus:QUEStionable register indicates an error, the error may
have occurred in any of the channel-specific subregisters. In this case, you must check
the subregister of each channel to determine which channel caused the error. By
default, querying the status of a subregister always returns the result for the currently
selected channel.

STATus:QUEStionable:EXTended Register

The STATus:QUEStionable:EXTended register contains further status information
not covered by the other status registers of the instrument in use. A separate
EXTended register exists for each active channel.

You can read out the register with STATus:QUEStionable:EXTended:
CONDition? or STATus:QUEStionable:EXTended[:EVENt]?
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Table 12-4: Meaning of the bits used in the STATus:QUEStionable:EXTended register

Bit No. Meaning

0 not used

1 INFO

This bit is set if a status message is available for the application.

Which type of message occurred is indicated in the STATus:QUEStionable:EXTended:INFO
Register.

2 to 14 Unused

15 This bit is always 0.

STATus:QUEStionable:EXTended:INFO Register

The STATus:QUEStionable:EXTended:INFO register contains information on the
type of messages that occur during operation of the instrument in use. A separate
INFO register exists for each active channel.

You can read out the register with STATus:QUEStionable:EXTended:INFO:
CONDition? or STATus:QUEStionable:EXTended:INFO[:EVENt]?. You can
query all messages that occur for a specific channel using the command SYSTem:
ERRor:EXTended? on page 428.

Table 12-5: Meaning of the bits used in the STATus:QUEStionable:EXTended:INFO register

Bit No. Meaning

0 MESSage

This bit is set if event or state has occurred that may lead to an error during further operation.

1 INFO

This bit is set if an informational status message is available for the application.

2 WARNing

This bit is set if an irregular situation occurs during measurement, e.g. the settings no longer
match the displayed results, or the connection to an external device was interrupted temporarily.

3 ERRor

This bit is set if an error occurs during a measurement, e.g. due to missing data or wrong set-
tings, so that the measurement cannot be completed correctly.

4 FATal

This bit is set if a serious error occurs in the application and regular operation is no longer possi-
ble.

5 to 14 Unused

15 This bit is always 0.

STATus:QUEStionable:FREQuency Register

The STATus:QUEStionable:FREQuency register contains information about the condi-
tion of the local oscillator and the reference frequency. A separate frequency register
exists for each active channel.
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You can read out the register with STATus:QUEStionable:FREQuency:
CONDition? or STATus:QUEStionable:FREQuency[:EVENt]?.

Table 12-6: Meaning of the bits used in the STATus:QUEStionable:FREQuency register

Bit No. Meaning

1 LO UNLocked

This bit is set if the local oscillator no longer locks. "LOUNL" is displayed.

2 to 7 Not used

8 EXTernalREFerence

This bit is set if you have selected an external reference oscillator but did not connect a useable
external reference source.

In that case the synthesizer can not lock. The frequency in all probability is not accurate.

9 to 14 Not used

15 This bit is always 0.

STATus:QUEStionable:LIMit Register

The STATus:QUEStionable:LIMit register contains information about the results of a
limit check when you are working with limit lines.

A separate LIMit register exists for each active channel and for each window.

You can read out the register with STATus:QUEStionable:LIMit<n>:
CONDition? or STATus:QUEStionable:LIMit<n>[:EVENt]?.

Table 12-7: Meaning of the bits used in the STATus:QUEStionable:LIMit register

Bit No. Meaning

0 LIMit 1 FAIL

This bit is set if limit line 1 is violated.

1 LIMit 2 FAIL

This bit is set if limit line 2 is violated.

2 LIMit 3 FAIL

This bit is set if limit line 3 is violated.

3 LIMit 4 FAIL

This bit is set if limit line 4 is violated.

4 LIMit 5 FAIL

This bit is set if limit line 5 is violated.

5 LIMit 6 FAIL

This bit is set if limit line 6 is violated.

6 LIMit 7 FAIL

This bit is set if limit line 7 is violated.

7 LIMit 8 FAIL

This bit is set if limit line 8 is violated.
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Bit No. Meaning

8 to 14 Unused

15 This bit is always 0.

STATus:QUEStionable:LMARgin Register

This register contains information about the observance of limit margins.

A separate LMARgin register exists for each active channel and for each window.

It can be read using the commands
STATus:QUEStionable:LMARgin:CONDition? and
STATus:QUEStionable:LMARgin[:EVENt]?.

Table 12-8: Meaning of the bits used in the STATus:QUEStionable:LMARgin register

Bit No. Meaning

0 LMARgin 1 FAIL

This bit is set if limit margin 1 is violated.

1 LMARgin 2 FAIL

This bit is set if limit margin 2 is violated.

2 LMARgin 3 FAIL

This bit is set if limit margin 3 is violated.

3 LMARgin 4 FAIL

This bit is set if limit margin 4 is violated.

4 LMARgin 5 FAIL

This bit is set if limit margin 5 is violated.

5 LMARgin 6 FAIL

This bit is set if limit margin 6 is violated.

6 LMARgin 7 FAIL

This bit is set if limit margin 7 is violated.

7 LMARgin 8 FAIL

This bit is set if limit margin 8 is violated.

8 to 14 Not used

15 This bit is always 0.

STATus:QUEStionable:POWer Register

The STATus:QUEStionable:POWer register contains information about possible
overload situations that may occur during operation of the instrument in use. A sepa-
rate power register exists for each active channel.

You can read out the register with STATus:QUEStionable:POWer:CONDition? or
STATus:QUEStionable:POWer[:EVENt]?
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STATus:QUEStionable:TIMe Register

The STATus:QUEStionable:TIMe register contains information about possible time
errors that may occur during operation of the instrument in use. A separate time regis-
ter exists for each active channel.

You can read out the register with STATus:QUEStionable:TIME:CONDition? or
STATus:QUEStionable:TIME[:EVENt]?
Table 12-9: Meaning of the bits used in the STATus:QUEStionable:TIMe register

Bit No. Meaning

0 not used

1 Sweep time too low

This bit is set if the sweep time is too low and thus calibration fails.

Note: the STATus:QUEStionable bit for CALibration is not affected by this error.

2 to 14 Unused

15 This bit is always 0.

12.1.5.4 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods
are used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller in order to

find out who sent a SRQ and why
● Parallel poll of all devices
● Query of a specific instrument status by means of commands
● Query of the error queue

Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. A service request is a request from an instrument for information, advice or
treatment by the controller. Usually this service request initiates an interrupt at the con-
troller, to which the control program can react appropriately. As evident from fig-
ure 12-1, an SRQ is always initiated if one or several of bits 2, 3, 4, 5 or 7 of the status
byte are set and enabled in the SRE. Each of these bits combines the information of a
further register, the error queue or the output buffer. The ENABle parts of the status
registers can be set such that arbitrary bits in an arbitrary status register initiate an
SRQ. In order to make use of the possibilities of the service request effectively, all bits
should be set to "1" in enable registers SRE and ESE.

The service request is the only possibility for the instrument to become active on its
own. Each controller program should cause the instrument to initiate a service request
if errors occur. The program should react appropriately to the service request.
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Use of the command *OPC to generate an SRQ at the end of a sweep

1. CALL InstrWrite(analyzer, "*ESE 1") 'Set bit 0 in the ESE (Operation
Complete)

2. CALL InstrWrite(analyzer, "*SRE 32") 'Set bit 5 in the SRE (ESB)

3. CALL InstrWrite(analyzer, "*INIT;*OPC") ' Generate an SRQ after
operation complete

After its settings have been completed, the instrument generates an SRQ.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

Parallel Poll

In a parallel poll, up to eight instruments are simultaneously requested by the controller
using a single command to transmit 1 bit of information each on the data lines, i.e., to
set the data line allocated to each instrument to a logical "0" or "1".

In addition to the SRE register, which determines the conditions under which an SRQ
is generated, there is a Parallel Poll Enable register (PPE) which is ANDed with the
STB bit by bit, considering bit 6 as well. This register is ANDed with the STB bit by bit,
considering bit 6 as well. The results are ORed, the result is possibly inverted and then
sent as a response to the parallel poll of the controller. The result can also be queried
without parallel poll using the command *IST?.

The instrument first has to be set for the parallel poll using the command PPC. This
command allocates a data line to the instrument and determines whether the response
is to be inverted. The parallel poll itself is executed using PPE.

The parallel poll method is mainly used to find out quickly which one of the instruments
connected to the controller has sent a service request. To this effect, SRE and PPE
must be set to the same value.

Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)
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The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

Decimal representation of a bit pattern

The STB and ESR registers contain 8 bits, the SCPI registers 16 bits. The contents of
a status register are specified and transferred as a single decimal number. To make
this possible, each bit is assigned a weighted value. The decimal number is calculated
as the sum of the weighted values of all bits in the register that are set to 1.

Example: 
The decimal value 40 = 32 + 8 indicates that bits no. 3 and 5 in the status register (e.g.
the QUEStionable status summary bit and the ESB bit in the STatus Byte ) are set.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor[:NEXT]? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor[:NEXT]? provides one entry
from the error queue. If no error messages are stored there any more, the instrument
responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
larly since faulty commands from the controller to the instrument are recorded there as
well.

12.1.5.5 Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except *RST and
SYSTem:PRESet, influence the functional instrument settings. In particular, DCL does
not change the instrument settings.
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Table 12-10: Resetting the status reporting system

Event Switching on supply
voltage

Power-On-Status-
Clear

DCL,
SDC

(Device
Clear,
Selected
Device
Clear)

*RST or
SYS-
Tem:PRE-
Set

STA-
Tus:PRE-
Set

*CLS

Effect 0 1

Clear STB, ESR - yes - - - yes

Clear SRE, ESE - yes - - - -

Clear PPE - yes - - - -

Clear EVENt parts of the regis-
ters

- yes - - - yes

Clear ENABle parts of all
OPERation and QUEStionable
registers;

Fill ENABle parts of all other
registers with "1".

- yes - - yes -

Fill PTRansition parts with "1";

Clear NTRansition parts

- yes - - yes -

Clear error queue yes yes - - - yes

Clear output buffer yes yes yes 1) 1) 1)

Clear command processing
and input buffer

yes yes yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

12.1.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In con-
trast, the priority of remote control is the "predictability" of the instrument status. Thus,
when a command attempts to define incompatible settings, the command is ignored
and the instrument status remains unchanged, i.e. other settings are not automatically
adapted. Therefore, control programs should always define an initial instrument status
(e.g. using the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also chapter 12.1.4.1, "Preventing Overlapping Execution", on page 234).
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Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its
own. Each controller program should instruct the instrument to initiate a service
request in case of malfunction. The program should react appropriately to the service
request.

Error queues

The error queue should be queried after every service request in the controller pro-
gram as the entries describe the cause of an error more precisely than the status regis-
ters. Especially in the test phase of a controller program the error queue should be
queried regularly since faulty commands from the controller to the instrument are
recorded there as well.

12.1.7 Locking Instruments for Exclusive Remote Control

In order to keep full control of the instrument while performing a specific task, it is
important to prevent access by other users or devices during remote control.

While in remote mode, you can prevent manual operation using the Local Lockout
function. If enabled, the instrument in use can no longer be operated by the keys on
the front panel or using the touchscreen. A remote command is required to enable
manual operation again.

Similarly, remote control by any other device can be prevented using the VISA lock
(see chapter 7.2.7, "Configuring the Behavior During Remote Control", on page 63). If
enabled, the connection to the instrument in use is locked by the first device to estab-
lish a connection, so that no other devices can access the instrument. The R&S VSE
software can be configured to lock all connections by default (see "Lock new VISA con-
nections" on page 252), or individual connections can be locked.

Note, however, that if you exclude manual operation and use the VISA lock, then if the
remote connection from the control PC to the instrument in use is interrupted, regaining
control of the instrument in use may cause problems (see "To regain control over a
blocked remote channel" on page 445).

12.2 Network and Remote Control Settings

Access: "File""Preferences" > "Network + Remote"
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Identification String
Defines the identification string for the R&S VSE which is provided as a response to
the *IDN? query. Maximum 36 characters are allowed.

Remote command: 
SYSTem:IDENtify[:STRing] on page 423

Reset to Factory String
Restores the default identification string. Each R&S VSE has a unique ID according to
the following syntax:

Rohde&Schwarz,VSE,<Unique number>

Remote command: 
SYSTem:IDENtify:FACTory on page 423

Remote Display Update
Defines whether the display of the R&S VSE is updated when changing from manual
operation to remote control.

Turning off the display update function improves performance during remote control.

Tip: you can also turn off the display update function on the instrument in use when it is
being controlled by the R&S VSE software, see "Display Update" on page 64.

Remote command: 
SYSTem:DISPlay:UPDate on page 423
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I/O Logging
Activates or deactivates the SCPI error log function. All remote control commands
received by the R&S VSE are recorded in the following log file:
C:
\ProgramData\Rohde-Schwarz\VSE\<version_number>\scpilogging\ScpiLog.txt
Logging the commands may be extremely useful for debug purposes, e.g. in order to
find misspelled keywords in control programs.

Remote command: 
SYSTem:CLOGging on page 422

Lock new VISA connections
Defines the default setting for the VISA connection lock for all subsequent instrument
connections (see "VISA lock state" on page 64). If the connection is locked, no other
devices can operate the same instrument remotely.

Tip: In order to lock existing connections, use the VISA lock state function (see chap-
ter 7.2.7, "Configuring the Behavior During Remote Control", on page 63).

Remote command: 
DEVice:LOCKing:DEFault on page 422

VISA library to use
Defines the VISA library to be used for subsequent instrument connections. Only VISA
libraries that were detected in the network when the software was started are listed.
However, you can select further libraries from the network manually.

If you change the VISA library to use and confirm the message, all currently estab-
lished connections are closed and the VISA library is deactivated. Then the new VISA
library is activated and the defined connections are re-established.

If the selected VISA library is not available at the time of connection, an error message
is displayed.

"<VISA
Library>"

Selects one of the VISA libraries detected in the network

"..." Opens a file selection dialog box to select a .dll file containing a
VISA library manually.

"Auto Select" Automatically selects the first available VISA library in the list to be
used

Remote command: 
not available

GPIB Terminator
Changes the GPIB receive terminator.

"LFEOI" According to the standard, the terminator in ASCII is <LF> and/or
<EOI>.
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"EOI" For binary data transfers (e.g. trace data) from the control computer
to the instrument, the binary code used for <LF> might be included in
the binary data block, and therefore should not be interpreted as a
terminator in this particular case. This can be avoided by using only
the receive terminator EOI.

Remote command: 
SYSTem:COMMunicate:GPIB[:SELF]:RTERminator on page 422

Network Configuration
Opens the standard Windows "Network Configuration" dialog box for further configura-
tion.

12.3 How to Set Up a Network and Remote Control

Remote operation of the R&S VSE software is possible using SCPI commands (see
chapter 12.1.1, "SCPI (Standard Commands for Programmable Instruments)",
on page 223).

12.3.1 How to Configure a Network

In order to operate the R&S Vector Signal Explorer Base Software remotely, the PC
running the R&S VSE software as well as the instrument in use must be connected to
a LAN network.

How to configure the R&S VSE software is described here. For details on configuring
the instrument in use see the instrument's documentation.

Windows Firewall Settings
A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends the use of the firewall on
your instrument. R&S instruments are shipped with the Windows firewall enabled and
preconfigured in such a way that all ports and connections for remote control are
enabled.
For more details on firewall configuration, see the Rohde & Schwarz White Paper
1DC01: Malware Protection.

12.3.1.1 How to Assign the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

● If the network does not support DHCP, or if the instrument is set to use alternate
TCP/IP configuration, the addresses must be set manually.
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By default, most instrument in use are configured to use dynamic TCP/IP configuration
and obtain all address information automatically. This means that it is safe to establish
a physical connection to the LAN without any previous instrument configuration.

When a DHCP server is used, a new IP address may be assigned each time the PC is
restarted. This address must first be determined on the PC itself. Thus, when using a
DHCP server, it is recommended that you use the permanent computer name, which
determines the address via the DNS server (see "Using a DNS server to determine the
IP address" on page 256).

Risk of network errors
Connection errors can affect the entire network. If your network does not support
DHCP, or if you choose to disable dynamic TCP/IP configuration, you must assign
valid address information before connecting the instrument to the LAN. Contact your
network administrator to obtain a valid IP address.

Assigning the IP address on the PC running the R&S VSE software

1. Select "File > Preferences > Network + Remote".

2. Select "Open Network Configuration".

3. Double-click the "Local Area Connection" icon.

4. In the "Local Area Connection Status" dialog box, select the "Properties" button.

The items used by the LAN connection are displayed.

5. Click the entry named "Internet Protocol Version 4 (TCP/IPv4)" to highlight it.

How to Set Up a Network and Remote Control



Network and Remote OperationR&S®VSE

255User Manual 1176.8839.02 ─ 03

6. Select the "Properties" button.

7. In the "General" tab, select "Use the following IP address" .

8. Enter the "IP Address", for example 10.0.0.10. The IP address consists of four
number blocks separated by dots. Every block contains 3 numbers in maximum.

9. Enter the "Subnet Mask", for example 255.255.255.0. The subnet mask consists of
four number blocks separated by dots. Every block contains 3 numbers in maxi-
mum.

10. Close the dialog box.

If you have entered an invalid IP address or subnet mask, the message "out of
range" is displayed in the status line. If the settings are correct, the configuration is
saved, and you are prompted to restart the PC.

11. Confirm the displayed message ("Yes" button) to restart the PC.
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Using a DNS server to determine the IP address

If a DNS server is configured on the PC running the R&S VSE software, the server can
determine the current IP address for the connection using the permanent computer
name.

1. For the instrument in use:

a) Obtain the name of your DNS domain and the IP addresses of the DNS and
WINS servers on your network.

b) Press the SETUP key and then the "Network + Remote" softkey.
c) In the "Network" tab, select the "Open Dialog 'Network Connections'" button.

2. For the PC running the R&S VSE software:

a) Select "File > Preferences > Network + Remote".
b) Select "Open Network Configuration".

3. click the "Local Area Network" icon.

4. In the "Local Area Connection Status" dialog box, select the "Properties" button.

The items used by the LAN connection are displayed.

5. Click the entry named "Internet Protocol Version 4 (TCP/IPv4)" to highlight it.

6. Select the "Properties" button.

7. On the "General" tab, select "Use the following DNS server addresses" and enter
your own DNS addresses.

For more information refer to the Windows 7 operating system Help.

12.3.2 How to Log on to the Network

Windows 7 requires that users identify themselves by entering a user name and pass-
word in a login window. You can set up two types of user accounts, either an adminis-
trator account with unrestricted access to the computer/domain or a standard user
account with limited access. Most instrumentss provide an auto-login function for the
administrator account, i.e. login with unrestricted access is carried out automatically in
the background. By default, the user name for the administrator account is "Instru-
ment", and the user name for the standard user account is "NormalUser". In both
cases the initial password is "894129". You can change the password in Windows 7 for
any user at any time. Some administrative tasks require administrator rights (e.g.
changing the computer name or the configuration of a LAN network).

At the same time you log on to the operating system, you are automatically logged on
to the network. As a prerequisite, the user name and the password must be identical
on the instrument and on the network.
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12.3.2.1 How to Change the User Password

After the new user has been created on the instrument, the password must be adapted
to the network password. This is also done using the "User Accounts" dialog box.

1.

Select the "Windows" icon in the toolbar to access the operating system.

2. Press CTRL  + ALT + DELETE, then select "Change a password".

3. Enter the user account name.

4. Enter the old password.

5. Enter the new password in the upper text line and repeat it in the following line.

6. Press ENTER.
The new password is now active.

12.3.3 How to Start a Remote Control Session from a PC

To start remote control

1. Send an addressed command (GTR - Go to Remote) from a controller to the instru-
ment.

The instrument is switched to remote control ("remote" state). Operation via the
front panel is disabled. Only the "Local" softkey is displayed to return to manual
operation. The instrument remains in the remote state until it is reset to the manual
state via the instrument or via remote control interfaces. Switching from manual
operation to remote control and vice versa does not affect the other instrument set-
tings.

2. To obtain optimum performance during remote control, send the
SYST:DISPlay:UPDate OFF command to deactivate the display of results on
the instrument in use.

3. Send the DEV:GEN:DISP:UPD ON command to activate the display of results in
the R&S VSE software (see DEVice:GENeral:DISPlay on page 270).

The changes in the device settings and the recorded measurement values are dis-
played in the software window.

4. To prevent other users from taking remote control of the instrument in use, lock the
connection using the DEVice:LOCKing or DEVice:LOCKing:ALL commands.

5. To prevent other users from taking manual control of the instrument in use, disable
the keys of the instrument and the "Local" function using the command
DEV:GEN:LLO ON.
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Switching to manual mode is only possible via remote control then.

6. To enable the keys of the instrument in use again use DEV:GEN:LLO OFF, or
switch the instrument to local mode (GTL - Go to Local), i.e. deactivate the REN line
of the remote control interface.

12.3.4 How to Return to Manual Operation on the Instrument

Before you switch the instrument back to manual operation, all remote command pro-
cessing must be completed. Otherwise, the instrument will switch back to remote con-
trol immediately.

1. If necessary, enable the keys of the instrument and the "Local" function using the
command DEV:GEN:LLO OFF.

2. On the instrument, if available, select the "Local" softkey or the PRESET key.
Alternatively, send the @LOC command to the instrument in use.
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13 Remote Commands
● Conventions used in SCPI Command Descriptions..............................................259
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● Configuring the Result Display..............................................................................299
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13.1 Conventions used in SCPI Command Descriptions

Note the following conventions used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitely.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S VSE follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Default unit
This is the unit used for numeric values if no other unit is provided with the parame-
ter.

● Manual operation
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If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

13.2 Common Suffixes

In the I/Q Analyzer application, the following common suffixes are used in remote com-
mands:

Suffix Value range Description

<m> 1

1..16

Marker

Deltamarker

<n> 1..16 Window

<t> 1..6 Trace

13.3 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CAL?...........................................................................................................................260
*CLS.............................................................................................................................261
*ESE.............................................................................................................................261
*ESR?...........................................................................................................................261
*IDN?............................................................................................................................261
*IST?............................................................................................................................ 261
*OPC............................................................................................................................262
*OPT?...........................................................................................................................262
*PCB............................................................................................................................ 262
*PRE............................................................................................................................ 262
*PSC............................................................................................................................ 262
*RST.............................................................................................................................263
*SRE............................................................................................................................ 263
*STB?...........................................................................................................................263
*TRG............................................................................................................................ 263
*TST?........................................................................................................................... 264
*WAI.............................................................................................................................264

*CAL?

Calibration query
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Initiates a calibration of the instrument and subsequently queries the calibration status.
Responses > 0 indicate errors.

Note: If you start a self-alignment remotely, then select the "Local" softkey while the
alignment is still running, the instrument only returns to the manual operation state
after the alignment is completed.

Usage: Query only

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event status read

Returns the contents of the event status register in decimal form and subsequently
sets the register to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification

Returns the instrument identification.

Usage: Query only

*IST?

Individual status query
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Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query form writes a "1" into
the output buffer as soon as all preceding commands have been executed. This is
used for command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description refer to the data sheet.

Usage: Query only

*PCB <Address>

Pass control back

Indicates the controller address to which remote control is returned after termination of
the triggered action.

Setting parameters: 
<Address> Range: 0  to  30

Usage: Setting only

*PRE <Value>

Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on status clear
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Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RST

Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

Manual operation: See "Restoring All Default Settings ( Preset All )" on page 76

*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.
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Usage: Event

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code in decimal form (see Ser-
vice Manual supplied with the instrument). "0" indicates no errors occured.

Note: If you start a self-test remotely, then select the "Local" softkey while the test is
still running, the instrument only returns to the manual operation state after the test is
completed. In this case, the self-test cannot be aborted.

Usage: Query only

*WAI

Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

13.4 Controlling Instruments and Capturing Data

● Configuring Instruments........................................................................................264
● Loading Input Files................................................................................................276
● Configuring Channel Input Sources...................................................................... 284
● Configuring Measurement Channels.....................................................................285
● Controlling Measurement Groups......................................................................... 292
● Controlling Measurement Sequences...................................................................297

13.4.1 Configuring Instruments

The R&S VSE can capture and analyze data from various instruments. These instru-
ments must be configured before measurements can be performed on them via the
R&S VSE.

How to configure instruments in manual mode is described in chapter 7.2, "Configuring
Instruments", on page 53.

● Configuring the Basic Connection Data................................................................ 265
● Obtaining Information on Connected Instruments.................................................268
● General Instrument Setup.....................................................................................270
● Configuring an External Reference on the Instrument..........................................272
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13.4.1.1 Configuring the Basic Connection Data

DEVice:CREate ............................................................................................................ 265
DEVice:DELete..............................................................................................................265
DEVice:DELete:ALL....................................................................................................... 266
DEVice:LIST?................................................................................................................266
DEVice:STATe?.............................................................................................................266
DEVice:TARGet.............................................................................................................267
DEVice:TARGet?........................................................................................................... 267
DEVice:TARGet:TYPE................................................................................................... 268

DEVice:CREate <DevName>,<Address>,<Protocol>

Defines a new connection to a instrument to be controlled by the R&S VSE software.

Setting parameters: 
<DevName> string

Name of the instrument to be used for subsequent reference

<Address> string
Network address of the instrument, for example IP address

<Protocol> Interface protocol used to connect the specified instrument to
the network
VXI11
Standard TCP/IP-based protocol
HiSlip
High performance protocol

Example: DEV:CRE 'SpecAnalyzer','100.100.100.100',VXI11
Usage: Setting only

Manual operation: See "New Instrument" on page 57

DEVice:DELete <DevName>

Deletes the connection settings of the specified instrument. Note that after deleting a
connection, the instrument is no longer known to the R&S VSE software.

Setting parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:CRE 'SpecAnalyzer','100.100.100.100',
'VXI11'
DEV:DEL 'SpecAnalyzer'

Usage: Setting only

Manual operation: See "Close Instrument" on page 57
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DEVice:DELete:ALL

Deletes the connection settings of all defined instruments. Note that after deleting a
connection, the instrument is no longer known to the R&S VSE software.

Usage: Event

Manual operation: See "Restoring All Default Settings and Deleting Instrument
Configurations ( Preset All & Delete Instruments )" on page 76

DEVice:LIST?

Queries the names of all defined instruments, whether they are currently connected or
not. Defined instruments with no (valid) IP address are also included. The names are
returned as a comma-separated list in the order of their definition.

Return values: 
<InstName> string

Name of the instrument

Example: DEV:LIST?
Result:
'FSW-8*','New Instrument*','New Instrument
(2)*'

Usage: Query only

DEVice:STATe? <DevName>

Queries the connection status of the specified instrument.

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
Instrument is connected to the network
OFF | 0
No connection to the instrument established.
*RST: OFF

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:STAT? 'SpecAnalyzer'
Usage: Query only

Manual operation: See "Connection State" on page 58
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DEVice:TARGet <DevName>,<Address>[,<Protocol>]

Changes the network address and, optionally, the interface protocol of the specified
instrument.

Setting parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

<Address> string
Network address of the instrument, for example IP address

<Protocol> Interface protocol used to connect the specified instrument to
the network
VXI11
Standard TCP/IP-based protocol
HiSlip
High performance protocol

Example: DEV:TARG 'SpecAnalyzer','100.100.100.100',
'VXI11'

Usage: Setting only

Manual operation: See "IP address" on page 57

DEVice:TARGet? <DevName>

Queries the network address of the specified instrument.

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Return values: 
<Address> string

Network address of the instrument, for example IP address

Example: DEV:TARG 'SpecAnalyzer','100.100.100.100',
'VXI11'
DEV:TARG? 'SpecAnalyzer'
Result:
'100.100.100.100'

Usage: Query only

Manual operation: See "IP address" on page 57
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DEVice:TARGet:TYPE <DevName>,<Protocol>
DEVice:TARGet:TYPE? <DevName>

Defines or queries the interface protocol used to connect the specified instrument to
the network.

For details on interfaces see chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 53

Setting parameters: 
<Protocol> Interface protocol used to connect the specified instrument to

the network
VXI11
Standard TCP/IP-based protocol
HiSlip
High performance protocol

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:TARG:TYPE 'SpecAnalyzer','VXI11'
Manual operation: See "Interface Type" on page 57

13.4.1.2 Obtaining Information on Connected Instruments

The following commands are required to query information on the firmware version and
options installed on the instrument in use.

For details on options refer to the instrument's documentation.

DEVice:INFO:HWINfo?...................................................................................................268
DEVice:INFO:IDN?.........................................................................................................269
DEVice:INFO:OPT?....................................................................................................... 269

DEVice:INFO:HWINfo? <DevName>

This command queries hardware information for the instrument in use.

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)
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Return values: 
<Info> String containing the following information for every hardware

component.
<component>: name of the hardware component
<serial#>: serial number of the component
<order#>: order number of the component
<model>: model of the component
<code>: code of the component
<revision>: revision of the component

Example: DEV:INFO:HWIN? 'SpecAnalyzer'
Queries the hardware information for the instrument named
'SpecAnalyzer'.
"FRONTEND|100001/003|1300.3009|03|01|00|00",
"MOTHERBOARD|123456/002|1300.3080|02|00|00|00",
...

Usage: Query only

Manual operation: See "Infos & Settings" on page 58

DEVice:INFO:IDN? <DevName>

Returns the instrument identification for the specified instrument.

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Return values: 
<ID> "Rohde&Schwarz,<device type>,<part number>/serial num-

ber>,<firmware version>"

Example: DEV:INFO:IDN? 'SpecAnalyzer'
Rohde&Schwarz,FSW-26,1312.8000K26/100005,1.30

Usage: Query only

Manual operation: See "Infos & Settings" on page 58

DEVice:INFO:OPT? <DevName>

Queries the options included in the specified instrument. For a list of all available
options and their description refer to the data sheet.

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)
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Return values: 
<Options> The query returns a list of all installed and activated options,

separated by commas, where:
B<number> describes hardware options
K<number> describes software options

Example: DEV:INFO:OPT? 'SpecAnalyzer'
B4,B5,B6,B7,B8,B10,B22,B30,B31,K7,K70

Usage: Query only

Manual operation: See "Infos & Settings" on page 58

13.4.1.3 General Instrument Setup

The following commands are required to configure initial instrument settings relevant
for control by the software.

DEVice:GENeral:DISPlay................................................................................................270
DEVice:GENeral:LLO..................................................................................................... 270
DEVice:LOCKing........................................................................................................... 271
DEVice:LOCKing:ALL.....................................................................................................272

DEVice:GENeral:DISPlay <DevName>

Activates or deactivates the display update function on the specified instrument.

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
The instrument display is updated while it is being controlled
remotely (e.g. by the R&S VSE software)
OFF | 0
The instrument's display is deactivated while it is being control-
led remotely. This improves performance during remote control.
*RST: OFF

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:GEN:DISP 'SpecAnalyzer', ON
Manual operation: See "Display Update" on page 64

DEVice:GENeral:LLO <DevName>

Activates or deactivates the local lockout function on the specified instrument.
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Parameters:
<State> ON | OFF | 1 | 0

ON | 1
Instrument is set to be controlled remotely (that is, by the
R&S VSE software)
OFF | 0
Instrument is set to be operated locally (via its graphical user
interface).
*RST: OFF

Query parameters: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:GEN:LLO 'SpecAnalyzer', ON
Manual operation: See "Local Lockout" on page 63

DEVice:LOCKing <DevName>,<STATe>
DEVice:LOCKing? <DevName>

Locks or unlocks the VISA connection to the selected instrument. If the connection is
locked, no other devices can operate the same instrument remotely. If no connection to
the instrument has been established yet, any subsequent connection to it is locked
immediately.

This command is similar to the DEVice:GENeral:LLO command, but for remote
operation.

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
Connection is locked, no other devices can establish a connec-
tion to the same instrument
OFF | 0
Connection is unlocked, other devices in the network can con-
nect to the instrument
*RST: OFF

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:LOCK 'SpecAnalyzer', ON
Manual operation: See "VISA lock state" on page 64
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DEVice:LOCKing:ALL <STATe>

Locks or unlocks the VISA connection for all currently connected instruments. (The
command has the same effect as the DEVice:LOCKing command for all currently
connected instruments.)

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
All instrument connections are locked; no other devices can
establish a connection to any of the instruments
OFF | 0
All instrument connections are unlocked; other devices in the
network can connect to all instruments
*RST: OFF

Example: DEV:LOCK:ALL ON
Usage: Setting only

Manual operation: See "VISA lock state" on page 64

13.4.1.4 Configuring an External Reference on the Instrument

The following commands are required to configure the use of an external reference on
the instrument in use.

For manual operation see chapter 13.4.1.4, "Configuring an External Reference on the
Instrument", on page 272.

DEVice:EXTRef:FREQuency...........................................................................................272
DEVice:EXTRef:LBWidth................................................................................................ 273
DEVice:EXTRef:O100.................................................................................................... 273
DEVice:EXTRef:O640.................................................................................................... 274
DEVice:EXTRef:OSYNc..................................................................................................274
DEVice:EXTRef:SOURce................................................................................................274
DEVice:EXTRef:TRANge................................................................................................275

DEVice:EXTRef:FREQuency <DevName>,<Frequency>
DEVice:EXTRef:FREQuency? <DevName>

This command defines the frequency of the external reference oscillator of the instru-
ment in use.

The reference signal must be connected to the rear panel of the instrument.

Parameters:
<Frequency> Range: 1 MHz  to  20 MHz

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)
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Example: DEV:EXTR:FREQ 'SpecAnalyzer',13MHZ
Sets the frequency for the 'SpecAnalyzer' instrument to 13 MHz.

Example: DEV:EXTR:FREQ? 'SpecAnalyzer'
Queries the external reference frequency for the 'SpecAnalyzer'
instrument.
Result: 13MHZ

Manual operation: See "Frequency" on page 65

DEVice:EXTRef:LBWidth <DevName>,<Bandwidth>
DEVice:EXTRef:LBWidth? <DevName>

Defines the loop bandwidth, that is, the speed of internal synchronization with the refer-
ence frequency on the instrument in use. The setting requires a compromise between
performance and increasing phase noise.

For a variable external reference frequency with a narrow tuning range (+/- 0.5 ppm),
the loop bandwidth is fixed to 0.1 Hz and cannot be changed.

Parameters:
<Bandwidth> 0.1 Hz | 1 Hz | 3 Hz | 10 Hz | 30 Hz | 100 Hz | 300 Hz

The possible values depend on the reference source and tuning
range (see instrument documentation).
Default unit: Hz

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR::LBW 3
Manual operation: See "Loop Bandwidth" on page 66

DEVice:EXTRef:O100 <DevName>,<State>
DEVice:EXTRef:O100? <DevName>

If enabled, a 100 MHz reference signal is provided to the REF OUTPUT 100 MHZ con-
nector of the instrument in use.

Parameters:
<State> ON | OFF

*RST: OFF

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR:O100 ON
Manual operation: See "Reference Frequency Output" on page 66
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DEVice:EXTRef:O640 <DevName>,<State>
DEVice:EXTRef:O640? <DevName>

If enabled, a 640 MHz reference signal is provided to the REF OUTPUT 640 MHZ con-
nector of the instrument in use.

Parameters:
<State> ON | OFF

*RST: OFF

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR:O640 ON
Manual operation: See "Reference Frequency Output" on page 66

DEVice:EXTRef:OSYNc <DevName>,<State>
DEVice:EXTRef:OSYNc? <DevName>

If enabled, a 100 MHz reference signal is provided to the SYNC TRIGGER OUTPUT
connector of the instrument in use.

Parameters:
<State> ON | OFF

*RST: OFF

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR:OSYN ON
Manual operation: See "Reference Frequency Output" on page 66

DEVice:EXTRef:SOURce <DevName>,<Source>
DEVice:EXTRef:SOURce? <DevName>

This command selects the reference oscillator for the instrument in use.

The external reference must be connected to the instrument in use.

Note that depending on the type of instrument connected to the R&S VSE software,
not all options may be available.
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Parameters:
<Source> INTernal

the internal reference is used (10 MHz)
EXTernal
the external reference from the REF INPUT 1..20 MHZ connec-
tor is used with a variable frequency; if none is available, an
error flag is displayed in the status bar
E10
the external reference from REF INPUT 1..20 MHZ connector is
used with a fixed 10 MHZ frequency; if none is available, an
error flag is displayed in the status bar
E100
the external reference from REF INPUT 100 MHZ connector is
used; if none is available, an error flag is displayed in the status
bar
EAUTo
the external reference is used as long as it is available, then the
instrument switches to the internal reference
SYNC
the external reference is used; if none is available, an error flag
is displayed in the status bar

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR:SOUR EXT
Usage: SCPI confirmed

Manual operation: See "Reference Frequency Input Source" on page 65

DEVice:EXTRef:TRANge <DevName>,<Range>
DEVice:EXTRef:TRANge? <DevName>

Defines the tuning range of the external reference for the instrument in use. The tuning
range is only available for the variable external reference frequency
(DEV:EXTR:SOUR EXT). It determines how far the frequency may deviate from the
defined level in parts per million (10-6).
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Parameters:
<Range> The possible values depend on the reference source (see instru-

ment documentation).
SMALl
With this smaller deviation (+/- 0.5 ppm) a very narrow fixed loop
bandwidth of 0.1 Hz is realized. With this setting the instrument
can synchronize to an external reference signal with a very pre-
cise frequency. Due to the very narrow loop bandwidth, unwan-
ted noise or spurious components on the external reference
input signal are strongly attenuated. Furthermore, the loop
requires about 30 seconds to reach a locked state. During this
locking process, "NO REF" is displayed in the status bar.
WIDE
The larger deviation (+/- 6 ppm) allows the instrument to syn-
chronize to less precise external reference input signals.

Parameters for setting and query: 
<DevName> string

Name of a configured instrument (see DEVice:CREate 
on page 265)

Example: DEV:EXTR:TRAN WIDE
Manual operation: See "Tuning Range" on page 65

13.4.2 Loading Input Files

The following commands are required to load measurement data from files to be used
as input. (See also chapter 8.3.4, "Recalling Measurement Data from Files",
on page 92).

Useful commands for using input files described elsewhere:
● INSTrument:BLOCk:CHANnel[:SETTings]:SOURce on page 285
● EXPort:IQ:META:DATA<I>:VALue? on page 404

Remote commands exclusive to loading input files:

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV.................................................... 277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:SAMPle.................................277
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:TIME.................................... 278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW.....................................................278
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT.................................................... 279
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:OFF.............................. 280
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:ON................................ 281
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:SAMPle.....................................281
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:TIME.........................................282
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:SAMPle......................................282
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:TIME..........................................283
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar].................................................283
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INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CSV
<FileName>,<ABW>[,<IQChannel]

Assigns the specified .csv file as the input source for the currently selected channel.
The file is automatically loaded to the R&S VSE software and assigned the sequential
number provided as the FILE<i> suffix. Subsequent commands concerning file input
from this file must use the same suffix.

Suffix: 
<i>

.
1..99
Sequential number of the source

Parameters:
<FileName> String containing the path and file name of the file to be loaded.

<ABW> The analysis bandwidth to be used by the measurement. The
bandwidth must be smaller than or equal to the bandwidth of the
data that was stored in the file.
Tip: If the file was stored using the R&S VSE software, the ABW
is included in the meta data information in the file (see "Meta
Data Settings" on page 90).

<IQChannel> ID of the I/Q channel in the stored file which is to be restored to
the selected measurement channel.
If this parameter is omitted, the first channel found is restored.
Tip: If the file was stored using the R&S VSE software, the I/Q
channel is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

Example: INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:FILE:CSV 'C:
\Users\ImportFile.csv',10MHZ,2
The data from the second I/Q channel stored in the file is used
as input for the current measurement channel 'IQ Analyzer'. The
displayed bandwidth is restricted to 10 MHz.

Manual operation: See "File" on page 73

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:SAMPle <Sample>

This command defines the sample within the input file <i> which is currently displayed.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Sample> numeric value

Range: 0  to  record length of stored data
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Example: INST:BLOC:CHAN:FILE:STAR:SAMP 10
INST:BLOC:CHAN:FILE:STOP:SAMP 1000
INST:BLOC:CHAN:FILE:CURR:SAMP 120
Data from the input file is replayed starting with sample number
10 and ending with sample number 1000. The current display is
at sample 120.

Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:CURRent:TIME <Time>

This command defines the (absolute) time within the input file <i> which is currently
displayed.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Time> double value

Absolute time
Range: 0  to  meas time of stored data
Default unit: s

Example: INST:BLOC:CHAN:FILE:STAR:TIME 0.32s
INST:BLOC:CHAN:FILE:STOP:TIME 0.64s
INST:BLOC:CHAN:FILE:CURR:TIME 0.40s
Data from the input file is replayed starting at 0.32 s and ending
at 0.64 s of the captured data. The current display is at 0.40 s.

Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:IQW
<FileName>,<ABW>,<SampleRate>[,Format][,<IQChannel]

Assigns the specified .iqw file as the input source for the currently selected channel.
The file is automatically loaded to the R&S VSE software and assigned the sequential
number provided as the FILE<i> suffix. Subsequent commands concerning file input
from this file must use the same suffix.

Suffix: 
<i>

.
1..99
Sequential number of the source

Parameters:
<FileName> String containing the path and file name of the file to be loaded.
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<ABW> The analysis bandwidth to be used by the measurement. The
bandwidth must be smaller than or equal to the bandwidth of the
data that was stored in the file.
Tip: If the file was stored using the R&S VSE software, the ABW
is included in the meta data information in the file (see "Meta
Data Settings" on page 90).

<SampleRate> The sample rate used to obtain the stored data.
Tip: If the file was stored using the R&S VSE software, the sam-
ple rate is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

<Format> The format in which the I/Q data is provided
IIQQ | IQBLock
First all I-values are listed, then the Q-values
(I,I,I,I,I,I,...Q,Q,Q,Q,Q,Q)
IQIQ | IQPair
One pair of I/Q values after the other is listed
(I,Q,I,Q,I,Q...).
*RST: IQPair

<IQChannel> ID of the I/Q channel in the stored file which is to be restored to
the selected measurement channel.
If this parameter is omitted, the first channel found is restored.
Tip: If the file was stored using the R&S VSE software, the I/Q
channel is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

Example: INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:FILE:IQW 'C:
\Users\ImportFile.iqw',10MHZ,32MHz,IIQQ,2
The data from the second I/Q channel stored in the file is used
as input for the current measurement channel 'IQ Analyzer'. The
displayed bandwidth is restricted to 10 MHz. A sample rate of 32
MHz is applied. The data is interpreted in the format "IIQQ".

Manual operation: See "File" on page 73

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:MAT
<FileName>,<ABW>,<SampleRate>[,Format][,<IQChannel]

Assigns the specified .mat file as the input source for the currently selected channel.
The file is automatically loaded to the R&S VSE software and assigned the sequential
number provided as the FILE<i> suffix. Subsequent commands concerning file input
from this file must use the same suffix.

Suffix: 
<i>

.
1..99
Sequential number of the source

Parameters:
<FileName> String containing the path and file name of the file to be loaded.
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<ABW> The analysis bandwidth to be used by the measurement. The
bandwidth must be smaller than or equal to the bandwidth of the
data that was stored in the file.
Tip: If the file was stored using the R&S VSE software, the ABW
is included in the meta data information in the file (see "Meta
Data Settings" on page 90).

<SampleRate> The sample rate used to obtain the stored data.
Tip: If the file was stored using the R&S VSE software, the sam-
ple rate is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

<Format> IIQQ | IQPair
The format in which the I/Q data is provided
IIQQ
First all I-values are listed, then the Q-values
(I,I,I,I,I,I,...Q,Q,Q,Q,Q,Q)
IQPair
One pair of I/Q values after the other is listed
(I,Q,I,Q,I,Q...).
*RST: IQPair

<IQChannel> ID of the I/Q channel in the stored file which is to be restored to
the selected measurement channel.
If this parameter is omitted, the first channel found is restored.
Tip: If the file was stored using the R&S VSE software, the I/Q
channel is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

Example: INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:FILE:MAT 'C:
\Users\ImportFile.mat',10MHZ,32MHz,IIQQ,2
The data from the second I/Q channel stored in the file is used
as input for the current measurement channel 'IQ Analyzer'. The
displayed bandwidth is restricted to 10 MHz. A sample rate of 32
MHz is applied. The data is interpreted in the format "IIQQ".

Manual operation: See "File" on page 73

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:OFF
<Percentage>

The overlap settings determine how successive records within one data file are
replayed.

This command defines the behaviour if a non-averaging trace detector is used.

After the first record has been replayed, the specified percentage (x) of the next record
is displayed together with the remaining data (meas time - x) from the previous record.
This leads to a smoother trace update; whereas without any overlap, the trace appears
to "jump" after each record.
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Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Percentage> numeric value

Range: 0  to  100
*RST: 90

Example: INST:BLOC:CHAN:FILE1:OVER:AVG:OFF 75
For normal clear/write traces, after each update, the display
shows 25% of the previous record and 75% of the next record.

Manual operation: See "Overlap Settings" on page 97

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:OVERlap:AVG:ON
<Percentage>

The overlap settings determine how successive records within one data file are
replayed.

This command defines the behaviour if an averaging trace detector is used.

After the first record has been replayed, the specified percentage (x) of the next record
is displayed together with the remaining data (meas time - x) from the previous record.
This leads to a smoother trace update; whereas without any overlap, the trace appears
to "jump" after each record.

On the other hand, if an overlap is applied, the overlapping data is included in multiple
averaging calculations, thus distorting the overall average.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Percentage> numeric value

Range: 0  to  100
*RST: 0

Example: INST:BLOC:CHAN:FILE1:OVER:AVG:ON 99
For averaged traces, after each update, the display shows 1% of
the previous record and 99% of the next record. Thus, 1% of
each record is included in multiple averaging calculations.

Manual operation: See "Overlap Settings" on page 97

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:SAMPle <Sample>

This command defines the sample within the input file <i> at which replay starts.
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Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Sample> numeric value

Range: 0  to  record length of stored data

Example: INST:BLOC:CHAN:FILE:START:SAMP 10
Data from the input file is replayed starting with sample number
10.

Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STARt:TIME <Time>

This command defines the start time within the input file <i> at which replay starts.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Time> double value

Absolute start time
Range: 0  to  meas time of stored data
Default unit: s

Example: INST:BLOC:CHAN:FILE:START:TIME 0.32s
Data from the input file is replayed starting at 0.32 s of the cap-
tured data.

Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:SAMPle <Sample>

This command defines the sample within the input file <i> at which replay stops.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Sample> numeric value

Range: 0  to  record length of stored data

Example: INST:BLOC:CHAN:FILE:STAR:SAMP 10
INST:BLOC:CHAN:FILE:STOP:SAMP 1000
Data from the input file is replayed starting with sample number
10 and ending with sample number 1000.
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Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>:STOP:TIME <Time>

This command defines the (absolute) time within the input file <i> at which replay
stops.

Suffix: 
<i>

.
1..99
Sequential number of a configured input file (required only if
multiple files are loaded for a single channel)

Parameters:
<Time> double value

Absolute stop time (not duration)
Range: 0  to  meas time of stored data
Default unit: s

Example: INST:BLOC:CHAN:FILE:START:TIME 0.32s
INST:BLOC:CHAN:FILE:STOP:TIME 0.64s
Data from the input file is replayed starting at 0.32 s and ending
at 0.64 s of the captured data.

Manual operation: See "Playback Settings" on page 96

INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar]
<FileName>,<ABW>[,<IQChannel]

Assigns the specified iq.tar file as the input source for the currently selected channel.
The file is automatically loaded to the R&S VSE software and assigned the sequential
number provided as the FILE<i> suffix. Subsequent commands concerning file input
from this file must use the same suffix.

To query the values of the stored meta data after loading the file, see EXPort:IQ:
META:DATA<I>:VALue? on page 404.

Suffix: 
<i>

.
1..99
Sequential number of the source

Parameters:
<FileName> String containing the path and file name of the file to be loaded.

<ABW> The analysis bandwidth to be used by the measurement. The
bandwidth must be smaller than or equal to the bandwidth of the
data that was stored in the file.
Tip: If the file was stored using the R&S VSE software, the ABW
is included in the meta data information in the file (see "Meta
Data Settings" on page 90).
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<IQChannel> ID of the I/Q channel in the stored file which is to be restored to
the selected measurement channel.
If this parameter is omitted, the first channel found is restored.
Tip: If the file was stored using the R&S VSE software, the I/Q
channel is included in the meta data information in the file (see
"Meta Data Settings" on page 90).

Example: INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:FILE 'C:
\Users\ImportFile.iqtar',10MHZ,2
The data from the second I/Q channel stored in the file is used
as input for the current measurement channel 'IQ Analyzer'. The
displayed bandwidth is restricted to 10 MHz.

Manual operation: See "File" on page 73

13.4.3 Configuring Channel Input Sources

The following commands define which type of input is used for a measurement chan-
nel.

The commands for input from a file are described in chapter 13.4.2, "Loading Input
Files", on page 276.

INSTrument:BLOCk:CHANnel[:SETTings]:DEVice<d>.......................................................284
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce.......................................................... 285
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce:TYPE................................................. 285

INSTrument:BLOCk:CHANnel[:SETTings]:DEVice<d> <DevName>

Assigns the specified instrument as the input source for the currently selected channel.
The instrument must have been configured before it can be assigned (see chap-
ter 13.4.1, "Configuring Instruments", on page 264).

Suffix: 
<d>

.
1..99
Sequential number of the source

Parameters:
<DevName> string

Name of a configured instrument.
'NONE'
No instrument or file is defined as the input source.

Example: INST:BLOCK:CHAN:DEV 'MyFSW'
Manual operation: See "Instrument" on page 73
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INSTrument:BLOCk:CHANnel[:SETTings]:SOURce <Type>

Selects an instrument or a file as the source of input provided to the channel.

Parameters:
<Type> FILE | DEVice | NONE

FILE
A loaded file is used for input.
(See chapter 13.4.2, "Loading Input Files", on page 276.)
DEVice
A configured device provides input for the measurement
(See chapter 13.4.1, "Configuring Instruments", on page 264.)
NONE
No input source defined.

Manual operation: See "Input Type" on page 72

INSTrument:BLOCk:CHANnel[:SETTings]:SOURce:TYPE <Source>

Configures the source of input to be used from the selected instrument.

See also chapter 7.1, "Input Sources", on page 52.

Parameters:
<Source> RF

Radio Frequency ("RF INPUT" connector)
'Channel 1' | 'Channel 2' | 'Channel 3' | 'Channel 4'
Oscilloscope input channel 1, 2, 3, or 4.
*RST: RF

Manual operation: See "Input Source" on page 73

13.4.4 Configuring Measurement Channels

The following commands are required to configure a measurement channel and select
the application in a remote environment. The tasks for manual operation are described
in chapter 7.3, "Controlling Measurement Channels, Groups, and Sequences",
on page 67.

Useful commands for configuring measurement channels described elsewhere:
● INSTrument:BLOCk:CHANnel[:SETTings]:USE on page 295
● INSTrument:BLOCk:CHANnel:MOVE on page 294
● chapter 13.4.3, "Configuring Channel Input Sources", on page 284
● chapter 13.4.2, "Loading Input Files", on page 276
● SYSTem:PRESet:CHANnel[:EXECute] on page 388
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Remote commands exclusive to configuring measurement channels:

ABORt.......................................................................................................................... 286
INITiate<n>:CONMeas................................................................................................... 287
INITiate<n>:CONTinuous................................................................................................287
INITiate<n>[:IMMediate]..................................................................................................288
INSTrument:BLOCk:CHANnel[:SETTings]:RECord............................................................289
INSTrument:CREate:DUPLicate...................................................................................... 289
INSTrument:CREate[:NEW]............................................................................................ 289
INSTrument:CREate:REPLace........................................................................................290
INSTrument:DELete....................................................................................................... 290
INSTrument:LIST?......................................................................................................... 291
INSTrument:REName.....................................................................................................291
INSTrument[:SELect]......................................................................................................292

ABORt

This command aborts the measurement in the current measurement channel and
resets the trigger system.

To prevent overlapping execution of the subsequent command before the measure-
ment has been aborted successfully, use the *OPC? or *WAI command after ABOR and
before the next command.

For details see chapter 12.1.4.1, "Preventing Overlapping Execution", on page 234.

To abort an entire group of measurements, use the INITiate:BLOCk:ABORt com-
mand.

To abort the entire sequence of measurements, use the INITiate:SEQuencer:
ABORt command.

Note on blocked remote control programs:

If a sequential command cannot be completed, for example because a triggered sweep
never receives a trigger, the remote control program will never finish and the remote
channel to the instrument in use is blocked for further commands. In this case, you
must interrupt processing on the remote channel first in order to abort the measure-
ment.

To do so, send a "Device Clear" command from the control instrument to the instru-
ment in use on a parallel channel to clear all currently active remote channels.
Depending on the used interface and protocol, send the following commands:

● Visa: viClear()
● GPIB: ibclr()
● RSIB: RSDLLibclr()
Now you can send the ABORt command on the remote channel performing the mea-
surement.

Example: ABOR;:INIT:IMM
Aborts the current measurement and immediately starts a new
one.
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Example: ABOR;*WAI
INIT:IMM
Aborts the current measurement and starts a new one once
abortion has been completed.

Usage: Event
SCPI confirmed

Manual operation: See "Pause / Cont" on page 74

INITiate<n>:CONMeas

This command restarts a (single) measurement that has been stopped (using ABORt)
or finished in single measurement mode.

The measurement is restarted at the beginning, not where the previous measurement
was stopped.

As opposed to INITiate<n>[:IMMediate], this command does not reset traces in
maxhold, minhold or average mode. Therefore it can be used to continue measure-
ments using maxhold or averaging functions.

Tip: To continue all measurements in a group, use the INITiate:BLOCk:CONMeas
command.

Suffix: 
<n>

.
irrelevant

Example: INIT:CONT OFF
Switches to single measurement mode.
DISP:WIND:TRAC:MODE AVER
Switches on trace averaging.
SWE:COUN 20
Setting the measurement counter to 20 measurements.
INIT;*WAI
Starts the measurement and waits for the end of the 20 mea-
surements.
INIT:CONM;*WAI
Continues the measurement (next 20 measurements) and waits
for the end.
Result: Averaging is performed over 40 measurements.

Usage: Event

Manual operation: See "Pause / Cont" on page 74

INITiate<n>:CONTinuous <State>

This command controls the measurement mode for an individual measurement chan-
nel.
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Note that in single measurement mode, you can synchronize to the end of the mea-
surement with *OPC, *OPC? or *WAI. In continuous measurement mode, synchroniza-
tion to the end of the measurement is not possible. Thus, it is not recommended that
you use continuous measurement mode in remote control, as results like trace data or
markers are only valid after a single measurement end synchronization.

For details on synchronization see chapter 12.1.4, "Command Sequence and Synchro-
nization", on page 233.

If the measurement mode is changed for a measurement channel while a measure-
ment sequence is active (see INITiate:SEQuencer:IMMediate on page 298) the
mode is only considered the next time the group containing the measurement channel
is started.

Tip: To change the measurement mode for an entire group, use the INITiate:
BLOCk:CONTinuous command.

Suffix: 
<n>

.
irrelevant

Parameters:
<State> ON | OFF | 0 | 1

ON | 1
Continuous measurement
OFF | 0
Single measurement
*RST: 1

Example: INIT:CONT OFF
Switches the measurement mode to single measurement.
INIT:CONT ON
Switches the measurement mode to continuous measurement.

Manual operation: See "Measurement mode ( Single / Continuous )" on page 74

INITiate<n>[:IMMediate]

This command starts a (single) new measurement.

With measurement count or average count > 0, this means a restart of the correspond-
ing number of measurements. With trace mode MAXHold, MINHold and AVERage, the
previous results are reset on restarting the measurement.

You can synchronize to the end of the measurement with *OPC, *OPC? or *WAI.

For details on synchronization see chapter 12.1.4, "Command Sequence and Synchro-
nization", on page 233.

Suffix: 
<n>

.
irrelevant
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Example: INIT:CONT OFF
Switches to single measurement mode.
DISP:WIND:TRAC:MODE AVER
Switches on trace averaging.
SWE:COUN 20
Sets the measurement counter to 20 measurements.
INIT;*WAI
Starts the measurement and waits for the end of the 20 mea-
surements.

Usage: Event

Manual operation: See "Capture" on page 74

INSTrument:BLOCk:CHANnel[:SETTings]:RECord

Starts a measurement for the currently selected channel and stores the measurement
data to a temporary file.

You can store the file permanently using EXPort:IQ:FILE) .

For details see chapter 8.3.1, "Recording Measurement Data", on page 86.

Usage: Event

Manual operation: See "Record" on page 74

INSTrument:CREate:DUPLicate

This command duplicates the currently selected measurement channel, i.e creates a
new measurement channel of the same type and with the identical measurement set-
tings. The name of the new channel is the same as the copied channel, extended by a
consecutive number (e.g. "IQAnalyzer" -> "IQAnalyzer2").

The channel to be duplicated must be selected first using the INST:SEL command.

The new channel is inserted in the currently selected group of the measurement
sequence (see INSTrument:BLOCk[:SELect] on page 297).

Example: INST:SEL 'IQAnalyzer'
INST:CRE:DUPL
Duplicates the channel named 'IQAnalyzer' and creates a new
measurement channel named 'IQAnalyzer2'.

Usage: Event

Manual operation: See "Duplicate Current Channel" on page 73

INSTrument:CREate[:NEW] <ChannelType>, <ChannelName>

This command adds an additional measurement channel.

The new channel is inserted in the currently selected group of the measurement
sequence (see INSTrument:BLOCk[:SELect] on page 297).
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See also
● INSTrument[:SELect] on page 292
● INSTrument:CREate:DUPLicate on page 289

Parameters:
<ChannelType> Channel type of the new channel.

For a list of available channel types see INSTrument:LIST?
on page 291.

<ChannelName> String containing the name of the channel. The channel name is
displayed as the tab label for the measurement channel.
Note: If the specified name for a new channel already exists, the
default name, extended by a sequential number, is used for the
new channel (see INSTrument:LIST? on page 291).

Example: INST:CRE IQ, 'IQAnalyzer2'
Adds an additional I/Q Analyzer channel named "IQAnalyzer2".

Manual operation: See "  New Channel" on page 73

INSTrument:CREate:REPLace <ChannelName1>,<ChannelType>,<ChannelName2>

This command replaces a measurement channel with another one.

Setting parameters: 
<ChannelName1> String containing the name of the measurement channel you

want to replace.

<ChannelType> Channel type of the new channel.
For a list of available channel types see INSTrument:LIST?
on page 291.

<ChannelName2> String containing the name of the new channel.
Note: If the specified name for a new channel already exists, the
default name, extended by a sequential number, is used for the
new channel (see INSTrument:LIST? on page 291).

Example: INST:CRE:REPL 'IQAnalyzer2',IQ,'IQAnalyzer'
Replaces the channel named 'IQAnalyzer2' by a new measure-
ment channel of type 'IQ Analyzer' named 'IQAnalyzer'.

Usage: Setting only

Manual operation: See "Replace Current Channel" on page 73

INSTrument:DELete <ChannelName>

This command deletes a measurement channel.

The last measurement channel cannot be deleted; at least one channel must always
be defined.

Tip: To remove a measurement channel without deleting it permanently, deactivate it
using INSTrument:BLOCk:CHANnel[:SETTings]:USE on page 295.
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Parameters:
<ChannelName> String containing the name of the channel you want to delete.

A measurement channel must exist in order to be able delete it.

Example: INST:DEL 'IQAnalyzer4'
Deletes the channel with the name 'IQAnalyzer4'.

Usage: Event

INSTrument:LIST?

This command queries all active measurement channels. This is useful in order to
obtain the names of the existing measurement channels, which are required in order to
replace or delete the channels.

Return values: 
<ChannelType>,
<ChannelName>

For each channel, the command returns the channel type and
channel name (see tables below).
Tip: to change the channel name, use the INSTrument:
REName command.

Example: INST:LIST?
Result for 3 measurement channels:
'ADEM','Analog Demod','IQ','IQ
Analyzer','IQ','IQ Analyzer2'

Usage: Query only

Table 13-1: Available measurement channel types and default channel names

Application <ChannelType> Parameter Default Channel Name*)

I/Q Analyzer IQ IQ Analyzer

Analog Demodulation ADEM Analog Demod

Pulse (R&S VSE-K6) PULSE Pulse

GSM (R&S VSE-K10) GSM GSM

VSA (R&S VSE-K70) DDEM VSA

3GPP FDD BTS
(R&S VSE-K72)

BWCD 3G FDD BTS

3GPP FDD UE (R&S VSE-
K72)

MWCD 3G FDD UE

WLAN (R&S VSE-K91) WLAN WLAN

LTE (R&S VSE-K10x) LTE LTE

Note: the default channel name is also listed in the table. If the specified name for a new channel already
exists, the default name, extended by a sequential number, is used for the new channel.

INSTrument:REName <ChannelName1>, <ChannelName2>

This command renames a measurement channel.
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Parameters:
<ChannelName1> String containing the name of the channel you want to rename.

<ChannelName2> String containing the new channel name.
Note that you can not assign an existing channel name to a new
channel; this will cause an error.

Example: INST:REN 'IQAnalyzer2','IQAnalyzer3'
Renames the channel with the name 'IQAnalyzer2' to 'IQAna-
lyzer3'.

Usage: Setting only

INSTrument[:SELect] <ChannelType> | <ChannelName>

This command activates a new measurement channel with the defined channel type,
or selects an existing measurement channel with the specified name.

Also see

● INSTrument:CREate[:NEW] on page 289

Parameters:
<ChannelType> Channel type of the new channel.

For a list of available channel types see INSTrument:LIST?
on page 291.

<ChannelName> String containing the name of the channel.

Example: INST IQ
Activates a measurement channel for the I/Q Analyzer applica-
tion.
INST 'MyIQSpectrum'
Selects the measurement channel named 'MyIQSpectrum' (for
example before executing further commands for that channel).

Usage: SCPI confirmed

Manual operation: See "I/Q Analyzer" on page 32

13.4.5 Controlling Measurement Groups

The following commands are required to control measurement sequences in a remote
environment. The functions for manual operation are described in chapter 7.3.1,
"Sequence Functions", on page 68 and chapter 7.3.2, "Group Functions", on page 69.

INITiate:BLOCk:ABORt...................................................................................................293
INITiate:BLOCk:CONMeas..............................................................................................293
INITiate:BLOCk:CONTinuous..........................................................................................293
INITiate:BLOCk:IMMediate..............................................................................................294
INSTrument:BLOCk:CHANnel:MOVE...............................................................................294
INSTrument:BLOCk:CHANnel[:SETTings]:USE.................................................................295
INSTrument:BLOCk:CREate[:NEW].................................................................................295
INSTrument:BLOCk:DELete............................................................................................296
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INSTrument:BLOCk:LIST?..............................................................................................296
INSTrument:BLOCk:MOVE............................................................................................. 296
INSTrument:BLOCk[:SELect].......................................................................................... 297
INSTrument:BLOCk:USE................................................................................................297

INITiate:BLOCk:ABORt

This command stops the currently active measurement group.

To continue the measurement for the group, use INITiate:BLOCk:CONMeas
on page 293. To start a new measurement for the group, use INITiate:
SEQuencer:IMMediate on page 298.

To abort the entire measurement sequence, use INITiate:SEQuencer:ABORt
on page 297.

Usage: Event

Manual operation: See "Pause / Cont" on page 71

INITiate:BLOCk:CONMeas [<GroupName>]

This command restarts a measurement that has been stopped in single capture mode.

The measurement is restarted from the beginning.

As opposed to INITiate:BLOCk:IMMediate on page 294, this command does not
reset traces in maxhold, minhold or average mode. Therefore it can be used to con-
tinue measurements using max hold or averaging functions.

Parameters:
<GroupName> String containing the name of the group for which the measure-

ment is continued.
If no group parameter is provided, the currently selected group is
continued (see INSTrument:BLOCk[:SELect] on page 297).

Usage: Event

Manual operation: See "Pause / Cont" on page 71

INITiate:BLOCk:CONTinuous <State> [,<GroupName>]

Defines the capture mode for the measurement group and channels it contains.

For details see "Measurement mode" on page 31.

To change the capture mode for an individual channel, use the INITiate<n>:
CONTinuous command.

Note: In order to synchronize to the end of a measurement sequence using *OPC,
*OPC? or *WAI you must use SINGle capture mode.
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If the capture mode is changed for a measurement channel while a measurement
sequence is active (see INITiate:SEQuencer:IMMediate on page 298) the mode
is only considered the next time the measurement in that channel is activated by the
Sequencer.

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
Continuous measurement
OFF | 0
Single measurement
*RST: OFF

Setting parameters: 
<GroupName> String containing the name of the group for which the capture

mode is defined.
If no group parameter is provided, the currently selected group is
configured (see INSTrument:BLOCk[:SELect]
on page 297).

Example: INITiate:BLOCk:CONT OFF,'Group 2'
Manual operation: See "Measurement mode ( Single / Continuous )" on page 71

INITiate:BLOCk:IMMediate [<GroupName>]

This command starts a new measurement for all active channels in the selected or
specified group.

Depending on the capture mode, a single or continuous measurements are performed
(see INITiate:BLOCk:CONTinuous on page 293).

Setting parameters: 
<GroupName> String containing the name of the group for which a measure-

ment is started.
If no group parameter is provided, the currently selected group is
started (see INSTrument:BLOCk[:SELect] on page 297).

Usage: Event

Manual operation: See "Capture" on page 70

INSTrument:BLOCk:CHANnel:MOVE <GroupName>, <Predecessor>,
<ChannelName>

This command moves the specified channel to a different group. This command is use-
ful to change the order in which the measurements are performed within a sequence
(within a single group, all measurements are performed synchronously).

To move an entire group within a sequence, see INSTrument:BLOCk:MOVE
on page 296.
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Setting parameters: 
<GroupName> String containing the name of the group in which the channel is

to be included.
For a list of available groups see INSTrument:SEQuencer:
LIST? on page 298.

<Predecessor> String containing the name of an existing channel in the speci-
fied group after which the specified channel will be inserted.
Use an empty string to move the channel to the first position in
the group.

<ChannelName> String containing the name of the channel to be moved.

Example: INST:BLOC:CHAN:MOVE 'Group 1','IQ Analyzer','IQ
Analyzer2'
Moves the measurement channel named IQ Analyzer2 to the
group 1, after the IQ Analyzer measurement channel.

Usage: Setting only

INSTrument:BLOCk:CHANnel[:SETTings]:USE <State>,<ChannelName>

If activated, the specified measurement channel is included in the currently selected
group measurement.

Parameters:
<State> 1 | 0

<ChannelName> String containing the name of the channel.

Example: INST:BLOC:CHAN:USE 1,'IQAnalyzer'
Manual operation: See "Activate/Deactivate Channel" on page 72

INSTrument:BLOCk:CREate[:NEW] <GroupName>, <Predecessor>

This command inserts a new group in the measurement sequence. The new group is
automatically selected for further group operations.

Tip: To insert a measurement channel in the group see INSTrument:CREate[:NEW]
on page 289.

Parameters:
<Predecessor> String containing the name of an existing group after which the

new group will be inserted.
Use an empty string to create the new group at the first position.

Setting parameters: 
<GroupName> String containing the name of the group you want to create.

Example: INST:BLOC:CRE 'AdemodGroup', 'Group 1'
Adds an additional group named "AdemodGroup2" after the
existing group named "Group 1".

Usage: Setting only
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Manual operation: See "New Group" on page 70

INSTrument:BLOCk:DELete <GroupName>

This command deletes a measurement group. At least one group with one measure-
ment channel must remain in the sequence.

Tip: To delete an individual measurement channel use INSTrument:DELete
on page 290.

To remove a group from the measurement sequence without deleting it permanently,
deactivate it using INSTrument:BLOCk:USE on page 297.

Parameters:
<GroupName> String containing the name of the group you want to delete.

The last existing group in a sequence cannot be deleted.

Example: INST:BLOC:DEL 'Group 1'
Usage: Event

Manual operation: See "Close" on page 71

INSTrument:BLOCk:LIST?

This command queries all active measurement channels in the currently selected
group. This is useful in order to obtain the names of the existing measurement chan-
nels, which are required in order to replace or delete the channels.

For a list of available channel types and names see INSTrument:LIST?
on page 291.

Return values: 
<ChannelName> Comma-separated list of strings containing the name of an

active channel in the group

Example: INST:BLOC:LIST?
Result for 3 measurement channels:
'Analog Demod','IQ Analyzer','IQ Analyzer 2'

Usage: Query only

INSTrument:BLOCk:MOVE <Predecessor>

This command moves the selected group to a different position within the measure-
ment sequence.

Tip: To move an individual channel between groups, see INSTrument:BLOCk:
CHANnel:MOVE on page 294.
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Parameters:
<Predecessor> String containing the name of an existing group after which the

selected group will be inserted.
Use an empty string to move the new group to the first position
in the sequence.

Usage: Event

INSTrument:BLOCk[:SELect] <GroupName>

This command selects a measurement group for further operations, for example chan-
nel functions.

Parameters:
<GroupName> String containing the name of the group.

Usage: Setting only

INSTrument:BLOCk:USE <State>,<GroupName>

If activated, the specified group is included in the measurement sequence.

Parameters:
<State> 1 | 0

Setting parameters: 
<GroupName> String containing the name of the group.

Example: INST:BLOC:USE 1,'Group 1'
Manual operation: See "Activate/Deactivate Group" on page 70

13.4.6 Controlling Measurement Sequences

The following commands are required to control measurement sequences in a remote
environment. The functions for manual operation are described in chapter 7.3.1,
"Sequence Functions", on page 68 and chapter 7.3.2, "Group Functions", on page 69.

INITiate:SEQuencer:ABORt............................................................................................ 297
INITiate:SEQuencer:IMMediate....................................................................................... 298
INITiate:SEQuencer:MODE.............................................................................................298
INSTrument:SEQuencer:LIST?........................................................................................298

INITiate:SEQuencer:ABORt

This command stops the currently active sequence of measurements.

You can start a new sequence any time using INITiate:SEQuencer:IMMediate
on page 298.

Tip: To stop the currently active group only - and continue the measurement sequence
with that group later - use the INITiate:BLOCk:ABORt and INITiate:BLOCk:
CONMeas commands.
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Usage: Event

Manual operation: See "Stop" on page 68

INITiate:SEQuencer:IMMediate

This command starts a new measurement sequence according to the capture mode
specified using INITiate:SEQuencer:MODE on page 298.

Usage: Event

Manual operation: See "Play" on page 68

INITiate:SEQuencer:MODE <Mode>

Defines the capture mode for the entire measurement sequence and all measurement
groups and channels it contains.

For details see "Measurement mode" on page 31.

Note: In order to synchronize to the end of a measurement sequence using *OPC,
*OPC? or *WAI you must use SINGle Sequence mode.

Parameters:
<Mode> SINGle

Each measurement group is started one after the other in the
order of definition. All measurement channels in a group are
started simultaneously and performed once. After all measure-
ments are completed, the next group is started. After the last
group, the measurement sequence is finished.
CONTinuous
Each measurement group is started one after the other in the
order of definition. All measurement channels in a group are
started simultaneously and performed once. After all measure-
ments are completed, the next group is started. After the last
group, the measurement sequence restarts with the first one and
continues until it is stopped explicitely (see "Play" on page 68).
*RST: CONTinuous

Manual operation: See "Measurement mode ( Single / Continuous )" on page 68

INSTrument:SEQuencer:LIST?

This command queries all active groups in a measurement sequence. This is useful in
order to obtain the names of the existing groups, which are required in order to replace
or delete the groups.

Return values: 
<Groups> Comma-separated list of strings containing the name of an

active group.
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Example: INST:SEQ:LIST?
Result for 2 groups:
'Group 1','Group 2'

Usage: Query only

13.5 Configuring the Result Display

The commands required to configure the screen display in a remote environment are
described here.

The tasks for manual operation are described in chapter 6, "Operating Basics",
on page 35.

● Global Layout Commands.....................................................................................299
● Working with Windows in the Display................................................................... 305
● General Window Commands................................................................................ 310

13.5.1 Global Layout Commands

The following commands are required to change the evaluation type and rearrange the
screen layout across measurement channels as you do in manual operation.

For compatibility with other Rohde & Schwarz Signal and Spectrum Analyzers, the lay-
out commands described in chapter 13.5.2, "Working with Windows in the Display",
on page 305 are also supported. Note, however, that the commands described there
only allow you to configure the layout within the active measurement channel.

LAYout:GLOBal:ADD[:WINDow]?.................................................................................... 299
LAYout:GLOBal:CATalog[:WINDow]?.............................................................................. 303
LAYout:GLOBal:IDENtify[:WINDow]?............................................................................... 304
LAYout:GLOBal:REMove[:WINDow]................................................................................ 305
LAYout:GLOBal:REPLace[:WINDow]............................................................................... 305

LAYout:GLOBal:ADD[:WINDow]?
<ExChanName>,<ExWinName>,<Direction>,<NewChanName>,<NewWinType>

This command adds a window to the display next to an existing window. The new win-
dow may belong to a different channel than the existing window.

To replace an existing window, use the LAYout:GLOBal:REPLace[:WINDow] com-
mand.

Parameters:
<ExChanName> string

Name of an existing channel
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<ExWinName> string
Name of the existing window within the <ExChanName> chan-
nel the new window is inserted next to.
By default, the name of a window is the same as its index. To
determine the name and index of all active windows use the
LAYout:GLOBal:IDENtify[:WINDow]? query.

<Direction> LEFT | RIGHt | ABOVe | BELow | TAB
Direction the new window is added relative to the existing win-
dow.
TAB
The new window is added as a new tab in the specified existing
window.
(See also "Window tabs" on page 45).

<NewChanName> string
Name of the channel for which a new window is to be added.

<NewWinType> string
Type of result display (evaluation method) you want to add.
See the table below for available parameter values.

Return values: 
<NewWindowName> When adding a new window, the command returns its name (by

default the same as its number) as a result.

Example: LAYout:GLOBal:ADD:WINDow? 'IQ
Analyzer','1',RIGH,'IQ Analyzer2','FREQ'
Adds a new window named 'Spectrum' with a Spectrum display
to the right of window 1 in the channel 'IQ Analyzer'.

Usage: Query only

Table 13-2: <WindowType> parameter values for IQ Analyzer application

Parameter value Window type

'FREQ' Spectrum

'MAGN' Magnitude

'MTABle' Marker table

'PEAKlist' Marker peak list

'RIMAG' Real/Imag (I/Q)

'VECT' I/Q Vector

Table 13-3: <WindowType> parameter values for Pulse application

Parameter value Window type

MCAPture Magnitude Capture Buffer

MTABle Marker Table

PDIStribution Parameter Distribution
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Parameter value Window type

PFRequency Pulse Frequency

PMAGnitude Pulse Magnitude

PPHase Pulse Phase

PPWrapped Pulse phase, wrapped

PRESults Pulse Results

PSPectrum Parameter Spectrum

PSTatistics Pulse Statistics

PTRend Parameter Trend

RRSPectrum Result Range Spectrum

Table 13-4: <WindowType> parameter values for AnalogDemod application

Parameter value Window type

MTABle Marker table

PEAKlist Marker peak list

RSUMmary Result summary

'XTIM:AM' RF Time Domain (= RF power)

'XTIM:AM:RELative' AM Time Domain

'XTIM:AM:RELative:AFSPec-
trum'

AM Spectrum

'XTIM:FM' FM Time Domain

'XTIM:FM:AFSPectrum' FM Spectrum

'XTIM:PM' PM Time Domain

'XTIM:PM:AFSPectrum' PM Spectrum

'XTIM:SPECtrum' RF Spectrum

Table 13-5: <WindowType> parameter values for GSM application

Parameter value Window type

CONStell Constellation

ETIMe EVM vs Time

MCAPture Magnitude Capture

MERRor Magnitude Error vs Time

MTABle Marker Table

MACCuracy Modulation Accuracy

MSFDomain Modulation Spectrum Graph (Frequency domain)

MSTable Modulation Spectrum Table
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Parameter value Window type

PERRor Phase Error vs Time

PSTable Power vs Slot

PTFull PvT Full Burst

TGSGraph Trigger to Sync Graph

TGSTable Trigger to Sync Table

TSFDomain Transient Spectrum Graph (Frequency domain)

TSTable Transient Spectrum Table

Table 13-6: <WindowType> parameter values for VSA application

Parameter value Data source (+default result display)

CBUFfer Capture buffer (Magnitude absolute)

MEAS Meas & Ref (Magnitude relative)

REF

EQUalizer Equalizer

EVECtor Error vector (EVM)

MACCuracy Modulation Accuracy (Result Summary)

MERRor Modulation Errors (Magnitude error)

SYMB Symbols (Hexadecimal)

Table 13-7: <WindowType> parameter values for 3GPP FDD application

Parameter value Window type

BITStream Bitstream

CCONst Composite Constellation

CDPower Code Domain Power

CDEPower Code Domain Error Power

CEVM Composite EVM

CTABle Channel Table

EVMChip EVM vs Chip

FESLot Frequency Error vs Slot

MECHip Magnitude Error vs Chip

MTABle Marker table

PCDerror Peak Code Domain Error

PDSLot Phase Discontinuity vs Slot

PECHip Phase Error vs Chip
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Parameter value Window type

PSLot Power vs Slot

PSYMbol Power vs Symbol

RSUMmary Result Summary

SCONst Symbol Constellation

SEVM Symbol EVM

SMERror Symbol Magnitude Error

SPERror Symbol Phase Error

Table 13-8: <WindowType> parameter values for WLAN application

Parameter value Window type

BITStream Bitstream

CMEMory Magnitude Capture

CONStellation Constellation

CVCarrier Constellation vs Carrier (IEEE 802.11a, ac, g (OFDM), n only)

EVCarrier EVM vs Carrier (IEEE 802.11a, ac, g (OFDM), n only)

EVCHip EVM vs Chip (IEEE 802.11b and g (DSSS) only)

EVSYmbol EVM vs Symbol (IEEE 802.11a, ac, g (OFDM), n only)

FSPectrum FFT Spectrum

GDELay Group Delay (IEEE 802.11a, ac, g (OFDM), n only)

PFPPdu PvT Full PPDU

RSDetailed Result Summary Detailed (IEEE 802.11a, ac, g (OFDM), n only)

RSGLobal Result Summary Global

SFIeld Signal Field (IEEE 802.11a, ac, g (OFDM), n)

PLCP Header (IEEE 802.11b and g (DSSS)

SFLatness Spectrum Flatness (IEEE 802.11a, ac, g (OFDM), n only)

LAYout:GLOBal:CATalog[:WINDow]?

This command queries the name and index of all active windows from top left to bot-
tom right for each active channel. The result is a comma-separated list of values for
each window, with the syntax:

<ChannelName_1>: <WindowName_1>,<WindowIndex_1>..<WindowName_n>,<Win-
dowIndex_n>

..

<ChannelName_m>: <WindowName_1>,<WindowIndex_1>..<WindowName_n>,<Win-
dowIndex_n>
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Return values: 
<ChannelName> String containing the name of the channel. The channel name is

displayed as the tab label for the measurement channel.

<WindowName> string
Name of the window.
In the default state, the name of the window is its index.

<WindowIndex> numeric value
Index of the window.

Example: LAY:GLOB:CAT?
Result:
IQ Analyzer: '1',1,'2',2
Analog Demod: '1',1,'4',4
For the I/Q Analyzer channel, two windows are displayed,
named '2' (at the top or left), and '1' (at the bottom or right).
For the Analog Demodulation channel, two windows are dis-
played, named '1' (at the top or left), and '4' (at the bottom or
right).

Usage: Query only

LAYout:GLOBal:IDENtify[:WINDow]? <ChannelName>,<WindowName>

This command queries the index of a particular display window in the specified chan-
nel.

Note: to query the name of a particular window, use the LAYout:WINDow<n>:
IDENtify? query.

Parameters:
<ChannelName> String containing the name of the channel. The channel name is

displayed as the tab label for the measurement channel.

Query parameters: 
<WindowName> String containing the name of a window.

Return values: 
<WindowIndex> Index number of the window.

Example: LAYout:GLOBal:ADD:WINDow? IQ,'1',RIGH,
'Spectrum',FREQ
Adds a new window named 'Spectrum' with a Spectrum display
to the right of window 1.

Example: LAYout:GLOBal:IDENtify? 'IQ Analyzer',
'Spectrum'
Result:
2
Window index is: 2.

Usage: Query only
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LAYout:GLOBal:REMove[:WINDow] <ChannelName>,<WindowName>

This command removes a window from the display.

Parameters:
<ChannelName> String containing the name of the channel.

<WindowName> String containing the name of the window.

Usage: Event

LAYout:GLOBal:REPLace[:WINDow]
<ExChannelName>,<WindowName>,<NewChannelName>,<WindowType>

This command replaces the window type (for example from "Diagram" to "Result Sum-
mary") of an already existing window while keeping its position, index and window
name.

To add a new window, use the LAYout:GLOBal:ADD[:WINDow]? command.

Parameters:
<ExChannelName> String containing the name of the channel in which a window is

to be replaced. The channel name is displayed as the tab label
for the measurement channel.

<WindowName> String containing the name of the existing window.
To determine the name and index of all active windows, use the
LAYout:GLOBal:CATalog[:WINDow]? query.

<NewChannelName> String containing the name of the channel for which a new win-
dow will be created.

<WindowType> Type of result display you want to use in the existing window.
Note that the window type must be valid for the specified chan-
nel (<NewChannelName>).
See LAYout:ADD[:WINDow]? on page 306 for a list of availa-
ble window types.

Example: LAY:GLOB:REPL:WIND 'IQ Analyzer','1',
'AnalogDemod',MTAB
Replaces the I/Q Analyzer result display in window 1 by a
marker table for the AnalogDemod channel.

13.5.2 Working with Windows in the Display

The following commands are required to change the evaluation type and rearrange the
screen layout for a measurement channel as you do using the SmartGrid in manual
operation. Since the available evaluation types depend on the selected application,
some parameters for the following commands also depend on the selected measure-
ment channel.

Note that the suffix <n> always refers to the window in the currently selected measure-
ment channel.
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(See INSTrument[:SELect] on page 292).

To configure the layout of windows across measurement channels, use the chap-
ter 13.5.1, "Global Layout Commands", on page 299.

LAYout:ADD[:WINDow]?.................................................................................................306
LAYout:CATalog[:WINDow]?...........................................................................................307
LAYout:IDENtify[:WINDow]?............................................................................................307
LAYout:REMove[:WINDow].............................................................................................308
LAYout:REPLace[:WINDow]............................................................................................308
LAYout:WINDow<n>:ADD?.............................................................................................309
LAYout:WINDow<n>:IDENtify?........................................................................................309
LAYout:WINDow<n>:REMove......................................................................................... 310
LAYout:WINDow<n>:REPLace........................................................................................310

LAYout:ADD[:WINDow]? <WindowName>,<Direction>,<WindowType>

This command adds a window to the display in the active measurement channel.

This command is always used as a query so that you immediately obtain the name of
the new window as a result.

To replace an existing window, use the LAYout:REPLace[:WINDow] command.

Parameters:
<WindowName> String containing the name of the existing window the new win-

dow is inserted next to.
By default, the name of a window is the same as its index. To
determine the name and index of all active windows, use the
LAYout:CATalog[:WINDow]? query.

<Direction> LEFT | RIGHt | ABOVe | BELow
Direction the new window is added relative to the existing win-
dow.

<WindowType> text value
Type of result display (evaluation method) you want to add.
See the table below for available parameter values.
Note that the window type must be valid for the active measure-
ment channel. To create a window for a different measurement
channel use the LAYout:GLOBal:REPLace[:WINDow] com-
mand.

Return values: 
<NewWindowName> When adding a new window, the command returns its name (by

default the same as its number) as a result.

Example: LAY:ADD? '1',LEFT,MTAB
Result:
'2'
Adds a new window named '2' with a marker table to the left of
window 1.

Usage: Query only
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Manual operation: See "Magnitude" on page 112

Table 13-9: <WindowType> parameter values for IQ Analyzer application

Parameter value Window type

FREQ Spectrum

MAGN Magnitude

MTABle Marker table

PEAKlist Marker peak list

POLar Phase vs. time

RIMAG Real/Imag (I/Q)

STATistic Statistics diagram

VECT I/Q Vector

LAYout:CATalog[:WINDow]?

This command queries the name and index of all active windows in the active mea-
surement channel from top left to bottom right. The result is a comma-separated list of
values for each window, with the syntax:

<WindowName_1>,<WindowIndex_1>..<WindowName_n>,<WindowIndex_n>

To query the name and index of all windows in all measurement channels use the
LAYout:GLOBal:CATalog[:WINDow]? command.

Return values: 
<WindowName> string

Name of the window.
In the default state, the name of the window is its index.

<WindowIndex> numeric value
Index of the window.

Example: LAY:CAT?
Result:
'2',2,'1',1
Two windows are displayed, named '2' (at the top or left), and '1'
(at the bottom or right).

Usage: Query only

LAYout:IDENtify[:WINDow]? <WindowName>

This command queries the index of a particular display window in the active measure-
ment channel.

Note: to query the name of a particular window, use the LAYout:WINDow<n>:
IDENtify? query.
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To query the index of a window in a different measurement channel use the LAYout:
GLOBal:IDENtify[:WINDow]? command.

Query parameters: 
<WindowName> String containing the name of a window.

Return values: 
<WindowIndex> Index number of the window.

Example: LAY:WIND:IDEN? '2'
Queries the index of the result display named '2'.
Response:
2

Usage: Query only

LAYout:REMove[:WINDow] <WindowName>

This command removes a window from the display in the active measurement channel.

To remove a window for a different measurement channel use the LAYout:GLOBal:
REMove[:WINDow] command.

Parameters:
<WindowName> String containing the name of the window.

In the default state, the name of the window is its index.

Example: LAY:REM '2'
Removes the result display in the window named '2'.

Usage: Event

LAYout:REPLace[:WINDow] <WindowName>,<WindowType>

This command replaces the window type (for example from "Diagram" to "Result Sum-
mary") of an already existing window in the active measurement channel while keeping
its position, index and window name.

To add a new window, use the LAYout:ADD[:WINDow]? command.

Parameters:
<WindowName> String containing the name of the existing window.

By default, the name of a window is the same as its index. To
determine the name and index of all active windows in the active
measurement channel, use the LAYout:CATalog[:WINDow]?
query.

<WindowType> Type of result display you want to use in the existing window.
See LAYout:ADD[:WINDow]? on page 306 for a list of availa-
ble window types.
Note that the window type must be valid for the active measure-
ment channel. To create a window for a different measurement
channel use the LAYout:GLOBal:REPLace[:WINDow] com-
mand.
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Example: LAY:REPL:WIND '1',MTAB
Replaces the result display in window 1 with a marker table.

LAYout:WINDow<n>:ADD? <Direction>,<WindowType>

This command adds a measurement window to the display. Note that with this com-
mand, the suffix <n> determines the existing window next to which the new window is
added, as opposed to LAYout:ADD[:WINDow]?, for which the existing window is
defined by a parameter.

To replace an existing window, use the LAYout:WINDow<n>:REPLace command.

This command is always used as a query so that you immediately obtain the name of
the new window as a result.

Parameters:
<Direction> LEFT | RIGHt | ABOVe | BELow

<WindowType> Type of measurement window you want to add.
See LAYout:ADD[:WINDow]? on page 306 for a list of availa-
ble window types.
Note that the window type must be valid for the active measure-
ment channel. To create a window for a different measurement
channel use the LAYout:GLOBal:ADD[:WINDow]? command.

Return values: 
<NewWindowName> When adding a new window, the command returns its name (by

default the same as its number) as a result.

Example: LAY:WIND1:ADD? LEFT,MTAB
Result:
'2'
Adds a new window named '2' with a marker table to the left of
window 1.

Usage: Query only

LAYout:WINDow<n>:IDENtify?

This command queries the name of a particular display window (indicated by the <n>
suffix) in the active measurement channel.

Note: to query the index of a particular window, use the LAYout:IDENtify[:
WINDow]? command.

Return values: 
<WindowName> String containing the name of a window.

In the default state, the name of the window is its index.

Example: LAY:WIND2:IDEN?
Queries the name of the result display in window 2.
Response:
'2'
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Usage: Query only

LAYout:WINDow<n>:REMove

This command removes the window specified by the suffix <n> from the display in the
active measurement channel.

The result of this command is identical to the LAYout:REMove[:WINDow] command.

To remove a window in a different measurement channel use the LAYout:GLOBal:
REMove[:WINDow] command.

Example: LAY:WIND2:REM
Removes the result display in window 2.

Usage: Event

LAYout:WINDow<n>:REPLace <WindowType>

This command changes the window type of an existing window (specified by the suffix
<n>) in the active measurement channel.

The result of this command is identical to the LAYout:REPLace[:WINDow] com-
mand.

To add a new window, use the LAYout:WINDow<n>:ADD? command.

Parameters:
<WindowType> Type of measurement window you want to replace another one

with.
See LAYout:ADD[:WINDow]? on page 306 for a list of availa-
ble window types.
Note that the window type must be valid for the active measure-
ment channel. To create a window for a different measurement
channel use the LAYout:GLOBal:REPLace[:WINDow] com-
mand.

Example: LAY:WIND2:REPL MTAB
Replaces the result display in window 2 with a marker table.

13.5.3 General Window Commands

The following commands are required to work with windows, independently of the
application.

Note that the suffix <n> always refers to the window in the currently selected measure-
ment channel.

(See INSTrument[:SELect] on page 292).

DISPlay[:WINDow<n>]:SELect........................................................................................ 311
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DISPlay[:WINDow<n>]:SELect

This command sets the focus on the selected result display window.

This window is then the active window.

Example: DISP:WIND1:SEL
Sets the window 1 active.

Usage: Setting only

13.6 Remote Commands for the I/Q Analyzer

● Configuring I/Q Analyzer Measurements.............................................................. 311
● I/Q Analysis...........................................................................................................344
● Retrieving Results.................................................................................................380

13.6.1 Configuring I/Q Analyzer Measurements

The following commands configure the I/Q Analyzer measurements.

● Configuring the Data Input and Output................................................................. 311
● Configuring the Vertical Axis (Amplitude, Scaling)................................................315
● Configuring the Axes for Statistical Displays.........................................................322
● Frequency............................................................................................................. 323
● Triggering..............................................................................................................325
● Configuring Data Acquisition.................................................................................333
● Adjusting Settings Automatically...........................................................................342

13.6.1.1 Configuring the Data Input and Output

The following commands are required to configure data input and output.

● RF Input................................................................................................................ 311
● Configuring the Outputs........................................................................................ 315

RF Input

INPut:ATTenuation:PROTection[:STATe]......................................................................... 312
INPut:COUPling.............................................................................................................312
INPut:FILTer:HPASs[:STATe]..........................................................................................312
INPut:FILTer:YIG[:STATe].............................................................................................. 313
INPut:IMPedance...........................................................................................................313
INPut:PRESelection:SET................................................................................................ 313
INPut:PRESelection[:STATe].......................................................................................... 313
INPut:SELect.................................................................................................................314
INPut:TYPE...................................................................................................................314
INSTrument:BLOCk:CHANnel[:SETTings]:SOURce.......................................................... 314
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INPut:ATTenuation:PROTection[:STATe] <State>

This command turns the availability of attenuation levels of 10 dB or less on and off.

Parameters:
<State> ON | OFF

*RST: OFF

Example: INP:ATT:PROT ON
Manual operation: See "10 dB Minimum Attenuation" on page 131

INPut:COUPling <CouplingType>

This command selects the coupling type of the RF input.

Parameters:
<CouplingType> AC

AC coupling
DC
DC coupling
*RST: AC

Example: INP:COUP DC
Usage: SCPI confirmed

Manual operation: See "Input Coupling" on page 130

INPut:FILTer:HPASs[:STATe] <State>

Activates an additional internal high-pass filter for RF input signals from 1  GHz to
3 GHz. This filter is used to remove the harmonics of the instrument in use in order to
measure the harmonics for a DUT, for example.

This function requires an additional high-pass filter hardware option.

(Note: for RF input signals outside the specified range, the high-pass filter has no
effect. For signals with a frequency of approximately 4 GHz upwards, the harmonics
are suppressed sufficiently by the YIG filter.)

Parameters:
<State> ON | OFF

*RST: OFF

Example: INP:FILT:HPAS ON
Turns on the filter.

Usage: SCPI confirmed

Manual operation: See "High-Pass Filter 1...3 GHz" on page 130
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INPut:FILTer:YIG[:STATe] <State>

This command turns the YIG-preselector on and off.

Note the special conditions and restrictions for the YIG filter described in "YIG-Prese-
lector" on page 130.

Example: INP:FILT:YIG OFF
Deactivates the YIG-preselector.

Manual operation: See "YIG-Preselector" on page 130

INPut:IMPedance <Impedance>

This command selects the nominal input impedance of the RF input. In some applica-
tions, only 50 Ω are supported.

75 Ω should be selected if the 50 Ω input impedance is transformed to a higher impe-
dance using a matching pad of the RAZ type (= 25 Ω in series to the input impedance
of the instrument). The power loss correction value in this case is 1.76 dB = 10 log
(75Ω/50Ω).

Parameters:
<Impedance> 50 | 75

*RST: 50 Ω

Example: INP:IMP 75
Usage: SCPI confirmed

Manual operation: See "Impedance" on page 130

INPut:PRESelection:SET <Mode>

This command selects the preselector mode.

The command is available with the optional preselector.

Parameters:
<Mode> NARRow

Performs a measurement by automatically applying all available
combinations of low and high pass filters consecutively. These
combinations all have a narrow bandwidth.
WIDE
Performs a measurement by automatically applying all available
bandpass filters consecutively. The bandpass filters have a wide
bandwidth.

Manual operation: See "Preselector Mode" on page 131

INPut:PRESelection[:STATe] <State>

This command turns the preselector on and off.
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Manual operation: See "Preselector State" on page 131

INPut:SELect <Source>

This command selects the signal source for measurements, i.e. it defines which con-
nector is used to input data to the R&S VSE.

This command is identical to INSTrument:BLOCk:CHANnel[:SETTings]:SOURce
on page 285, applied to the currently selected channel and block.

Parameters:
<Source> RF

Radio Frequency ("RF INPUT" connector)
FIQ
I/Q data file
*RST: RF

Manual operation: See "Input Type" on page 72

INPut:TYPE <Input>

The command selects the signal source.

Parameters:
<Input> INPUT1

Selects RF input 1.
INPUT2
Selects RF input 2.
*RST: INPUT1

Example: INP:TYPE INPUT1
Selects RF input 1.

Manual operation: See "Input Selection" on page 132

INSTrument:BLOCk:CHANnel[:SETTings]:SOURce <Type>

Selects an instrument or a file as the source of input provided to the channel.

Parameters:
<Type> FILE | DEVice | NONE

FILE
A loaded file is used for input.
(See chapter 13.4.2, "Loading Input Files", on page 276.)
DEVice
A configured device provides input for the measurement
(See chapter 13.4.1, "Configuring Instruments", on page 264.)
NONE
No input source defined.

Manual operation: See "Input Type" on page 72
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Configuring the Outputs

Configuring trigger input/output is described in "Configuring the Trigger Output"
on page 332.

DIAGnostic:SERVice:NSOurce........................................................................................315

DIAGnostic:SERVice:NSOurce <State>

This command turns the 28 V supply of the BNC connector labeled NOISE SOURCE
CONTROL on the instrument in use on and off.

For details see chapter 10.2.4.1, "Input from Noise Sources", on page 125.

Parameters:
<State> ON | OFF

*RST: OFF

Example: DIAG:SERV:NSO ON
Manual operation: See "Noise Source" on page 133

13.6.1.2 Configuring the Vertical Axis (Amplitude, Scaling)

The following commands are required to configure the amplitude and vertical axis set-
tings in a remote environment.

● Amplitude Settings................................................................................................ 315
● Configuring the Attenuation...................................................................................317
● Configuring a Preamplifier.....................................................................................319
● Scaling the Y-Axis.................................................................................................320

Amplitude Settings

The tasks for manual configuration are described in chapter 10.3.3.2, "Amplitude Set-
tings", on page 137.

Remote commands exclusive to amplitude configuration:

CALCulate<n>:MARKer<m>:FUNCtion:REFerence...........................................................315
CALCulate<n>:UNIT:POWer........................................................................................... 316
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel....................................................... 316
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel:OFFSet........................................... 316
[SENSe:]ADJust:LEVel...................................................................................................317

CALCulate<n>:MARKer<m>:FUNCtion:REFerence

This command matches the reference level to the power level of a marker.

If you use the command in combination with a delta marker, that delta marker is turned
into a normal marker.
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Example: CALC:MARK2:FUNC:REF
Sets the reference level to the level of marker 2.

Usage: Event

Manual operation: See "Reference Level = Marker Level" on page 205

CALCulate<n>:UNIT:POWer <Unit>

This command selects the unit of the y-axis.

The unit applies to all power-based measurement windows (regardless of the <n> suf-
fix).

Parameters:
<Unit> DBM | V | A | W | DBPW | WATT | DBUV | DBMV | VOLT |

DBUA | AMPere
*RST: dBm

Example: CALC:UNIT:POW DBM
Sets the power unit to dBm.

Manual operation: See "Unit" on page 139

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel <ReferenceLevel>

This command defines the reference level (for all traces, <t> is irrelevant).

With a reference level offset ≠ 0, the value range of the reference level is modified by
the offset.

Parameters:
<ReferenceLevel> The unit is variable.

Range: see datasheet
*RST: 0 dBm

Example: DISP:TRAC:Y:RLEV -60dBm
Usage: SCPI confirmed

Manual operation: See "Reference Level" on page 138

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel:OFFSet <Offset>

This command defines a reference level offset (for all traces, <t> is irrelevant).

Parameters:
<Offset> Range: -200 dB  to  200 dB

*RST: 0dB

Example: DISP:TRAC:Y:RLEV:OFFS -10dB
Manual operation: See "Shifting the Display (Offset)" on page 138
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[SENSe:]ADJust:LEVel

This command initiates a single (internal) measurement that evaluates and sets the
ideal reference level for the current input data and measurement settings. This ensures
that the settings of the RF attenuation and the reference level are optimally adjusted to
the signal level without overloading the R&S VSE or limiting the dynamic range by an
S/N ratio that is too small.

Example: ADJ:LEV
Usage: Event

Manual operation: See "Setting the Reference Level Automatically (Auto Level)"
on page 139

Configuring the Attenuation

INPut:ATTenuation.........................................................................................................317
INPut:ATTenuation:AUTO...............................................................................................317
INPut:EATT...................................................................................................................318
INPut:EATT:AUTO......................................................................................................... 318
INPut:EATT:STATe........................................................................................................318

INPut:ATTenuation <Attenuation>

This command defines the total attenuation for RF input.

If you set the attenuation manually, it is no longer coupled to the reference level, but
the reference level is coupled to the attenuation. Thus, if the current reference level is
not compatible with an attenuation that has been set manually, the command also
adjusts the reference level.

Parameters:
<Attenuation> Range: see data sheet

Increment: 5 dB
*RST: 10 dB (AUTO is set to ON)

Example: INP:ATT 30dB
Defines a 30 dB attenuation and decouples the attenuation from
the reference level.

Usage: SCPI confirmed

Manual operation: See "Attenuation Mode / Value" on page 140

INPut:ATTenuation:AUTO <State>

This command couples or decouples the attenuation to the reference level. Thus, when
the reference level is changed, the R&S VSE determines the signal level for optimal
internal data processing and sets the required attenuation accordingly.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1
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Example: INP:ATT:AUTO ON
Couples the attenuation to the reference level.

Usage: SCPI confirmed

Manual operation: See "Attenuation Mode / Value" on page 140

INPut:EATT <Attenuation>

This command defines an electronic attenuation manually. Automatic mode must be
switched off (INP:EATT:AUTO OFF, see INPut:EATT:AUTO on page 318).

If the current reference level is not compatible with an attenuation that has been set
manually, the command also adjusts the reference level.

This command requires the electronic attenuation hardware option.

Parameters:
<Attenuation> attenuation in dB

Range: see data sheet
Increment: 1 dB
*RST: 0 dB (OFF)

Example: INP:EATT:AUTO OFF
INP:EATT 10 dB

Manual operation: See "Using Electronic Attenuation" on page 140

INPut:EATT:AUTO <State>

This command turns automatic selection of the electronic attenuation on and off.

If on, electronic attenuation reduces the mechanical attenuation whenever possible.

This command requires the electronic attenuation hardware option.

Parameters:
<State> 1 | 0 | ON | OFF

1 | ON
0 | OFF
*RST: 1

Example: INP:EATT:AUTO OFF
Manual operation: See "Using Electronic Attenuation" on page 140

INPut:EATT:STATe <State>

This command turns the electronic attenuator on and off.

This command requires the electronic attenuation hardware option.
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Parameters:
<State> 1 | 0 | ON | OFF

1 | ON
0 | OFF
*RST: 0

Example: INP:EATT:STAT ON
Switches the electronic attenuator into the signal path.

Manual operation: See "Using Electronic Attenuation" on page 140

Configuring a Preamplifier

INPut:GAIN:STATe........................................................................................................ 319
INPut:GAIN[:VALue].......................................................................................................319

INPut:GAIN:STATe <State>

This command turns the preamplifier on the instrument in use on and off. It requires
the additional preamplifiier hardware option on the connected instrument.

Depending on the instrument in use, the preamplification is defined by INPut:GAIN[:
VALue].

Parameters:
<State> ON | OFF

*RST: OFF

Example: INP:GAIN:STAT ON
Switches on 30 dB preamplification.

Usage: SCPI confirmed

Manual operation: See "Preamplifier" on page 141

INPut:GAIN[:VALue] <Gain>

This command selects the gain level if the preamplifier is activated (INP:GAIN:STAT
ON, see INPut:GAIN:STATe on page 319).

The command requires the additional preamplifier hardware option.

Parameters:
<Gain> 15 dB | 30 dB

The availability of gain levels depends on the model of the
instrument in use.
*RST: OFF

Example: INP:GAIN:VAL 30
Switches on 30 dB preamplification.

Usage: SCPI confirmed

Manual operation: See "Preamplifier" on page 141
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Scaling the Y-Axis

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]................................................................... 320
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:AUTO ONCE............................................... 320
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:MODE.........................................................320
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:PDIVision.................................................... 321
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RPOSition................................................... 321
DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing.................................................................. 321

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] <Range>

This command defines the display range of the y-axis (for all traces, <t> is irrelevant).

Note that the command works only for a logarithmic scaling. You can select the scaling
with DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing.

Parameters:
<Range> Range: 1 dB  to  200 dB

*RST: 100 dB

Example: DISP:TRAC:Y 110dB
Usage: SCPI confirmed

Manual operation: See "Range" on page 141

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:AUTO ONCE

Automatic scaling of the y-axis is performed once, then switched off again (for all
traces, <t> is irrelevant).

Usage: SCPI confirmed

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:MODE <Mode>

This command selects the type of scaling of the y-axis (for all traces, <t> is irrelevant).

When the display update during remote control is off, this command has no immediate
effect.

Parameters:
<Mode> ABSolute

absolute scaling of the y-axis
RELative
relative scaling of the y-axis
*RST: ABSolute

Example: DISP:TRAC:Y:MODE REL
Manual operation: See "Scaling" on page 142
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DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:PDIVision <Value>

This remote command determines the grid spacing on the Y-axis for all diagrams,
where possible.

The suffix <t> is irrelevant.

Parameters:
<Value> numeric value WITHOUT UNIT (unit according to the result dis-

play)
Defines the range per division (total range = 10*<Value>)
*RST: depends on the result display

Example: DISP:TRAC:Y:PDIV 10
Sets the grid spacing to 10 units (e.g. dB) per division

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RPOSition <Position>

This command defines the vertical position of the reference level on the display grid
(for all traces, <t> is irrelevant).

The R&S VSE adjusts the scaling of the y-axis accordingly.

Parameters:
<Position> 0 PCT corresponds to the lower display border, 100% corre-

sponds to the upper display border.
*RST: 100 PCT = frequency display; 50 PCT = time dis-

play

Example: DISP:TRAC:Y:RPOS 50PCT
Usage: SCPI confirmed

Manual operation: See "Ref Level Position" on page 142

DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing <ScalingType>

This command selects the scaling of the y-axis (for all traces, <t> is irrelevant).

Parameters:
<ScalingType> LOGarithmic

Logarithmic scaling.
LINear
Linear scaling in %.
LDB
Linear scaling in the specified unit.
PERCent
Linear scaling in %.
*RST: LOGarithmic

Example: DISP:TRAC:Y:SPAC LIN
Selects linear scaling in %.
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Usage: SCPI confirmed

Manual operation: See "Scaling" on page 142

13.6.1.3 Configuring the Axes for Statistical Displays

For statistical displays, the scaling can be configured for both the x-axis and the y-axis.

CALCulate<n>:IQ:STATistics:SCALe:X:QUANtize.............................................................322
CALCulate<n>:IQ:STATistics:SCALe:X:RANGe................................................................ 322
CALCulate<n>:IQ:STATistics:SCALe:X:RLEVel:OFFSet....................................................322
CALCulate<n>:IQ:STATistics:SCALe:X:RVALue............................................................... 323
CALCulate<n>:IQ:STATistics:SCALe:Y:LOWer.................................................................323
CALCulate<n>:IQ:STATistics:SCALe:Y:UPPer..................................................................323

CALCulate<n>:IQ:STATistics:SCALe:X:QUANtize <StatNofColumns>

This command defines the number of columns for the statistical distribution.

Setting parameters: 
<StatNofColumns> numeric value

Range: 2  to  1024
*RST: 101
Default unit: NONE

Example: CALC:IQ:STAT:SCAL:X:QUAN 10
Manual operation: See "Quantize Bins" on page 143

CALCulate<n>:IQ:STATistics:SCALe:X:RANGe <Range>

This command defines the display range of the x-axis for statistical measurements.

The effects are identical to DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe].

Parameters:
<Range> Range: 1 dB  to  200 dB

*RST: 100 dB

Example: CALC:IQ:STAT:SCAL:X:RANG 20dB
Manual operation: See "Range" on page 143

CALCulate<n>:IQ:STATistics:SCALe:X:RLEVel:OFFSet <Level>

This command defines an arithmetic level offset. This offset is added to the measured
level irrespective of the selected unit. The scaling of the x-axis is changed accordingly.

Parameters:
<Level> The unit is variable.

Example: CALC:IQ:STAT:SCAL:X:RLEV:OFFS -10dBm
Manual operation: See "Offset" on page 143
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CALCulate<n>:IQ:STATistics:SCALe:X:RVALue <RefLevel>

This command sets the reference level for statistical measurements. The effects are
identical to DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe]:RLEVel.

Note that in case of statistical measurements the reference level applies to the x-axis.

Parameters:
<RefLevel> The unit is variable.

If a reference level offset is included, the range is adjusted by
that offset.
Range: -130 dBm  to  30 dBm
*RST: 0 dBm

Example: CALC:IQ:STAT:SCAL:X:RVAL -60dBm
Manual operation: See "X-Axis Reference Value" on page 143

CALCulate<n>:IQ:STATistics:SCALe:Y:LOWer <Magnitude>

This command defines the lower vertical limit of the diagram.

Parameters:
<Magnitude> The number is a statistical value and therefore dimensionless.

Range: 1E-9  to  0.1
*RST: 1E-6

Example: CALC:IQ:STAT:SCAL:Y:LOW 0.001
Manual operation: See "Y-Max / Y-Min" on page 143

CALCulate<n>:IQ:STATistics:SCALe:Y:UPPer <Magnitude>

This command defines the upper vertical limit of the diagram.

Parameters:
<Magnitude> The number is a statistical value and therefore dimensionless.

Range: 1E-5  to  1.0
*RST: 1.0

Example: CALC:IQ:STAT:SCAL:Y:UPP 0.01
Manual operation: See "Y-Max / Y-Min" on page 143

13.6.1.4 Frequency

CALCulate<n>:MARKer<m>:FUNCtion:CENTer................................................................324
[SENSe:]FREQuency:CENTer.........................................................................................324
[SENSe:]FREQuency:CENTer:STEP............................................................................... 324
[SENSe:]FREQuency:CENTer:STEP:AUTO..................................................................... 325
[SENSe:]FREQuency:OFFSet......................................................................................... 325
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CALCulate<n>:MARKer<m>:FUNCtion:CENTer

This command matches the center frequency to the frequency of a marker.

If you use the command in combination with a delta marker, that delta marker is turned
into a normal marker.

Example: CALC:MARK2:FUNC:CENT
Sets the center frequency to the frequency of marker 2.

Usage: Event

Manual operation: See "Center Frequency = Marker Frequency" on page 205

[SENSe:]FREQuency:CENTer <Frequency>

This command defines the center frequency.

Parameters:
<Frequency> The allowed range and fmax is specified in the data sheet.

UP
Increases the center frequency by the step defined using the
[SENSe:]FREQuency:CENTer:STEP command.

DOWN
Decreases the center frequency by the step defined using the
[SENSe:]FREQuency:CENTer:STEP command.

*RST: fmax/2
Default unit: Hz

Example: FREQ:CENT 100 MHz
FREQ:CENT:STEP 10 MHz
FREQ:CENT UP
Sets the center frequency to 110 MHz.

Usage: SCPI confirmed

Manual operation: See "Center frequency" on page 144

[SENSe:]FREQuency:CENTer:STEP <StepSize>

This command defines the center frequency step size.

You can increase or decrease the center frequency quickly in fixed steps using the
SENS:FREQ UP AND SENS:FREQ DOWN commands, see [SENSe:]FREQuency:
CENTer on page 324.

Parameters:
<StepSize> fmax is specified in the data sheet.

Range: 1  to  fMAX
*RST: 0.1 x span
Default unit: Hz
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Example: FREQ:CENT 100 MHz
FREQ:CENT:STEP 10 MHz
FREQ:CENT UP
Sets the center frequency to 110 MHz.

Manual operation: See "Center Frequency Stepsize" on page 144

[SENSe:]FREQuency:CENTer:STEP:AUTO <State>

This command couples or decouples the center frequency step size to the span.

In time domain (zero span) measurements, the center frequency is coupled to the
RBW.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: FREQ:CENT:STEP:AUTO ON
Activates the coupling of the step size to the span.

[SENSe:]FREQuency:OFFSet <Offset>

This command defines a frequency offset.

If this value is not 0 Hz, the application assumes that the input signal was frequency
shifted outside the application. All results of type "frequency" will be corrected for this
shift numerically by the application.

See also "Frequency Offset" on page 144.

Parameters:
<Offset> Range: -100 GHz  to  100 GHz

*RST: 0 Hz

Example: FREQ:OFFS 1GHZ
Usage: SCPI confirmed

Manual operation: See "Frequency Offset" on page 144

13.6.1.5 Triggering

The following remote commands are required to configure a triggered measurement in
a remote environment. More details are described for manual operation in chap-
ter 10.3.5.2, "Trigger Settings", on page 148.

Note that the availability of trigger settings depends on the instrument in use.
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*OPC should be used after requesting data. This will hold off any subsequent changes
to the selected trigger source, until after the sweep is completed and the data is
returned.

● Configuring the Triggering Conditions...................................................................326
● Configuring the Trigger Output..............................................................................332

Configuring the Triggering Conditions

The following commands are required to configure a triggered measurement.

Note that the availability of trigger sources depends on the instrument in use.

TRIGger[:SEQuence]:DTIMe...........................................................................................326
TRIGger[:SEQuence]:HOLDoff[:TIME]..............................................................................326
TRIGger[:SEQuence]:IFPower:HOLDoff........................................................................... 327
TRIGger[:SEQuence]:IFPower:HYSTeresis...................................................................... 327
TRIGger[:SEQuence]:LEVel[:EXTernal<port>].................................................................. 327
TRIGger[:SEQuence]:LEVel:IFPower...............................................................................328
TRIGger[:SEQuence]:LEVel:IQPower.............................................................................. 328
TRIGger[:SEQuence]:LEVel:MAPower.............................................................................328
TRIGger[:SEQuence]:LEVel:RFPower..............................................................................329
TRIGger[:SEQuence]:MAPower:HOLDoff......................................................................... 329
TRIGger[:SEQuence]:MAPower:HYSTeresis.................................................................... 329
TRIGger[:SEQuence]:SLOPe.......................................................................................... 330
TRIGger[:SEQuence]:SOURce........................................................................................330
TRIGger[:SEQuence]:TIME:RINTerval............................................................................. 331

TRIGger[:SEQuence]:DTIMe <DropoutTime>

Defines the time the input signal must stay below the trigger level before a trigger is
detected again.

Parameters:
<DropoutTime> Dropout time of the trigger.

Range: 0 s to 10.0 s
*RST: 0 s

Manual operation: See "Drop-Out Time" on page 152

TRIGger[:SEQuence]:HOLDoff[:TIME] <Offset>

Defines the time offset between the trigger event and the start of the measurement.

A negative offset is possible for time domain measurements.

Parameters:
<Offset> For measurements in the frequency domain, the range is 0 s to

30 s.
For measurements in the time domain, the range is the negative
measurement time to 30 s.
*RST: 0 s
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Example: TRIG:HOLD 500us
Manual operation: See "Trigger Offset" on page 152

TRIGger[:SEQuence]:IFPower:HOLDoff <Period>

This command defines the holding time before the next trigger event.

Note that this command can be used for any trigger source, not just IF Power
(despite the legacy keyword).

For (offline) input from a file, this command does not apply. In this case, use
TRIGger[:SEQuence]:MAPower:HOLDoff on page 329.

Parameters:
<Period> Range: 0 s  to  10 s

*RST: 0 s

Example: TRIG:SOUR EXT
Sets an external trigger source.
TRIG:IFP:HOLD 200 ns
Sets the holding time to 200 ns.

Manual operation: See "Trigger Holdoff" on page 152

TRIGger[:SEQuence]:IFPower:HYSTeresis <Hysteresis>

This command defines the trigger hysteresis, which is only available for "IF Power" trig-
ger sources.

Parameters:
<Hysteresis> Range: 3 dB  to  50 dB

*RST: 3 dB

Example: TRIG:SOUR IFP
Sets the IF power trigger source.
TRIG:IFP:HYST 10DB
Sets the hysteresis limit value.

Manual operation: See "Hysteresis" on page 152

TRIGger[:SEQuence]:LEVel[:EXTernal<port>] <TriggerLevel>

This command defines the level the external signal must exceed to cause a trigger
event.

In the I/Q Analyzer application only EXTernal1 is supported.
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Suffix: 
<port>

.
Selects the trigger port.
1 = trigger port 1 (TRIGGER INPUT connector on front panel)
2 = trigger port 2 (TRIGGER INPUT/OUTPUT connector on front
panel)
3 = trigger port 3 (TRIGGER3 INPUT/OUTPUT connector on
rear panel)

Parameters:
<TriggerLevel> Range: 0.5 V  to  3.5 V

*RST: 1.4 V

Example: TRIG:LEV 2V
Manual operation: See "Trigger Level" on page 151

TRIGger[:SEQuence]:LEVel:IFPower <TriggerLevel>

This command defines the power level at the third intermediate frequency that must be
exceeded to cause a trigger event. Note that any RF attenuation or preamplification is
considered when the trigger level is analyzed. If defined, a reference level offset is also
considered.

Parameters:
<TriggerLevel> For details on available trigger levels and trigger bandwidths see

the data sheet.
*RST: -10 dBm

Example: TRIG:LEV:IFP -30DBM
Manual operation: See "Trigger Level" on page 151

TRIGger[:SEQuence]:LEVel:IQPower <TriggerLevel>

This command defines the magnitude the I/Q data must exceed to cause a trigger
event. Note that any RF attenuation or preamplification is considered when the trigger
level is analyzed.

Parameters:
<TriggerLevel> Range: -130 dBm  to  30 dBm

*RST: -20 dBm

Example: TRIG:LEV:IQP -30DBM
Manual operation: See "Trigger Level" on page 151

TRIGger[:SEQuence]:LEVel:MAPower <TriggerLevel>

This command defines the power level that must be exceeded to cause a trigger event
for (offline) input from a file.
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Parameters:
<TriggerLevel> For details on available trigger levels and trigger bandwidths see

the data sheet.

Example: TRIG:LEV:MAP -30DBM
Manual operation: See "Trigger Level" on page 151

TRIGger[:SEQuence]:LEVel:RFPower <TriggerLevel>

This command defines the power level the RF input must exceed to cause a trigger
event. Note that any RF attenuation or preamplification is considered when the trigger
level is analyzed. If defined, a reference level offset is also considered.

The input signal must be between 500 MHz and 8 GHz.

Parameters:
<TriggerLevel> For details on available trigger levels and trigger bandwidths see

the data sheet.
*RST: -20 dBm

Example: TRIG:LEV:RFP -30dBm
Manual operation: See "Trigger Level" on page 151

TRIGger[:SEQuence]:MAPower:HOLDoff <Period>

This command defines the holding time before the next trigger event for (offline) input
from a file.

Parameters:
<Period> Range: 0 s  to  10 s

*RST: 0 s

Example: TRIG:SOUR MAGN
Sets an offline magnitude trigger source.
TRIG:MAP:HOLD 200 ns
Sets the holding time to 200 ns.

Manual operation: See "Trigger Holdoff" on page 152

TRIGger[:SEQuence]:MAPower:HYSTeresis <Hysteresis>

This command defines the trigger hysteresis for the (offline) magnitude trigger source
(used for input from a file).

Parameters:
<Hysteresis> Range: 3 dB  to  50 dB

*RST: 3 dB

Example: TRIG:SOUR MAP
Sets the (offline) magnitude trigger source.
TRIG:MAP:HYST 10DB
Sets the hysteresis limit value.
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Manual operation: See "Hysteresis" on page 152

TRIGger[:SEQuence]:SLOPe <Type>

Parameters:
<Type> POSitive | NEGative

POSitive
Triggers when the signal rises to the trigger level (rising edge).
NEGative
Triggers when the signal drops to the trigger level (falling edge).
*RST: POSitive

Example: TRIG:SLOP NEG
Manual operation: See "Slope" on page 153

TRIGger[:SEQuence]:SOURce <Source>

This command selects the trigger source.

Note that the availability of trigger sources depends on the instrument in use.

For details on trigger sources see "Trigger Source" on page 150.

Note on external triggers:

If a measurement is configured to wait for an external trigger signal in a remote control
program, remote control is blocked until the trigger is received and the program can
continue. Make sure this situation is avoided in your remote control programs.

For troubleshooting tips see "Uncompleted sequential commands - blocked remote
channels" on page 445.
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Parameters:
<Source> IMMediate

Free Run
EXT | EXT2 | EXT3 | EXT4
Trigger signal from the corresponding TRIGGER INPUT/
OUTPUT connector on the instrument in use, or the oscillo-
scope's corresponding input channel.
For details on the connectors see the instrument's Getting Star-
ted manual.
RFPower
First intermediate frequency
IFPower
Second intermediate frequency
IQPower
Magnitude of sampled I/Q data
For applications that process I/Q data, such as the I/Q Analyzer
or optional applications.
VIDeo
Video mode is available in the time domain and only in the
Spectrum application.
MAGNitude
For (offline) input from a file, rather than an instrument. Triggers
on a specified signal level.
*RST: IMMediate

Example: TRIG:SOUR EXT
Selects the external trigger input as source of the trigger signal

Manual operation: See "Trigger Source" on page 150

TRIGger[:SEQuence]:TIME:RINTerval <Interval>

This command defines the repetition interval for the time trigger.

Parameters:
<Interval> 2.0 ms to 5000

Range: 2 ms  to  5000 s
*RST: 1.0 s

Example: TRIG:SOUR TIME
Selects the time trigger input for triggering.
TRIG:TIME:RINT 50
The measurement starts every 50 s.

Manual operation: See "Repetition Interval" on page 151
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Configuring the Trigger Output

The following commands are required to send the trigger signal to one of the variable
TRIGGER INPUT/OUTPUT connectors on the instrument in use.

OUTPut:TRIGger<port>:DIRection...................................................................................332
OUTPut:TRIGger<port>:LEVel........................................................................................ 332
OUTPut:TRIGger<port>:OTYPe...................................................................................... 332
OUTPut:TRIGger<port>:PULSe:IMMediate.......................................................................333
OUTPut:TRIGger<port>:PULSe:LENGth.......................................................................... 333

OUTPut:TRIGger<port>:DIRection <Direction>

This command selects the trigger direction for trigger ports that serve as an input as
well as an output.

Suffix: 
<port>

.

Parameters:
<Direction> INPut

Port works as an input.
OUTPut
Port works as an output.
*RST: INPut

Manual operation: See "Trigger 2/3" on page 134

OUTPut:TRIGger<port>:LEVel <Level>

This command defines the level of the signal generated at the trigger output.

This command works only if you have selected a user defined output with OUTPut:
TRIGger<port>:OTYPe.

Suffix: 
<port>

.
Selects the trigger port to which the output is sent.

Parameters:
<Level> HIGH

TTL signal.
LOW
0 V
*RST: LOW

Manual operation: See "Trigger 2/3" on page 134

OUTPut:TRIGger<port>:OTYPe <OutputType>

This command selects the type of signal generated at the trigger output.

Suffix: 
<port>

.
Selects the trigger port to which the output is sent.
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Parameters:
<OutputType> DEVice

Sends a trigger signal when the R&S VSE has triggered inter-
nally.
TARMed
Sends a trigger signal when the trigger is armed and ready for
an external trigger event.
UDEFined
Sends a user defined trigger signal. For more information see
OUTPut:TRIGger<port>:LEVel.

*RST: DEVice

Manual operation: See "Output Type" on page 134

OUTPut:TRIGger<port>:PULSe:IMMediate

This command generates a pulse at the trigger output.

Suffix: 
<port>

.
Selects the trigger port to which the output is sent.

Usage: Event

Manual operation: See "Send Trigger" on page 135

OUTPut:TRIGger<port>:PULSe:LENGth <Length>

This command defines the length of the pulse generated at the trigger output.

Suffix: 
<port>

.
Selects the trigger port to which the output is sent.

Parameters:
<Length> Pulse length in seconds.

Manual operation: See "Pulse Length" on page 134

13.6.1.6 Configuring Data Acquisition

The following commands are required to capture data in the I/Q Analyzer.

Remote commands exclusive to I/Q data acquisition

[SENSe:]IQ:BANDwidth|BWIDth:MODE........................................................................... 334
[SENSe:]IQ:BANDwidth|BWIDth:RESolution.....................................................................334
[SENSe:]IQ:FFT:ALGorithm............................................................................................ 335
[SENSe:]IQ:FFT:LENGth................................................................................................ 335
[SENSe:]IQ:FFT:WINDow:LENGth...................................................................................336
[SENSe:]IQ:FFT:WINDow:OVERlap.................................................................................336
[SENSe:]IQ:FFT:WINDow:TYPE......................................................................................336
[SENSe:]SWAPiq...........................................................................................................337
[SENSe:]SWEep:COUNt.................................................................................................337
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[SENSe:]SWEep:POINts.................................................................................................338
[SENSe:]SWEep:TIME................................................................................................... 338
TRACe:IQ:BWIDth......................................................................................................... 338
TRACe:IQ:RLENgth....................................................................................................... 338
TRACe:IQ:SET.............................................................................................................. 339
TRACe:IQ:SRATe..........................................................................................................340
TRACe:IQ:TPISample?...................................................................................................340
TRACe:IQ:WBANd[:STATe]............................................................................................ 341
TRACe:IQ:WBANd:MBWIDTH.........................................................................................341

[SENSe:]IQ:BANDwidth|BWIDth:MODE <Mode>

This command defines how the resolution bandwidth is determined.

Parameters:
<Mode> AUTO | MANual | FFT

AUTO
(Default) The RBW is determined automatically depending on
the sample rate and record length.
MANual
The user-defined RBW is used and the (FFT) window length
(and possibly the sample rate) are adapted accordingly. The
RBW is defined using the [SENSe:]IQ:BANDwidth|BWIDth:
RESolution command.

FFT
The RBW is determined by the FFT parameters.
*RST: AUTO

Example: IQ:BAND:MODE MAN
Switches to manual RBW mode.
IQ:BAND:RES 120000
Sets the RBW to 120 kHz.

Usage: SCPI confirmed

Manual operation: See "RBW" on page 157

[SENSe:]IQ:BANDwidth|BWIDth:RESolution <Bandwidth>

This command defines the resolution bandwidth manually if [SENSe:]IQ:
BANDwidth|BWIDth:MODE is set to MAN.

Defines the resolution bandwidth. The available RBW values depend on the sample
rate and record length.

For details see chapter 10.2.3.1, "Frequency Resolution of FFT Results - RBW",
on page 120.

Parameters:
<Bandwidth> refer to data sheet

*RST: RBW: AUTO mode is used
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Example: IQ:BAND:MODE MAN
Switches to manual RBW mode.
IQ:BAND:RES 120000
Sets the RBW to 120 kHz.

Usage: SCPI confirmed

Manual operation: See "RBW" on page 157

[SENSe:]IQ:FFT:ALGorithm <Method>

Defines the FFT calculation method.

Parameters:
<Method> SINGle

One FFT is calculated for the entire record length; if the FFT
length is larger than the record length (see [SENSe:]IQ:FFT:
LENGth and TRACe:IQ:RLENgth), zeros are appended to the
captured data.
AVERage
Several overlapping FFTs are calculated for each record; the
results are averaged to determine the final FFT result for the
record.
The user-defined window length and window overlap are used
(see [SENSe:]IQ:FFT:WINDow:LENGth and [SENSe:]IQ:
FFT:WINDow:OVERlap).

*RST: AVER

Example: IQ:FFT:ALG SING
Usage: SCPI confirmed

Manual operation: See "Transformation Algorithm" on page 158

[SENSe:]IQ:FFT:LENGth <NoOfBins>

Defines the number of frequency points determined by each FFT calculation. The more
points are used, the higher the resolution in the spectrum becomes, but the longer the
calculation takes.

Parameters:
<NoOfBins> integer value

Range: 3 to 524288
*RST: 4096

Example: IQ:FFT:LENG 2048
Usage: SCPI confirmed

Manual operation: See "FFT Length" on page 158
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[SENSe:]IQ:FFT:WINDow:LENGth <NoOfFFT>

Defines the number of samples to be included in a single FFT window when multiple
FFT windows are used.

Parameters:
<NoOfFFT> integer value

Range: 3  to  1001
*RST: 1001

Example: IQ:FFT:WIND:LENG 500
Usage: SCPI confirmed

Manual operation: See "Window Length" on page 158

[SENSe:]IQ:FFT:WINDow:OVERlap <Rate>

Defines the part of a single FFT window that is re-calculated by the next FFT calcula-
tion.

Parameters:
<Rate> double value

Percentage rate
Range: 0  to  1
*RST: 0.75

Example: IQ:FFT:WIND:OVER 0.5
Half of each window overlaps the previous window in FFT calcu-
lation.

Usage: SCPI confirmed

Manual operation: See "Window Overlap" on page 158

[SENSe:]IQ:FFT:WINDow:TYPE <Function>

In the I/Q Analyzer you can select one of several FFT window types.

Parameters:
<Function> BLACkharris

Blackman-Harris
FLATtop
Flattop
GAUSsian
Gauss
RECTangular
Rectangular
P5
5-Term
*RST: FLAT
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Example: IQ:FFT:WIND:TYPE GAUS
Usage: SCPI confirmed

Manual operation: See "Window Function" on page 158

[SENSe:]SWAPiq <State>

This command defines whether or not the recorded I/Q pairs should be swapped (I<-
>Q) before being processed. Swapping I and Q inverts the sideband.

This is useful if the DUT interchanged the I and Q parts of the signal; then the
R&S VSE can do the same to compensate for it.

Parameters:
<State> ON

I and Q signals are interchanged
Inverted sideband, Q+j*I
OFF
I and Q signals are not interchanged
Normal sideband, I+j*Q
*RST: OFF

Manual operation: See "Swap I/Q" on page 156

[SENSe:]SWEep:COUNt <SweepCount>

This command defines the number of measurements that the application uses to aver-
age traces.

In case of continuous measurement mode, the application calculates the moving aver-
age over the average count.

In case of single measurement mode, the application stops the measurement and cal-
culates the average after the average count has been reached.

Parameters:
<SweepCount> When you set a capture count of 0 or 1, the R&S VSE performs

one single measurement in single measurement mode.
In continuous measurement mode, if the capture count is set to
0, a moving average over 10 measurements is performed.
Range: 0  to  200000
*RST: 0

Example: SWE:COUN 64
Sets the number of measurements to 64.
INIT:CONT OFF
Switches to single measurement mode.
INIT;*WAI
Starts a measurement and waits for its end.

Usage: SCPI confirmed
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[SENSe:]SWEep:POINts <MeasPoints>

This command defines the number of measurement points to analyze after a measure-
ment.

Note that the number of measurement points is limited to 10001 when measuring spu-
rious emissions.

Parameters:
<MeasPoints> Range: 51  to  524288

*RST: 1001

Example: SWE:POIN 251
Usage: SCPI confirmed

Manual operation: See "Points" on page 159

[SENSe:]SWEep:TIME <Time>

This command defines the measurement time.

Parameters:
<Time> refer to data sheet

*RST: depends on current settings (determined automati-
cally)

Example: SWE:TIME 10s
Usage: SCPI confirmed

Manual operation: See "Meas Time" on page 156

TRACe:IQ:BWIDth

This command defines or queries the bandwidth of the resampling filter.

The bandwidth of the resampling filter depends on the sample rate.

Parameters:
<Bandwidth> For details on the maximum bandwidth see chapter 10.2.2,

"Sample Rate, Record Length and Analysis Bandwidth",
on page 119.

Manual operation: See "Analysis Bandwidth" on page 155

TRACe:IQ:RLENgth <NoOfSamples>

This command sets the record length for the acquired I/Q data.

Increasing the record length also increases the measurement time.

Note: Alternatively, you can define the measurement time using the SENS:SWE:TIME
command.
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Parameters:
<NoOfSamples> Number of samples to record.

See chapter 10.2.2, "Sample Rate, Record Length and Analysis
Bandwidth", on page 119
*RST: 1001

Example: TRAC:IQ:RLEN 256
Manual operation: See "Record Length" on page 156

TRACe:IQ:SET NORM, 0, <SampleRate>, <TriggerMode>, <TriggerSlope>,
<PretriggerSamp>, <NumberSamples>

This command sets up the R&S VSE for I/Q measurements.

If you do not use this command to set up I/Q measurements, the R&S VSE will use its
current settings for I/Q measurements.

If the I/Q Analyzer has not been turned on previously, the command also switches to
the I/Q Analyzer.

Note: If you use the default settings with TRACe:IQ:DATA??, the following minimum
buffer sizes for the response data are recommended:

ASCII format: 10 kBytes

4

Binary format: 2 kBytes

Parameters:
NORM This value is always NORM.

0 This value is always 0.

<SampleRate> Sample rate for the data acquisition.
Range: 100 Hz to 10 GHz, continuously adjustable
*RST: 32000000

<TriggerMode> Selection of the trigger source used for the measurement.
IMMediate | EXTernal | EXT2 | EXT3 | IFPower
For IMM mode, gating is automatically deactivated.
*RST: IMM

<TriggerSlope> Used trigger slope.
POSitive | NEGative
*RST: POS

<PretriggerSamp> Defines the trigger offset in terms of pretrigger samples. Nega-
tive values correspond to a trigger delay.
This value also defines the interval between the trigger signal
and the gate edge in samples.
Range: -461373339  to  461373339
*RST: 0
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<NumberSamples> Number of measurement values to record (including the pretrig-
ger samples).
See chapter 10.2.2, "Sample Rate, Record Length and Analysis
Bandwidth", on page 119.
*RST: 1001

Example: TRAC:IQ:SET NORM,0,32MHz,EXT,POS,0,2048
Reads 2048 I/Q-values starting at the trigger point.
sample rate = 32 MHz
trigger = External
slope = Positive
TRAC:IQ:SET NORM,0,4 MHz,EXT,POS,1024,512
Reads 512 I/Q-values from 1024 measurement points before the
trigger point.
filter type = NORMAL
sample rate = 4 MHz
trigger = External
slope = Positive

Manual operation: See "Record Length" on page 156

TRACe:IQ:SRATe <SampleRate>

This command sets the final user sample rate for the acquired I/Q data. Thus, the user
sample rate can be modified without affecting the actual data capturing settings on the
R&S VSE.

Parameters:
<SampleRate> The valid sample rates depend on the instrument in use. Refer

to the instrument's documentation.
*RST: 32 MHz

Manual operation: See "Sample Rate" on page 155

TRACe:IQ:TPISample?

This command queries the time offset between the sample start and the trigger event
(trigger point in sample = TPIS). Since the R&S VSE usually samples with a much
higher sample rate than the specific application actually requires, the trigger point
determined internally is much more precise than the one determined from the (down-
sampled) data in the application. Thus, the TPIS indicates the offset between the sam-
ple start and the actual trigger event.
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This value can only be determined in triggered measurements using external or
IFPower triggers, otherwise the value is 0.

Example: TRAC:IQ:TPIS?
Result for a sample rate of 1 MHz: between 0 and 1/1 MHz, i.e.
between 0 and 1 μs (the duration of 1 sample).

Usage: Query only

Manual operation: See "Trigger Offset" on page 152

TRACe:IQ:WBANd[:STATe] <State>

This command determines whether the wideband provided by bandwidth extension
options is used or not (if installed).

Parameters:
<State> ON | OFF

ON
If enabled, bandwidth extension options installed on the instru-
ment in use can be used.
OFF
No bandwidth extension options installed on the instrument in
use are used. The maximum analysis bandwidth is restricted,
depending on the used instrument.
*RST: ON

Manual operation: See "Maximum Bandwidth" on page 156

TRACe:IQ:WBANd:MBWIDTH <Limit>

Defines the maximum analysis bandwidth. Any value can be specified; the next higher
fixed bandwidth is used.

The available fixed values depend on the instrument in use and the installed bandwidth
extenstion options.

Manual operation: See "Maximum Bandwidth" on page 156
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13.6.1.7 Adjusting Settings Automatically

The commands required to adjust settings automatically in a remote environment are
described here.

[SENSe:]ADJust:ALL......................................................................................................342
[SENSe:]ADJust:CONFigure:DURation............................................................................ 342
[SENSe:]ADJust:CONFigure:DURation:MODE..................................................................343
[SENSe:]ADJust:CONFigure:HYSTeresis:LOWer..............................................................343
[SENSe:]ADJust:CONFigure:HYSTeresis:UPPer...............................................................343
[SENSe:]ADJust:CONFigure:TRIG...................................................................................343
[SENSe:]ADJust:FREQuency..........................................................................................344
[SENSe:]ADJust:LEVel...................................................................................................344

[SENSe:]ADJust:ALL

This command initiates a measurement to determine and set the ideal settings for the
current task automatically (only once for the current measurement).

This includes:

● Center frequency
● Reference level

Example: ADJ:ALL
Usage: Event

Manual operation: See "Adjusting all Determinable Settings Automatically (Auto
All)" on page 162

[SENSe:]ADJust:CONFigure:DURation <Duration>

In order to determine the ideal reference level, the R&S VSE performs a measurement
on the current input data. This command defines the length of the measurement if
[SENSe:]ADJust:CONFigure:DURation:MODE is set to MANual.

Parameters:
<Duration> Numeric value in seconds

Range: 0.001  to  16000.0
*RST: 0.001
Default unit: s

Example: ADJ:CONF:DUR:MODE MAN
Selects manual definition of the measurement length.
ADJ:CONF:LEV:DUR 5ms
Length of the measurement is 5 ms.

Manual operation: See "Automatic Measurement Time Mode and Value"
on page 163
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[SENSe:]ADJust:CONFigure:DURation:MODE <Mode>

In order to determine the ideal reference level, the R&S VSE performs a measurement
on the current input data. This command selects the way the R&S VSE determines the
length of the measurement .

Parameters:
<Mode> AUTO

The R&S VSE determines the measurement length automati-
cally according to the current input data.
MANual
The R&S VSE uses the measurement length defined by
[SENSe:]ADJust:CONFigure:DURation on page 342.

*RST: AUTO

Manual operation: See "Automatic Measurement Time Mode and Value"
on page 163

[SENSe:]ADJust:CONFigure:HYSTeresis:LOWer <Threshold>

Parameters:
<Threshold> Range: 0 dB  to  200 dB

*RST: +1 dB
Default unit: dB

Example: SENS:ADJ:CONF:HYST:LOW 2
For an input signal level of currently 20 dBm, the reference level
will only be adjusted when the signal level falls below 18 dBm.

Manual operation: See "Lower Level Hysteresis" on page 163

[SENSe:]ADJust:CONFigure:HYSTeresis:UPPer <Threshold>

Parameters:
<Threshold> Range: 0 dB  to  200 dB

*RST: +1 dB
Default unit: dB

Example: SENS:ADJ:CONF:HYST:UPP 2
Example: For an input signal level of currently 20 dBm, the reference level

will only be adjusted when the signal level rises above 22 dBm.

Manual operation: See "Upper Level Hysteresis" on page 163

[SENSe:]ADJust:CONFigure:TRIG <State>

Defines the behaviour of the measurement when adjusting a setting automatically
(using SENS:ADJ:LEV ON, for example).
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Parameters:
<State> ON | 1

The measurement for automatic adjustment waits for the trigger.
OFF | 0
The measurement for automatic adjustment is performed imme-
diately, without waiting for a trigger.
*RST: 1

[SENSe:]ADJust:FREQuency

This command sets the center frequency to the frequency with the highest signal level
in the current frequency range.

Example: ADJ:FREQ
Usage: Event

Manual operation: See "Adjusting the Center Frequency Automatically (Auto Freq)"
on page 162

[SENSe:]ADJust:LEVel

This command initiates a single (internal) measurement that evaluates and sets the
ideal reference level for the current input data and measurement settings. This ensures
that the settings of the RF attenuation and the reference level are optimally adjusted to
the signal level without overloading the R&S VSE or limiting the dynamic range by an
S/N ratio that is too small.

Example: ADJ:LEV
Usage: Event

Manual operation: See "Setting the Reference Level Automatically (Auto Level)"
on page 139

13.6.2 I/Q Analysis

General result analysis settings concerning the trace, markers, etc. can be configured
using the following commands. They are identical to the analysis functions in the Spec-
trum application except for the special marker functions.

● Configuring Standard Traces................................................................................ 345
● Configuring Spectrograms.................................................................................... 349
● Using Markers.......................................................................................................354
● Zooming into the Display.......................................................................................378
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13.6.2.1 Configuring Standard Traces

Useful commands for trace configuration described elsewhere

● DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing on page 321
● DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] on page 320

Remote commands exclusive to trace configuration

DISPlay[:WINDow<n>]:TRACe<t>:MODE.........................................................................345
DISPlay[:WINDow<n>]:TRACe<t>:MODE:HCONtinuous....................................................346
DISPlay[:WINDow<n>]:TRACe<t>[:STATe].......................................................................346
[SENSe:]AVERage<n>:TYPE..........................................................................................347
[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion]...............................................................347
[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion]:AUTO.....................................................347
TRACe<n>:COPY..........................................................................................................348
[SENSe:]AVERage<n>:COUNt........................................................................................348
TRACe:IQ:AVERage:COUNt...........................................................................................348
[SENSe:]AVERage<n>[:STATe<t>]..................................................................................348
TRACe:IQ:AVERage[:STATe]......................................................................................... 348

DISPlay[:WINDow<n>]:TRACe<t>:MODE <Mode>

This command selects the trace mode.

Parameters:
<Mode> WRITe

Overwrite mode: the trace is overwritten by each sweep. This is
the default setting.
AVERage
The average is formed over several sweeps. The "Sweep/Aver-
age Count" determines the number of averaging procedures.
MAXHold
The maximum value is determined over several sweeps and dis-
played. The R&S VSE saves the sweep result in the trace mem-
ory only if the new value is greater than the previous one.
MINHold
The minimum value is determined from several measurements
and displayed. The R&S VSE saves the sweep result in the
trace memory only if the new value is lower than the previous
one.
VIEW
The current contents of the trace memory are frozen and dis-
played.
BLANk
Hides the selected trace.
*RST: Trace 1: WRITe, Trace 2-6: BLANk
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Example: INIT:CONT OFF
Switching to single sweep mode.
SWE:COUN 16
Sets the number of measurements to 16.
DISP:TRAC3:MODE WRIT
Selects clear/write mode for trace 3.
INIT;*WAI
Starts the measurement and waits for the end of the measure-
ment.

Manual operation: See "Trace Mode" on page 175

DISPlay[:WINDow<n>]:TRACe<t>:MODE:HCONtinuous <State>

This command turns an automatic reset of a trace on and off after a parameter has
changed.

The reset works for trace modes min hold, max hold and average.

Note that the command has no effect if critical parameters like the span have been
changed to avoid invalid measurement results

Parameters:
<State> ON

The automatic reset is off.
OFF
The automatic reset is on.
*RST: OFF

Example: DISP:WIND:TRAC3:MODE:HCON ON
Switches off the reset function.

Manual operation: See "Hold" on page 176

DISPlay[:WINDow<n>]:TRACe<t>[:STATe] <State>

This command turns a trace on and off.

The measurement continues in the background.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1 for TRACe1, 0 for TRACe 2 to 6

Example: DISP:TRAC3 ON
Usage: SCPI confirmed

Manual operation: See "Trace 1/Trace 2/Trace 3/Trace 4/Trace 5/Trace 6"
on page 175
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[SENSe:]AVERage<n>:TYPE <Mode>

This command selects the trace averaging mode.

Parameters:
<Mode> VIDeo

The logarithmic power values are averaged.
LINear
The power values are averaged before they are converted to
logarithmic values.
POWer
The power level values are converted into unit Watt prior to
averaging. After the averaging, the data is converted back into
its original unit.
*RST: VIDeo

Example: AVER:TYPE LIN
Switches to linear average calculation.

Usage: SCPI confirmed

Manual operation: See "Average Mode" on page 177

[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion] <Detector>

Defines the trace detector to be used for trace analysis.

For details see "Mapping Samples to measurement Points with the Trace Detector"
on page 164.

Parameters:
<Detector> APEak

Autopeak
NEGative
Negative peak
POSitive
Positive peak
SAMPle
First value detected per trace point
*RST: APEak

Example: DET POS
Sets the detector to "positive peak".

Manual operation: See "Detector" on page 176

[SENSe:][WINDow<n>:]DETector<t>[:FUNCtion]:AUTO <State>

This command couples and decouples the detector to the trace mode.
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Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: DET:AUTO OFF
The selection of the detector is not coupled to the trace mode.

Manual operation: See "Detector" on page 176

TRACe<n>:COPY <TraceNumber>, <TraceNumber>

This command copies data from one trace to another.

Parameters:
<TraceNumber>,
<TraceNumber>

TRACE1 | TRACE2 | TRACE3 | TRACE4 | TRACE5 | TRACE6
The first parameter is the destination trace, the second parame-
ter is the source.
(Note the 'e' in the parameter is required!)

Example: TRAC:COPY TRACE1,TRACE2
Copies the data from trace 2 to trace 1.

Usage: SCPI confirmed

Manual operation: See "Copy Trace" on page 178

[SENSe:]AVERage<n>:COUNt <AverageCount>
TRACe:IQ:AVERage:COUNt <NumberSets>

This command defines the number of I/Q data sets that the averaging is based on.

Parameters:
<NumberSets> Range: 0  to  32767

*RST: 0

Example: TRAC:IQ ON
Switches on acquisition of I/Q data.
TRAC:IQ:AVER ON
Enables averaging of the I/Q measurement data
TRAC:IQ:AVER:COUN 10
Selects averaging over 10 data sets
TRAC:IQ:DATA?
Starts the measurement and reads out the averaged data.

Manual operation: See "Average Count" on page 177

[SENSe:]AVERage<n>[:STATe<t>] <State>
TRACe:IQ:AVERage[:STATe] <State>

This command turns averaging of the I/Q data on and off.

If averaging is on, the maximum amount of I/Q data that can be recorded is 512kS
(524288 samples).
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Parameters:
<State> ON | OFF

*RST: OFF

Example: TRAC:IQ ON
Switches on acquisition of I/Q data.
TRAC:IQ:AVER ON
Enables averaging of the I/Q measurement data.
TRAC:IQ:AVER:COUN 10
Selects averaging over 10 data sets.
TRAC:IQ:DATA?
Starts the measurement and reads out the averaged data.

13.6.2.2 Configuring Spectrograms

In addition to the standard "level versus frequency" or "level versus time" spectrum
traces, the R&S VSE also provides a spectrogram display of the measured data. A
spectrogram shows how the spectral density of a signal varies over time. The x-axis
shows the frequency, the y-axis shows the time. The commands required to configure
spectrograms in a remote environment are described here. For details and manual
operation see "Spectrogram Settings" on page 178.

When configuring spectrograms, the window suffix is irrelevant. The settings are
always applied to the spectrogram window, or to all spectrogram windows, if several
are active for the same measurement channel.

For commands to set markers in spectrograms, see "Marker Search (Spectrograms)"
on page 359.

Configuring a Spectrogram Measurement.................................................................. 349

Configuring the Color Map.......................................................................................... 352

Configuring a Spectrogram Measurement

CALCulate<n>:SGRam:CLEar[:IMMediate].......................................................................350
CALCulate<n>:SPECtrogram:CLEar[:IMMediate].............................................................. 350
CALCulate<n>:SGRam:CONT.........................................................................................350
CALCulate<n>:SPECtrogram:CONT................................................................................ 350
CALCulate<n>:SGRam:FRAMe:COUNt........................................................................... 350
CALCulate<n>:SPECtrogram:FRAMe:COUNt...................................................................350
CALCulate<n>:SGRam:FRAMe:SELect........................................................................... 351
CALCulate<n>:SPECtrogram:FRAMe:SELect...................................................................351
CALCulate<n>:SGRam:HDEPth......................................................................................351
CALCulate<n>:SPECtrogram:HDEPth..............................................................................351
CALCulate<n>:SGRam[:STATe]......................................................................................351
CALCulate<n>:SPECtrogram[:STATe]............................................................................. 351
CALCulate<n>:SGRam:TRACe....................................................................................... 352
CALCulate<n>:SPECtrogram:TRACe...............................................................................352
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CALCulate<n>:SGRam:CLEar[:IMMediate]
CALCulate<n>:SPECtrogram:CLEar[:IMMediate]
This command resets the spectrogram and clears the history buffer.

(<n> is irrelevant.)

Example: CALC:SGR:CLE
Resets the result display and clears the memory.

Usage: Event

Manual operation: See "Clear Spectrogram" on page 161

CALCulate<n>:SGRam:CONT <State>
CALCulate<n>:SPECtrogram:CONT <State>

This command determines whether the results of the last measurement are deleted
before starting a new measurement in single sweep mode.

(<n> is irrelevant.)

Parameters:
<State> ON | OFF

*RST: OFF

Example: INIT:CONT OFF
Selects single sweep mode.
INIT;*WAI
Starts the sweep and waits for the end of the sweep.
CALC:SGR:CONT ON
Repeats the single sweep measurement without deleting the
results of the last measurement.

Manual operation: See "Continue Frame" on page 161

CALCulate<n>:SGRam:FRAMe:COUNt <Frames>
CALCulate<n>:SPECtrogram:FRAMe:COUNt <Frames>

This command defines the number of frames to be recorded in a single capture.

(<n> is irrelevant.)

Parameters:
<Frames> The maximum number of frames depends on the history depth.

Range: 1  to  history depth
Increment: 1
*RST: 1

Example: INIT:CONT OFF
Selects single capture mode.
CALC:SGR:FRAM:COUN 200
Sets the number of frames to 200.

Manual operation: See "Frame Count" on page 161
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CALCulate<n>:SGRam:FRAMe:SELect <Frame> | <Time>
CALCulate<n>:SPECtrogram:FRAMe:SELect <Frame> | <Time>

This command selects a specific frame for further analysis.

(<n> is irrelevant.)

The command is available if no measurement is running or after a single sweep has
ended.

Parameters:
<Frame> Selects a frame directly by the frame number. Valid if the time

stamp is off.
The range depends on the history depth.

<Time> Selects a frame via its time stamp. Valid if the time stamp is on.
The number is the distance to frame 0 in seconds. The range
depends on the history depth.

Example: INIT:CONT OFF
Stop the continuous sweep.
CALC:SGR:FRAM:SEL -25
Selects frame number -25.

Manual operation: See "Selecting a frame to display" on page 160

CALCulate<n>:SGRam:HDEPth <History>
CALCulate<n>:SPECtrogram:HDEPth <History>

This command defines the number of frames to be stored in the R&S VSE memory.

(<n> is irrelevant.)

Parameters:
<History> The maximum number of frames depends on the number of

sweep points.
Range: 781  to  20000
Increment: 1
*RST: 3000

Example: CALC:SGR:SPEC 1500
Sets the history depth to 1500.

Manual operation: See "History Depth" on page 180

CALCulate<n>:SGRam[:STATe] <State>
CALCulate<n>:SPECtrogram[:STATe] <State>

This command turns the spectrogram on and off.

(<n> is irrelevant.)

Parameters:
<State> ON | OFF

*RST: OFF
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Example: CALC:SGR ON
Activates the Spectrogram result display.

Manual operation: See "State" on page 179

CALCulate<n>:SGRam:TRACe <Trace>
CALCulate<n>:SPECtrogram:TRACe <Trace>

This command determines the trace in the result display the Spectrogram is based on.

Query parameters: 
<Trace> TRACE1 | TRACE2 | TRACE3 | TRACE4 | TRACE5 | TRACE6

How many traces are available depends on the selected result
display.

Example: CALC2:SPEC:TRAC TRACE3

Configuring the Color Map

DISPlay[:WINDow<n>]:SGRam:COLor:DEFault................................................................ 352
DISPlay[:WINDow<n>]:SPECtrogram:COLor:DEFault........................................................352
DISPlay[:WINDow<n>]:SGRam:COLor:LOWer................................................................. 352
DISPlay[:WINDow<n>]:SPECtrogram:COLor:LOWer......................................................... 352
DISPlay[:WINDow<n>]:SGRam:COLor:SHAPe................................................................. 353
DISPlay[:WINDow<n>]:SPECtrogram:COLor:SHAPe.........................................................353
DISPlay[:WINDow<n>]:SGRam:COLor:UPPer.................................................................. 353
DISPlay[:WINDow<n>]:SPECtrogram:COLor:UPPer..........................................................353
DISPlay[:WINDow<n>]:SGRam:COLor[:STYLe]................................................................ 353
DISPlay[:WINDow<n>]:SPECtrogram:COLor[:STYLe]........................................................353

DISPlay[:WINDow<n>]:SGRam:COLor:DEFault
DISPlay[:WINDow<n>]:SPECtrogram:COLor:DEFault
This command restores the original color map.

Usage: Event

Manual operation: See "Set to Default" on page 182

DISPlay[:WINDow<n>]:SGRam:COLor:LOWer <Percentage>
DISPlay[:WINDow<n>]:SPECtrogram:COLor:LOWer <Percentage>

This command defines the starting point of the color map.

Parameters:
<Percentage> Statistical frequency percentage.

Range: 0  to  66
*RST: 0
Default unit: %

Example: DISP:WIND:SGR:COL:LOW 10
Sets the start of the color map to 10%.

Remote Commands for the I/Q Analyzer



Remote CommandsR&S®VSE

353User Manual 1176.8839.02 ─ 03

Manual operation: See "Start / Stop" on page 181

DISPlay[:WINDow<n>]:SGRam:COLor:SHAPe <Shape>
DISPlay[:WINDow<n>]:SPECtrogram:COLor:SHAPe <Shape>

This command defines the shape and focus of the color curve for the spectrogram
result display.

Parameters:
<Shape> Shape of the color curve.

Range: -1  to  1
*RST: 0

Manual operation: See "Shape" on page 181

DISPlay[:WINDow<n>]:SGRam:COLor:UPPer <Percentage>
DISPlay[:WINDow<n>]:SPECtrogram:COLor:UPPer <Percentage>

This command defines the end point of the color map.

Parameters:
<Percentage> Statistical frequency percentage.

Range: 0  to  66
*RST: 0
Default unit: %

Example: DISP:WIND:SGR:COL:UPP 95
Sets the start of the color map to 95%.

Manual operation: See "Start / Stop" on page 181

DISPlay[:WINDow<n>]:SGRam:COLor[:STYLe] <ColorScheme>
DISPlay[:WINDow<n>]:SPECtrogram:COLor[:STYLe] <ColorScheme>

This command selects the color scheme.

Parameters:
<ColorScheme> HOT

Uses a color range from blue to red. Blue colors indicate low lev-
els, red colors indicate high ones.
COLD
Uses a color range from red to blue. Red colors indicate low lev-
els, blue colors indicate high ones.
RADar
Uses a color range from black over green to light turquoise with
shades of green in between.
GRAYscale
Shows the results in shades of gray.
*RST: HOT
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Example: DISP:WIND:SPEC:COL GRAY
Changes the color scheme of the spectrogram to black and
white.

Manual operation: See "Hot/Cold/Radar/Grayscale" on page 182

13.6.2.3 Using Markers

The following commands are available for marker settings and functions in the I/Q Ana-
lyzer application.

For "I/Q Vector" displays markers are not available.

● Setting Up Individual Markers............................................................................... 354
● General Marker Settings....................................................................................... 358
● Marker Search (Spectrograms).............................................................................359
● Configuring and Performing a Marker Search.......................................................367
● Positioning the Marker.......................................................................................... 370
● Band Power Marker.............................................................................................. 375

Setting Up Individual Markers

The following commands define the position of markers in the diagram.

CALCulate<n>:DELTamarker<m>:AOFF..........................................................................354
CALCulate<n>:DELTamarker<m>:LINK........................................................................... 355
CALCulate<n>:DELTamarker<m>:LINK:TO:MARKer<m>.................................................. 355
CALCulate<n>:DELTamarker<m>:MODE.........................................................................355
CALCulate<n>:DELTamarker<m>:MREF......................................................................... 356
CALCulate<n>:DELTamarker<m>[:STATe].......................................................................356
CALCulate<n>:DELTamarker<m>:TRACe........................................................................356
CALCulate<n>:DELTamarker<m>:X................................................................................ 356
CALCulate<n>:MARKer<m>:AOFF..................................................................................357
CALCulate<n>:MARKer<m>:LINK:TO:MARKer<m>.......................................................... 357
CALCulate<n>:MARKer<m>[:STATe]...............................................................................357
CALCulate<n>:MARKer<m>:TRACe................................................................................358
CALCulate<n>:MARKer<m>:X........................................................................................ 358

CALCulate<n>:DELTamarker<m>:AOFF

This command turns all delta markers off.

(<m> is irrelevant)

Example: CALC:DELT:AOFF
Turns all delta markers off.

Usage: Event
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CALCulate<n>:DELTamarker<m>:LINK <State>

This command links delta marker <m> to marker 1.

If you change the horizontal position (x-value) of marker 1, delta marker <m> changes
its horizontal position to the same value.

Tip: to link any marker to a different marker than marker 1, use the CALCulate<n>:
DELTamarker<m>:LINK:TO:MARKer<m> or CALCulate<n>:MARKer<m>:LINK:
TO:MARKer<m> commands.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:DELT2:LINK ON
Manual operation: See "Linking to Another Marker" on page 196

CALCulate<n>:DELTamarker<m>:LINK:TO:MARKer<m> <State>

This command links delta marker <m1> to any active normal marker <m2>.

If you change the horizontal position of marker <m2>, delta marker <m1> changes its
horizontal position to the same value.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:DELT4:LINK:TO:MARK2 ON
Links the delta marker 4 to the marker 2.

Manual operation: See "Linking to Another Marker" on page 196

CALCulate<n>:DELTamarker<m>:MODE <Mode>

This command defines whether the position of a delta marker is provided as an abso-
lute value or relative to a reference marker (for all delta markers, <m> is irrelevant).

Note that when the position of a delta marker is queried, the result is always an abso-
lute value (see CALCulate<n>:DELTamarker<m>:X on page 356)!

Parameters:
<Mode> ABSolute

Delta marker position in absolute terms.
RELative
Delta marker position in relation to a reference marker.
*RST: RELative

Example: CALC:DELT:MODE ABS
Absolute delta marker position.
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CALCulate<n>:DELTamarker<m>:MREF <Reference>

This command selects a reference marker for a delta marker other than marker 1.

Parameters:
<Reference> 1 to 16

Selects markers 1 to 16 as the reference.

Example: CALC:DELT3:MREF 2
Specifies that the values of delta marker 3 are relative to marker
2.

Manual operation: See "Reference Marker" on page 196

CALCulate<n>:DELTamarker<m>[:STATe] <State>

This command turns delta markers on and off.

If necessary, the command activates the delta marker first.

No suffix at DELTamarker turns on delta marker 1.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:DELT2 ON
Turns on delta marker 2.

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:DELTamarker<m>:TRACe <Trace>

This command selects the trace a delta marker is positioned on.

Note that the corresponding trace must have a trace mode other than "Blank".

If necessary, the command activates the marker first.

Parameters:
<Trace> Trace number the marker is assigned to.

Example: CALC:DELT2:TRAC 2
Positions delta marker 2 on trace 2.

CALCulate<n>:DELTamarker<m>:X <Position>

This command moves a delta marker to a particular coordinate on the x-axis.

If necessary, the command activates the delta marker and positions a reference
marker to the peak power.
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Parameters:
<Position> Numeric value that defines the marker position on the x-axis.

The position is relative to the reference marker.
To select an absolute position you have to change the delta
marker mode with CALCulate<n>:DELTamarker<m>:MODE
on page 355.
A query returns the absolute position of the delta marker.
Range: The value range and unit depend on the measure-

ment and scale of the x-axis.

<Position> Numeric value that defines the marker position on the x-axis.
Range: The value range and unit depend on the measure-

ment and scale of the x-axis.

Example: CALC:DELT:X?
Outputs the absolute x-value of delta marker 1.

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:MARKer<m>:AOFF

This command turns all markers off.

Example: CALC:MARK:AOFF
Switches off all markers.

Usage: Event

Manual operation: See "All Markers Off" on page 197

CALCulate<n>:MARKer<m>:LINK:TO:MARKer<m> <State>

This command links normal marker <m1> to any active normal marker <m2>.

If you change the horizontal position of marker <m2>, marker <m1> changes its hori-
zontal position to the same value.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK4:LINK:TO:MARK2 ON
Links marker 4 to marker 2.

Manual operation: See "Linking to Another Marker" on page 196

CALCulate<n>:MARKer<m>[:STATe] <State>

This command turns markers on and off. If the corresponding marker number is cur-
rently active as a deltamarker, it is turned into a normal marker.
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Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK3 ON
Switches on marker 3.

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:MARKer<m>:TRACe <Trace>

This command selects the trace the marker is positioned on.

Note that the corresponding trace must have a trace mode other than "Blank".

If necessary, the command activates the marker first.

Parameters:
<Trace> 1 to 6

Trace number the marker is assigned to.

Example: CALC:MARK3:TRAC 2
Assigns marker 3 to trace 2.

Manual operation: See "Assigning the Marker to a Trace" on page 196

CALCulate<n>:MARKer<m>:X <Position>

This command moves a marker to a particular coordinate on the x-axis.

If necessary, the command activates the marker.

If the marker has been used as a delta marker, the command turns it into a normal
marker.

Parameters:
<Position> Numeric value that defines the marker position on the x-axis.

The unit is either Hz (frequency domain) or s (time domain) or
dB (statistics).
The unit depends on the result display.
Range: The range depends on the current x-axis range.

Example: CALC:MARK2:X 1.7MHz
Positions marker 2 to frequency 1.7 MHz.

Manual operation: See "Marker Table" on page 117

General Marker Settings

The following commands control general marker functionality.

Remote commands exclusive to general marker functionality

DISPlay:MTABle............................................................................................................ 359
CALCulate<n>:MARKer<m>:X:SSIZe.............................................................................. 359
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DISPlay:MTABle <DisplayMode>

This command turns the marker table on and off.

Parameters:
<DisplayMode> ON

Turns the marker table on.
OFF
Turns the marker table off.
AUTO
Turns the marker table on if 3 or more markers are active.
*RST: AUTO

Example: DISP:MTAB ON
Activates the marker table.

Manual operation: See "Marker Table Display" on page 198

CALCulate<n>:MARKer<m>:X:SSIZe <StepSize>

This command selects the marker step size mode for all markers in all windows (<m>,
<n> are irrelevant).

The step size defines the distance the marker moves when you move it with the mouse
wheel.

It therefore takes effect in manual operation only.

Parameters:
<StepSize> STANdard

the marker moves from one pixel to the next
POINts
the marker moves from one sweep point to the next
*RST: POINts

Example: CALC:MARK:X:SSIZ STAN
Sets the marker step size to one pixel.

Manual operation: See "Marker Stepsize" on page 198

Marker Search (Spectrograms)

The following commands automatically define the marker and delta marker position in
the spectrogram.

Using Markers

The following commands control spectrogram markers.

Useful commands for spectrogram markers described elsewhere

The following commands define the horizontal position of the markers.

● CALCulate<n>:MARKer<m>:MAXimum:LEFT on page 371
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● CALCulate<n>:MARKer<m>:MAXimum:NEXT on page 371
● CALCulate<n>:MARKer<m>:MAXimum[:PEAK] on page 371
● CALCulate<n>:MARKer<m>:MAXimum:RIGHt on page 372
● CALCulate<n>:MARKer<m>:MINimum:LEFT on page 372
● CALCulate<n>:MARKer<m>:MINimum:NEXT on page 372
● CALCulate<n>:MARKer<m>:MINimum[:PEAK] on page 373
● CALCulate<n>:MARKer<m>:MINimum:RIGHt on page 373

Remote commands exclusive to spectrogram markers

CALCulate<n>:MARKer<m>:SGRam:FRAMe................................................................... 360
CALCulate<n>:MARKer<m>:SPECtrogram:FRAMe...........................................................360
CALCulate<n>:MARKer<m>:SGRam:SARea....................................................................361
CALCulate<n>:MARKer<m>:SPECtrogram:SARea........................................................... 361
CALCulate<n>:MARKer<m>:SGRam:XY:MAXimum[:PEAK]...............................................361
CALCulate<n>:MARKer<m>:SPECtrogram:XY:MAXimum[:PEAK]...................................... 361
CALCulate<n>:MARKer<m>:SGRam:XY:MINimum[:PEAK]................................................361
CALCulate<n>:MARKer<m>:SPECtrogram:XY:MINimum[:PEAK]....................................... 361
CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:ABOVe................................................ 361
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:ABOVe........................................361
CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:BELow.................................................362
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:BELow........................................ 362
CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:NEXT...................................................362
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:NEXT.......................................... 362
CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum[:PEAK].................................................362
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum[:PEAK]........................................ 362
CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:ABOVe................................................. 362
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:ABOVe......................................... 362
CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:BELow..................................................362
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:BELow..........................................362
CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:NEXT....................................................363
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:NEXT........................................... 363
CALCulate<n>:MARKer<m>:SGRam:Y:MINimum[:PEAK]..................................................363
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum[:PEAK]......................................... 363

CALCulate<n>:MARKer<m>:SGRam:FRAMe <Frame> | <Time>
CALCulate<n>:MARKer<m>:SPECtrogram:FRAMe <Frame> | <Time>

This command positions a marker on a particular frame.

Parameters:
<Frame> Selects a frame directly by the frame number. Valid if the time

stamp is off.
The range depends on the history depth.

<Time> Selects a frame via its time stamp. Valid if the time stamp is on.
The number is the (negative) distance to frame 0 in seconds.
The range depends on the history depth.
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Example: CALC:MARK:SGR:FRAM -20
Sets the marker on the 20th frame before the present.
CALC:MARK2:SGR:FRAM -2s
Sets second marker on the frame 2 seconds ago.

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:MARKer<m>:SGRam:SARea <SearchArea>
CALCulate<n>:MARKer<m>:SPECtrogram:SARea <SearchArea>

This command defines the marker search area for all spectrogram markers in the mea-
surement channel (<n>, <m> are irrelevant).

Parameters:
<SearchArea> VISible

Performs a search within the visible frames.
Note that the command does not work if the spectrogram is not
visible for any reason (e.g. if the display update is off).
MEMory
Performs a search within all frames in the memory.
*RST: VISible

Manual operation: See "Marker Search Area" on page 202

CALCulate<n>:MARKer<m>:SGRam:XY:MAXimum[:PEAK]
CALCulate<n>:MARKer<m>:SPECtrogram:XY:MAXimum[:PEAK]
This command moves a marker to the highest level of the spectrogram.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:XY:MINimum[:PEAK]
CALCulate<n>:MARKer<m>:SPECtrogram:XY:MINimum[:PEAK]
This command moves a marker to the minimum level of the spectrogram.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:ABOVe
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:ABOVe
This command moves a marker vertically to the next lower peak level for the current
frequency.

The search includes only frames above the current marker position. It does not change
the horizontal position of the marker.

Usage: Event
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CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:BELow
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:BELow
This command moves a marker vertically to the next lower peak level for the current
frequency.

The search includes only frames below the current marker position. It does not change
the horizontal position of the marker.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum:NEXT
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum:NEXT
This command moves a marker vertically to the next lower peak level for the current
frequency.

The search includes all frames. It does not change the horizontal position of the
marker.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MAXimum[:PEAK]
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MAXimum[:PEAK]
This command moves a marker vertically to the highest level for the current frequency.

The search includes all frames. It does not change the horizontal position of the
marker.

If the marker hasn't been active yet, the command looks for the peak level in the whole
spectrogram.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:ABOVe
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:ABOVe
This command moves a marker vertically to the next higher minimum level for the cur-
rent frequency.

The search includes only frames above the current marker position. It does not change
the horizontal position of the marker.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:BELow
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:BELow
This command moves a marker vertically to the next higher minimum level for the cur-
rent frequency.

The search includes only frames below the current marker position. It does not change
the horizontal position of the marker.
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Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MINimum:NEXT
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum:NEXT
This command moves a marker vertically to the next higher minimum level for the cur-
rent frequency.

The search includes all frames. It does not change the horizontal position of the
marker.

Usage: Event

CALCulate<n>:MARKer<m>:SGRam:Y:MINimum[:PEAK]
CALCulate<n>:MARKer<m>:SPECtrogram:Y:MINimum[:PEAK]
This command moves a marker vertically to the minimum level for the current fre-
quency.

The search includes all frames. It does not change the horizontal position of the
marker.

If the marker hasn't been active yet, the command first looks for the peak level for all
frequencies and moves the marker vertically to the minimum level.

Usage: Event

Using Delta Markers

The following commands control spectrogram delta markers.

Useful commands for spectrogram markers described elsewhere

The following commands define the horizontal position of the delta markers.

● CALCulate<n>:DELTamarker<m>:MAXimum:LEFT on page 373
● CALCulate<n>:DELTamarker<m>:MAXimum:NEXT on page 374
● CALCulate<n>:DELTamarker<m>:MAXimum[:PEAK] on page 374
● CALCulate<n>:DELTamarker<m>:MAXimum:RIGHt on page 374
● CALCulate<n>:DELTamarker<m>:MINimum:LEFT on page 374
● CALCulate<n>:DELTamarker<m>:MINimum:NEXT on page 374
● CALCulate<n>:DELTamarker<m>:MINimum[:PEAK] on page 375
● CALCulate<n>:DELTamarker<m>:MINimum:RIGHt on page 375

Remote commands exclusive to spectrogram markers

CALCulate<n>:DELTamarker<m>:SGRam:FRAMe........................................................... 364
CALCulate<n>:DELTamarker<m>:SPECtrogram:FRAMe...................................................364
CALCulate<n>:DELTamarker<m>:SGRam:SARea............................................................364
CALCulate<n>:DELTamarker<m>:SPECtrogram:SARea................................................... 364
CALCulate<n>:DELTamarker<m>:SGRam:XY:MAXimum[:PEAK].......................................365
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CALCulate<n>:DELTamarker<m>:SPECtrogram:XY:MAXimum[:PEAK].............................. 365
CALCulate<n>:DELTamarker<m>:SGRam:XY:MINimum[:PEAK]........................................365
CALCulate<n>:DELTamarker<m>:SPECtrogram:XY:MINimum[:PEAK]............................... 365
CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:ABOVe........................................ 365
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:ABOVe................................ 365
CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:BELow......................................... 365
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:BELow.................................365
CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:NEXT...........................................366
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:NEXT.................................. 366
CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum[:PEAK].........................................366
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum[:PEAK]................................ 366
CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:ABOVe..........................................366
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:ABOVe................................. 366
CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:BELow.......................................... 366
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:BELow..................................366
CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:NEXT............................................366
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:NEXT................................... 366
CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum[:PEAK]..........................................367
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum[:PEAK]................................. 367

CALCulate<n>:DELTamarker<m>:SGRam:FRAMe <Frame> | <Time>
CALCulate<n>:DELTamarker<m>:SPECtrogram:FRAMe <Frame> | <Time>

This command positions a delta marker on a particular frame. The frame is relative to
the position of marker 1.

The command is available for the spectrogram.

Parameters:
<Frame> Selects a frame directly by the frame number. Valid if the time

stamp is off.
The range depends on the history depth.

<Time> Selects a frame via its time stamp. Valid if the time stamp is on.
The number is the distance to frame 0 in seconds. The range
depends on the history depth.

Example: CALC:DELT4:SGR:FRAM -20
Sets fourth deltamarker 20 frames below marker 1.
CALC:DELT4:SGR:FRAM 2 s
Sets fourth deltamarker 2 seconds above the position of marker
1.

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:DELTamarker<m>:SGRam:SARea <SearchArea>
CALCulate<n>:DELTamarker<m>:SPECtrogram:SARea <SearchArea>

This command defines the marker search area for all spectrogram markers in the mea-
surement channel (<n> and <m> are irrelevant).
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Parameters:
<SearchArea> VISible

Performs a search within the visible frames.
Note that the command does not work if the spectrogram is not
visible for any reason (e.g. if the display update is off).
MEMory
Performs a search within all frames in the memory.
*RST: VISible

Manual operation: See "Marker Search Area" on page 202

CALCulate<n>:DELTamarker<m>:SGRam:XY:MAXimum[:PEAK]
CALCulate<n>:DELTamarker<m>:SPECtrogram:XY:MAXimum[:PEAK]
This command moves a marker to the highest level of the spectrogram over all fre-
quencies.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:XY:MINimum[:PEAK]
CALCulate<n>:DELTamarker<m>:SPECtrogram:XY:MINimum[:PEAK]
This command moves a delta marker to the minimum level of the spectrogram over all
frequencies.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:ABOVe
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:ABOVe
This command moves a marker vertically to the next higher level for the current fre-
quency.

The search includes only frames above the current marker position. It does not change
the horizontal position of the marker.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:BELow
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:BELow
This command moves a marker vertically to the next higher level for the current fre-
quency.

The search includes only frames below the current marker position. It does not change
the horizontal position of the marker.

Usage: Event
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CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum:NEXT
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum:NEXT
This command moves a delta marker vertically to the next higher level for the current
frequency.

The search includes all frames. It does not change the horizontal position of the
marker.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MAXimum[:PEAK]
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MAXimum[:PEAK]
This command moves a delta marker vertically to the highest level for the current fre-
quency.

The search includes all frames. It does not change the horizontal position of the
marker.

If the marker hasn't been active yet, the command looks for the peak level in the whole
spectrogram.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:ABOVe
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:ABOVe
This command moves a delta marker vertically to the next minimum level for the cur-
rent frequency.

The search includes only frames above the current marker position. It does not change
the horizontal position of the marker.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:BELow
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:BELow
This command moves a delta marker vertically to the next minimum level for the cur-
rent frequency.

The search includes only frames below the current marker position. It does not change
the horizontal position of the marker.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum:NEXT
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum:NEXT
This command moves a delta marker vertically to the next minimum level for the cur-
rent frequency.
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The search includes all frames. It does not change the horizontal position of the
marker.

Usage: Event

CALCulate<n>:DELTamarker<m>:SGRam:Y:MINimum[:PEAK]
CALCulate<n>:DELTamarker<m>:SPECtrogram:Y:MINimum[:PEAK]
This command moves a delta marker vertically to the minimum level for the current fre-
quency.

The search includes all frames. It does not change the horizontal position of the
marker.

If the marker hasn't been active yet, the command first looks for the peak level in the
whole spectrogram and moves the marker vertically to the minimum level.

Usage: Event

Configuring and Performing a Marker Search

The following commands control the marker search.

CALCulate<n>:MARKer<m>:LOEXclude.......................................................................... 367
CALCulate<n>:MARKer<m>:PEXCursion.........................................................................367
CALCulate<n>:MARKer<m>:SEARch.............................................................................. 368
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe]................................................................368
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT....................................................................369
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHT..................................................................369
CALCulate<n>:MARKer<m>:X:SLIMits:ZOOM[:STATe]..................................................... 369
CALCulate<n>:THReshold..............................................................................................370
CALCulate<n>:THReshold:STATe...................................................................................370

CALCulate<n>:MARKer<m>:LOEXclude <State>

This command turns the suppression of the local oscillator during automatic marker
positioning on and off (for all markers in all windows; <m>, <n> are irrelevant).

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: CALC:MARK:LOEX ON
Manual operation: See "Exclude LO" on page 200

CALCulate<n>:MARKer<m>:PEXCursion <Excursion>

This command defines the peak excursion (for all markers in all windows; <m>, <n>
are irrelevant).

The peak excursion sets the requirements for a peak to be detected during a peak
search.
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The unit depends on the measurement.

Application/Result display Unit

Spectrum dB

Example: CALC:MARK:PEXC 10dB
Defines peak excursion as 10 dB.

Manual operation: See "Peak Excursion" on page 200

CALCulate<n>:MARKer<m>:SEARch <MarkRealImag>

This command selects the trace type a marker search is performed on.

(For all markers, <m> is irrelevant.)

Parameters:
<MarkRealImag> REAL

Marker search functions are performed on the real trace of the
"I/Q" measurement.
IMAG
Marker search functions are performed on the imaginary trace of
the "I/Q" measurement.
MAGN
Marker search functions are performed on the magnitude of the I
and Q data.
*RST: REAL

Example: CALC4:MARK:SEAR IMAG
Manual operation: See "Branch for Peak Search" on page 201

CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] <State>

This command turns marker search limits on and off for all markers in all windows
(<m>, <n> are irrelevant).

If you perform a measurement in the time domain, this command limits the range of the
trace to be analyzed.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK:X:SLIM ON
Switches on search limitation.

Manual operation: See "Search Limits (Left / Right)" on page 200
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CALCulate<n>:MARKer<m>:X:SLIMits:LEFT <SearchLimit>

This command defines the left limit of the marker search range for all markers in all
windows (<m>, <n> are irrelevant).

If you perform a measurement in the time domain, this command limits the range of the
trace to be analyzed.

Parameters:
<SearchLimit> The value range depends on the frequency range or measure-

ment time.
The unit is Hz for frequency domain measurements and s for
time domain measurements.
*RST: left diagram border

Example: CALC:MARK:X:SLIM ON
Switches the search limit function on.
CALC:MARK:X:SLIM:LEFT 10MHz
Sets the left limit of the search range to 10 MHz.

Manual operation: See "Search Limits (Left / Right)" on page 200

CALCulate<n>:MARKer<m>:X:SLIMits:RIGHT <SearchLimit>

This command defines the right limit of the marker search range for all markers in all
windows (<m>, <n> are irrelevant).

If you perform a measurement in the time domain, this command limits the range of the
trace to be analyzed.

Parameters:
<Limit> The value range depends on the frequency range or measure-

ment time.
The unit is Hz for frequency domain measurements and s for
time domain measurements.
*RST: right diagram border

Example: CALC:MARK:X:SLIM ON
Switches the search limit function on.
CALC:MARK:X:SLIM:RIGH 20MHz
Sets the right limit of the search range to 20 MHz.

Manual operation: See "Search Limits (Left / Right)" on page 200

CALCulate<n>:MARKer<m>:X:SLIMits:ZOOM[:STATe] <State>

This command adjusts the marker search range to the zoom area for all markers in all
windows (<m>, <n> are irrelevant).

Parameters:
<State> ON | OFF

*RST: OFF
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Example: CALC:MARK:X:SLIM:ZOOM ON
Switches the search limit function on.
CALC:MARK:X:SLIM:RIGH 20MHz
Sets the right limit of the search range to 20 MHz.

Manual operation: See "Using Zoom Limits" on page 201

CALCulate<n>:THReshold <Level>

This command defines a threshold level for the marker peak search (for all markers in
all windows; <n> is irrelevant).

Parameters:
<Level> Numeric value. The value range and unit are variable.

*RST: -120 dBm

Example: CALC:THR -82DBM
Sets the threshold value to -82 dBm.

Manual operation: See "Search Threshold" on page 201

CALCulate<n>:THReshold:STATe <State>

This command turns a threshold for the marker peak search on and off (for all markers
in all windows; <n> is irrelevant).

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:THR:STAT ON
Switches on the threshold line.

Manual operation: See "Deactivating All Search Limits" on page 201

Positioning the Marker

This chapter contains remote commands necessary to position the marker on a trace.

● Positioning Normal Markers .................................................................................370
● Positioning Delta Markers..................................................................................... 373

Positioning Normal Markers

The following commands position markers on the trace.

CALCulate<n>:MARKer<m>:MAXimum:AUTO..................................................................371
CALCulate<n>:MARKer<m>:MAXimum:LEFT...................................................................371
CALCulate<n>:MARKer<m>:MAXimum:NEXT.................................................................. 371
CALCulate<n>:MARKer<m>:MAXimum[:PEAK]................................................................ 371
CALCulate<n>:MARKer<m>:MAXimum:RIGHt..................................................................372
CALCulate<n>:MARKer<m>:MINimum:AUTO...................................................................372
CALCulate<n>:MARKer<m>:MINimum:LEFT....................................................................372
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CALCulate<n>:MARKer<m>:MINimum:NEXT................................................................... 372
CALCulate<n>:MARKer<m>:MINimum[:PEAK]................................................................. 373
CALCulate<n>:MARKer<m>:MINimum:RIGHt...................................................................373

CALCulate<n>:MARKer<m>:MAXimum:AUTO <State>

This command turns an automatic marker peak search for a trace maximum on and
off. The R&S VSE performs the peak search after each sweep.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK:MAX:AUTO ON
Activates the automatic peak search function for marker 1 at the
end of each particular sweep.

Manual operation: See "Auto Max / Min Peak Search" on page 200

CALCulate<n>:MARKer<m>:MAXimum:LEFT

This command moves a marker to the next lower peak.

The search includes only measurement values to the left of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204

CALCulate<n>:MARKer<m>:MAXimum:NEXT

This command moves a marker to the next lower peak.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204

CALCulate<n>:MARKer<m>:MAXimum[:PEAK]

This command moves a marker to the highest level.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

If the marker is not yet active, the command first activates the marker.

Usage: Event
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Manual operation: See "Peak Search" on page 204

CALCulate<n>:MARKer<m>:MAXimum:RIGHt

This command moves a marker to the next lower peak.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204

CALCulate<n>:MARKer<m>:MINimum:AUTO <State>

This command turns an automatic marker peak search for a trace minimum on and off.
The R&S VSE performs the peak search after each sweep.

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK:MIN:AUTO ON
Activates the automatic minimum value search function for
marker 1 at the end of each particular sweep.

Manual operation: See "Auto Max / Min Peak Search" on page 200

CALCulate<n>:MARKer<m>:MINimum:LEFT

This command moves a marker to the next minimum value.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205

CALCulate<n>:MARKer<m>:MINimum:NEXT

This command moves a marker to the next minimum value.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205
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CALCulate<n>:MARKer<m>:MINimum[:PEAK]

This command moves a marker to the minimum level.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

If the marker is not yet active, the command first activates the marker.

Usage: Event

Manual operation: See "Search Minimum" on page 205

CALCulate<n>:MARKer<m>:MINimum:RIGHt

This command moves a marker to the next minimum value.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205

Positioning Delta Markers

The following commands position delta markers on the trace.

CALCulate<n>:DELTamarker<m>:MAXimum:LEFT...........................................................373
CALCulate<n>:DELTamarker<m>:MAXimum:NEXT.......................................................... 374
CALCulate<n>:DELTamarker<m>:MAXimum[:PEAK]........................................................ 374
CALCulate<n>:DELTamarker<m>:MAXimum:RIGHt..........................................................374
CALCulate<n>:DELTamarker<m>:MINimum:LEFT............................................................374
CALCulate<n>:DELTamarker<m>:MINimum:NEXT........................................................... 374
CALCulate<n>:DELTamarker<m>:MINimum[:PEAK]......................................................... 375
CALCulate<n>:DELTamarker<m>:MINimum:RIGHt...........................................................375

CALCulate<n>:DELTamarker<m>:MAXimum:LEFT

This command moves a delta marker to the next higher value.

The search includes only measurement values to the left of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204
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CALCulate<n>:DELTamarker<m>:MAXimum:NEXT

This command moves a marker to the next higher value.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204

CALCulate<n>:DELTamarker<m>:MAXimum[:PEAK]

This command moves a delta marker to the highest level.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

If the marker is not yet active, the command first activates the marker.

Usage: Event

Manual operation: See "Peak Search" on page 204

CALCulate<n>:DELTamarker<m>:MAXimum:RIGHt

This command moves a delta marker to the next higher value.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the maximum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Peak" on page 204

CALCulate<n>:DELTamarker<m>:MINimum:LEFT

This command moves a delta marker to the next higher minimum value.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205

CALCulate<n>:DELTamarker<m>:MINimum:NEXT

This command moves a marker to the next higher minimum value.
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In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205

CALCulate<n>:DELTamarker<m>:MINimum[:PEAK]

This command moves a delta marker to the minimum level.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

If the marker is not yet active, the command first activates the marker.

Usage: Event

Manual operation: See "Search Minimum" on page 205

CALCulate<n>:DELTamarker<m>:MINimum:RIGHt

This command moves a delta marker to the next higher minimum value.

The search includes only measurement values to the right of the current marker posi-
tion.

In the spectrogram, the command moves a marker horizontally to the minimum level in
the currently selected frame. The vertical marker position remains the same.

Usage: Event

Manual operation: See "Search Next Minimum" on page 205

Band Power Marker

The following commands control the marker for band power measurements.

Using Markers

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:MODE....................................................375
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:RESult?..................................................376
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:SPAN.....................................................376
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer[:STATe]..................................................376

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:MODE <Mode>

This command selects the way the results for a band power marker are displayed.
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Parameters:
<Mode> POWer

Result is displayed as an absolute power. The power unit
depends on the CALCulate<n>:UNIT:POWer setting.
setting.
DENSity
Result is displayed as a density in dBm/Hz.
*RST: POWer

Example: CALC:MARK4:FUNC:BPOW:MODE DENS
Configures marker 4 to show the measurement results in
dBm/Hz.

Manual operation: See "Power Mode" on page 207

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:RESult?

This command queries the results of the band power measurement.

Return values: 
<Power> Signal power over the marker bandwidth.

Example: Activate the band power marker:
CALC:MARK:FUNC:BPOW:STAT ON
Select the density mode for the result:
CALC:MARK:FUNC:BPOW:MODE DENS
Query the result:
CALC:MARK:FUNC:BPOW:RES?
Response:
20dBm/Hz

Usage: Query only

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:SPAN <Span>

This command defines the bandwidth around the marker position.

Parameters:
<Span> Frequency. The maximum span depends on the marker position

and R&S VSE model.
*RST: 5% of current span
Default unit: Hz

Example: CALC:MARK:FUNC:BPOW:SPAN 2MHz
Measures the band power over 2 MHz around the marker.

Manual operation: See "Span" on page 207

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer[:STATe] <State>

This command turns markers for band power measurements on and off.

Remote Commands for the I/Q Analyzer



Remote CommandsR&S®VSE

377User Manual 1176.8839.02 ─ 03

Parameters:
<State> ON | OFF

*RST: OFF

Example: CALC:MARK4:FUNC:BPOW:STAT ON
Activates or turns marker 4 into a band power marker.

Manual operation: See "Band Power Measurement State" on page 206

Using Delta Markers

CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:MODE............................................ 377
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:RESult?..........................................377
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:SPAN.............................................377
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer[:STATe]..........................................378

CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:MODE <Mode>

This command selects the way the results for a band power delta marker are dis-
played.

Parameters:
<Mode> POWer

Result is displayed as an absolute power. The power unit
depends on the CALCulate<n>:UNIT:POWer setting.

DENSity
Result is displayed as a density in dBm/Hz.
*RST: POWer

Manual operation: See "Power Mode" on page 207

CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:RESult?

This command queries the results of the band power measurement.

Return values: 
<Power> Signal power over the delta marker bandwidth.

Usage: Query only

CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:SPAN <Span>

This command defines the bandwidth around the delta marker position.

Parameters:
<Span> Frequency. The maximum span depends on the marker position

and R&S VSE model.
*RST: 5% of current span
Default unit: Hz

Manual operation: See "Span" on page 207
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CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer[:STATe] <State>

This command turns delta markers for band power measurements on and off.

If neccessary, the command also turns on a reference marker.

Parameters:
<State> ON | OFF

*RST: OFF

Manual operation: See "Band Power Measurement State" on page 206

13.6.2.4 Zooming into the Display

Using the Single Zoom

DISPlay[:WINDow<n>]:ZOOM:AREA............................................................................... 378
DISPlay[:WINDow<n>]:ZOOM:STATe..............................................................................378

DISPlay[:WINDow<n>]:ZOOM:AREA <x1>,<y1>,<x2>,<y2>

This command defines the zoom area.

To define a zoom area, you first have to turn the zoom on.

1 = origin of coordinate system (x1 = 0, y1 = 0)
2 = end point of system (x2 = 100, y2= 100)
3 = zoom area (e.g. x1 = 60, y1 = 30, x2 = 80, y2 = 75)

Parameters:
<x1>,<y1>,
<x2>,<y2>

Diagram coordinates in % of the complete diagram that define
the zoom area.
The lower left corner is the origin of coordinate system. The
upper right corner is the end point of the system.
Range: 0  to  100
Default unit: PCT

Manual operation: See "Single Zoom" on page 209

DISPlay[:WINDow<n>]:ZOOM:STATe <State>

This command turns the zoom on and off.
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Parameters:
<State> ON | OFF

*RST: OFF

Example: DISP:ZOOM ON
Activates the zoom mode.

Manual operation: See "Single Zoom" on page 209

Using the Multiple Zoom

DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:AREA.....................................................379
DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:STATe................................................... 379

DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:AREA <x1>,<y1>,<x2>,<y2>

This command defines the zoom area for a multiple zoom.

To define a zoom area, you first have to turn the zoom on.

1 = origin of coordinate system (x1 = 0, y1 = 0)
2 = end point of system (x2 = 100, y2= 100)
3 = zoom area (e.g. x1 = 60, y1 = 30, x2 = 80, y2 = 75)

Suffix: 
<zoom>

.
1...4
Selects the zoom window.

Parameters:
<x1>,<y1>,
<x2>,<y2>

Diagram coordinates in % of the complete diagram that define
the zoom area.
The lower left corner is the origin of coordinate system. The
upper right corner is the end point of the system.
Range: 0  to  100
Default unit: PCT

Manual operation: See "Multiple Zoom" on page 209

DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>:STATe <State>

This command turns the mutliple zoom on and off.
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Suffix: 
<zoom>

.
1...4
Selects the zoom window.
If you turn off one of the zoom windows, all subsequent zoom
windows move up one position.

Parameters:
<State> ON | OFF

*RST: OFF

Manual operation: See "Multiple Zoom" on page 209

13.6.3 Retrieving Results

The following commands can be used to retrieve the results of the I/Q Analyzer mea-
surement.

● Retrieving Captured I/Q Data................................................................................380
● Retrieving I/Q Trace Data..................................................................................... 383
● Retrieving Marker and Peak Search Results........................................................ 385

13.6.3.1 Retrieving Captured I/Q Data

The captured I/Q data is output in the form of a list, three different formats can be
selected for this list (see TRACe:IQ:DATA:FORMat on page 381).

For details on formats refer to chapter A.4, "Reference: Format Description for I/Q Data
Files", on page 458.

TRACe:IQ:DATA?..........................................................................................................380
TRACe:IQ:DATA:FORMat...............................................................................................381
TRACe:IQ:DATA:MEMory?............................................................................................. 381

TRACe:IQ:DATA?

This command queries the captured data from measurements with the I/Q Analyzer.

To get the results, the command also initiates a measurement with the current settings
of the R&S VSE.

Note: Using the command with the *RST values for the TRACe:IQ:SET command, the
following minimum buffer sizes for the response data are recommended: ASCII format
10 kBytes, binary format: 2 kBytes

Return values: 
<Results> Measured voltage for I and Q component for each sample that

has been captured during the measurement.
The number of samples depends on TRACe:IQ:SET. In ASCII
format, the number of results is 2* the number of samples.
The data format depends on TRACe:IQ:DATA:FORMat
on page 381.
Default unit: V
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Example: TRAC:IQ:STAT ON
Enables acquisition of I/Q data
TRAC:IQ:SET NORM,10MHz,32MHz,EXT,POS,0,4096
Measurement configuration:
Sample Rate = 32 MHz
Trigger Source = External
Trigger Slope = Positive
Pretrigger Samples = 0
Number of Samples = 4096
FORMat REAL,32
Selects format of response data
TRAC:IQ:DATA?
Starts measurement and reads results

Usage: Query only

TRACe:IQ:DATA:FORMat <Format>

This command selects the order of the I/Q data.

For details see chapter A.4, "Reference: Format Description for I/Q Data Files",
on page 458.

Parameters:
<Format> COMPatible | IQBLock | IQPair

COMPatible
I and Q values are separated and collected in blocks: A block
(512k) of I values is followed by a block (512k) of Q values, fol-
lowed by a block of I values, followed by a block of Q values etc.
(I,I,I,I,Q,Q,Q,Q,I,I,I,I,Q,Q,Q,Q...)
IQBLock
First all I-values are listed, then the Q-values
(I,I,I,I,I,I,...Q,Q,Q,Q,Q,Q)
IQPair
One pair of I/Q values after the other is listed
(I,Q,I,Q,I,Q...).
*RST: IQBL

TRACe:IQ:DATA:MEMory? [<OffsetSamples>,<NoOfSamples>]

This command queries the I/Q data currently stored in the memory of the R&S VSE.

By default, the command returns all I/Q data in the memory. You can, however, narrow
down the amount of data that the command returns using the optional parameters.

By default, the amount of available data depends on TRACe:IQ:SET.
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Parameters:
<OffsetSamples> Selects an offset at which the output of data should start in rela-

tion to the first data. If omitted, all captured samples are output,
starting with the first sample.
Range: 0 to <# of samples> – 1, with <# of samples> being

the maximum number of captured values
*RST: 0

<NoOfSamples> Number of samples you want to query, beginning at the offset
you have defined. If omitted, all captured samples (starting at
offset) are output.
Range: 1 to <# of samples> - <offset samples> with <# of

samples> maximum number of captured values
*RST: <# of samples>

Return values: 
<IQData> Measured value pair (I,Q) for each sample that has been recor-

ded.
The data format depends on FORMat[:DATA].

Default unit: V

Example: TRAC:IQ:STAT ON
Enables acquisition of I/Q data
TRAC:IQ:SET NORM,10MHz,32MHz,EXT,POS,100,4096
Measurement configuration:
Sample Rate = 32 MHz
Trigger Source = External
Trigger Slope = Positive
Pretrigger Samples = 100
Number of Samples = 4096
INIT;*WAI
Starts measurement and wait for sync
FORMat REAL,32
Determines output format
To read the results:
TRAC:IQ:DATA:MEM?
Reads all 4096 I/Q data
TRAC:IQ:DATA:MEM? 0,2048
Reads 2048 I/Q data starting at the beginning of data acquisition
TRAC:IQ:DATA:MEM? 2048,1024
Reads 1024 I/Q data from half of the recorded data
TRAC:IQ:DATA:MEM? 100,512
Reads 512 I/Q data starting at the trigger point (<Pretrigger
Samples> was 100)

Usage: Query only
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13.6.3.2 Retrieving I/Q Trace Data

In addition to the raw captured I/Q data, the results from I/Q analysis as shown in the
result displays can also be retrieved.

FORMat[:DATA].............................................................................................................383
FORMat:DEXPort:DSEParator........................................................................................ 383
TRACe<n>[:DATA]?.......................................................................................................384
TRACe<n>[:DATA]:MEMory?..........................................................................................384
TRACe<n>[:DATA]:X?....................................................................................................385

FORMat[:DATA] <Format>

This command selects the data format that is used for transmission of trace data from
the R&S VSE to the controlling computer.

Note that the command has no effect for data that you send to the R&S VSE. The
R&S VSE automatically recognizes the data it receives, regardless of the format.

For details on data formats see chapter A.3, "Formats for Returned Values: ASCII For-
mat and Binary Format", on page 458.

Parameters:
<Format> ASCii

ASCii format, separated by commas.
This format is almost always suitable, regardless of the actual
data format. However, the data is not as compact as other for-
mats may be.
REAL,32
32-bit IEEE 754 floating-point numbers in the "definite length
block format".
For I/Q data, 8 bytes per sample are returned for this format set-
ting.
*RST: ASCII

Example: FORM REAL,32
Usage: SCPI confirmed

FORMat:DEXPort:DSEParator <Separator>

This command selects the decimal separator for data exported in ASCII format.

Parameters:
<Separator> COMMa

Uses a comma as decimal separator, e.g. 4,05.
POINt
Uses a point as decimal separator, e.g. 4.05.
*RST: *RST has no effect on the decimal separator.

Default is POINt.
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Example: FORM:DEXP:DSEP POIN
Sets the decimal point as separator.

TRACe<n>[:DATA]? <ResultType>

This command queries current trace data and measurement results.

The data format depends on FORMat[:DATA].

Query parameters: 
<ResultType> Selects the type of result to be returned.

TRACE1 | ... | TRACE6
Returns the trace data for the corresponding trace.
SPECtrogram | SGRam
Returns the results of the spectrogram result display.
For details see table 13-10.

Return values: 
<TraceData> Returns the sweep point values as shown in the result display.

If you are measuring with the auto peak detector, the command
returns positive peak values only. (To retrieve negative peak val-
ues, define a second trace with a negative peak detector.)
For the Magnitude and Spectrum result displays in the I/Q Ana-
lyzer application, this command returns the magnitude of the I
and Q values (I+jQ) for each sweep point (=1001 values).
For the Real/Imag (I/Q) result display, the command returns first
the real parts for each trace point, then the imaginary parts
(I1,...,I1001, Q1,...,Q1001).
For the I/Q Vector result display, the I and Q values for each
trace point are returned (1001 pairs of I and Q values).

Example: TRAC? TRACE3
Queries the data of trace 3.

Usage: SCPI confirmed

Manual operation: See "Magnitude" on page 112

Table 13-10: Return values for SPECtrogram parameter

For every frame in the spectrogram, the command returns the power levels that have been measured, one
for each sweep point. The number of frames depends on the size of the history depth. The power level
depends on the unit you have currently set.

TRACe<n>[:DATA]:MEMory? <Trace>,<OffsSwPoint>,<NoOfSwPoints>

This command queries the previously captured trace data for the specified trace from
the memory. As an offset and number of sweep points to be retrieved can be specified,
the trace data can be retrieved in smaller portions, making the command faster than
the TRAC:DATA? command. This is useful if only specific parts of the trace data are of
interest.
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If no parameters are specified with the command, the entire trace data is retrieved; in
this case, the command is identical to TRAC:DATA? TRACE1
For details on the returned values see the TRAC:DATA? <TRACE...> command.

Query parameters: 
<Trace> TRACE1 | TRACE2 | TRACE3 | TRACE4 | TRACE5 | TRACE6

<OffsSwPoint> The offset in sweep points related to the start of the measure-
ment at which data retrieval is to start.

<NoOfSwPoints> Number of sweep points to be retrieved from the trace.

Example: TRAC:DATA:MEM? TRACE1,25,100
Retrieves 100 sweep points from trace 1, starting at sweep point
25.

Usage: Query only

TRACe<n>[:DATA]:X? <TraceNumber>

This command queries the horizontal trace data for each sweep point in the specified
window, for example the frequency in frequency domain or the time in time domain
measurements.

This is especially useful for traces with non-equidistant x-values.

Query parameters: 
<TraceNumber> Trace number.

TRACE1 | ... | TRACE6

Example: TRAC3:X? TRACE1
Returns the x-values for trace 1 in window 3.

Usage: Query only

13.6.3.3 Retrieving Marker and Peak Search Results

The following commands are required to retrieve the results of markers and peak
searches.

Useful commands for retrieving marker results described elsewhere:
● CALCulate<n>:DELTamarker<m>:X on page 356
● CALCulate<n>:MARKer<m>:X on page 358

Remote commands exclusive to retrieving marker results:

CALCulate<n>:DELTamarker<m>:X:RELative?.................................................................385
CALCulate<n>:DELTamarker<m>:Y?...............................................................................386
CALCulate<n>:MARKer<m>:Y?.......................................................................................386

CALCulate<n>:DELTamarker<m>:X:RELative?

This command queries the relative position of a delta marker on the x-axis.
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If necessary, the command activates the delta marker first.

Return values: 
<Position> Position of the delta marker in relation to the reference marker.

Example: CALC:DELT3:X:REL?
Outputs the frequency of delta marker 3 relative to marker 1 or
relative to the reference position.

Usage: Query only

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:DELTamarker<m>:Y?

This command queries the relative position of a delta marker on the y-axis.

If necessary, the command activates the delta marker first.

To get a valid result, you have to perform a complete measurement with synchroniza-
tion to the end of the measurement before reading out the result. This is only possible
for single measurement mode.

See also INITiate<n>:CONTinuous on page 287.

The unit depends on the application of the command.

Table 13-11: Base unit

Parameter, measuring function or result display Output unit

DBM | DBPW | DBUV | DBMV | DBUA dB (lin/log)

WATT | VOLT | AMPere dB (lin), % (log)

statistics function (APD or CCDF) on dimensionless output

Return values: 
<Position> Position of the delta marker in relation to the reference marker.

Example: INIT:CONT OFF
Switches to single sweep mode.
INIT;*WAI
Starts a sweep and waits for its end.
CALC:DELT2 ON
Switches on delta marker 2.
CALC:DELT2:Y?
Outputs measurement value of delta marker 2.

Usage: Query only

Manual operation: See "  Marker 1/ Delta 1/ Delta 2/.../Delta 16" on page 195

CALCulate<n>:MARKer<m>:Y?

This command queries the position of a marker on the y-axis.
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If necessary, the command activates the marker first.

To get a valid result, you have to perform a complete measurement with synchroniza-
tion to the end of the measurement before reading out the result. This is only possible
for single measurement mode.

See also INITiate<n>:CONTinuous on page 287.

Return values: 
<Result> Result at the marker position.

The unit is variable and depends on the one you have currently
set.
In the Real/Imag (I/Q) result display of the I/Q Analyzer, the
command returns the real part first, then the imaginary part.

Example: INIT:CONT OFF
Switches to single measurement mode.
CALC:MARK2 ON
Switches marker 2.
INIT;*WAI
Starts a measurement and waits for the end.
CALC:MARK2:Y?
Outputs the measured value of marker 2.
In I/Q Analyzer application, for "Real/Imag (I/Q)", for example:
1.852719887E-011,0

Usage: Query only

Manual operation: See "Marker Table" on page 117

13.7 Managing Settings and Results

The commands required to store and load software settings and import and export
measurement results in a remote environment are described here.

The tasks for manual operation are described in chapter 8, "Data Management",
on page 76.

Addressing drives

The various drives can be addressed via the "mass storage instrument specifier"
<msis> using the conventional Windows syntax. The internal hard disk is addressed by
"C:".

For details on storage locations refer to chapter 8.2.2.2, "Storage Location and File
Name", on page 80.

The file names (<FileName> parameter) are given as string parameters enclosed in
quotation marks. They also comply with Windows conventions. Windows file names do
not distinguish between uppercase and lowercase notation.
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Wildcards

The two characters "*" and "?" can be used as "wildcards", i.e., they are variables for a
selection of several files. The question mark "?" replaces exactly one character, the
asterisk replaces any of the remaining characters in the file name. "*.*" thus means all
files in a directory.

Path names

Storage locations can be specified either as absolute (including the entire path) or rela-
tive paths (including only subfolders of the current folder). Use the MMEM:CDIR? query
to determine the current folder.

● Restoring the Default Configuration (Preset)........................................................ 388
● General Data Storage and Loading Commands...................................................389
● Selecting the Items to Store..................................................................................395
● Storing and Loading Measurement Settings.........................................................397
● Exporting Recorded I/Q Data................................................................................401
● Storing or Printing Screenshots............................................................................ 407
● Examples: Managing Data....................................................................................413

13.7.1 Restoring the Default Configuration (Preset)

SYSTem:PRESet...........................................................................................................388
SYSTem:PRESet:CHANnel[:EXECute]............................................................................ 388

SYSTem:PRESet

This command presets the R&S VSE.

Example: SYST:PRES
Usage: Event

SCPI confirmed

Manual operation: See "Restoring All Default Settings ( Preset All )" on page 76

SYSTem:PRESet:CHANnel[:EXECute]

This command restores the default software settings in the current channel.

Use INST:SEL to select the channel.

Example: INST 'Spectrum2'
Selects the channel for "Spectrum2".
SYST:PRES:CHAN:EXEC
Restores the factory default settings to the "Spectrum2" channel.

Usage: Event

Manual operation: See "Restoring Channel Settings ( Preset Selected Channel )"
on page 77
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13.7.2 General Data Storage and Loading Commands

See also:
● FORMat[:DATA] on page 383

MMEMory:CATalog?...................................................................................................... 389
MMEMory:CATalog:LONG?............................................................................................ 390
MMEMory:CDIRectory....................................................................................................390
MMEMory:COMMent......................................................................................................390
MMEMory:COPY........................................................................................................... 391
MMEMory:DATA............................................................................................................391
MMEMory:DELete..........................................................................................................392
MMEMory:MDIRectory................................................................................................... 392
MMEMory:MOVE........................................................................................................... 392
MMEMory:MSIS.............................................................................................................393
MMEMory:NAME........................................................................................................... 393
MMEMory:NETWork:DISConnect.................................................................................... 393
MMEMory:NETWork:MAP...............................................................................................393
MMEMory:NETWork:UNUSeddrives?.............................................................................. 394
MMEMory:NETWork:USEDdrives?.................................................................................. 394
MMEMory:RDIRectory....................................................................................................394

MMEMory:CATalog? <Path>

This command returns the contents of a particular directory.

Query parameters: 
<Path> String containing the path and directory

If you leave out the path, the command returns the contents of
the directory selected with MMEMory:CDIRectory.
The path may be relative or absolute. Using wildcards ('*') is
possible to query a certain type of files only.
If you use a specific file as a parameter, the command returns
the name of the file if the file is found in the specified directory,
or an error if the file is not found ("-256,"File name not
found").

Return values: 
<FileNames> List of file and directory names, separated by commas

If no files are found, an error is displayed: "-256,"File name
not found"

Example: MMEM:CAT? 'C:\R_S\Instr\user\SPOOL?.PNG'
Returns all files in C:\R_S\Instr\user whose names start with
SPOOL, have 6 letters and the extension ".PNG", e.g.:
SPOOL1.PNG,SPOOL2.PNG,SPOOL3.PNG

Example: MMEM:CAT? 'C:\R_S\Instr\user\SPOOL6.PNG'
Query whether the file 'SPOOL6.PNG' also exists in the directory;
Result:
-256,"File name not found;:MMEMory:CATalog? 'C:
\R_S\Instr\user\SPOOL6.PNG'
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Usage: Query only
SCPI confirmed

Manual operation: See "Selecting the Storage Location - Drive/ Path/ Files"
on page 81

MMEMory:CATalog:LONG? <Path>

This command returns the contents of a particular directory with additional information
about the files.

Query parameters: 
<Path> String containing the path and directory.

If you leave out the path, the command returns the contents of
the directory selected with MMEMory:CDIRectory.
The path may be relative or absolute. Using wildcards ('*') is
possible to query a certain type of files only.

Return values: 
<UsedDiskSpace> Byte size of all files in the directory.

<FreeDiskSpace> Remaining disk space in bytes.

<FileInfo> <NameFileN>,<SuffixFileN>,<SizeFileN>
Describes the individual file.
<NameFileN>
Name of the file.
<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory,
STAT
<SizeFileN>
Size of the file in bytes.

Usage: Query only

MMEMory:CDIRectory <Directory>

This command changes the current directory.

Parameters:
<Directory> String containing the path to another directory.

The path may be relative or absolute.

Usage: SCPI confirmed

MMEMory:COMMent <Comment>

This command defines a comment for the stored settings.

Parameters:
<Comment> String containing the comment.
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Example: MMEMory:COMMent "ACP measurement with Standard
Tetra from 23.05."
MMEMory::MMEMory:STORe1:STATe 1, "ACP_T"
As a result, in the selection list for recall settings, the comment
"ACP measurement with Standard Tetra from
23.05." is added to the ACP entry.

Manual operation: See "Comment" on page 82

MMEMory:COPY <SourceFile>,<DestinationFile>

This command copies one or more files to another directory.

Parameters:
<SourceFile> String containing the path and file name of the source file.

<DestinationFile> String containing the path and name of the target file.
The path may be relative or absolute.

Usage: SCPI confirmed

MMEMory:DATA <FileName>, [<Block>]

This command writes block data into a file. The delimiter must be set to EOI to obtain
error-free data transfer.

When you query the contents of a file, you can save them in a file on the remote con-
trol computer.

The command is useful for reading stored settings files or trace data from the software
or for transferring them to the software

Parameters:
<FileName> String containing the path and name of the target file.

<Block> Data block with the following structure.
#
Hash sign.
<number>
Length of the length information.
<number>
Length information of the binary data (number of bytes).
<data>
Binary data with the indicated <number> of bytes.
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Example: MMEM:NAME '\Public\User\Testfile.txt'
Creates a new file called 'testfile.txt'.
MMEM:DATA 'Testfile.txt',#220Contents of the
file
The parameter means:
#2: hash sign and length of the length information (20 bytes = 2
digits)
20: indicates the number of subsequent binary data bytes.
Contents of the file: store 20 binary bytes (characters) to the file.

Usage: SCPI confirmed

MMEMory:DELete <FileName>

This command deletes a file.

Parameters:
<FileName> String containing the path and file name of the file to delete.

The path may be relative or absolute.

Usage: Event
SCPI confirmed

MMEMory:MDIRectory <Directory>

This command creates a new directory.

Parameters:
<Directory> String containing the path and new directory name

The path may be relative or absolute.

Usage: Event

MMEMory:MOVE <SourceFile>,<NewFileName>

This command moves a file to another directory.

The command also renames the file if you define a new name in the target directory.

If you do not include a path for <NewFileName>, the command just renames the file.

Parameters:
<SourceFile> String containing the path and file name of the source file.

<NewFileName> String containing the path and name of the target file.

Example: MMEM:MOVE 'C:\TEST01.CFG','SETUP.CFG'
Renames TEST01.CFG in SETUP.CFG in directory C:\.

Usage: Event
SCPI confirmed
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MMEMory:MSIS <Device>

This command selects the default storage device used by all MMEMory commands.

Parameters:
<Device> 'A:' | 'C:' | … | 'Z:'

String containing the device drive name
*RST: 'C:'

Usage: SCPI confirmed

MMEMory:NAME <FileName>

This command creates a new and empty file.

It also sets the file name for screenshots taken with HCOPy[:IMMediate<device>].
Note that you have to route the printer output to a file.

Parameters:
<FileName> String containing the path and name of the target file.

Example: MMEM:NAME 'C:\R_S\instr\user\PRINT1.BMP'
Selects the file name.

Usage: Event
SCPI confirmed

MMEMory:NETWork:DISConnect <Drive>

This command disconnects a network drive.

Parameters:
<Drive> String containing the drive name.

Usage: Event

MMEMory:NETWork:MAP <Drive>, <HostName> [, <UserName>, <Password>][,
<Reconnect>]

This command maps a drive to a server or server directory of the network.

Note that you have to allow sharing for a server or folder in Microsoft networks first.

Parameters:
<Drive> String containing the drive name or path of the directory you

want to map.

<HostName> String containing the host name of the computer or the IP
address and the share name of the drive.
'<\host name or IP address\share name>'

<UserName> String containing a user name in the network.
The user name is optional.
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<Password> String containing the password corresponding to the <User-
Name>.
The password is optional.

<Reconnect> ON | OFF
ON
Reconnects at logon with the same user name.
OFF
Does not reconnect at logon.

Usage: Event

MMEMory:NETWork:UNUSeddrives?

This command returns a list of unused network drives.

Return values: 
<DriveName> List of network drives in alphabetically descending order, e.g.

'W:,V:,U:,...'

Usage: Query only

MMEMory:NETWork:USEDdrives? <State>

This command returns a list of all network drives in use.

Parameters:
<State> You do not have to use the parameter. If you do not include the

parameter, the command returns a list of all drives in use.
This is the same behavior as if you were using the parameter
OFF.
ON
Returns a list of all drives in use including the folder information.
OFF
Returns al list of all drives in use.

Usage: Query only

MMEMory:RDIRectory <Directory>

This command deletes the indicated directory.

Parameters:
<Directory> String containing the path of the directory to delete.

Note that the directory you want to remove must be empty.

Usage: Event
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13.7.3 Selecting the Items to Store

The following commands select the items to be included in the configuration file.

Depending on the used command, either the items from the entire software
(MMEMory:SELect[:ITEM]...), or only those from the currently selected channel
(MMEM:SELect:CHANnel[:ITEM]...) are stored.

MMEMory:SELect:CHANnel[:ITEM]:ALL...........................................................................395
MMEMory:SELect[:ITEM]:ALL......................................................................................... 395
MMEMory:SELect:CHANnel[:ITEM]:DEFault.....................................................................395
MMEMory:SELect[:ITEM]:DEFault................................................................................... 395
MMEMory:SELect:CHANnel[:ITEM]:HWSettings............................................................... 396
MMEMory:SELect[:ITEM]:HWSettings..............................................................................396
MMEMory:SELect:CHANnel[:ITEM]:LINes:ALL................................................................. 396
MMEMory:SELect[:ITEM]:LINes:ALL................................................................................396
MMEMory:SELect:CHANnel[:ITEM]:NONE....................................................................... 396
MMEMory:SELect[:ITEM]:NONE..................................................................................... 396
MMEMory:SELect:CHANnel[:ITEM]:SGRam.....................................................................397
MMEMory:SELect[:ITEM]:SGRam................................................................................... 397
MMEMory:SELect:CHANnel[:ITEM]:TRACe[:ACTive]........................................................ 397
MMEMory:SELect[:ITEM]:TRACe[:ACTive].......................................................................397

MMEMory:SELect:CHANnel[:ITEM]:ALL
MMEMory:SELect[:ITEM]:ALL
This command includes all items when storing or loading a configuration file.

The items are:

● Limit lines: MMEMory:SELect[:ITEM]:LINes:ALL
● Spectrogram data: MMEMory:SELect[:ITEM]:SGRam
● Trace data: MMEMory:SELect[:ITEM]:TRACe[:ACTive]
Example: MMEM:SEL:ALL
Usage: Event

Manual operation: See "Items" on page 82

MMEMory:SELect:CHANnel[:ITEM]:DEFault
MMEMory:SELect[:ITEM]:DEFault
This command selects the current settings as the only item to store to and load from a
configuration file.

Usage: Event

Manual operation: See "Items" on page 82
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MMEMory:SELect:CHANnel[:ITEM]:HWSettings <State>
MMEMory:SELect[:ITEM]:HWSettings <State>

This command includes or excludes measurement (hardware) settings when storing or
loading a configuration file.

Measurement settings include:

● general channel configuration
● measurement hardware configuration including markers
● limit lines

Note that a configuration may include no more than 8 limit lines. This number
includes active limit lines as well as inactive limit lines that were used last.
Therefore the combination of inactivate limit lines depends on the sequence of use
with MMEMory:LOAD:STATe.

● color settings

Depending on the used command, either the items for all channels
(MMEMory:SELect[:ITEM]...), or only those from the currently selected channel
(MMEM:SELect:CHANnel[:ITEM]...) are stored or loaded.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: MMEM:SEL:HWS ON
Manual operation: See "Items" on page 82

MMEMory:SELect:CHANnel[:ITEM]:LINes:ALL <State>
MMEMory:SELect[:ITEM]:LINes:ALL <State>

This command includes or excludes all limit lines (active and inactive) when storing or
loading a configuration file.

Parameters:
<State> ON | OFF

*RST: OFF

Example: MMEM:SEL:LIN:ALL ON
Manual operation: See "Items" on page 82

MMEMory:SELect:CHANnel[:ITEM]:NONE
MMEMory:SELect[:ITEM]:NONE
This command does not include any of the following items when storing or loading a
configuration file.

● Hardware configuration: MMEMory:SELect[:ITEM]:HWSettings
● Limit lines: MMEMory:SELect[:ITEM]:LINes:ALL
● Spectrogram data: MMEMory:SELect[:ITEM]:SGRam
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● Trace data: MMEMory:SELect[:ITEM]:TRACe[:ACTive]
Example: MMEM:SEL:NONE
Usage: Event

Manual operation: See "Items" on page 82

MMEMory:SELect:CHANnel[:ITEM]:SGRam <State>
MMEMory:SELect[:ITEM]:SGRam <State>

This command includes or excludes spectrogram data when storing or loading a con-
figuration file.

Parameters:
<State> ON | OFF

*RST: OFF

Example: MMEM:SEL:SGR ON
Adds the spectrogram data to the list of data subsets.

MMEMory:SELect:CHANnel[:ITEM]:TRACe[:ACTive] <State>
MMEMory:SELect[:ITEM]:TRACe[:ACTive] <State>

This command includes or excludes trace data when storing or loading a configuration
file.

Parameters:
<State> ON | OFF

*RST: OFF, i.e. no traces is stored

Example: MMEM:SEL:TRAC ON
Manual operation: See "Items" on page 82

13.7.4 Storing and Loading Measurement Settings

See also:

● INSTrument[:SELect] on page 292 to select the channel.

MMEMory:CLEar:ALL.....................................................................................................397
MMEMory:CLEar:STATe................................................................................................ 398
MMEMory:LOAD:AUTO..................................................................................................398
MMEMory:LOAD:STATe.................................................................................................398
MMEMory:LOAD:TYPE.................................................................................................. 399
MMEMory:STORe<n>:STATe......................................................................................... 400
MMEMory:STORe<n>:STATe:NEXT................................................................................400
MMEMory:STORe<n>:TYPE...........................................................................................401

MMEMory:CLEar:ALL

This command deletes all software configuration files in the current directory.
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You can select the directory with MMEMory:CDIRectory.

Example: MMEM:CLE:ALL
Usage: Event

MMEMory:CLEar:STATe 1,<FileName>

This command deletes a instrument configuration file.

Parameters:
1

<FileName> String containing the path and name of the file to delete.
The string may or may not contain the file's extension.

Example: MMEM:CLE:STAT 1,'TEST'
Usage: Event

MMEMory:LOAD:AUTO 1, 'Factory' | <FileName>

This command restores an software configuration and defines that configuration as the
default state.

The default state is restored after a preset (*RST) or after you turn on the R&S VSE.

Parameters:
1

'Factory' |
<FileName>

'Factory'
Restores the factory settings as the default state.
'<file_name>
String containing the path and name of the configuration file.
Note that only All channels settings files can be selected for the
startup recall function; single channel settings files cause an
error.

Example: MMEM:LOAD:AUTO 1,'C:\R_S\Instr\user\TEST'
Usage: Event

Manual operation: See "Startup Recall" on page 84

MMEMory:LOAD:STATe 1, <FileName>

This command restores and activates the software configuration stored in a *.dfl file.

Note that files with other formats cannot be loaded with this command.

The contents that are reloaded from the file are defined by the last selection made
either in the "Save/Recall" dialogs (manual operation) or through the
MMEMory:SELect[:ITEM] commands (remote operation; the settings are identical in
both cases).
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By default, the selection is limited to the user settings ("User Settings" selection in the
dialogs, HWSettings in SCPI). The selection is not reset by PRESET or *RST.

As a consequence, the results of a SCPI script using the MMEMory:LOAD:STATe com-
mand without a previous MMEMory:SELect[:ITEM] command may vary, depending
on previous actions in the GUI or in previous scripts, even if the script starts with the
*RST command.

It is therefore recommended that you use the appropriate MMEMory:SELect[:ITEM]
command before using MMEMory:LOAD:STATe.

Parameters:
1

<FileName> String containing the path and name of the file to load.
The string may or may not include the file's extension.

Example: MMEM:SEL:ALL
//Save all items (User Settings, All Traces, All Limit Lines) from
the R&S VSE.
MMEM:LOAD:STAT 1,'C:\R_S\Instr\user\TEST01'
//Reloads all items
In the "Recall" dialog, select only "User Settings" and "All Limit
Lines".
MMEM:LOAD:STAT 1,'C:\R_S\Instr\user\TEST01'
//Reloads user settings and all limit lines.
*RST
//Reset software.
MMEM:LOAD:STAT 1,'C:\R_S\Instr\user\TEST01'
//Selected items are retained. Reloads user settings and all limit
lines.
Restart the software.
MMEM:LOAD:STAT 1,'C:\R_S\Instr\user\TEST01'
// Selected items are set to default. Reloads only the user set-
tings.

Usage: SCPI confirmed

Manual operation: See "Recall" on page 79

MMEMory:LOAD:TYPE <Mode>

This command defines whether the channel-specific settings that will be loaded with
the subsequent MMEM:LOAD:STAT command will replace the current channel or acti-
vate a new channel.
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Parameters:
<Mode> NEW | REPLace

NEW
The loaded settings will be activated in a new channel.
REPLace
The loaded settings will replace the currently active channel.
*RST: NEW

Example: INST:SEL 'SPECTRUM2'
Selects measurement channel 'SPECTRUM2'.
MMEM:STOR:TYP CHAN
Specifies that channel-specific data is to be stored.
MMEM:STOR:STAT 1, 'C:\R_S\Instr\user\Spectrum'
Stores the settings from channel 'SPECTRUM2' to the file
'C:\R_S\Instr\user\Spectrum'.
MMEM:LOAD:TYPE NEW
Specifies that channel-specific settings are to be activated in a
new channel.
MMEM:LOAD:STAT 1, 'C:\R_S\Instr\user\Spectrum'
Loads the channel-specific settings from the file
'C:\R_S\Instr\user\Spectrum' to the new channel
'SPECTRUM2*'.

MMEMory:STORe<n>:STATe 1,<FileName>

This command saves the current software configuration in a *.dfl file.

The suffix <n> is irrelevant.

Parameters:
1

<FileName> String containing the path and name of the target file.
The file extension is .dfl.

Example: MMEM:STOR:STAT 1,'Save'
Saves the current software settings in the file Save.dfl.

Usage: Event
SCPI confirmed

Manual operation: See "Save File" on page 83

MMEMory:STORe<n>:STATe:NEXT

This command saves the current software configuration in a *.dfl file.

The suffix <n> is irrelevant.

The file name depends on the one you have set with MMEMory:STORe<n>:STATe.
This command adds a consecutive number to the file name.
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Example: MMEM:STOR:STAT 1,'Save'
Saves the current software settings in the file Save.dfl.
MMEM:STOR:STAT:NEXT
Saves the current software settings in the file Save_001.dfl
MMEM:STOR:STAT:NEXT
Saves the current software settings in the file Save_002.dfl

Usage: Event

Manual operation: See "Save File" on page 83

MMEMory:STORe<n>:TYPE <Mode>

This command defines whether the data from the entire software or only from the cur-
rent channel is stored with the subsequent MMEM:STOR... command.

The suffix <n> is irrelevant.

Parameters:
<Mode> INSTrument | CHANnel

INSTrument
Stores data from the entire software.
CHANnel
Stores data from an individual channel.
*RST: INST

Example: INST:SEL 'SPECTRUM2'
Selects measurement channel 'SPECTRUM2'.
MMEM:STOR:TYPE CHAN
Specifies that channel-specific data is to be stored.

13.7.5 Exporting Recorded I/Q Data

The following commands are required to export I/Q recording files

Useful commands for exporting recorded data described elsewhere:
● INSTrument:BLOCk:CHANnel[:SETTings]:RECord on page 289

Remote commands exclusive to exporting recorded data:

EXPort:IQ:FILE..............................................................................................................402
EXPort:IQ:FORMat.........................................................................................................402
EXPort:IQ:META:DATA.................................................................................................. 402
EXPort:IQ:META:DATA:SET........................................................................................... 403
EXPort:IQ:META:DATA<I>:VALue?................................................................................. 404
MMEMory:LOAD:IQ:STATe............................................................................................ 405
MMEMory:STORe<n>:IQ:COMMent................................................................................ 405
MMEMory:STORe<n>:IQ:STATe.....................................................................................405
MMEMory:STORe<n>:SGRam........................................................................................406
MMEMory:STORe<n>:SPECtrogram............................................................................... 406
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RECord:COMMent[:DEFault]...........................................................................................406
RECord:COUNt............................................................................................................. 406
RECord:MAXimum:RLEN............................................................................................... 407
RECord:SETTling:TIME..................................................................................................407

EXPort:IQ:FILE <FileName>

This command writes the captured I/Q data to a file.

The file type is defined using EXPort:IQ:FORMat on page 402.

Parameters:
<FileName> String containing the path and name of the target file.

Example: EXP:IQ:FORM IQTAR
EXP:IQ:FILE 'C:\R_S\Instr\user\data.iq.tar'
Stores the captured I/Q data to the specified file.

Manual operation: See "Save" on page 91

EXPort:IQ:FORMat <FileType>

Defines the file type used to store the I/Q data.

For details on file formats see chapter A.5, "Reference: Supported File Formats",
on page 460.

Parameters:
<FileType> IQTAR

Compressed file format for an individual measurement channel
CSV
Comma-separated ASCII file format
IQW
Binary file format; contains only I/Q data from a single channel,
without any meta data
MAT
Matlab file format

Manual operation: See "File Type" on page 89

EXPort:IQ:META:DATA <Datatype>,<State>{,<Datatype>,<State>}

Defines which meta data is included in the data file if a user-defined set is specified
(see EXPort:IQ:META:DATA:SET on page 403).

Note that only the settings used during recording are stored; subsequent changes to
the settings are ignored.

To query the values of the stored meta data after loading the file, see EXPort:IQ:
META:DATA<I>:VALue? on page 404.
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Parameters:
<Datatype> 'AttenuElecState' | 'AttenuElecValue[dB]' | 'AttenuMech[dB]' |

'CalibrationState' | 'DeviceHwInfo' | 'DeviceId' | 'DeviceOptions' |
'FilterSettings' | 'HighPassFilterState' | 'Impedance[Ohm]' |
'InputCoupling' | 'InputPath' | 'MeasBandwith[Hz]' |
'NumberOfPreSamples' | 'NumberOfPostSamples' |
'PreampGain[dB]' | 'PreampState' | 'RefLevel[dBm]' |
'RefLevelOffset[dB]' | 'RefOscillatorInput' |
'RefOscillatorFreq[Hz]' | 'TrgDropOut[s]' | 'TrgHoldoff[s]' |
'TrgHysteresis[dB]' | 'TrgLevel[dBm]' | 'TrgOffset[s]' | 'TrgSlope' |
'TrgSource' | 'YigPreSelectorState' | 
Individual meta data type

<State> ON | OFF | 1 | 0
All parameters that are ON are included in file.
*RST: OFF

Example: EXP:IQ:META:DATA MIN
Includes minimum set of meta data.

Example: EXP:IQ:META:DATA MIN
EXP:IQ:META:DATA 'InputPath',ON
EXP:IQ:META:DATA 'AttenuMech[dB]',ON
EXP:IQ:META:DATA 'PreampState',ON
EXP:IQ:META:DATA 'Impedance[Ohm]',ON
Includes minimum set of data except for input path, plus
mechanical attentuation, preamplifier, input impedance

Manual operation: See "Meta Data Settings" on page 90

EXPort:IQ:META:DATA:SET <Set>

Defines which meta data is included in the data file. Either a fixed set of data can be
specified, or a user-defined set of data types can be included.

Note that only the settings used during recording are stored; subsequent changes to
the settings are ignored.

For iqw file format, no meta data is available.

To query the values of the stored meta data after loading the file, see EXPort:IQ:
META:DATA<I>:VALue? on page 404.
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Parameters:
<Set> Defines a fixed set of meta data. For a detailed description of

these sets see "Meta Data Settings" on page 90.
MINimum
The minimum set of measurement settings required to restore
the channel later are stored.
MAXimum
All available meta data from the entire signal processing chain
(input path to the output) is stored.
CUSTom
A user-defined set of individual data types is included. The data
types are defined using EXPort:IQ:META:DATA on page 402.

Example: EXP:IQ:META:DATA:SET MIN
Includes minimum set of meta data.

Manual operation: See "Meta Data Settings" on page 90

EXPort:IQ:META:DATA<I>:VALue? <Datatype>

Queries the meta data stored in the specified input source file, if available (see
EXPort:IQ:META:DATA on page 402).

Suffix: 
<i>

.
1..99
Sequential number of the source

Parameters:
<Datatype> 'AttenuElecState' | 'AttenuElecValue[dB]' | 'AttenuMech[dB]' |

'CalibrationState' | 'DeviceHwInfo' | 'DeviceId' | 'DeviceOptions' |
'FilterSettings' | 'HighPassFilterState' | 'Impedance[Ohm]' |
'InputCoupling' | 'InputPath' | 'InputSelection' |
'MeasBandwith[Hz]' | 'NumberOfPreSamples' |
'NumberOfPostSamples' | 'PreampGain[dB]' | 'PreampState' |
'PreselectorState' | 'PreselectorType' | 'RefLevel[dBm]' |
'RefLevelOffset[dB]' | 'RefOscillatorInput' |
'RefOscillatorFreq[Hz]' | 'TrgDropOut[s]' | 'TrgHoldoff[s]' |
'TrgHysteresis[dB]' | 'TrgLevel[dBm]' | 'TrgOffset[s]' | 'TrgSlope' |
'TrgSource' | 'YigPreSelectorState' | 
String containing the individual meta data type
(Note: 'InputSelection', 'PreselectorState' , 'PreselectorType' are
only available if an R&S FSWT is connected.)

Return values: 
<Result> Value of the specified datatype

Example: EXPort:IQ:META:DATA:VALue? 'AttenuElecState'
Result:
OFF

Usage: Query only
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MMEMory:LOAD:IQ:STATe 1,<FileName>

This command restores I/Q data from a file.

The file extension is *.iq.tar.

Note: This command is maintained for compatiblity with various Rohde & Schwarz sig-
nal and spectrum analyzers only. For new R&S VSE remote control programs, use the
INSTrument:BLOCk:CHANnel[:SETTings]:FILE<i>[:IQTar] command.

Parameters:
<FileName> String containing the path and name of the source file.

Example: MMEM:LOAD:IQ:STAT 1, 'C:
\R_S\Instr\user\data.iq.tar'
Loads IQ data from the specified file.

Usage: Setting only

MMEMory:STORe<n>:IQ:COMMent <Comment>

This command adds a comment to a file that contains I/Q data.

The suffix <n> is irrelevant.

Parameters:
<Comment> String containing the comment.

Example: MMEM:STOR:IQ:COMM 'Device test 1b'
Creates a description for the export file.
MMEM:STOR:IQ:STAT 1, 'C:
\R_S\Instr\user\data.iq.tar'
Stores I/Q data and the comment to the specified file.

Manual operation: See "Comment" on page 89

MMEMory:STORe<n>:IQ:STATe 1, <FileName>

This command writes the captured I/Q data to a file.

The suffix <n> is irrelevant.

The file extension is *.iq.tar. By default, the contents of the file are in 32-bit floating
point format.

Note: This command is maintained for compatiblity with various Rohde & Schwarz sig-
nal and spectrum analyzers only. For new R&S VSE remote control programs, use the
EXPort:IQ:FILE command.

Parameters:
1

<FileName> String containing the path and name of the target file.
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Example: MMEM:STOR:IQ:STAT 1, 'C:
\R_S\Instr\user\data.iq.tar'
Stores the captured I/Q data to the specified file.

Manual operation: See "Save" on page 91

MMEMory:STORe<n>:SGRam <FileName>
MMEMory:STORe<n>:SPECtrogram <FileName>

This command exports spectrogram data to an ASCII file.

The file contains the data for every frame in the history buffer. The data corresponding
to a particular frame begins with information about the frame number and the time that
frame was recorded.

Note that, depending on the size of the history buffer, the process of exporting the data
can take a while.

Parameters:
<FileName> String containing the path and name of the target file.

Example: MMEM:STOR:SGR 'Spectrogram'
Copies the spectrogram data to a file.

RECord:COMMent[:DEFault] <Comment>

Defines a default text for the comment to the stored data file. This default comment is
displayed in the "Save I/Q Recording" dialog box (see Comment).

Parameters:
<Comment> string

Manual operation: See "Default Comment" on page 87

RECord:COUNt <NoRecords>

Defines the number of records to be stored. One record contains the data captured
during the defined measurement time for a single channel. If more measurements are
available than the specified number (x) of records, only the most recent (x) measure-
ment results are stored.

As a rule, the recording is limited by the maximum record length provided by the instru-
ment.

This setting is ignored for RECord:MAXimum:RLEN ON.

Parameters:
<NoRecords> numeric value

*RST: 1

Manual operation: See "Number of Records" on page 87
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RECord:MAXimum:RLEN <State>

Defines how many records are stored.

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
All available records for the channel are stored. The RECord:
COUNt command is ignored.

OFF | 0
Only the most recent records (defined by RECord:COUNt) are
stored.
*RST: ON

Manual operation: See "Always Maximum Record Length" on page 88

RECord:SETTling:TIME <State>

If enabled, additional samples (in addition to the specified capture time) are stored for
the channel to compensate for settling effects.

This setting is required for instrument in uses that do not support the standard band-
width-to-sample-rate-ratio of 0.8 and thus require an upsampler. The additional sam-
ples compensate for settling effects in the filters used by the upsampler.

Parameters:
<State> ON | OFF | 1 | 0

*RST: OFF

Manual operation: See "Additional Settling Samples" on page 88

13.7.6 Storing or Printing Screenshots

Useful commands to configure screenshots described elsewhere

● MMEMory:NAME on page 393

Remote commands exclusive to configure screenshots

DISPlay:LOGO.............................................................................................................. 408
HCOPy:ABORt.............................................................................................................. 408
HCOPy:CMAP<item>:DEFault<colors>............................................................................ 408
HCOPy:CMAP<item>:HSL..............................................................................................409
HCOPy:CMAP<item>:PDEFined..................................................................................... 409
HCOPy:DESTination<device>......................................................................................... 409
HCOPy:DEVice:COLor................................................................................................... 410
HCOPy:DEVice:LANGuage<device>............................................................................... 410
HCOPy[:IMMediate<device>].......................................................................................... 411
HCOPy[:IMMediate<device>]:NEXT.................................................................................411
HCOPy:ITEM:ALL..........................................................................................................411
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HCOPy:ITEM:WINDow:TEXT..........................................................................................411
HCOPy:PAGE:ORIentation<device>................................................................................ 412
HCOPy:TDSTamp:STATe<device>................................................................................. 412
SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?........................................................ 412
SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?...................................................... 412
SYSTem:COMMunicate:PRINter:SELect<device>.............................................................413

DISPlay:LOGO <State>

Activates/deactivates the printout of the Rohde & Schwarz company logo in the upper
left corner.

Parameters:
<State> ON | OFF

*RST: ON

Example: DISP:LOGO OFF
Manual operation: See "Print Logo" on page 99

HCOPy:ABORt

This command aborts a running hardcopy output.

Example: HCOP:ABOR
Usage: Event

SCPI confirmed

HCOPy:CMAP<item>:DEFault<colors> 

This command defines the color scheme for print jobs.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.

<colors> 1...4
1
Current colors with a white background and a black grid.
2
Optimized colors.
3
Customized colors.
4
Current screen colors (setting for hardcopies).

Example: HCOP:CMAP:DEF2
Selects the optimized color set for the color settings of a printout
or a hardcopy.

Usage: Event
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Manual operation: See "Print colors" on page 105

HCOPy:CMAP<item>:HSL <Color>

This command selects the color for various screen elements in print jobs.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.

Parameters:
<Color> hue

tint
sat
saturation
lum
brightness
The value range is 0 to 1 for all parameters.

Example: HCOP:CMAP2:HSL 0.3,0.8,1.0
Changes the grid color

Manual operation: See "Defining User-specific Colors" on page 106

HCOPy:CMAP<item>:PDEFined <Color>

This command selects a predefined color for various screen elements in print jobs.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.

Parameters:
<Color> BLACk | BLUE | BROWn | GREen | CYAN | RED | MAGenta |

YELLow | WHITe | DGRAy | LGRAy | LBLUe | LGREen |
LCYan | LRED | LMAGenta

Example: HCOP:CMAP2:PDEF GRE
Manual operation: See "Predefined Colors" on page 106

HCOPy:DESTination<device> <Destination>

This command selects the destination of a print job.

Suffix: 
<device>

.
1 | 2
Printing device.
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Parameters:
<Destination> 'MMEM'

Sends the hardcopy to a file.
You can select the file name with MMEMory:NAME.
You can select the file format with HCOPy:DEVice:
LANGuage<device>.

'SYST:COMM:PRIN'
Sends the hardcopy to a printer.
You can select the printer withSYSTem:COMMunicate:
PRINter:SELect<device> .

'SYST:COMM:CLIP'
Sends the hardcopy to the clipboard.
The format should be WEMF.
*RST: 'SYST:COMM:CLIP'

Usage: SCPI confirmed

HCOPy:DEVice:COLor <State>

This command turns color printing on and off.

Parameters:
<State> ON

Color printing
OFF
Black and white printing
*RST: OFF

Example: HCOP:DEV:COL ON
Usage: SCPI confirmed

HCOPy:DEVice:LANGuage<device> <Format>

This command selects the file format for a print job.

Suffix: 
<device>

.
1 | 2
Printing device.

Parameters:
<Format> GDI

Graphics Device Interface.
Default format for the output to a printer configured under Win-
dows. Must be selected for the output to the printer interface.
Can be used for the output to a file. The printer driver configured
under Windows is used in this case and a printer-specific file for-
mat is thus generated.
BMP, JPG, PNG
Data format for output to files only.
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Usage: SCPI confirmed

HCOPy[:IMMediate<device>]

This command initiates a print job.

If you are printing to a file, the file name depends on MMEMory:NAME.

Suffix: 
<device>

.
1 | 2
Printing device.

Usage: Event
SCPI confirmed

Manual operation: See "  Print" on page 99

HCOPy[:IMMediate<device>]:NEXT

This command initiates a print job.

If you are printing to a file, the file name depends on MMEMory:NAME. This command
adds a consecutive number to the file name.

Suffix: 
<device>

.
1 | 2
Printing device.

Usage: Event

Manual operation: See "  Print" on page 99

HCOPy:ITEM:ALL

This command includes all screen elements in the printout.

The screen elements include comments, title, time and date.

Usage: SCPI confirmed

Manual operation: See "  Print" on page 99

HCOPy:ITEM:WINDow:TEXT <Comment>

This command defines a comment to be added to the printout.

Parameters:
<Comment> String containing the comment.

Usage: SCPI confirmed

Manual operation: See "Comment" on page 99
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HCOPy:PAGE:ORIentation<device> <Orientation>

The command selects the format of the print job.

The command is only available if the output device is a printer.

Suffix: 
<device>

.
1 | 2
Printing device.

Parameters:
<Orientation> LANDscape | PORTrait

*RST: PORTrait

Usage: SCPI confirmed

Manual operation: See "Orientation" on page 99

HCOPy:TDSTamp:STATe<device> <State>

This command includes or excludes the time and date in the printout.

Suffix: 
<device>

.
1 | 2
Printing device.

Parameters:
<State> ON | OFF

*RST: OFF

Manual operation: See "Print Date and Time" on page 99

SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt?

This command queries the name of the first available printer.

To query the name of other installed printers, use SYSTem:COMMunicate:PRINter:
ENUMerate[:NEXT]?.

Return values: 
<PrinterName> String containing the name of the first printer as defined in Win-

dows.
If the command cannot find a printer, it returns an empty string
(' ').

Usage: Query only

SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?

This command queries the name of available printers.

You have to use SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? for this
command to work properly.
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Return values: 
<PrinterName> String containing the name of one printer as defined in Windows.

To get a complete list of printers you have to send this query
several times until no more printers could be found. In that case,
the return value is an empty string (' '). Further queries after the
empty string result in an error.

Usage: Query only

SYSTem:COMMunicate:PRINter:SELect<device> <PrinterName>

This command selects the printer that processes jobs sent by the R&S VSE.

Use HCOPy:DESTination<device> to select another output destination.

Suffix: 
<device>

.
1 | 2
Printing device.

Parameters:
<PrinterName> String containing the printer name.

Use
• SYSTem:COMMunicate:PRINter:ENUMerate:FIRSt? and
• SYSTem:COMMunicate:PRINter:ENUMerate[:NEXT]?
to query all available printers.
*RST: NONE

13.7.7 Examples: Managing Data

● Storing Data.......................................................................................................... 413
● Loading Data.........................................................................................................414
● Storing Software Settings......................................................................................414
● Loading Software Settings.................................................................................... 415
● Printing to a File.................................................................................................... 415
● Printing on a Printer.............................................................................................. 415

13.7.7.1 Storing Data

MMEM:MSIS 'C:'
//Selects drive C: as the default storage device.
-----Connecting a network drive--------
MMEM:NETW:USED?
//Returns a list of all drives in use in the network.
MMEM:NETW:UNUS?
//Returns a list of free drive names in the network.
MMEM:NETW:MAP 'T:','Server\ACLRTest'
//Maps drive T: to the directory 'Server\ACLRTest'
-----Saving data from the software
MMEM:MDIR 'C:\R_S\INST\USER\ACLRTest'
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//Creates a directory called 'ACLRTest' on drive C:
MMEM:NAME 'C:\R_S\INST\USER\Test001.txt'
//Creates a file called 'Test001.txt'
MMEM:COMM 'ACLR test results'
//Creates a comment for the file.
MMEM:DATA 'Test001.txt',#212FileContents
//Writes 12 characters to the file 'Test001.txt'
-----Copying the data to another location---
MMEM:COPY 'C:\R_S\INST\USER\Results\Test001.txt','T:'
//Copies the specified file to network drive T:.
MMEM:DEL 'C:\R_S\INST\USER\Results\Test001.txt'
//Deletes the specified file from the instrument hard disk.
//or
MMEM:MOVE 'C:\R_S\INST\USER\Results\Test001.xml','D:\TestResults.txt'//
//Moves the file 'Test001.txt' to drive T:, renames it to 'Testresults.txt'
//and removes it from the instrument hard disk.
MMEM:RDIR 'C:\R_S\INST\USER\Results'
//Deletes the directory called 'Results' from drive C:, unless it still contains any content.
-----Disconnecting the network drive---
MMEM:NETW:DISC 'T:'
//Disconnect drive T:.

13.7.7.2 Loading Data

MMEM:CDIR?
//Returns the path of the current directory.
//e.g.
C:\R_S\Instr\user\
MMEM:CDIR 'C:\R_S\INST\USER\Results'
//Changes the current directory.
MMEM:CAT? 'C:\R_S\INST\USER\Results\*.xml'
//or
MMEM:CAT? '*.xml'
//Returns a list of all xml files in the directory 'C:\R_S\INST\USER\Results'.
MMEM:CAT:LONG? '*.xml'
//Returns additional information about the xml files in the directory 'C:\R_S\INST\USER\Results'.

13.7.7.3 Storing Software Settings

In this example we will store the software settings for the "IQ Analyzer" channel.

INST:SEL 'IQ Analyzer'
//Selects measurement channel 'IQ Analyzer'.
MEMM:STOR:TYPE CHAN
//Specifies that channel-specific data is to be stored.
MMEM:STOR:STAT 1, 'C:\R_S\Instr\user\IQAnalyzer'
//Stores the channel settings from the 'IQ Analyzer' channel
// to the file 'IQAnalyzer.dfl'.
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13.7.7.4 Loading Software Settings

In this example we will load the software settings from the configuration file
IQAnalyzer.dfl to a new "IQ Analyzer 2" channel.

MEMM:LOAD:TYPE NEW
//Specifies that settings will be loaded to a new channel besides the existing 
//'IQ Analyzer' channel.
MMEM:LOAD:STAT 1, 'C:\R_S\Instr\user\IQAnalyzer'
//Loads the channel-specific settings from the file 'C:\R_S\Instr\user\IQAnalyzer.dfl'
//to a new channel. The new channel is named 'IQ Analyzer 2' to avoid a naming conflict
//with the existing 'IQ Analyzer' channel.
INST:REN 'IQ Analyzer 2','IQ Analyzer 3'
//Renames the loaded channel to 'IQ Analyzer 3'.

13.7.7.5 Printing to a File

HCOP:DEST 'MMEM'
//Prints the data to a file.
HCOP:DEV:LANG BMP
//Selects bmp as the file format.
MMEM:NAME 'C:\R_S\INST\USER\Screenshot.bmp'
//Selects the file name for the printout.
HCOP:ITEM:ALL
//Prints all screen elements
HCOP:ITEM:WIND:TEXT 'ACLRResults'
//Adds a comment to the printout.
HCOP
//Stores the printout in a file called 'Screenshot.bmp'.
HCOP:NEXT
//Stores the printout in a file called 'Screenshot_001.bmp'.

13.7.7.6 Printing on a Printer

HCOP:DEST2 'SYST:COMM:PRIN'
//Prints the data on a printer.
SYST:COMM:PRIN:ENUM:FIRS?
SYST:COMM:PRIN:ENUM?
//Returns the available printers, e.g.
'LASER on LPT1'
''
//Means that one printer is available.
SYST:COMM:PRIN:SEL2 'LASER on LPT1'
//Selects the printer for the print job on device 2.
HCOP:PAGE:ORI2 LAND
//Selects the landscape format for the printout.
HCOP:TDST:STAT2 ON
//Includes date and time on the printout.
HCOP:ITEM:ALL
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//Prints all screen elements
HCOP
//Initiates the printout.

13.8 Configuring the Software

● Software Support and Information........................................................................ 416
● General Display.....................................................................................................417
● Colors and Themes...............................................................................................418
● CMAP Suffix Assignment......................................................................................420

13.8.1 Software Support and Information

The following commands are required to obtain information concerning optional func-
tionality, licenses, service functions, or system messages.

DIAGnostic:SERVice:SINFo?.......................................................................................... 416
DIAGnostic:SERVice:VERSinfo?..................................................................................... 417

DIAGnostic:SERVice:SINFo? <FileName>

This command creates a *.zip file with important support information. The *.zip file con-
tains the system configuration information ("device footprint"), the current eeprom data
and a screenshot of the screen display (if available).

This data is stored to the following directory on the PC the R&S VSE software is instal-
led on:

C:\ProgramData\Rohde-Schwarz\VSE\<version_no>\user.

As a result of this command, the created file name (including the drive and path) is
returned.

If you contact the Rohde&Schwarz support to get help for a certain problem, send this
file to the support in order to identify and solve the problem faster.

Return values: 
<FileName> C:\ProgramData\Rohde-Schwarz\VSE\<version_no>\user\<R&S

Device ID>_<CurrentDate>_<CurrentTime>
String containing the drive, path and file name of the created
support file, where the file name consists of the following ele-
ments:
<R&S Device ID>: The unique R&S device ID indicated in the
"Versions + Options" information
(See chapter 9.4.1, "Licensing, Versions and Options",
on page 108)
<CurrentDate>: The date on which the file is created
(<YYYYMMDD>)
<CurrentTime>: The time at which the file is created
(<HHMMSS>)
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Example: DIAG:SERV:SINF?
Result:
C:\ProgramData\Rohde-Schwarz\VSE\0.80a_63\user\
VSE_1310.0002K02-900014-if_20140807_091003.zip

Usage: Query only

Manual operation: See "Creating R&S Support Information" on page 110

DIAGnostic:SERVice:VERSinfo?

This command queries information about the hardware and software components.

Return values: 
<Information> String containing the version of hardware and software compo-

nents including the types of licenses for installed options.

Example: DIAG:SERV:VERS?
Queries the version information.
Response:
R&S VSE |0.80a 51 Beta, 
Time Control Management ||active, 
Analog Modulation Analysis K7|0.70|permanent,
 maintenance until 2018-09-30, 
Software Maintenance || Expires on 2018-09-30

Usage: Query only
SCPI confirmed

13.8.2 General Display

DISPlay:ANNotation:CBAR............................................................................................. 417
DISPlay:ANNotation:FREQuency.....................................................................................417
DISPlay:SBAR[:STATe].................................................................................................. 418

DISPlay:ANNotation:CBAR <State>

This command hides or displays the channel bar information.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: DISP:ANN:CBAR OFF
Usage: SCPI confirmed

DISPlay:ANNotation:FREQuency <State>

This command turns the label of the x-axis on and off.
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Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: DISP:ANN:FREQ OFF
Usage: SCPI confirmed

Manual operation: See "Diagram Footer (Annotation)" on page 103

DISPlay:SBAR[:STATe] <State>

This command turns the status bar on and off.

Parameters:
<State> ON | OFF | 0 | 1

*RST: 1

Example: DISP:SBAR:OFF
Manual operation: See "Status Bar" on page 103

13.8.3 Colors and Themes

Useful commands to customize display colors described elsewhere

The HCOPY commands define the print colors and thus only take effect on the display
colors, if the display shows the printing colors.

● HCOPy:CMAP<item>:DEFault<colors> on page 408
● HCOPy:CMAP<item>:HSL on page 409
● HCOPy:CMAP<item>:PDEFined on page 409

Remote commands exclusive to customize the display colors and themes

DISPlay:CMAP<item>:DEFault<colors>........................................................................... 418
DISPlay:CMAP<item>:HSL............................................................................................. 419
DISPlay:CMAP<item>:PDEFined.....................................................................................419
DISPlay:THEMe:CATalog?............................................................................................. 420
DISPlay:THEMe:SELect................................................................................................. 420

DISPlay:CMAP<item>:DEFault<colors>

This command resets the color scheme for the display.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.
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<colors> 1...4
1
Current colors with a white background and a black grid.
2
Optimized colors.
3
Customized colors.
4
Current screen colors (setting for hardcopies).

Example: DISP:CMAP:DEF2
Selects default setting 2 for setting the colors.

Usage: Event
SCPI confirmed

Manual operation: See "Screen colors" on page 105

DISPlay:CMAP<item>:HSL <Color>

This command selects the color for various screen elements in the display.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.

Parameters:
<Color> hue

tint
sat
saturation
lum
brightness
The value range is 0 to 1 for all parameters.

Example: DISP:CMAP2:HSL 0.3,0.8,1.0
Changes the grid color.

DISPlay:CMAP<item>:PDEFined <Color>

This command selects a predefined color for various screen elements.

Suffix: 
<item>

.
Selects the item for which the color scheme is to be defined.
For more information see chapter 13.8.4, "CMAP Suffix Assign-
ment", on page 420.

Parameters:
<Color> BLACk | BLUE | BROWn | GREen | CYAN | RED | MAGenta |

YELLow | WHITe | DGRAy | LGRAy | LBLUe | LGREen |
LCYan | LRED | LMAGenta

Configuring the Software



Remote CommandsR&S®VSE

420User Manual 1176.8839.02 ─ 03

Example: DISP:CMAP2:PDEF GRE
Manual operation: See "Restoring the User Settings to Default Colors" on page 107

DISPlay:THEMe:CATalog?

This command queries all available display themes.

Parameters:
<Themes> String containing all available display themes.

Example: DISP:THEMe:CAT?
Usage: Query only

DISPlay:THEMe:SELect <Theme>

This command selects the display theme.

Parameters:
<Theme> String containing the name of the theme.

*RST: SPL

Example: DISP:THEM:SEL "OceanBlue"
Manual operation: See "Theme" on page 104

13.8.4 CMAP Suffix Assignment

Several commands to change the color settings of individual items of the display or
printout are available. Which item is to be configured is defined using a <CMAP> suffix.
The following assignment applies:

Suffix Description

CMAP1 Background

CMAP2 Grid

CMAP3 *) Common Text

CMAP4 *) Check Status OK

CMAP5 *) Check Status Error

CMAP6 *) Text Special 1

CMAP7 *) Text Special 2

CMAP8 Trace 1

CMAP9 Trace 2

CMAP10 Trace 3

CMAP11 Marker Info Text

CMAP12 Limit Lines
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Suffix Description

CMAP13 Limit and Margin Check – "Pass"

CMAP14 Limit and Margin Check – "Fail"

CMAP15 *) Softkey Text

CMAP16 *) Softkey Background

CMAP17 *) Selected Field Text

CMAP18 *) Selected Field Background

CMAP19 *) Softkey 3D Bright Part

CMAP20 *) Softkey 3D Dark Part

CMAP21 *) Softkey State "On"

CMAP22 *) Softkey State "Dialog open"

CMAP23 *) Softkey Text Disabled

CMAP24 Logo

CMAP25 Trace 4

CMAP26 Grid – Minorlines

CMAP27 Marker

CMAP28 Display Lines

CMAP29 *) Sweepcount – Text

CMAP30 Limit and Margin Check – Text

CMAP31 Limit and Margin Check – \"Margin\"

CMAP32 *) Table Overall – Title Text

CMAP33 *) Table Overall – Title Background

CMAP34 *) Table Overall – Text

CMAP35 *) Table Overall – Background

CMAP36 *) Table Value – Title Text

CMAP37 *) Table Value – Title Background

CMAP38 *) Table Value – Text

CMAP39 *) Table Value – Background

CMAP40 Trace 5

CMAP41 Trace 6

*) these settings can only be defined via the theme (DISPlay:THEMe:SELect) and
are thus ignored in the SCPI command
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13.9 Commands for Remote Instrument Operation

The following commands are required to shutdown or reboot the R&S VSE from a
remote PC.

DEVice:LOCKing:DEFault...............................................................................................422
SYSTem:CLOGging....................................................................................................... 422
SYSTem:COMMunicate:GPIB[:SELF]:RTERminator..........................................................422
SYSTem:DISPlay:UPDate.............................................................................................. 423
SYSTem:IDENtify:FACTory.............................................................................................423
SYSTem:IDENtify[:STRing]............................................................................................. 423

DEVice:LOCKing:DEFault <STATe>

Defines the default setting for the VISA connection lock for all subsequent instrument
connections (see DEVice:LOCKing on page 271).

Parameters:
<State> ON | OFF | 1 | 0

ON | 1
Connection is locked, no other devices can establish a connec-
tion to the same instrument
OFF | 0
Connection is unlocked, other devices in the network can con-
nect to the instrument
*RST: OFF

Example: DEV:LOCK:DEF ON
Manual operation: See "Lock new VISA connections" on page 252

SYSTem:CLOGging <State>

This command turns logging of remote commands on and off.

Parameters:
<State> ON

Writes all remote commands that have been sent to a file.
The destination is C:
\R_S\instr\ScpiLogging\ScpiLog.txt.

OFF
*RST: OFF

Manual operation: See "I/O Logging" on page 252

SYSTem:COMMunicate:GPIB[:SELF]:RTERminator <Terminator>

This command selects the GPIB receive terminator.

Output of binary data from the instrument to the control computer does not require
such a terminator change.
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Parameters:
<Terminator> LFEOI | EOI

LFEOI
According to the standard, the terminator in ASCII is <LF>
and/or <EOI>.
EOI
For binary data transfers (e.g. trace data) from the control com-
puter to the instrument, the binary code used for <LF> might be
included in the binary data block, and therefore should not be
interpreted as a terminator in this particular case. This can be
avoided by using only the receive terminator EOI.

*RST: LFEOI

Example: SYST:COMM:GPIB:RTER EOI
Manual operation: See "GPIB Terminator" on page 252

SYSTem:DISPlay:UPDate <State>

This command turns the display during remote operation on and off.

If on, the R&S VSE updates the diagrams, traces and display fields only.

The best performance is obtained if the display is off during remote control operation.

Parameters:
<State> ON | OFF

*RST: OFF

Example: SYST:DISP:UPD ON
Manual operation: See "Remote Display Update" on page 251

SYSTem:IDENtify:FACTory

This command resets the query to *IDN? to its default value.

Usage: Event

Manual operation: See "Reset to Factory String" on page 251

SYSTem:IDENtify[:STRing] <String>

This command defines the response to *IDN?.

Parameters:
<String> String containing the description of the instrument.

Manual operation: See "Identification String" on page 251
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13.10 Working with Status Registers

● Using the Status Register..................................................................................... 424

13.10.1 Using the Status Register

For more information on the contents of the status registers see:

● "STATus:OPERation Register" on page 242
● "STATus:QUEStionable:EXTended Register" on page 242
● "STATus:QUEStionable:FREQuency Register" on page 243
● "STATus:QUEStionable:LIMit Register" on page 244
● "STATus:QUEStionable:LMARgin Register" on page 245
● "STATus:QUEStionable:POWer Register" on page 245
● "STATus:QUEStionable:TIMe Register" on page 246

● General Status Register Commands.................................................................... 424
● Reading Out the CONDition Part.......................................................................... 425
● Reading Out the EVENt Part.................................................................................425
● Controlling the ENABle Part..................................................................................426
● Controlling the Negative Transition Part............................................................... 426
● Controlling the Positive Transition Part.................................................................427

13.10.1.1 General Status Register Commands

STATus:PRESet............................................................................................................ 424
STATus:QUEue[:NEXT]?................................................................................................424

STATus:PRESet

This command resets the edge detectors and ENABle parts of all registers to a defined
value. All PTRansition parts are set to FFFFh, i.e. all transitions from 0 to 1 are
detected. All NTRansition parts are set to 0, i.e. a transition from 1 to 0 in a
CONDition bit is not detected. The ENABle part of the STATus:OPERation and
STATus:QUEStionable registers are set to 0, i.e. all events in these registers are not
passed on.

Usage: Event

STATus:QUEue[:NEXT]?

This command queries the most recent error queue entry and deletes it.

Positive error numbers indicate device-specific errors, negative error numbers are error
messages defined by SCPI. If the error queue is empty, the error number 0, "No error",
is returned.

This command is identical to the SYSTem:ERRor[:NEXT]? command.
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Usage: Query only

13.10.1.2 Reading Out the CONDition Part

For more information on the condition part see chapter 12.1.5.2, "Structure of a SCPI
Status Register", on page 238.

STATus:OPERation:CONDition?
STATus:QUEStionable:CONDition?
STATus:QUEStionable:EXTended:CONDition? <ChannelName>
STATus:QUEStionable:EXTended:INFO:CONDition? <ChannelName>
STATus:QUEStionable:FREQuency:CONDition? <ChannelName>
STATus:QUEStionable:LIMit<n>:CONDition? <ChannelName>
STATus:QUEStionable:LMARgin<n>:CONDition? <ChannelName>
STATus:QUEStionable:POWer:CONDition? <ChannelName>
STATus:QUEStionable:TEMPerature:CONDition? <ChannelName>
STATus:QUEStionable:TIME:CONDition? <ChannelName>

These commands read out the CONDition section of the status register.

The commands do not delete the contents of the CONDition section.

Query parameters: 
<ChannelName> String containing the name of the channel.

The parameter is optional. If you omit it, the command works for
the currently active channel.

Usage: Query only

13.10.1.3 Reading Out the EVENt Part

For more information on the event part see chapter 12.1.5.2, "Structure of a SCPI Sta-
tus Register", on page 238.

STATus:OPERation[:EVENt]?
STATus:QUEStionable[:EVENt]?
STATus:QUEStionable:EXTended[:EVENt]? <ChannelName>
STATus:QUEStionable:EXTended:INFO[:EVENt]? <ChannelName>
STATus:QUEStionable:FREQuency[:EVENt]? <ChannelName>
STATus:QUEStionable:LIMit<n>[:EVENt]? <ChannelName>
STATus:QUEStionable:LMARgin<n>[:EVENt]? <ChannelName>
STATus:QUEStionable:POWer[:EVENt]? <ChannelName>
STATus:QUEStionable:TEMPerature[:EVENt]? <ChannelName>
STATus:QUEStionable:TIME[:EVENt]? <ChannelName>

These commands read out the EVENt section of the status register.

At the same time, the commands delete the contents of the EVENt section.

Query parameters: 
<ChannelName> String containing the name of the channel.

The parameter is optional. If you omit it, the command works for
the currently active channel.
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Usage: Query only

13.10.1.4 Controlling the ENABle Part

For more information on the enable part see chapter 12.1.5.2, "Structure of a SCPI
Status Register", on page 238.

STATus:OPERation:ENABle <SumBit>
STATus:QUEStionable:ENABle <SumBit>
STATus:QUEStionable:EXTended:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:EXTended:INFO:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:FREQuency:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:LIMit<n>:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:LMARgin<n>:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:POWer:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:TEMPerature:ENABle <SumBit>,<ChannelName>
STATus:QUEStionable:TIME:ENABle <SumBit>,<ChannelName>

These commands control the ENABle part of a register.

The ENABle part allows true conditions in the EVENt part of the status register to bere-
ported in the summary bit. If a bit is 1 in the enable register and its associated event bit
transitions to true, a positive transition will occur in the summary bit reported to the
next higher level.

Parameters:
<SumBit> Range: 0  to  65535

<ChannelName> String containing the name of the channel.
The parameter is optional. If you omit it, the command works for
the currently active channel.

13.10.1.5 Controlling the Negative Transition Part

For more information on the positive transition part see chapter 12.1.5.2, "Structure of
a SCPI Status Register", on page 238.

STATus:OPERation:NTRansition <SumBit>
STATus:QUEStionable:NTRansition <SumBit>
STATus:QUEStionable:EXTended:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:EXTended:INFO:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:FREQuency:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:LIMit<n>:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:LMARgin<n>:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:POWer:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:TEMPerature:NTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:TIME:NTRansition <SumBit>,<ChannelName>

These commands control the Negative TRansition part of a register.
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Setting a bit causes a 1 to 0 transition in the corresponding bit of the associated regis-
ter. The transition also writes a 1 into the associated bit of the corresponding EVENt
register.

Parameters:
<SumBit> Range: 0  to  65535

<ChannelName> String containing the name of the channel.
The parameter is optional. If you omit it, the command works for
the currently active channel.

13.10.1.6 Controlling the Positive Transition Part

For more information on the negative transition part see chapter 12.1.5.2, "Structure of
a SCPI Status Register", on page 238.

STATus:OPERation:PTRansition <SumBit>
STATus:QUEStionable:PTRansition <SumBit>
STATus:QUEStionable:EXTended:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:EXTended:INFO:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:FREQuency:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:LIMit<n>:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:LMARgin<n>:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:POWer:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:TEMPerature:PTRansition <SumBit>,<ChannelName>
STATus:QUEStionable:TIME:PTRansition <SumBit>,<ChannelName>

These commands control the Positive TRansition part of a register.

Setting a bit causes a 0 to 1 transition in the corresponding bit of the associated regis-
ter. The transition also writes a 1 into the associated bit of the corresponding EVENt
register.

Parameters:
<SumBit> Range: 0  to  65535

<ChannelName> String containing the name of the channel.
The parameter is optional. If you omit it, the command works for
the currently active channel.

13.11 Retrieving Error Messages

SYSTem:ERRor:CLEar:ALL............................................................................................427
SYSTem:ERRor:EXTended?...........................................................................................428
SYSTem:ERRor:LIST?................................................................................................... 428
SYSTem:ERRor[:NEXT]?................................................................................................429

SYSTem:ERRor:CLEar:ALL

This command deletes all contents of the "System Messages" table.
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Example: SYST:ERR:CLE:ALL
Usage: Event

SYSTem:ERRor:EXTended? <MessageType>[, <ChannelName>]

This command queries all system messages, or all messages of a defined type, dis-
played in the status bar for a specific measurement channel (application).

Note: This command queries the strings displayed for manual operation. For remote
programs, do not define processing steps depending on these results. Instead, query
the results of the STATus:QUEStionable:EXTended:INFO status register, which
indicates whether messages of a certain type have occurred (see "STATus:QUEStion-
able:EXTended:INFO Register" on page 243).

Query parameters: 
<MessageType> ALL | INFO | WARNing | ERRor | FATal | MESSage

<ChannelName> String containing the name of the channel.
The parameter is optional. If you omit it, the command works for
the currently active channel.

Return values: 
<Messages> String containing all messages of the selected type for the speci-

fied measurement channel. Each message is separated by a
comma and inserted in parentheses. If no messages are availa-
ble, empty parentheses are returned.

Example: SYST:ERR:EXT? ALL
Returns all messages for the currently active application, e.g.
"Message 1","Message 2".

Example: SYST:ERR:EXT? FAT,'Spectrum2'
Queries fatal errors in the 'Spectrum2' application. If none have
occurred, the result is: "  ".

Usage: Query only

SYSTem:ERRor:LIST? [<MessType>]

This command queries the error messages that occur during R&S VSE operation.

Query parameters: 
<MessType> SMSG

(default) Queries the system messages which occurred during
manual operation.
REMote
Queries the error messages that occurred during remote opera-
tion.
Note: The remote error list is automatically cleared when the
R&S VSE is shut down.

Return values: 
<SystemMessages> String containing all messages in the "System Messages" table.
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<RemoteErrors> <Error_no> | <Description> | <Command> | <Date> | <Time>
Comma-separated list of errors from the "Remote Errors" table,
where:
<Error_no>: device-specific error code
<Description>: brief description of the error
<Command>: remote command causing the error
<Date>|<Time>: date and time the error occurred

Example: SYST:ERR:LIST?
Usage: Query only

SYSTem:ERRor[:NEXT]?

This command queries the most recent error queue entry and deletes it.

Positive error numbers indicate device-specific errors, negative error numbers are error
messages defined by SCPI. If the error queue is empty, the error number 0, "No error",
is returned.

For details on error queues see chapter 12.1.5, "Status Reporting System",
on page 236.

Usage: Query only

13.12 Programming Examples

The following programming examples demonstrate how to capture I/Q data and per-
form basic I/Q data analysis using the I/Q Analyzer in a remote environment.

● Configuring File Input............................................................................................429
● Configuring Input from an Instrument....................................................................430
● Performing a Sequence of Measurements............................................................431
● Basic I/Q Analysis................................................................................................. 433
● Recording I/Q Data............................................................................................... 436
● Saving and Loading Measurement Settings......................................................... 437
● Programming Example: Complete Sequential Measurement with Data Export....438

13.12.1 Configuring File Input

This example demonstrates how to configure input from a file for a measurement in a
remote environment.

//********** Prepare software **********
*RST

//Assign the file as input source for the default channel 1 in VSE **********
INST:BLOC:CHAN:SETT:SOUR FILE
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//Define file to load
INST:BLOC:CHAN:FILE 'C:\ProgramData\Rohde-Schwarz\VSE\1.0_11\user\vsa\DemoSignals\
GSM_8PSK.iq.tar',866KHZ

//Load 10ms of measurement time, starting at 1ms; current display at 2.5ms from start
INST:BLOC:CHAN:SETT:FILE:STAR:TIME   0.001
INST:BLOC:CHAN:SETT:FILE:STOP:TIME   0.01
INST:BLOC:CHAN:SETT:FILE:CURR:TIME   0.0025

//Start playing the data from the current position in single measurement mode
INIT:CONT OFF
INIT:IMM;*WAI

13.12.2 Configuring Input from an Instrument

This example demonstrates how to configure two different connected instruments for a
measurement in a remote environment. Only one instrument is used for input in this
example. For a more complex example see chapter 13.12.3, "Performing a Sequence
of Measurements", on page 431.

//Prepare software
*RST
//Configure connection to MyFSW at 123.456.789.100 using VSI11 protocol
DEV:CRE 'MyFSW','123.456.789.100',VXI11;*WAI
//Query the network address of MyFSW
DEV:TARG? 'MyFSW'
//Result: '123.456.789.100'
//Query connection state to MyFSW
DEV:STAT? 'MyFSW'
//Result: 1 (connection established)

//Query information on MyFSW
//Installed hardware?
DEV:INFO:HWIN? 'MyFSW'
//Instrument ID?
DEV:INFO:IDN? 'MyFSW'
//Installed options?
DEV:INFO:OPT? 'MyFSW'

//Define the use of an external reference on MyFSW
DEV:EXTR:SOUR 'MyFSW',EXT
DEV:EXTR:FREQ  'MyFSW',13MHZ

//Assign MyFSW as input source for default channel 1 in VSE
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV  'MyFSW'

//Configure connection to YourFSW at 100.100.100.99 using HiSlip protocol
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DEV:CRE 'YourFSW','100.100.100.99',HiSlip

//Start capturing data from MyFSW
//Select default channel 1
INST 'IQ Analyzer'
//Start measurement on channel 1
INIT:IMM;*WAI

13.12.3 Performing a Sequence of Measurements

This example demonstrates how to configure and perform a sequence of measure-
ments in a remote environment. It assumes the instruments 'MyFSW' and 'YourFSW'
have been configured, as described in chapter 13.12.2, "Configuring Input from an
Instrument", on page 430.

//********** Prepare software **********
*RST

//********** Configure four channels **********
//1) (default): IQ Analyzer: I/Q Analyzer for instrument input from 'MyFSW', 
//2) AnalogDemodFSW: AnalogDemod for instrument input from 'MyFSW',
//3) Your IQ Analyzer: I/Q Analyzer for instrument input from 'YourFSW'
//4) AnalogDemodFile: AnalogDemod for file input

//Create channel 2
INST:CRE:NEW ADEM,'AnalogDemodFSW'
//Duplicate default channel 1 to create channel 3
INST:SEL 'IQ Analyzer'
INST:CRE:DUPL
//Result: 'IQ Analyzer 2'
INST:REN 'IQ Analyzer 2','Your IQ Analyzer'
//Create channel 4
INST:CRE:NEW ADEM,'AnalogDemodFile'
//Query list of channels
INST:LIST?
//Result: 'IQ','IQ Analyzer', 'ADEM','AnalogDemodFSW', 'IQ','Your IQ Analyzer',
//'ADEM','AnalogDemodFile'

//Configure input sources for each channel
INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV  'MyFSW'

INST:SEL 'AnalogDemodFSW'
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV 'MyFSW'

INST:SEL 'Your IQ Analyzer'
INST:BLOC:CHAN:SETT:SOUR DEV
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INST:BLOC:CHAN:SETT:DEV 'YourFSW'

INST:SEL 'AnalogDemodFile'
INST:BLOC:CHAN:SETT:SOUR FILE
INST:BLOC:CHAN:FILE 'C:\ProgramData\Rohde-Schwarz\VSE\0.90a_32\user\vsa\
DemoSignals\GSM_8PSK.iq.tar',866KHZ

//********** Configure two groups **********
//Measurements on one instrument cannot be performed simultaneously 
//-> Separate channels using same instrument as input into different groups:
//Group 1: (default)'Group 1': channels 1,3
//Group 2: 'AdemodGroup': channels 2,4

//Create new group 2:
INST:BLOC:CRE 'AdemodGroup', 'Group 1'
//Move channels 2+4 to new group:
INST:BLOC:CHAN:MOVE 'AdemodGroup','','AnalogDemodFSW'
INST:BLOC:CHAN:MOVE 'AdemodGroup','AnalogDemodFSW','AnalogDemodFile'

//Query list of channels in group 2:
INST:BLOC:LIST?
//Result: 'AnalogDemodFSW','AnalogDemodFile'
//Query list of channels in group 1:
INST:BLOC:SEL 'Group 1'
INST:BLOC:LIST?
//Result: 'IQ Analyzer','Your IQ Analyzer'

//********** Activate all channels and groups for measurement **********
INST:BLOC:CHAN:USE 1,'IQ Analyzer'
INST:BLOC:CHAN:USE 1,'AnalogDemodFSW'
INST:BLOC:CHAN:USE 1,'Your IQ Analyzer'
INST:BLOC:CHAN:USE 1,'AnalogDemodFile'
INST:BLOC:USE 1, 'Group 1'
INST:BLOC:USE 1, 'AdemodGroup'

//********** Perform a single measurement on all groups **********
//Measurements 1+3 are started simultaneously; 
//When I/Q Analyzer measurements on both instruments are finished, 
//measurements 2+4 are started;
INIT:SEQ:MODE SING
INIT:SEQ:IMM;*WAI

//********** Retrieve results for I/Q Analyzer channel **********
INST:SEL 'IQ Analyzer'
TRAC:DATA? TRACE1
//Returns the magnitude for each trace point
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13.12.4 Basic I/Q Analysis

This example demonstrates how to configure and perform a basic I/Q data acquisition
and analyze the data using the I/Q Analyzer in a remote environment.

//--------------Activate the I/Q Analyzer application ---------------------
//Reset the software
*RST
//Default channel is I/Q Analyzer with Magnitude result display
//For demonstration purposes, create a new channel for I/Q Analyzer
INST:CRE:NEW IQ,'My IQ Analyzer'
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV 'MyFSW'

//--------------Configure data acquisition-------------
//Define the sample rate
TRAC:IQ:SRAT 32MHZ
//Set the record length (number of samples to capture) to 1000 samples
TRAC:IQ:RLEN 1000
//Query the bandwidth of the resampling filter, determined by the sample rate
TRAC:IQ:BWID?

//--------------Configure the trace--------------------
//Define averaging for the I/Q trace
TRAC:IQ:AVER ON
//Define an average over 10 measurements
TRAC:IQ:AVER:COUN 10

//Add traces with different trace modes
DISP:TRAC1:MODE WRIT
DISP:TRAC2:MODE MAXH
DISP:TRAC3:MODE MINH

//--------------Perform the measurement---------------------
//Initiate a new measurement and wait until the measurement has finished
INIT:CONT OFF
INIT;*WAI

//---------------Retrieve results----------------------------
//Format the data as 32-byte real values
INST:SEL 'My IQ Analyzer'
//Use real 32-bit format for data
FORM:DATA REAL,32
//List all I values first, then all Q values in the trace results
TRAC:IQ:DATA:FORM IQP

//Query the magnitude for each trace point
TRAC:DATA? TRACE1
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TRAC:DATA? TRACE2
TRAC:DATA? TRACE3

//Change the result display to Real/Imag (I/Q)
LAY:REPL:WIND '1',RIMAG

//Configure searches to search both I and Q branches
CALC:MARK:SEAR MAGN
//Query the result of the peak search on both branches
CALC:MARK:Y?

//Query the first 500 samples of the stored I/Q data for the measurement
TRAC:IQ:DATA:MEM? 0,500
//For each sample, first the I-value, then the Q-value is listed.

//Query the second half of the 1000 captured sample values
TRAC:IQ:DATA:MEM? 500,500

13.12.4.1 Programming Example: Configuring a Spectrogram

This example demonstrates how to configure a spectrogram for a basic I/Q measure-
ment in a remote environment. The spectrogram is displayed in a subwindow of the
Spectrum display. In addition, the usage of special spectrogram markers is demonstra-
ted (see "Marker Search (Spectrograms)" on page 359).

//-----------Preparing the Measurement ------------
//Reset the I/Q Analyzer channel settings, but not the instrument assignment
INST:SEL 'My IQ Analyzer'
SYST:PRES:CHAN
//Add a Spectrum result display
LAY:ADD:WIND? '1',RIGH,FREQ
//Result is window name: '2'
//Display a Spectrogram 
CALC2:SPEC:STAT ON
//The spectrogram is updated with each new measurement.

//--------------Configuring the Spectrogram--------------
//Clear the displayed spectrogram to start a new one
CALC2:SGR:CLE
//Configure a continuous spectrogram for a series of measurements.
//The display is not cleared when a new measurement is started.
CALC2:SGR:CONT ON
//Set the number of frames to be recorded per measurement to 100.
CALC2:SGR:FRAM:COUN 100
//Set the number of frames to be stored to 1000 (=10 measurements)
CALC2:SGR:HDEP 1000

//--------------Configuring the Color Map----------------
//Define a gray-scaled coloring: low values light gray, high values dark gray
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DISP:WIND2:SGR:COL GRAY
//Define a color map for a range that comprises 40% of the measurement range,
//excluding 30% at each end. The colors are not scaled linearly; the light gray  
//colors are stretched to distinguish low values better.
DISP:WIND2:SGR:COL:LOW 30
DISP:WIND2:SGR:COL:UPP 70
DISP:WIND2:SGR:COL:SHAP 0.8

//--------------Performing the Measurement---------------
//Select single capture mode.
INIT:CONT OFF
//Define 10 captures to be performed per measurement
SENS:AVER:COUN 10
//Initiate a new measurement and wait until the captures have finished
INIT;*WAI
//The spectrogram is updated with each new capture

//--------------Positioning Markers----------------------
//Includes all frames in the memory in the search area 
CALC2:MARK:SGR:SAR MEM
//Set marker 1 to the frame 1 second after measurement begin. (Note the
//negative value!
CALC2:MARK1:SGR:FRAM -1s
//Set marker 1 to the minimum level in this frame
CALC2:MARK1:MIN
//Set marker 1 to the minimum level for the same frequency the marker is 
//currently positioned at in all frames.
CALC2:MARK1:SGR:Y:MIN
//Set marker 2 to the maximum level in the entire spectrogram.
CALC2:MARK2:SGR:XY:MAX
//Set the deltamarker 1 to the frame number -3. By default
//it is set to the peak of that frame and displays the level difference to marker 1.
//Note the negative value!
CALC2:DELT1:SGR:FRAM -3
//Set deltamarker 1 to the minimum level in this frame.
CALC2:DELT1:MIN
//Set deltamarker 3 to the maximum level in the entire spectrogram. By default
//its value is the difference to marker 1. We will change it to refer to marker 2.
CALC2:DELT3:SGR:XY:MAX
CALC2:DELT3:MREF 2
//Deltamarker 3 now refers to marker 2, both are positioned on the maximum of the
//spectrogram. Thus, D3=0.

//---------------Retrieving Results----------------------
//Query the frequency (x), level (y) and frame values of marker 1.
CALC2:MARK1:X?
CALC2:MARK1:Y?
CALC2:MARK1:SGR:FRAM?
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//Query the frequency (x), level (y) and frame values of marker 2.
CALC2:MARK2:X?
CALC2:MARK2:Y?
CALC2:MARK2:SGR:FRAM?

//Query the frequency (x), level (y) and frame values of deltamarker 1.
CALC2:DELT1:X?
CALC2:DELT1:Y?
CALC2:DELT1:SGR:FRAM?

//Query the frequency (x), level (y) and frame values of deltamarker 3.
CALC2:DELT3:X?
CALC2:DELT3:Y?
CALC2:DELT3:SGR:FRAM?

//Select the frame that was captured 1 second after measurement start (Note the
//negative value!). This frame is displayed in the Spectrum window.
CALC2:SGR:FRAM:SEL -1
//Retrieve the Spectrum trace data for the selected frame only.
TRAC2:DATA? TRACE1

13.12.4.2 Programming Example: Marker Search in Spectrograms

This example demonstrates how to search for peak values in spectrograms in a remote
environment. It assumes a spectrogram is already available (see chapter 13.12.4.1,
"Programming Example: Configuring a Spectrogram", on page 434) and thus does not
begin by presetting the instrument.

//---------------- Analyzing the results using markers -------------------
//Set marker1 on the peak power in the most recent spectrum and query
//its position
CALC2:SPEC:FRAM:SEL 0
CALC2:MARK1 ON
CALC2:MARK1:X?
CALC2:MARK1:Y?

//Set marker3 on peak power level in the entire spectrogram in memory and
//query its position
CALC2:MARK3 ON
CALC2:MARK:SPEC:SAR MEM
CALC2:MARK3:SPEC:XY:MAX
CALC2:MARK3:X?
CALC2:MARK3:Y?

13.12.5 Recording I/Q Data

This example demonstrates how to record I/Q data in a remote environment. It
assumes a measurement has been configured as described in chapter 13.12.4, "Basic
I/Q Analysis", on page 433.
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How to recall recorded I/Q data in a remote environment is described in chap-
ter 13.12.1, "Configuring File Input", on page 429.

//********** Configure recording **********
//Store most recent 10 measurements (10 * 1000 records)
REC:COUN 10
REC:MAX:RLEN OFF
//Configure default comment to be 'FSW_data_'
REC:COMM 'FSW_data_'
//Store additional samples for settling time (for demonstration purposes only)
REC:SETT:TIME ON

//********** Perform the measurement **********
INST:SEL 'My IQ Analyzer'
INST:BLOC:CHAN:REC;*WAI

//********** Export the recorded data **********
//Include minimum set of meta data except for input path, plus
//preamplifier, input impedance
EXP:IQ:META:DATA:SET MIN
EXP:IQ:META:DATA:SET CUST
EXP:IQ:META:DATA 'InputCoupling',OFF
EXP:IQ:META:DATA 'PreampState',ON

//Store the data to an iq.tar file 
EXP:IQ:FORM IQTAR;*WAI;
EXP:IQ:FILE 'C:\ProgramData\Rohde-Schwarz\VSE\1.0_11\user\
MyFSW_IQanalyzer_results.iq.tar'

13.12.6 Saving and Loading Measurement Settings

This example demonstrates how to save and load measurement settings in a remote
environment. It assumes a measurement has been configured as described in chap-
ter 13.12.4, "Basic I/Q Analysis", on page 433.

//********* Store the channel settings **********

//Select the channel whose settings are to be saved
INST:SEL 'My IQ Analyzer'
//Specify that channel-specific data is to be stored.
MMEM:STOR:TYPE CHAN
//Store the channel settings from the 'My IQ Analyzer' channel
// to the file 'MyFSW_IQanalyzer.dfl'. 
MMEM:STOR:STAT 1, 'C:\temp\MyFSW_IQanalyzer.dfl'

//********* Load the channel settings **********

//Specify that settings will be loaded to a new channel besides the existing 
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//'My IQ Analyzer' channel.
MMEM:LOAD:TYPE NEW
//Select all settings and results to be loaded.
MMEM:SEL:CHAN:ALL
//Load the channel-specific settings from the file 'MyFSW_IQanalyzer.dfl'
//to a new channel. The new channel is named 'My IQ Analyzer 2' by default
MMEM:LOAD:STAT 1, 'C:\temp\MyFSW_IQanalyzer.dfl'
//Rename the loaded channel to 'MyFSW_IQanalyzer_FromFile'.
INST:REN 'My IQ Analyzer 2','MyFSW_IQanalyzer_FromFile'

13.12.7 Programming Example: Complete Sequential Measurement with
Data Export

The following example comprises many of the tasks described above to provide a com-
plete measurement example in one script.

For this measurement, two instruments (R&S FSW) are configured for input. The mea-
surement consists of four measurement channels:

1) IQ Analyzer: I/Q Analyzer for instrument input from 'MyFSW',

2) AnalogDemodFSW: AnalogDemod for instrument input from 'MyFSW',

3) Your IQ Analyzer: I/Q Analyzer for instrument input from 'YourFSW'

4) AnalogDemodFile: AnalogDemod for file input

The individual measurements are configured, then performed and the captured data is
recorded. Finally, the recorded data and the measurement results are stored to a file.

//****************************************
//********** Prepare software **********
//****************************************
*RST

//******************************************************
//********** Configure instrument connections **********
//******************************************************

//Configure connection to MyFSW at 123.456.789.100 using VSI11 protocol
DEV:CRE 'MyFSW','123.456.789.100',VXI11
//Query the network address of MyFSW
DEV:TARG? 'MyFSW'
//Result: '123.456.789.100'
//Query connection state to MyFSW
DEV:STAT? 'MyFSW'
//Result: 1 (connection established)

//Query information on MyFSW
//Installed hardware?
DEV:INFO:HWIN? 'MyFSW'
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//Instrument ID?
DEV:INFO:IDN? 'MyFSW'
//Installed options?
DEV:INFO:OPT? 'MyFSW'

//Define the use of an external reference on MyFSW
DEV:EXTR:SOUR 'MyFSW',EXT
DEV:EXTR:FREQ  'MyFSW',13MHZ

//Assign MyFSW as input source for default channel 1
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV  'MyFSW'

//Configure connection to YourFSW at 100.100.100.99 using HiSlip protocol
DEV:CRE 'YourFSW','100.100.100.99',HiSlip

//*********************************************
//********** Configure four channels **********
//*********************************************

//1) (default): IQ Analyzer: I/Q Analyzer for instrument input from 'MyFSW', 
//2) AnalogDemodFSW: AnalogDemod for instrument input from 'MyFSW',
//3) Your IQ Analyzer: I/Q Analyzer for instrument input from 'YourFSW'
//4) AnalogDemodFile: AnalogDemod for file input

//Create channel 2
INST:CRE:NEW ADEM,'AnalogDemodFSW'
//Duplicate default channel 1 to create channel 3
INST:SEL 'IQ Analyzer'
INST:CRE:DUPL
//Result: 'IQ Analyzer 2'
INST:REN 'IQ Analyzer 2','Your IQ Analyzer'
//Create channel 4
INST:CRE:NEW ADEM,'AnalogDemodFile'
//Query list of channels
INST:LIST?
//Result: 'IQ','IQ Analyzer', 'ADEM','AnalogDemodFSW', 'IQ','Your IQ Analyzer', 
//'ADEM','AnalogDemodFile'

//Configure input sources for each channel
INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV  'MyFSW'

INST:SEL 'AnalogDemodFSW'
INST:BLOC:CHAN:SETT:SOUR DEV
INST:BLOC:CHAN:SETT:DEV  'MyFSW'

INST:SEL 'Your IQ Analyzer'
INST:BLOC:CHAN:SETT:SOUR DEV
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INST:BLOC:CHAN:SETT:DEV  'YourFSW'

INST:SEL 'AnalogDemodFile'
INST:BLOC:CHAN:SETT:SOUR FILE
INST:BLOC:CHAN:FILE 'C:\temp\vsa\
DemoSignals\GSM_8PSK.iq.tar',866KHZ
//Load 10ms of measurement time, starting at 1ms; current display at 2.5ms from start
INST:BLOC:CHAN:SETT:FILE:STAR:TIME 0.001
INST:BLOC:CHAN:SETT:FILE:STOP:TIME 0.01
INST:BLOC:CHAN:SETT:FILE:CURR:TIME 0.0025

//******************************************
//********** Configure two groups **********
//******************************************

//Measurements on one instrument cannot be performed simultaneously 
//-> Separate channels using same instrument as input into different groups:
//Group 1: (default)'Group 1': channels 1,3
//Group 2: 'AdemodGroup': channels 2,4

//Create new group 2:
INST:BLOC:CRE 'AdemodGroup', 'Group 1'
//Move channels 2+4 to new group:
INST:BLOC:CHAN:MOVE 'AdemodGroup','','AnalogDemodFSW'
INST:BLOC:CHAN:MOVE 'AdemodGroup','AnalogDemodFSW','AnalogDemodFile'

//Query list of channels in group 2:
INST:BLOC:LIST?
//Result: 'AnalogDemodFSW','AnalogDemodFile'
//Query list of channels in group 1:
INST:BLOC:SEL 'Group 1'
INST:BLOC:LIST?
//Result: 'IQ Analyzer','Your IQ Analyzer'

//Activate all channels and groups for measurement
INST:BLOC:CHAN:USE 1,'IQ Analyzer'
INST:BLOC:CHAN:USE 1,'AnalogDemodFSW'
INST:BLOC:CHAN:USE 1,'Your IQ Analyzer'
INST:BLOC:CHAN:USE 1,'AnalogDemodFile'
INST:BLOC:USE 1, 'Group 1'
INST:BLOC:USE 1, 'AdemodGroup'

//************************************************************
//********** Configure the I/Q Analyzer application **********
//************************************************************

//Select the channel
INST:SEL 'IQ Analyzer'

//********** Configure data acquisition **********
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//Define the sample rate.
TRAC:IQ:SRAT 32MHZ
//Set the record length (number of samples to capture) to 1000 samples.
TRAC:IQ:RLEN 1000
//Query the bandwidth of the resampling filter, determined by the sample rate
TRAC:IQ:BWID?
//Format the data as 32-byte real values.
FORM:DATA REAL,32
//List all I values first, then all Q values in the trace results.
TRAC:IQ:DATA:FORM IQP

//********** Configure the trace **********
//Define averaging for the I/Q trace.
TRAC:IQ:AVER ON
//Define an average over 10 captures.
TRAC:IQ:AVER:COUN 10

//Change the trace modes.
DISP:TRAC1:MODE WRIT
DISP:TRAC2:MODE MAXH
DISP:TRAC3:MODE MINH

//*********************************************************************
//**********  Configure the Analog Demod measurement channel **********
//*********************************************************************

//Select Analog Demod channel
INST:SEL 'AnalogDemodFSW'

//Set the center frequency to 500 MHz
FREQ:CENT 500 MHz
//Set the reference level to 0 dBm
DISP:TRAC:Y:SCAL:RLEV 0

//**********  Configure data acquisition **********

//Set the measurement time to 1 ms (=10 periods)
ADEM:MTIM 1ms
//Optimize the scaling of the y-axis for the current measurement (continuously)
SENS:ADJ:SCAL:Y:AUTO ON
//Set the demodulation bandwidth to 400 kHz
BAND:DEM 400 kHz
//Use (offline) FM trigger
TRIG:SOUR IQP
//Trigger when magnitude of I/Q data reaches -50dBm
TRIG:LEV:IQP -50

//**********  Configure the result display **********

//Add an FM Spectrum result display below FM Time Domain
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LAY:ADD:WIND? '1',BEL,'XTIM:FM:AFSP'
//Define two traces in the FM Spectrum: 1: Clear/write, 2: average
ADEM:FM:AFSP WRIT,AVER,OFF,OFF,OFF,OFF
//Define two traces in the FM Time domain: 1: Clear/write, 2: average
ADEM:FM:AFSP WRIT,AVER,OFF,OFF,OFF,OFF
//Set analog demodulator to execute 30 captures with 32000 samples each
//at a sample rate of 8 MHz; use IQP trigger, trigger on positive slope
//with a pretrigger offset of 500 samples
ADEM:SET 8MHz,32000,IQP,POS,-500,30

//****************************************************************
//********** Perform a single measurement on all groups **********
//****************************************************************

//Measurements 1+3 are started simultaneously; 
//When I/Q Analyzer measurements on both instruments are finished, 
//measurements 2+4 are started;
INIT:SEQ:MODE SING
INIT:SEQ:IMM;*WAI

//******************************************************
//********** Retrieve results for I/Q Analyzer**********
//******************************************************

//Return the magnitude for each trace point
INST:SEL 'IQ Analyzer'
TRAC:DATA? TRACE1
TRAC:DATA? TRACE2
TRAC:DATA? TRACE3

//Change the result display to Real/Imag (I/Q)
LAY:REPL:WIND '1',RIMAG

//Configure searches to search both I and Q branches.
CALC:MARK:SEAR MAGN
//Query the result of the peak search on both branches.
CALC:MARK:Y?

//Return the first 500 samples of the stored I/Q data for the measurement.
//For each sample, first the I-value, then the Q-value is listed.
TRAC:IQ:DATA:MEM? 0,500

//Return the second half of the 1000 captured sample values.
TRAC:IQ:DATA:MEM? 500,500

//**************************************************************
//********** Retrieve Results for Analog Demodulation **********
//**************************************************************

INST:SEL 'AnalogDemodFSW'
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//Query the carrier power
CALC:MARK:FUNC:ADEM:CARR?
//Result: -10.37 [dBm]
//Retrieve the trace data of the most recent measurement (trace 1)
TRAC:DATA? TRACE1
//Result: -1.201362252,-1.173495054,-1.187217355,-1.186594367,-1.171583891,
//-1.188250422,-1.204138160,-1.181404829,-1.186317205,-1.197872400, [...]
//Retrieve the averaged trace data for all 30 measurements (trace 2)
TRAC:DATA? TRACE2
//Result: -1.201362252,-1.173495054,-1.187217355,-1.186594367,-1.171583891,
//-1.188250422,-1.204138160,-1.181404829,-1.186317205,-1.197872400, [...]

//*****************************************
//********** Configure recording **********
//*****************************************

//Store most recent 10 measurements (10 * 1000 records)
REC:COUN 10
REC:MAX:RLEN OFF
//Configure default comment to be 'FSW_data_'
REC:COMM 'FSW_data_'
//Store additional samples for settling time (for demonstration purposes only)
REC:SETT:TIME ON

//Perform the measurement
INST:SEL 'IQ Analyzer'
INST:BLOC:CHAN:REC

//Export the recorded data
//Include minimum set of meta data except for input path, plus
//preamplifier, input impedance
EXP:IQ:META:DATA:SET MIN
EXP:IQ:META:DATA:SET CUST
EXP:IQ:META:DATA 'InputCoupling',OFF
EXP:IQ:META:DATA 'PreampState',ON

//Store the data to an iq.tar file 
EXP:IQ:FORM IQTAR;*WAI
EXP:IQ:FILE 'C:\temp\MyFSW_IQanalyzer_results.iq.tar'

//***********************************************
//********* Store the channel settings **********
//***********************************************

//Select the channel whose settings are to be saved
INST:SEL 'IQ Analyzer'
//Specify that channel-specific data is to be stored.
MMEM:STOR:TYPE CHAN
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//Store the channel settings from the 'IQ Analyzer' channel
// to the file 'MyFSW_IQanalyzer.dfl'. 
MMEM:STOR:STAT 1, 'C:\temp\MyFSW_IQanalyzer.dfl'

//**********************************************
//********* Load the channel settings **********
//**********************************************

//Specify that settings will be loaded to a new channel besides the existing 
//'IQ Analyzer' channel.
MMEM:LOAD:TYPE NEW
//Select all settings and results to be loaded.
MMEM:SEL:CHAN:ALL
//Load the channel-specific settings from the file 'MyFSW_IQanalyzer.dfl'
//to a new channel. The new channel is named 'IQ Analyzer 2' by default
MMEM:LOAD:STAT 1, 'C:\temp\MyFSW_IQanalyzer.dfl'
//Rename the loaded channel to 'MyFSW_IQanalyzer_FromFile'.
INST:REN 'IQ Analyzer 2','MyFSW_IQanalyzer_FromFile'

Programming Examples



TroubleshootingR&S®VSE

445User Manual 1176.8839.02 ─ 03

14 Troubleshooting
If the results do not meet your expectations, or problems occur, the following informa-
tion may help you solve your problem.

● Troubleshooting Remote Operation......................................................................445
● Error Messages in Remote Control Mode.............................................................446
● Obtaining Technical Support.................................................................................447

14.1 Troubleshooting Remote Operation

If problems arise during measurement in remote operation, try the following methods to
solve them.

Uncompleted sequential commands - blocked remote channels

If a sequential command cannot be completed, for example because a triggered sweep
never receives a trigger, the remote control program will never finish and the remote
channel to the R&S VSE is blocked for further commands. In this case, you must inter-
rupt processing on the remote channel in order to abort the measurement.

To regain control over a blocked remote channel

Usually, if you wait a minute for the VISA connection to detect the lost connection and
clear the control channel by itself, you can then re-establish the connection again. If
this fails, try the following:

1. Press "Local" on the front panel of the instrument in use to return to manual opera-
tion (if not disabled). Then re-establish the connection.

2. Send a "Device Clear" command from the control instrument to the R&S VSE to
clear all currently active remote channels. Depending on the used interface and
protocol, send the following commands:

● Visa: viClear()
The remote channel currently processing the uncompleted command is then ready
to receive further commands again.

3. On the remote channel performing the measurement, send the SCPI command
ABORt to abort the current measurement and reset the trigger system.

4. If the instrument in use still does not react to the remote commands, switch it off
and back on.

Ignored commands

When a remote command attempts to define incompatible settings, the command is
ignored and the instrument status remains unchanged, i.e. other settings are not auto-
matically adapted. Therefore, control programs should always define an initial instru-
ment status (e.g. using the *RST command) and then implement the required settings.
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Detecting false commands

If a remote program does not provide the expected results and you are using a GPIB
connection, you can log the commands and any errors that may occur. To activate the
SCPI error log function, in the "Network + Remote" dialog box, in the "GPIB" tab,
select"I/O Logging".

All remote control commands received by the R&S VSE are recorded in the following
log file:

C:\R_S\instr\ScpiLogging\ScpiLog.txt
Logging the commands may be extremely useful for debug purposes, e.g. in order to
find misspelled keywords in control programs. However, remember to turn off the log-
ging function after debugging to avoid unnecessary access to the hard drive and use of
storage space.

14.2 Error Messages in Remote Control Mode

In remote control mode error messages are entered in the error/event queue of the sta-
tus reporting system and can be queried with the command SYSTem:ERRor?. The
answer format of R&S VSE to the command is as follows:

<error code>, "<error text with queue query>; <remote control
command concerned>"
The indication of the remote control command with prefixed semicolon is optional.

Example: 
The command TEST:COMMAND generates the following answer to the query
SYSTem:ERRor?
-113,"Undefined header;TEST:COMMAND"

There are two types of error messages:

● Error messages defined by SCPI are marked by negative error codes. These mes-
sages are defined and described in the SCPI standard and not listed here.

● Device-specific error messages use positive error codes. These messages are
described below.

Table 14-1: Device-specific error messages

Error code Error text in the case of queue poll

Error explanation

1052 Frontend LO is Unlocked

This message is displayed when the phase regulation of the local oscillator fails in the RF
front-end.

1060 Trigger-Block Gate Delay Error- gate length < Gate Delay

This message is displayed when the gate signal length is not sufficient for the pull-in delay
with a predefined gate delay.
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Error code Error text in the case of queue poll

Error explanation

1064 Tracking LO is Unlocked

This message is displayed when the phase regulation of the local oscillator fails on the
external generator module.

2028 Hardcopy not possible during measurement sequence

This message is displayed when a printout is started during scan sequences that cannot
be interrupted. Such sequences are for example:
● Recording the system error correction data (alignment)
● Instrument self-test

In such cases synchronization to the end of the scan sequence should be performed prior
to starting the printout.

2033 Printer Not Available

This message is displayed when the selected printer is not included in the list of available
output devices. A possible cause is that the required printer driver is missing or incorrectly
installed.

2034 CPU Temperature is too high

This message is displayed when the temperature of the processor exceeds 70 °C.

14.3 Obtaining Technical Support

If problems occur, the software generates error messages which in most cases will be
sufficient for you to detect the cause of an error and find a remedy.

Error messages are described in chapter 14, "Troubleshooting", on page 445.

In addition, our customer support centers are there to assist you in solving any prob-
lems that you may encounter with your R&S VSE. We will find solutions more quickly
and efficiently if you provide us with the information listed below.
● Error Log: The log file

(C:\ProgramData\Rohde-Schwarz\VSE\<version_number>\log\
RSError.log contains a chronological record of errors.

● Support file: a *.zip file with important support information can be created auto-
matically. The *.zip file contains the system configuration information, the current
software data and a screenshot of the screen display.

See also chapter 9.4.2, "R&S Support Information", on page 110.

To collect the support information

► Select "Help > Support" and then "Create R&S Support Information".

This data is stored to the following directory on the PC the R&S VSE software is
installed on:
C:\ProgramData\Rohde-Schwarz\VSE\<version_no>\user.
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Attach the files to an e-mail in which you describe the problem and send it to the cus-
tomer support address for your region as listed in the Internet (http://www.rohde-
schwarz.com/en/service-support/customer_support_107711.html).

Obtaining Technical Support
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A Reference

A.1 Menu Reference

Most functions in the R&S VSE are available from the menus.

● Common R&S VSE Menus................................................................................... 449
● I/Q Analyzer Menus...............................................................................................452

A.1.1 Common R&S VSE Menus

The following menus provide basic functions for all applications:

● File Menu.............................................................................................................. 449
● Window Menu....................................................................................................... 451
● Help Menu.............................................................................................................452

A.1.1.1 File Menu

The "File" menu includes all functionality directly related to any file operations, printing
or setting up general parameters.

Menu item Correspond-
ing icon in
toolbar

Description

Save Saves the current software configuration to a file

See chapter 8.2, "Storing and Recalling Measurement Settings",
on page 77

Recall Recalls a saved software configuration from a file

See chapter 8.2, "Storing and Recalling Measurement Settings",
on page 77

Save IQ Recording - Saves the recorded I/Q data from a measurement channel to a
file

See chapter 8.3.3, "Exporting Recorded I/Q Data", on page 88

Recall IQ Recording - Loads the recorded I/Q data from a file

See chapter 8.3.4, "Recalling Measurement Data from Files",
on page 92

Measurement Group > - Configures measurement channels and groups

See chapter 7.3, "Controlling Measurement Channels, Groups,
and Sequences", on page 67

> New Group - Inserts a new group in the measurement sequence

See "New Group" on page 70

> New Measurement
Channel

- Inserts a new channel in the selected group

See "  New Channel" on page 73
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Menu item Correspond-
ing icon in
toolbar

Description

> Replace Measure-
ment Channel

- Replaces the currently selected channel by the selected applica-
tion.

See "Replace Current Channel" on page 73

> Delete Current Mea-
surement Channel

- Deletes the currently selected channel.

See "Close" on page 75

> Measurement Group
Setup

- Displays the "Measurement Group Setup" tool window.

See chapter 7.3, "Controlling Measurement Channels, Groups,
and Sequences", on page 67

Instruments > - Configures instruments to be used for input to the R&S VSE soft-
ware

See chapter 7.2, "Configuring Instruments", on page 53

> New - Creates a new instrument configuration

See chapter 7.2.2, "Defining the Connection Information Man-
ually", on page 56

> Search - Searches for connected instruments in the network

See chapter 7.2.4, "Searching for Connected Instruments Auto-
matically", on page 61

> Delete All - Deletes all current instrument configurations

See chapter 7.2.5, "Deleting all Instrument Configurations",
on page 62

> Setup - Hides or displays the "Instrument" tool window

See chapter 7.2, "Configuring Instruments", on page 53

Preset > - Restores stored settings

See chapter 8.1, "Restoring the Default Software Configuration
(Preset)", on page 76

> All - Restores the default software configuration globally for the entire
software

See "Restoring All Default Settings ( Preset All )" on page 76

> All & Delete Instru-
ments

 Restores the default software configuration globally for the entire
software and deletes all instrument configurations

See "Restoring All Default Settings and Deleting Instrument Con-
figurations ( Preset All & Delete Instruments )" on page 76

> Selected Channel - Restores the default software configuration for an individual
channel

See "Restoring Channel Settings ( Preset Selected Channel )"
on page 77

> Reset VSE Layout - Restores the default layout of windows, toolbars etc. in the
R&S VSE software

See "Restoring User-Specific Settings ( Reset VSE Layout )"
on page 77

> Digital Standards - VSA application only

Menu Reference
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Menu item Correspond-
ing icon in
toolbar

Description

> Restore VSA Factory
Settings

- VSA application only:

Restores the standards predefined by Rohde & Schwarz availa-
ble at the time of delivery.

Note that this function will overwrite customized standards that
have the same name as predefined standards.

Preferences > - Configures global software settings

See chapter 9.1, "General Software Behavior", on page 101

> General - See chapter 9.1, "General Software Behavior", on page 101

> Displayed Items - Hides or shows individual screen elements

See chapter 9.2.1, "Displayed Items", on page 102

> Theme & Color - Configures the style of individual screen elements

See chapter 9.2.2, "Display Theme and Colors", on page 103

> Network & Remote - Configures the network settings and remote access to or from
other devices

See chapter 12.2, "Network and Remote Control Settings",
on page 250

> Recording - Configures general recording parameters

See chapter 8.3.2, "General Recording Settings", on page 87

Print - Opens "Print" dialog to print selected measurement results

See chapter 8.4, "Printing Current Measurement Results",
on page 97

Exit - Closes the R&S VSE software

A.1.1.2 Window Menu

The "Window" menu allows you to hide or show individual windows.

Menu item Correspond-
ing icon in
toolbar

Description

Player... - Displays the "Player" tool window to recall I/Q data recordings

See chapter 8.3.4.2, "Restoring the Measurement Results -
R&S VSE Player", on page 94

Instrument Setup... - Displays the "Instruments" window to configure input instruments

See chapter 7.2, "Configuring Instruments", on page 53

Measurement Group
Setup...

- Displays the "Measurement Group Setup" window to configure a
measurement sequence

See chapter 7.3, "Controlling Measurement Channels, Groups,
and Sequences", on page 67

New Window > Inserts a new result display window for the selected measure-
ment channel

See "New Measurement Window" on page 74
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Menu item Correspond-
ing icon in
toolbar

Description

Channel Infos > - Displays the channel bar with global channel information for the
selected meausrement channel

See "Channel bar" on page 41

Active Windows > - Selects a result display as the active window; the corresponding
channel is also activated

See "Active windows, selected window" on page 46

Configure Selected
Result Window

- Displays the "Window Configuration" dialog box to configure
result-specific settings

A.1.1.3 Help Menu

The "Help" menu provides access to help, support and licensing functions.

Menu item Correspond-
ing icon in
toolbar

Description

Help Opens the Online help window

See chapter 6.4, "Getting Help", on page 49

License - Licensing, version and options information

See chapter 9.4.1, "Licensing, Versions and Options",
on page 108

Support - Support functions

See chapter 9.4.2, "R&S Support Information", on page 110

Register VSE - Attempts to create an email with the default mail program (if
available) to the Rohde & Schwarz support address for registra-
tion.

Online Support - Opens the default web browser and attempts to establish an
Internet connection to the Rohde & Schwarz product site.

About - Software version information

A.1.2 I/Q Analyzer Menus

The following menus are only available if an I/Q Analyzer measurement channel is
selected.

● Input & Output Menu.............................................................................................453
● Meas Setup Menu.................................................................................................453
● Trace Menu...........................................................................................................453
● Marker Menu.........................................................................................................454
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A.1.2.1 Input & Output Menu

The "Input & Output" menu provides functions to configure the input source, frontend
parameters and output settings for the measurement.

This menu is application-specific.

Table 1-1: "Input" menu items for the I/Q Analyzer

Menu item Description

Amplitude chapter 10.3.3, "Amplitude", on page 135

Scale chapter 10.3.3.3, "Scaling the Y-Axis", on page 141

Frequency chapter 10.3.4, "Frequency Settings", on page 143

Trigger chapter 10.3.5.2, "Trigger Settings", on page 148

Input Source chapter 10.3.2.1, "Radio Frequency Input", on page 129

Output chapter 10.3.2.3, "Output Settings", on page 133

A.1.2.2 Meas Setup Menu

The "Meas Setup" menu provides access to most measurement-specific settings, as
well as bandwidth, sweep and auto configuration settings, and the configuration "Over-
view" window.

This menu is application-specific.

Table 1-2: "Meas Setup" menu items for the I/Q Analyzer

Menu item Description

Data acquisition chapter 10.3.6.1, "Data Acquisition", on page 154

Capture chapter 10.3.6.2, "Capture Settings", on page 159

Overview chapter 10.3.1, "Configuration Overview", on page 127

A.1.2.3 Trace Menu

The "Trace" menu provides access to trace-specific functions.

See chapter 10.4.1, "Trace Configuration", on page 164

This menu is application-specific.

Table 1-3: "Trace" menu items for the I/Q Analyzer

Menu item Description

Trace <x> Selects the corresponding trace for configuration. The currently selected
trace is highlighted blue

Copy Trace Copies trace data to another trace
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Menu item Description

Spectrogram  

Trace Opens the "Traces" configuration dialog box

A.1.2.4 Marker Menu

The "Marker" menu provides access to marker-specific functions.

This menu is application-specific.

Table 1-4: "Marker" menu items for the I/Q Analyzer

Menu item Correspond-
ing icon in
toolbar

Description

Place New Marker "  Place New Marker" on page 194

Select marker <x> "Select Marker" on page 197

Marker to Trace - "Assigning the Marker to a Trace" on page 196

All Markers Off "All Markers Off" on page 197

Marker... "Individual Marker Setup" on page 193

Search... "Marker Search Settings" on page 199

Marker Function... - chapter 10.4.2, "Marker Usage", on page 187

A.2 Reference of Toolbar Functions

Common functions can be performed via the icons in the toolbars.

Individual toolbars can be hidden or displayed.

Hiding and displaying a toolbar

1. Right-click any toolbar or the menu bar.

A context menu with a list of all available toolbars is displayed.

2. Select the toolbar you want to hide or display.

A checkmark indicates that the toolbar is currently displayed.

The toolbar is toggled on or off.
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Note that some icons are only available for specific applications. Those functions are
described in the individual application's User Manual.

General toolbars

The following functions are generally available for all applications:

"Main" toolbar

For a description of these functions see chapter 8, "Data Management", on page 76.

Table 1-5: Functions in the "Main" toolbar

Icon Description

Overview: Displays the configuration overview for the current measurement channel

Save: Saves the current software configuration to a file

Recall: Recalls a saved software configuration from a file

Save I/Q recording: Stores the recorded I/Q data to a file

Recall I/Q recording: Loads recorded I/Q data from a file

Print immediately: prints the current display (screenshot) as configured

Add Window: Inserts a new result display window for the selected measurement channel

"Control" toolbar

For a description of these functions see chapter 7, "Controlling Instruments and Cap-
turing I/Q Data", on page 52.

Table 1-6: Functions in the "Control" toolbar

Icon Description

Selects the currently active channel

Capture: performs the selected measurement

Pause: temporarily stops the current measurement

Continuous: toggles to continuous measurement mode for next capture

Single: toggles to single measurement mode for next capture

Record: performs the selected measurement and records the captured data and
results

Refresh: Repeats the evaluation of the data currently in the capture buffer without
capturing new data (VSA application only).

Reference of Toolbar Functions
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"Help" toolbar

For a description of these functions see chapter 6.4, "Getting Help", on page 49.

Table 1-7: Functions in the "Help" toolbar

Icon Description

Help (+ Select): allows you to select an object for which context-specific help is displayed

(not available in standard Windows dialog boxes or measurement result windows)

Help: displays context-sensitive help topic for currently selected element

Application-specific toolbars

The following toolbars are application-specific; not all functions shown here may be
available in each application:

"Zoom" toolbar

For a description of these functions see chapter 10.4.3, "Zoomed Displays",
on page 207.

Table 1-8: Functions in the "Zoom" toolbar

Icon Description

Normal mouse mode: the cursor can be used to select (and move) markers in a zoomed display

Zoom mode: displays a dotted rectangle in the diagram that can be expanded to define the
zoom area

Multiple zoom mode: multiple zoom areas can be defined for the same diagram

Zoom off: displays the diagram in its original size

Table 1-9: Functions in the "Marker" toolbar

Icon Description

Place new marker

Select marker

Marker type "normal"

Marker type "delta"

Global peak

Absolute peak

(Currently only for GSM application)

Next peak to the left

Reference of Toolbar Functions
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Icon Description

Next peak to the right

 Next peak up (for spectrograms only: search in more recent frames)

 Next peak down (for spectrograms only: search in previous frames)

Global minimum

Next minimum left

Next minimum right

 Next min up (for spectrograms only: search in more recent frames)

 Next min down (for spectrograms only: search in previous frames)

Set marker value to center frequency

Set reference level to marker value

All markers off

Marker search configuration

Marker configuration

Table 1-10: Functions in the "AutoSet" toolbar

Icon Description

Auto level

Auto frequency

 Auto trigger (R&S VSE GSM application only)

 Auto frame (R&S VSE GSM application only)

 Auto search (R&S VSE 3GPP FDD application only)

 Auto scale (R&S VSE 3GPP FDD + Pulse applications only)

 Auto scale all (R&S VSE 3GPP FDD + Pulse applications only)

Auto all

Configure auto settings

Reference of Toolbar Functions
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A.3 Formats for Returned Values: ASCII Format and
Binary Format

When trace data is retrieved using the TRAC:DATA or TRAC:IQ:DATA command, the
data is returned in the format defined using the FORMat[:DATA]. The possible for-
mats are described here.

● ASCII Format (FORMat ASCII):
The data is stored as a list of comma separated values (CSV) of the measured val-
ues in floating point format.

● Binary Format (FORMat REAL,32):
The data is stored as binary data (Definite Length Block Data according to IEEE
488.2), each measurement value being formatted in 32 Bit IEEE 754 Floating-
Point-Format.
The schema of the result string is as follows:
#41024<value1><value2>…<value n> with

#4 number of digits (= 4 in the example) of the following number of data bytes

1024 number of following data bytes (= 1024 in the example)

<Value> 4-byte floating point value

Reading out data in binary format is quicker than in ASCII format. Thus, binary format
is recommended for large amounts of data.

A.4 Reference: Format Description for I/Q Data Files

This section describes how I/Q data is transferred to the memory during remote control
(see TRACe:IQ:DATA:FORMat on page 381 command).

For details on the format of the individual values, see chapter A.3, "Formats for
Returned Values: ASCII Format and Binary Format", on page 458.

For details on the format of I/Q export files (using the "I/Q Export" function), seechap-
ter A.5, "Reference: Supported File Formats", on page 460 .
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Fig. 1-1: I/Q data formats

Note: 512k corresponds to 524288 samples

For maximum performance, the formats "Compatible" or "IQPair" should be used. Fur-
thermore, for large amounts of data, the data should be in binary format to improve
performance.

In binary format, the number of I- and Q-data can be calculated as follows:

For the format "QBLock", the offset of Q-data in the output buffer can be calculated as
follows:

with "LengthIndicatorDigits" being the number of digits of the length indicator including
the #. In the example above (#41024…), this results in a value of 6 for "LengthIndica-
torDigits" and the offset for the Q-data results in 512 + 6 = 518.

Reference: Format Description for I/Q Data Files
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A.5 Reference: Supported File Formats

Various file types are supported for I/Q data import and export (see chapter 8.3,
"Recording and Recalling Captured I/Q Data for Evaluation", on page 85). The most
important characteristics as well as optional and mandatory data elements for each for-
mat are described here.

For best performance and to ensure comprehensive meta data is available, use the
iq.tar format. This is a widely used file format for Rohde & Schwarz products.

File format File extension Comment

iq-tar .iq.tar An iq-tar file contains I/Q data in binary format together with meta information that describes
the nature and the source of data, e.g. thesample rate. The objective of the iq-tar file format is
to separate I/Q data from the meta information while still having both inside one file. In addi-
tion, the file format allows a preview of the I/Q data in a web browser, and inclusion of user-
specific data.

Limitations:

Recorded files > 2 GB do not contain an xml-preview of the I/Q data.

IQW (IQIQIQ) .iqw A file that contains float32 data in a binary format (values are stored interleaved starting with
the first I value). The file does not contain any additional infromation as a header.

CSV .csv A file containing I/Q data as comma-separated values (CSV). Additional metadata can be
saved.

Matlab® v4 .mat A file containing I/Q data in Matlab® file format v4. Channel-related information is stored in
matlab variables with names starting with 'ChX_'. 'X' represents the number of the channel
with a lower bound of 1, e.g. the variable Ch1_ChannelName contains the name of the first
channel. The corresponding data is contained in ChX_Data. Optional user data can be saved
to variables named UserDataX, where 'X' starts at 0. The variable UserData_Count con-
tains the number of UserData variables. For compatibility reasons user data needs to be
saved as a 2xN char array, where the first row contains the key of the user data and the sec-
ond row the actual value. Both rows must have the same column count and are therefore
right-padded with white spaces. Variables can be written to the *.mat files in arbitrary order.

Limitations:

In general, the file format is limited to a maximum of 2 GB. A maximum of 100000000 values
can be stored in a single variable, e.g. 50000000 complex data samples.

Matlab® v7.3 .mat A file containing I/Q data in Matlab® file format v7.3.

Limitations:

The Matlab® v7.3. file format requires the Matlab® Compiler Runtime (MCR) to be installed
on the system and registered in the PATH environment variable. Download an MCR version
≥ 7.2 from http://www.mathworks.de/products/compiler/mcr/.

● IQ-tar File Format..................................................................................................461
● CSV File Format....................................................................................................465
● IQW File Format....................................................................................................467
● Matlab® v. 4 / v. 7.3 File Format...........................................................................468
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A.5.1 IQ-tar File Format

I/Q data is packed in a file with the extension .iq.tar. An iq-tar file contains I/Q data
in binary format together with meta information that describes the nature and the
source of data, e.g. the sample rate. The objective of the iq-tar file format is to separate
I/Q data from the meta information while still having both inside one file. In addition, the
file format allows you to preview the I/Q data in a web browser, and allows you to
include user-specific data.

For more details see the specification, available from the Rohde & Schwarz Internet
site: http://www.rohde-schwarz.com/en/manual/rohde-schwarz-iq-tar-file-format-specifi-
cation-manuals-gb1_78701-37313.html.

● Mandatory Data Elements.....................................................................................461
● Optional Data Elements........................................................................................ 461
● Example................................................................................................................ 463

A.5.1.1 Mandatory Data Elements

The following infromation must be available in all iq-tar files used to import data to the
R&S VSE software. This information is always provided by an iq-tar file export from the
R&S VSE software.

Parameter Name Possible Values

Name String

Comment String

DateTime Year-Month-DayTHour:Min:Sec

Format complex

DataType float32

NumberOfChannels Integer

CH<n>_ChannelName String

CH<n>_Samples Integer

CH<n>_Clock[Hz] double

CH<n>_CenterFrequency[Hz] Double

IQ Data Header <Channel Name>_I; <Channel Name>_Q

(IQ data value)

----- Double ; Double

(IQ data I/Q pairs)

A.5.1.2 Optional Data Elements

The following infromation may optionally be available in iq-tar files used to import data
to the R&S VSE software. This information may also be provided by an iq-tar file export
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from the R&S VSE software, if selected. Note that the available parameters during data
export depend on the instrument in use.

Parameter name Possible Values

Ch<n>_AttenuElecState ON | OFF

Ch<n>_AttenuElecValue[dB] Integer

Ch<n>_AttenuMech[dB] Integer

Ch<n>_CalibrationState ON | OFF

Ch<n>_DeviceHwInfo String

Ch<n>_DeviceId String

Ch<n>_DeviceOptions String

Ch<n>_DeviceVersions String

Ch<n>_FilterSettings FLAT | GAUSS | OFF

Ch<n>_HighPassFilterState ON | OFF

Ch<n>_Impedance[Ohm] 50 | 75

Ch<n>_InputCoupling AC | DC

Ch<n>_InputPath RF

Ch<n>_InputSelection INPUT1 | INPUT2

(R&S FSWT only)

Ch<n>_MeasBandwidth[Hz] double

Ch<n>_NumberOfPostSamples Integer

Ch<n>_NumberOfPreSamples Integer

Ch<n>_PreampGain[dB] Integer

Ch<n>_PreampState ON | OFF

Ch<n>_PreSelectorState ON | OFF

(R&S FSWT only)

Ch<n>_PreSelectorType NARROW | WIDE

(R&S FSWT only)

Ch<n>_RefLevelOffset[dB] Double

Ch<n>_RefLevel[dBm] Double

Ch<n>_RefOscillatorInput OFF | ON

Ch<n>_RefOscillatorFreq[Hz] Double

Ch<n>_TrgSource Extern <1 ..4> | I/Q Power | IF Power | RF Power |
Power Sensor | Time

Ch<n>_TrgLevel[dB] Double

Ch<n>_TrgHysteresis[dB] Double

Ch<n>_TrgTpis[s] Double

Reference: Supported File Formats



ReferenceR&S®VSE

463User Manual 1176.8839.02 ─ 03

Parameter name Possible Values

Ch<n>_TrgOffset[s] Double

Ch<n>_TrgSlope Rising | Falling | Rising/Falling

Ch<n>_TrgHoldoff[s] Double

Ch<n>_TrgDropOut[s] Double

Ch<n>_YigPreSelectorState ON | OFF

A.5.1.3 Example

The following example demonstrates the XML description inside the iq-tar file.

Open the xml file in a web browser. If the stylesheet
open_IqTar_xml_file_in_web_browser.xslt is in the same directory, the web
browser displays the xml file in a readable format.
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<?xml version="1.0" encoding="UTF-8"?>
<?xml-stylesheet type="text/xsl" href="open_IqTar_xml_file_in_web_browser.xslt"?>
<RS_IQ_TAR_FileFormat fileFormatVersion="1" xsi:noNamespaceSchemaLocation=
"http://www.rohde-schwarz.com/file/RsIqTar.xsd" xmlns:xsi=
"http://www.w3.org/2001/XMLSchema-instance">
  <Name>VSE_1.10a 29 Beta</Name>
  <Comment></Comment>
  <DateTime>2015-02-19T15:24:58</DateTime>
  <Samples>1301</Samples>
  <Clock unit="Hz">32000000</Clock>
  <Format>complex</Format>
  <DataType>float32</DataType>

Reference: Supported File Formats
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  <ScalingFactor unit="V">1</ScalingFactor>
  <NumberOfChannels>1</NumberOfChannels>
  <DataFilename>File.complex.1ch.float32</DataFilename>
  
<UserData>
    <RohdeSchwarz>
      <DataImportExport_MandatoryData>
        <ChannelNames>
          <ChannelName>IQ Analyzer</ChannelName>
        </ChannelNames>
        <CenterFrequency unit="Hz">0</CenterFrequency>
      </DataImportExport_MandatoryData>
      <DataImportExport_OptionalData>
        <Key name="Ch1_NumberOfPostSamples">150</Key>
        <Key name="Ch1_NumberOfPreSamples">150</Key>
      </DataImportExport_OptionalData>
    </RohdeSchwarz>
  </UserData>
 
</RS_IQ_TAR_FileFormat>

A.5.2 CSV File Format

CSV files contain I/Q data as comma-separated values. Additional metadata can be
saved.

● Mandatory Data Elements.....................................................................................465
● Optional Data Elements........................................................................................ 466
● Example................................................................................................................ 467

A.5.2.1 Mandatory Data Elements

Parameter Name Possible Values

Name String

Comment String

DateTime Year-Month-DayTHour:Min:Sec

Format complex

DataType float32

NumberOfChannels Integer

CH<n>_ChannelName String

CH<n>_Samples Integer

CH<n>_Clock[Hz] double

CH<n>_CenterFrequency[Hz] Double
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Parameter Name Possible Values

IQ Data Header <Channel Name>_I; <Channel Name>_Q

(IQ data value)

----- Double ; Double

(IQ data I/Q pairs)

A.5.2.2 Optional Data Elements

Parameter name Possible Values

Ch<n>_AttenuElecState ON | OFF

Ch<n>_AttenuElecValue[dB] Integer

Ch<n>_AttenuMech[dB] Integer

Ch<n>_CalibrationState ON | OFF

Ch<n>_DeviceHwInfo String

Ch<n>_DeviceId String

Ch<n>_DeviceOptions String

Ch<n>_DeviceVersions String

Ch<n>_FilterSettings FLAT | GAUSS | OFF

Ch<n>_HighPassFilterState ON | OFF

Ch<n>_Impedance[Ohm] 50 | 75

Ch<n>_InputCoupling AC | DC

Ch<n>_InputPath RF

Ch<n>_MeasBandwidth[Hz] double

Ch<n>_NumberOfPostSamples Integer

Ch<n>_NumberOfPreSamples Integer

Ch<n>_PreampGain[dB] Integer

Ch<n>_PreampState ON | OFF

Ch<n>_RefLevelOffset[dB] Double

Ch<n>_RefLevel[dBm] Double

Ch<n>_RefOscillatorInput OFF | ON

Ch<n>_RefOscillatorFreq[Hz] Double

Ch<n>_TrgSource Extern <1 ..4> | I/Q Power | IF Power | RF Power |
Power Sensor | Time

Ch<n>_TrgLevel[dB] Double

Ch<n>_TrgHysteresis[dB] Double

Ch<n>_TrgTpis[s] Double
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Parameter name Possible Values

Ch<n>_TrgOffset[s] Double

Ch<n>_TrgSlope Rising | Falling | Rising/Falling

Ch<n>_TrgHoldoff[s] Double

Ch<n>_TrgDropOut[s] Double

Ch<n>_YigPreSelectorState ON | OFF

A.5.2.3 Example

DataImportExport_MandatoryData;
Name;ExampleFile
Comment;Example Comment
DateTime;2015-02-19T15:26:33
Format;complex
DataType;float32
NumberOfChannels;1
Ch1_ChannelName;Example_Channel
Ch1_Samples;10
Ch1_Clock[Hz];3,2000000E+007
Ch1_CenterFrequency[Hz];100,0000000E+007
DataImportExport_EndHeaderSection;
Example_Channel_I;Example_Channel_Q
-5,9390777E-006;-3,4644620E-006
9,8984629E-007;-8,4631858E-005
-5,9885701E-005;4,1078620E-005
2,0786772E-005;7,8692778E-005
-4,9492314E-006;-1,5095156E-004
1,6332464E-005;1,8312156E-005
-5,4936470E-005;4,5532928E-005
-4,8997390E-005;9,7004937E-005
-1,1383232E-005;4,5532928E-005
-8,2157239E-005;3,2170003E-005

A.5.3 IQW File Format

IQW is a binary file format containing one channel of complex IQ data.

Format description details:
● IQDataFormat: Complex
● IQDataType: Float32
● Byte order: Intel
● Data order: IQIQIQ (I/Q paired or interleaved) or IIIQQQ (I/Q blocks, default)

Currently, the R&S VSE software saves I/Q data in interleaved order for IQW file
format.
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Mandatory Data Elements

Only the binary I/Q data.

Optional Data Elements

None.

A.5.4 Matlab® v. 4 / v. 7.3 File Format

In Matlab®files, channel-related information is stored in matlab variables with names
starting with 'ChX_'. 'X' represents the number of the channel with a lower bound of 1,
e.g. the variable Ch1_ChannelName contains the name of the first channel. The corre-
sponding data is contained in ChX_Data.

Optional user data can be saved to variables named UserDataX, where 'X' starts at 0.
The variable UserData_Count contains the number of UserData variables. For com-
patibility reasons user data needs to be saved as a 2xN char array, where the first row
contains the key of the user data and the second row the actual value. Both rows must
have the same column count and are therefore right-padded with white spaces.

Variables can be written to the *.mat files in arbitrary order.

The Matlab® v7.3. file format requires the Matlab® Compiler Runtime (MCR) to be
installed on the system and registered in the PATH environment variable.

● Mandatory Data Elements.....................................................................................468
● Optional Data Elements........................................................................................ 469
● Example................................................................................................................ 470

A.5.4.1 Mandatory Data Elements

Variable name Class Format / possible values

Name char  

Comment char  

DateTime char Year-Month-DayTHour:Min:Sec

Format char complex

DataType char float32

NumberOfChannels Double  

CH<n>_ChannelName char  

CH<n>_Samples double  

CH<n>_Clock_Hz double  

CH<n>_CFrequency_Hz Double  
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Variable name Class Format / possible values

CH<n>_Data Double, Double I,Q

UserData_Count Double (Number of optional user data variables)

A.5.4.2 Optional Data Elements

Optional user data can be saved to variables named UserDataX, where 'X' starts at 0.
The variable UserData_Count contains the number of UserData variables. For com-
patibility reasons user data needs to be saved as a 2xN char array, where the first row
contains the key of the user data and the second row the actual value. Both rows must
have the same column count and are therefore right-padded with white spaces.

Variable name Class Format

UserData<n> char Optional Data Parameter name, Value

Table 1-11: Optional parameter names to be defined in UserData<n> variables

Parameter name Possible Values

Ch<n>_AttenuElecState ON | OFF

Ch<n>_AttenuElecValue_dB Integer

Ch<n>_AttenuMech_dB Integer

Ch<n>_CalibrationState ON | OFF

Ch<n>_DeviceHwInfo String

Ch<n>_DeviceId String

Ch<n>_DeviceOptions String

Ch<n>_DeviceVersions String

Ch<n>_FilterSettings FLAT | GAUSS | OFF

Ch<n>_HighPassFilterState ON | OFF

Ch<n>_Impedance_Ohm 50 | 75

Ch<n>_InputCoupling AC | DC

Ch<n>_InputPath RF

Ch<n>_MeasBandwidth_Hz double

Ch<n>_NumberOfPostSamples Integer

Ch<n>_NumberOfPreSamples Integer

Ch<n>_PreampGain_dB Integer

Ch<n>_PreampState ON | OFF

Ch<n>_RefLevelOffset_dB Double

Ch<n>_RefLevel_dBm Double
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Parameter name Possible Values

Ch<n>_RefOscillatorInput OFF | ON

Ch<n>_RefOscillatorFreq_Hz Double

Ch<n>_TrgSource Extern <1 ..4> | I/Q Power | IF Power | RF Power |
Power Sensor | Time

Ch<n>_TrgLevel_dB Double

Ch<n>_TrgHysteresis_dB Double

Ch<n>_TrgTpis_s Double

Ch<n>_TrgOffset_s Double

Ch<n>_TrgSlope Rising | Falling | Rising/Falling

Ch<n>_TrgHoldoff_s Double

Ch<n>_TrgDropOut_s Double

Ch<n>_YigPreSelectorState ON | OFF

A.5.4.3 Example 
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List of remote commands (basic software)
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[SENSe:]ADJust:CONFigure:DURation:MODE.............................................................................................343
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CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer:MODE.....................................................................377
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